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INTRODUCTION

Overview

This manual describes how to configure and monitor the SMxTAT2SA via the web via its RJ-45 serial
interface and Ethernet ports. The SMXTAT2SA Smart Managed GbE PoE+ switch is the next-generation
Ethernet switch offering powerful L2 features with better functionality and usability. It delivers cost-
effective business and transport Ethernet services via fiber or copper connections.

The SMxTAT2SA delivers 8/16/24 (10M/100M/1G) RJ45 ports with 8 PoE+ ports (supports 802.3 at/af
and total up to 130W on the SM8TAT2SA) and 2 GbE SFP ports. SMXTAT2SA provides high hardware
performance and environment flexibility for SMBs and Enterprises. The embedded Device Managed
System (DMS) feature makes the switch easy to use, configure, install, and troubleshoot in video
surveillance, wireless access, and other SMB and Enterprise applications.

SMXTAT2SA features include:

e Compliant with IEEE 802.3at PoE+ and e SNMP v1/v2c/v3
802.3af PoE e RMON groups 1,2,3,9

e PoE configuration, Power delay, and e IGMP v1/v2/v3 and MLD v1/v2 Snooping
Scheduling e RADIUS and TACACS+ authentication

e PoE Auto Power Reset e |P Source Guard

e Device Management Software e DHCP Snooping, DHCP Relay (Option 82),
(Graphical Monitoring, Traffic DHCP statistics, DHCP per Port
Monitoring, and Troubleshooting) e 802.1d (STP), 802.1w (RSTP) and 802.1s

e |2+ features for better manageability, (MSTP)
security, QoS, and performance e LACP and static link aggregation

e |Pv4/IPv6 dual stack management e Q-in-Q double tag VLAN

e SSH/SSL secured management e GVRP dynamic VLAN

Models

This manual documents three similar models as described below. The models differ mainly in port
count. Model differences are noted where applicable in this manual.

PoE+ layer 2 Smart Managed Switch with Web GUI, SNMP management;
SMS8TAT2SA PoE scheduling, APR, and DMS feature support. Port support description:
(8) 10/100/1000Base-T PoE+ ports with 2 SFP ports

PoE+ layer 2 Smart Managed Switch with Web GUI, SNMP management;
SM16TAT2SA PoE scheduling, APR, and DMS feature support. Port support description:
(16) 10/100/1000Base-T PoE+ ports with 2 SFP ports

PoE+ layer 2 Smart Managed Switch with Web GUI, SNMP management;
SM24TAT2SA PoE scheduling, APR, and DMS feature support. Port support description:
(24) 10/100/1000Base-T PoE+ ports with 2 SFP ports

33717 Rev. C https://www.transition.com Page 8 of 284



https://www.transition.com/

Transition Networks SMXTAT2SA Web User Guide

Purpose

This manual gives specific information on how to operate and use the SMxTAT2SA Web management
functions with an HTTP/HTTPs web browser. This manual describes how to configure and monitor
SMXTAT2SA switch functions. Note that this manual provides links to third party web sites for which
Transition Networks is not responsible.

Audience

This manual is intended for use by network administrators who are responsible for operating and
maintaining network equipment; it assumes a basic working knowledge of general switch functions,
the Internet Protocol (IP), and Hypertext Transfer Protocol (HTTP).

Note: See the Install Guide for important Cautions and Warnings.

Related Manuals
Other related manuals are listed below.
. SMXTAT2SA Quick Start Guide, 33715
. SMXTAT2SA Install Guide, 33716
. SMXTATS2A CLI Reference, 33718
e  Release Notes (version specific)

For Transition Networks Drivers, Firmware, etc. go to the Product Support webpage (logon required).

For Manuals, Brochures, Data Sheets, etc. go to the Support Library (no logon required).
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Chapter 1 - Web-based Management

Initial Configuration

This chapter describes how to configure and manage the SMxTAT2SA via the web user interface. With
this facility, you can easily access and monitor through any one port of the switch all the status of the
switch, including each port activity, Spanning tree status, port aggregation status, multicast traffic, VLAN
and priority status, even illegal access. SMXTAT2SA default values are:

IP Address 192.168.1.77
Subnet Mask 255.255.255.0
Default Gateway 192.168.1.254
Username admin
Password admin

After the SMXTAT2SA interface has been configured, you can browse it. For instance, type 192.168.1.77
in the address row in a browser. The Login page displays prompting for a username and password.

The default Username is admin and default Password is admin. For first time use, enter the default
username and password, and then click the Login button. (You must enter the complete username and
password respectively.) The login process now is complete. The SMxTAT2SA allows two or more users
using administrator’s identity to manage this switch; the administrator to do the last setting will be the
configuration to affect the system.

@ Note: When you login to the switch Web page to manage, type the Username admin and press the
<tab> key. Then type the Password admin and press Enter. When you login to the switch Web Ul, you can
use IPv4 or IPv6 login to manage.

To optimize the display effect, we recommend Microsoft IE 6.0 above, Netscape V7.1 above or Firefox
V1.00 above with 1024x768 resolution. See the SMXTAT2SA Install Guide for Web browser support.

@ Note: The SMXTAT2SA has the DHCP function disabled by default, so if you do not have a
DHCP server to provide an IP addresses to the switch, enter the default IP address (192.168.1.77).

Figure 1: The Login page
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Chapter 2 - First Time Wizard

The first time you use this switch you must configure some basic settings, such as password, IP address,
date and time, and system information. Use the following procedure:

Step 1: Change default password

Enter a new password and then enter it again. Click the Next button.

e
TRANSITION

Change default password

New password

Repeat new password

Figure 2-1: Change default password
Step 2: Set IP address

Select “Obtain IP address via DHCP” or “Set IP address manually” to set the IP address.
Click the Next button.

—
JRANSITION

PAZZADRD 1P ADoRERE CATESTIME NFORMATION

Set IP address

Interface VLAN ID

1

Obitain IP address via DHCP

® Set IP address manually

IF address

192168 177

Subnet mask

255.255.255.0

Default router

182.168.1.254

Figure 2-2: Set IP address
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Step 3: Set date and time

Enable “Automatic data and time” or select manually to set date and time. Click the Next

button.

TR
JRANRNIL.

12 2

FABEWORD IP ACCREES CATE & TIME NFORMATIGN

Set date and time

Automatic date and time

IManually

2018-08-07 14:52:8

Figure 2-3: Set date and time

Step 4: Set system information

You can set some system information to this device, such as “System contact

“System location”. Click the Apply button.

=
JRANSITION.

12 8 a

FAZTNOAD IP ADDREEE DATE & TIME MFDRMATION

Set system information

System contact
System name

SMIGTATZSA

System location

[l

Figure 2-4: Set system information
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Menu Bar Overview

~T —_ &nsmn’i‘
TRANSITIION = bl B 0 &

Click the Transition Networks logo to return to the Switch > System > System Information page.

Click the == icon to toggle between the current menu path and the previous one.

e LI
. . Port 5 d
Hover the cursor over any port to see Its current status: or .

Click on any port to display its current Detailed Port Statistics page.
Top right corner icons:

B @ =

Save Help Logout Back
Reload
Save as...
# Home - System ~ System Information Prin..

Cast..

Right click to display other options:

Translate to English

View page source

Inspect
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Chapter 3 - System
This chapter describes the basic configuration tasks including System Information and certain System
parameters (e.g., IP, Advanced IP, Time, Account, IP, Syslog, and NTP.)
3-1 System Information
You can identify the system by configuring system name, location, and contact information. Additional
switch-related information is also provided here.
Web interface
To configure System Information in the web interface:
1. Click System and System Information.
2. Enter System Name, Location, and Contact information (optional).

3. Click the Apply button.

— 1
TRANSITION © =| mwsms ss - MO G
\-—’ NETWORKS
SM16TAT2SA System Information @Homs - System - System Infarmation
Switch DMS
Model Name SM1GTAT2SA
P System i
e System Description Smart Managed Switch, 16-port Gigabit PoE+, 2-port 100/1000 SFP
# IP Address 4 Hardware Version v1.03
System Time . .
¥ SR Mechanical Version v1.01
» LLDP <
Firmware Version v1.02.1415
> UPnP
PoE Firmware Version 208-211
» Port Management &
» PoE Management < MAC Address 00-C0-F2-49-3E-F6
| » vLAN Management < Serial Number €021319BR2100002
» Quality of Service < System Name SM1ETAT25A
» Spanning Tree < .
Location
» MAC Address Table <
b Multicast < Contact
» DHCP s System Date 2017-01-01 00:17:26 +0000
R ¢ .
b Security System Uptime 0days, 0:17:43
» Access Control <
» SHMP < Appl ” H
» Event Notification <
» Diagnostics <
» Maintenance &

Figure 3-1: System Information (SM16TAT2SA shown)

Parameter descriptions:
Model Name: the specific switch model number (i.e.,, SM8TAT2SA, SM16TAT2SA, or SM24TAT2SA).
System Description: e.g., Smart Managed Switch, 16-port Gigabit PoE+, 2-port 100/1000 SFP.

Hardware Version: the current version of hardware (e.g., v1.03).
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Mechanical Version: the current mechanical version (e.g., v1.01).

Firmware Version: the current running version of switch firmware (e.g., v1.02.1409).

PoE Firmware Version: the current PoE MCU FW version (e.g., 208-211).

MAC Address: the switch MAC Address (e.g., 00-40-C7-1C-CB-6E).

Serial Number: the switch S/N (e.g., C021316AR3300004 or C021319BR2100002).

System Name: An administratively assigned name for this managed node. By convention, this is the
node's fully-qualified domain name. A domain name is a text string drawn from the alphabet (A-Z, a-z),
digits (0-9), minus sign (-). No space characters are permitted as part of a name. The first or last character
must not be a minus sign. The allowed string length is 0 - 128 characters.

Location: The physical location of this node (e.g., telephone closet, 3rd floor). The allowed string length is
0 to 128, and the allowed content is an ASCII character 32-126.

Contact: The textual identification of the contact person for this managed node, with information on how
to contact this person. The allowed string length is 0-128 characters, and the allowed content is ASCII
characters 32-126.

System Date: the current date (e.g., 2019-08-13 14:23:29 +0000).

System Uptime: the amount of time the switch has been running since the last power cycle (e.g., 6 days,
23:28:42).

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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3-2 IP Address
3-2.1 1P Settings

At System > IP Address > IP Settings you can configure the IPv4 address and related parameters.

The IPv4 address for the switch could be obtained via DHCP Server for VLAN 1. To manually configure an
address, you need to change the switch's default settings to values that are compatible with your network.
You may also need to establish a default gateway between the switch and management stations that exist
on another network segment. This page lets you configure basic IP settings.

Web Interface

To configure IP settings in the web interface:

1. Click System, IP Address, IP Settings.

2. Check the "IPv4 DHCP Client Enable” box.

3. Enter the IPv4 Address, Subnet Mask, Gateway, and DNS Server parameters.
4

Click Apply.
TRANSITION ‘' =| Zwsmr . = >
\—-’ f - i
NETWORKS
SM16TAT2SA IP Settings Slizwn s SEms s ST
Switch DMS
IPv4 DHCP Client Enable [
b System
» System Information IPv4 Address 152.162.1.77
% |P Address
Subnet Mask 255.255.255.0
> IP Settings
> Advanced Gateway 192.162.1.254
> Status
DNS Server Mo DS server v
> System Time
» LLDP £ -
Apply
> UPnP |—| . | =

Figure 3-2.1: IP Settings page

Parameter descriptions:

IPv4 DHCP Client Enable: Check the box to enable DHCP Client support globally. Enable the DHCP client
by checking this box. If this option is enabled, the system will configure the IPv4 address and mask of the
interface using the DHCP protocol. The DHCP client will announce the configured System Name as
hostname to provide DNS lookup.

IPv4 Address: e.g., 192.168.1.77. The IPv4 address of the interface in dotted decimal notation. If DHCP is
enabled, this field is not used. The field may also be left blank if IPv4 operation on the interface is not
desired.

Subnet Mask: The IP address of the IP gateway. Valid format is dotted decimal notation or a valid IPv6
notation. Gateway and Network must be of the same type. User IP subnet mask of the entry (e.g.,
255.255.255.0).

Gateway: The IP address of the IP gateway. Valid format is dotted decimal notation or a valid IPv6
notation (e.g., 192.168.1.254). Gateway and Network must be of the same type.
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DNS Server: Select either No DNS server, Configured, From this DHCP interface, or
From any DHCP interfaces. If you select “Configured”, enter an IP address.

Mo DNS server ¥

No DNS server
If you select “From this DHCP interface”, enter a DNS Server number (configured in Configured

the following section “Advanced IP Settings”. From this DHCP interface
From any DHCP interfaces

This setting controls the DNS name resolution done by the switch. The following
modes are supported:

No DNS server: No DNS server will be used.
Configured: Explicitly provide the IP address of the DNS Server in dotted decimal notation.

From this DHCP interface: Specify from which DHCP-enabled interface a provided DNS server
should be preferred.

From any DHCP interfaces: The first DNS server offered from a DHCP lease to a DHCP-enabled
interface will be used.

Buttons

Apply: Click to save changes.
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3-2.1 Advanced IP Settings

The IPv4 address for the switch can be obtained via DHCP Server for VLAN 1. To manually configure an
address, you must change the switch's default settings to values that are compatible with your network.
You may also need to establish a default gateway between the switch and management stations that exist
on another network segment.

Configure the switch-managed IP information on this page and configure IP basic settings, control IP
interfaces and IP routes. You can configure up to 8 interfaces and 8 routes.

Web Interface

To configure an IP configuration in the web interface:

1. Click System, IP Address, Advanced IP Settings.

2. Click Add Interface and configure the new Interface for the switch.
3. Click Add Route and configure the new route for the switch.
4

. Click Apply.
‘ﬁ T .
TRANSITION * =| wers szss M oG
e NETWORKS
SM16TAT2SA Advanced IP Settings ghHome - System - IPAddress - Advanced IP Settings
Switch DMS
DNS Server Na DNS server v
b System v
IP Interfaces
DHCP Per Port
Mode Dissbled ¥
P
> System Time
» LLDP <
» UPnP DHCPv4 IPv4 IPVE
» Port Management < Current Mask Mask
_ Delete VLAN  Enable Fallback Lease Address Length Address Length
» PoE Management <
» WLAN Management < O 1 O
b Quality of Service 3
. ‘ Add Interface |
» Spanning Tree <
b MAC Address Table < Link-Local Address binding interface VIANL ¥
» Multicast <
» DHCP S IP Routes
» Security <
Delete Network Mask Length Gateway Next Hop VLAN
» Access Control <
(] 0.0.0.0 0 192.168.1.254 0
» SHMP <
» Event Motification < ‘ dd Route ‘
» Diagnostics <
o [pewy ) [Reset]

» Maintenance

Figure 3-2.1: Advanced IP Settings
Parameter descriptions:

Advanced IP Settings

DNS Server: Controls the DNS name resolution done by the switch. These modes are supported:
No DNS server: No DNS server will be used.
Configured: Explicitly provide the IP address of the DNS Server in dotted decimal notation.

From this DHCP interface: Specify from which DHCP-enabled interface a provided DNS server
should be preferred.
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From any DHCP interfaces: The first DNS server offered from a DHCP lease to a DHCP-enabled
interface will be used.

IP Interfaces
Delete: Select this option to delete an existing IP interface.

DHCP Per Port Mode: At the dropdown select Enable or Disable DHCP per Port operation. The default is
Disabled.

DHCP Per Port IP: Define the IP range for DHCP Per Port. The range must be equal to the number of
switch RJ45/TP ports (e.g., 16 for the SM16TAT2SA).

VLAN: The VLAN associated with the IP interface. Only ports in this VLAN will be able to access the IP
interface. This field is only available for input when creating a new interface.

DHCPv4 Enabled: Enable the IPv4 DHCP client by checking this box. If this option is enabled, the system
will configure the IPv4 address and mask of the interface using the DHCP protocol. The DHCP client will
announce the configured System Name as hostname to provide DNS lookup.

DHCPv4 Fallback: The number of seconds for trying to obtain a DHCP lease. After this Timeout period
expires, a configured IPv4 address will be used as IPv4 interface address. A value of zero disables the
fallback mechanism, such that DHCP will keep retrying until a valid lease is obtained. Legal values are 0 to
4294967295 seconds.

DHCPv4 Current Lease: For IPv4 DHCP interfaces with an active lease, this column show the current
interface address, as provided by the DHCP server.

IPv4 Address: The IPv4 address of the interface in dotted decimal notation.
If DHCP is enabled, this field is not used. The field may also be left blank if IPv4 operation on the interface
is not desired.

IPv4 Mask: The IPv4 network mask, in number of bits (prefix length). Valid values are 0 - 30 bits for an
IPv4 address. If DHCP is enabled, this field is not used. The field may also be left blank if IPv4 operation on
the interface is not desired.

IPv6 Address: The IPv6 address of the interface. An IPv6 address is in 128-bit records represented as eight
fields of up to four hexadecimal digits with a colon separating each field (:). For example,
fe80::215:¢5ff:fe03:4dc7. The symbol :: is a special syntax that can be used as a shorthand way of
representing multiple 16-bit groups of contiguous zeros; but it can appear only once. It can also represent
a legally valid IPv4 address. For example, ::192.1.2.34.

The field may be left blank if IPv6 operation on the interface is not desired.

IPv6 Mask: The IPv6 network mask, in number of bits (prefix length). Valid values are 1 - 128 bits for an
IPv6 address. The field may be left blank if IPv6 operation on the interface is not desired.

Link-Local Address binding interface: Configure Link-Local IP address to a different VLAN interface. The
first IP interface entry is for the default value.

IP Routes
Delete: Select this option to delete an existing IP route.

Network: The destination IP network or host address of this route. Valid format is dotted decimal
notation or a valid IPv6 notation. A default route can use the value 0.0.0.0or IPv6 :: notation.

Mask Length: The destination IP network or host mask, in number of bits (prefix length). It defines how
much of a network address that must match, in order to qualify for this route. Valid values are 0 - 32 bits
for IPv4 routes and128 bits for IPv6 routes. Only a default route will have a mask length of 0 (as it will
match anything).
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Gateway: The IP address of the IP gateway. Valid format is dotted decimal notation or a valid IPv6
notation. Gateway and Network must be of the same type.

Next Hop VLAN (Only for IPv6): The VLAN ID (VID) of the specific IPv6 interface associated with the
gateway. The valid VID range is 1 - 4094 and will be effective only when the corresponding IPv6 interface
is valid.

If the IPv6 gateway address is link-local, it must specify the next hop VLAN for the gateway.

If the IPv6 gateway address is not link-local, system ignores the next hop VLAN for the gateway.

Buttons

Add Interface: Click to add a new IP interface. A maximum of 8 interfaces is supported.
Add Route: Click to add a new IP route. A maximum of 8 routes is supported.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

Messages:

ERROR: DHCP Per Port IP range (192.168.1.1 - 192.168.1.10) is not equal to switch RJ45/TP port number
(16)

Subnet overlaps with VLAN 1
VLAN 1 used for more than one interface

This field is required.
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3-2.2 IP Status

This page displays the status of the IP protocol layer. The status is defined by the IP interfaces, the IP
routes and the neighbor cache (ARP cache) status.

Web Interface
To display the log configuration in the web interface:
1. Click System, IP Address, Status.

2. View the IP Configuration information.

-, =
TRANSITION =|| = >
S HETRIDRES. = - G
SM1ETAT2SA IP Status Beime o Game o Fisiws o Susa
Switch DM3 —
Auts-refresh | Rafreah |
IP Interfaces
Interfsce * Type Addrezs Status
osdo Link 00-00-00-00-00-00 UP LODPBACK RUNNING MTU:16436 Metric:d
— 0sdo 1P 137.0.0.48
osdo PG =1 /128
VLANL Link 00-40-CT-1C-CE-6E UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1
VLANL 1Pwd 162 168 177/24 Menual
VLANL IPvE FeB0:24D:CTH felc:che 64 Link Local Address
IP Routes
Network * Gateway Status Interface
0.0.0:0/0 1921681254 UF GATEWAY VLANL
00000 0000 uzp VLANL
127.0.00(24 0.0.0.0 uz OSdo
169.254.0.0/16 0.0.00 ue VLANL
162.162.4.0/24 0.0.0.0 uz VLANL
:1/128 ue 0stle
Felilz 64 up VLANL
fe80: 240 TH:felc:chBe /128 ue 0stle
02 up VLANL
Neighbour Cache
IP Address * Link Addrezs
152168199 VLAN1:00-1b-11-b2-5d-4b
DNS Server
Type IF Address Interface
Hore LLLE

Figure 3-2.2: IP Status page
Parameter descriptions:

IP Interfaces
Interface: Shows the name of the interface (e.g., OS:lo or VLAN1).
Type: Shows the address type of the entry. This may be LINK or IPv4 or IPv6.

Address: Shows the current address of the interface (of the given type; e.g., 192.168.1.77/24 or ::1/128 or
00-40-C7-1C-CB-6E).

Status: Shows the status flags of the interface (and/or address). For example: UP LOOPBACK RUNNING
MTU:16436 Metric:1 or UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1, or Manual, or Link
Local Address.
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IP Routes

Network: Shows the destination IP network or host address of this route (e.g., 192.168.1.0/24).

Gateway: Shows the gateway address of this route (e.g., 192.168.1.254 or :).

Status: Shows the status flags of the route (e.g., UP or UP GATEWAY).

Interface: Shows the name of the interface (e.g., OS:lo or VLAN1).

Neighbor Cache
IP Address: Show the IP address of the entry (e.g., 192.168.1.99).

Link Address: Show the Link (MAC) address for which a binding to the given IP address exists (e.g.,
VLAN1:00-1b-11-b2-6d-4b).

DNS Server
Type: Show the address type of the entry. This may be LINK or IPv4.
IP Address: Show the current address of the interface (of the given type).

Interface: Show the name of the interface.

Auto-refresh Refresh
Buttons LJ

Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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The switch provides manual and automatic ways to set the system time via NTP. For manual setting, enter
the "Year”, "Month”, “Day”, "Hour" and “Minute” within the valid value range indicated for each item.

Web Interface

To configure Time in the web interface:
1. Click System and System Time.
2. Specify the Time parameters.
3. Click Apply.

o=

MAC Address Table < Daylight Saving Time

» Multicast <
» DHCP <
Month Jan[v
» Security < an[v]
» Access Control < Week 1]
P SNMP <
Day Mon[¥]
» Event Notification &€
Hours o [+
» Diagnostics < |
» Maintenance <
Month san[¥]
Week 1V
Day Hon[~]
Hours o [+
Offset a0
| Apply ” Reset |

TR SITIO A JRANSITION "
N NETWORKS L)
SM16TAT2SA Time Configuration
Switch DMS
Time Configuration
» System
> System Information Clock Source Local Settingz ] |
* |P Address < :
+ System Time System Date 2017-01-01 03:06:17 (yyyy-mm-dd hh:mm:ss)
» LLDP <
> UPnP Time Zone Configuration
<
» Port Management Time Zone Nome ™
» PoE Management ¢
Acrom 0-16¢ch t
» VLAN Management € vm ( characters)
» Quality of Service €
Daylight Saving Time Configuration
» Spanning Tree €

Start Time settings

End Time settings

Offset settings

(1-720) Minutes

e c

#iHome - System - System Time

Figure 3-3: Time Configuration page

Parameter descriptions:

Time Configuration

Clock Source: There are two modes for configuring how the Clock Source from. Select "Local Settings" :
Clock Source from Local Time. Select "NTP Server" : Clock Source from NTP Server.

System Date: Show the current time of the system. The year of system date must be 2000 - 2037.
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Time Zone Configuration

Time Zone: Lists various Time Zones worldwide. Select appropriate Time Zone from the drop down and
click Apply to set.

Acronym: You can set the acronym of the time zone. This is a user configurable acronym to identify the
time zone (range: up to 16 characters).

Daylight Saving Time Configuration

Daylight Saving Time: This is used to set the clock forward or backward according to the configurations
set below for a defined Daylight Saving Time duration. Select 'Disable’ to disable the Daylight Saving Time
configuration. Select '‘Recurring' and configure the Daylight Saving Time duration to repeat the
configuration every year. Select 'Non-Recurring' and configure the Daylight Saving Time duration for
single time configuration. (Default: Disabled).

Recurring Configuration

Start time settings:
Month - Select the starting month (Jan — Dec).
Week - Select the starting week number (1-5).
Day - Select the starting day (Mon — Sun).
Hours - Select the starting hour (0-23).

End time settings:
Month - Select the starting month (Jan — Dec).
Week - Select the starting week number (1-5).
Day - Select the starting day (Mon — Sun).
Hours - Select the starting hour (0-23).

Offset settings: Offset - Enter the number of minutes to add during Daylight Saving Time. The valid range
is 1 to 1440 minutes. The default is 60 minutes.

@ NoOTE: The information under "Start Time Settings” and "End Time Settings” displays what
you set on the “Start Time Settings” and “End Time Settings” field information.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Configure NTP Server: At "Clock Source” select NTP Server. This enables the Configure NTP Server
button.

— | Jransmow : T T T W T T T : »
TRANSITION =/ msnat . Sasssars .| M OC
NETWORKS . J
SM16TAT2SA Time Configuration @Home  System - System Time
Switch DMS
Time Configuration

» System -

» SRR AT Clock Source | wtpserver v \ Configure NTP Server |

» |P Address < : :

> SEEmine System Date 2017-01-01 00:12:47 (yyyy-mm-dd hh:mm:ss)

» LLDP <

> UPnP Time Zone Configuration
(]

» Port Management < .
| Time 7one | oo -

Click the Configure NTP Server button to configure NTP server.

ﬁ —
TRANSIT'ON — || TRANSITION : TTT T LT o 9 G
= | =R : N
" NETWORKS i i il i .
SM16TAT2SA NTP Configuration @Home - System - System Time

Switch DMS

Server
P System v 1
> System Information

Server
» |P Address < 5
> System Time
» LLDP ¢ | |Server

3
> UPnP

Server
» Port Management < 4
» PoE Management <

Server
» VLAN Management < 5
» Quality of Service < Server
» Spanning Tree < 6
» MAC Address Table $ Interval v
» Multicast < 5min ,

10 min

» DHCP < ( W 15 min

Apply || R 30min
b Security < "~ | 80min

120 min -

Figure 3-3: The NTP Configuration page

NTP (Network Time Protocol) is used to sync the network time based Greenwich Mean Time (GMT). If use
the NTP mode and select a built-in NTP time server or manually specify an user-defined NTP server as well
as Time Zone, the switch will sync the time in a short after pressing Apply button. Though it synchronizes
the time automatically, NTP does not update the time periodically without user’s processing.

Time Zone is an offset time off GMT. You have to select the time zone first and then perform time sync via
NTP because the switch will combine this time zone offset and updated NTP time to come out the local
time, otherwise, you will not able to get the correct time. The switch supports configurable time zone
from =12 to +13 step 1 hour. The default Time zone is +8 Hrs.
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Parameter descriptions:

Server 1 to 6: Provide the NTP IPv4 or IPv6 address of this switch. IPv6 address is in 128-bit records
represented as eight fields of up to four hexadecimal digits with a colon separating each field (:).

For example, 'fe80::215:c5ff:fe03:4dc7'. The symbol ":' can be used as a shorthand way of representing
multiple 16-bit groups of contiguous zeros; but it can only appear once. It can also represent a valid IPv4
address. For example, '::192.1.2.34".

Interval: You can specify the time interval in seconds after which a time check Interval Z’
and, in case of deviation, a resynchronization of the internal device clock against 5 min
the specified timeserver via Network Time Protocol (NTP) should be performed. 10 min
1 15 min
The selections are 5 min, 10 min, 15 min, 30 min, 60 min, and 120 min. [ 30min
| 60min
| 120 min

Buttons: These buttons are displayed on the NTP page:
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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3-5LLDP

The switch supports the LLDP. The Link Layer Discovery Protocol (LLDP) provides a standards-based
method for enabling switches to advertise themselves to adjacent devices and to learn about adjacent
LLDP devices.

LLDP is a vendor-neutral Link Layer protocol in the Internet Protocol Suite used by network devices for
advertising their identity, capabilities, and neighbors on a IEEE 802 local area network, principally wired
Ethernet. The protocol is formally referred to by the IEEE as Station and Media Access Control Connectivity
Discovery specified in standards document IEEE 802.1AB.

3-5.1 LLDP Configuration

You can configure LLDP detail parameters on a per-port basis and the settings will take effect
immediately. This page lets you view and configure the current LLDP port settings.

Web Interface
To configure LLDP:

1.  Click System, LLDP, and LLDP Configuration.
2. Modify LLDP timing parameters.
3. Set the required mode for transmitting or receiving LLDP messages.
4.  Specify the information to include in the TLV field of advertised messages.
5. Click Apply.
\ — TRANSITION
AT = v °oc
SM16TAT2SA LLDP Conﬁguration @Home - System - LLDP - LLDP Configuration
Switch DMS
LLDP Parameters
» System ¥
> System Information Tx Interval 20 seconds
» IP Address <
> System Time Tx Hold 4 times
» LLDP v Tx Delay 2 seconds
> LLDP Configuration
» LLDP-MED Configuration Tx Reinit 2 seconds
> LLDP Neighbor
> LLDP-MED Neighbor LLDP Port Configuration

> LLDP Statistics
Optional TLVs

> UPnP
» Port Management ¢ Port Mode CDP Aware PortDescription System Name System Description System Capabilities Management Address
» PoE Management & 1 Disabled [w]
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» DHCP <
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Figure 3-5.1: LLDP Configuration page
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LLDP Parameters:

Tx Interval: The switch periodically transmits LLDP frames to its neighbors for having the network
discovery information up-to-date. The interval between each LLDP frame is determined by the Tx Interval
value. Valid values are 5 - 32768 seconds. The default is 30 seconds.

Tx Hold: Each LLDP frame contains information about how long the information in the LLDP frame will be
considered valid. The LLDP information valid period is set to Tx Hold multiplied by Tx Interval seconds.
Valid values are 2 - 10 times. The default is 4 times.

Tx Delay: If some configuration is changed (e.g. the IP address) a new LLDP frame is transmitted, but the
time between the LLDP frames will always be at least the value of Tx Delay seconds. Tx Delay cannot be
larger than 1/4 of the Tx Interval value. Valid values are 1 - 8192 seconds. The default is 2 seconds.

Tx Reinit: When a port is disabled, LLDP is disabled or the switch is rebooted, an LLDP shutdown frame is
transmitted to the neighboring units, signaling that the LLDP information isn't valid anymore. Tx Reinit
controls the number of seconds between the shutdown frame and a new LLDP initialization. Valid values
are 1 - 10 seconds. The default is 2 seconds.

LLDP Port Configuration: The LLDP port settings relate to the currently selected, as reflected by the
page header.

Port: The switch port number of the logical LLDP port.

Mode: Select LLDP mode:
Rx only The switch will not send out LLDP information, but LLDP information from neighbor units is
analyzed.

Tx only The switch will drop LLDP information received from neighbors, but will send out LLDP
information.

Disabled The switch will not send out LLDP information and will drop LLDP information received
from neighbors.

Enabled the switch will send out LLDP information and will analyze LLDP information received from
neighbors.
CDP Aware: Select CDP awareness.
The CDP operation is restricted to decoding incoming CDP frames (The switch doesn't transmit CDP
frames). CDP frames are only decoded if LLDP on the port is enabled.

Only CDP TLVs that can be mapped to a corresponding field in the LLDP neighbors’ table are decoded. All
other TLVs are discarded (Unrecognized CDP TLVs and discarded CDP frames are not shown in the LLDP
statistics.). CDP TLVs are mapped onto LLDP neighbors’ table as shown below.

CDP TLV "Device ID" is mapped to the LLDP "Chassis ID" field.

CDP TLV "Address" is mapped to the LLDP "Management Address" field. The CDP address TLV can contain
multiple addresses, but only the first address is shown in the LLDP neighbors’ table.

CDP TLV "Port ID" is mapped to the LLDP "Port ID" field.
CDP TLV "Version and Platform" is mapped to the LLDP "System Description” field.

Both the CDP and LLDP support "system capabilities”, but the CDP capabilities cover capabilities that are
not part of the LLDP. These capabilities are shown as "others" in the LLDP neighbors’ table.

If all ports have CDP awareness disabled, the switch forwards CDP frames received from neighbor devices.
If at least one port has CDP awareness enabled all CDP frames are terminated by the switch.
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NoTe: When CDP awareness on a port is disabled the CDP information isn't removed
immediately, but gets disabled when the hold time is exceeded.

Port Descr: Optional TLV: When checked the "port description” is included in LLDP information transmitted.
Sys Name: Optional TLV: When checked the "system name" is included in LLDP information transmitted.

Sys Descr: Optional TLV: When checked the "system description" is included in LLDP information
transmitted.

Sys Capa: Optional TLV: When checked the "system capability” is included in LLDP information transmitted.

Mgmt Addr: Optional TLV: When checked the "management address” is included in LLDP information
transmitted.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

Messages:

Tx Delay must not be larger than 1/4 of the Tx Interval value (IEEE 802.1AB-clause 10.5.4.2)
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Media Endpoint Discovery is an enhancement of LLDP, known as LLDP-MED that provides these facilities:

Auto-discovery of LAN policies (such as VLAN, Layer 2 Priority and Differentiated services (Diffserv)

settings) enabling plug and play networking.

Device location discovery allows creation of location databases and, in the case of Voice over Internet
Protocol (VoIP), Enhanced 911 services.

Extended and automated power management of Power over Ethernet (PoE) end points is provided.

Inventory management, allowing network administrators to track their network devices, and

determine their characteristics (manufacturer, software and hardware versions, and serial or asset

number).

This page lets you configure LLDP-MED. This function applies to VoIP devices which support LLDP-MED.

Web Interface

To configure LLDP-MED:

1.  Click System, LLDP, and LLDP-MED Configuration.
2. Modify Fast start repeat count parameter; the default is 4.
3. Modify Coordinates Location parameters.
4.  Enter Civic Address Location parameters.
5. Add and configure a new policy.
6. Click Apply, will show following Policy Port Configuration.
7. Select a Policy ID for each port.
8. Click Apply.
SM16TAT2SA LLDP-MED Configuratien @htome - System - LLDP - LLDP-MED Confguration
Switch DMS
. Fast Start Repeat Count
Fast start repeat count seconds
Coordinates Location
Latitude Nerth[V] Longitude o East [V]
Altitude saters[™] Map Datum wess ~
Civic Address Location
Country Code State/Province County o
P Port Management <
Pk Manaerment . dty City District Block (Neighborhaod)
» VLAN Management < Street Leading Street Direction Trailing Street Suffix
> ArETyEEe € Streetsuffix House No. House No. Suffix
» Spanning Tree g
b MAC Address Table = Landmark Additional Location Info Name
» Multicast < Zip Code Building Apartment
0 BET? " Foor Room Ho. Place Type
: if::'[\iar‘lml a Postal Community Name P.0. Box Additional Code
- :
 event Notfcation . Emergency Call Service
» Diagnostics 2 Emergency Call Service
» Maintenance g
Policies.
Delete Policy ID Application Type Tag VLAN ID L2 Priority DSCP
o 0 [~ Tezsed [v] 1 o [
Policy Port Configuration
Figure 3-5.2: LLDP-MED Configuration page
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Parameter descriptions:

Fast start repeat count

Rapid startup and Emergency Call Service Location Identification Discovery of endpoints is a critically
important aspect of VoIP systems in general. In addition, it is best to advertise only those pieces of
information which are specifically relevant to particular endpoint types (for example only advertise the
voice network policy to permitted voice-capable devices), both in order to conserve the limited LLDPU
space and to reduce security and system integrity issues that can come with inappropriate knowledge of
the network policy.

With this in mind LLDP-MED defines an LLDP-MED Fast Start interaction between the protocol and the
application layers on top of the protocol, in order to achieve these related properties. Initially, a Network
Connectivity Device will only transmit LLDP TLVs in an LLDPDU. Only after an LLDP-MED Endpoint Device
is detected, will an LLDP-MED capable Network Connectivity Device start to advertise LLDP-MED TLVs in
outgoing LLDPDUs on the associated port. The LLDP-MED application will temporarily speed up the
transmission of the LLDPDU to start within a second, when a new LLDP-MED neighbor has been detected
in order share LLDP-MED information as fast as possible to new neighbors.

Because there is a risk of an LLDP frame being lost during transmission between neighbors, it is
recommended to repeat the fast start transmission multiple times to increase the possibility of the
neighbors receiving the LLDP frame. With Fast start repeat count it is possible to specify the number of
times the fast start transmission would be repeated. The recommended value is 4 times, given that 4 LLDP
frames with a 1 second interval will be transmitted, when an LLDP frame with new information is received.

It should be noted that LLDP-MED and the LLDP-MED Fast Start mechanism is only intended to run on
links between LLDP-MED Network Connectivity Devices and Endpoint Devices, and as such does not apply
to links between LAN infrastructure elements, including Network Connectivity Devices, or other types of
links.

Coordinates Location

Latitude: Latitude normalized to within 0-90 degrees with a maximum of 4 digits. It is possible to specify
the direction to either North of the equator or South of the equator.

Longitude: Longitude normalized to within 0-180 degrees with a maximum of 4 digits. It is possible to
specify the direction to either East of the prime meridian or West of the prime meridian.

Altitude: Altitude normalized to within -32767 to 32767 with a maximum of 4 digits.
It is possible to select between two altitude types (floors or meters).
Meters: Representing meters of Altitude defined by the vertical datum specified.

Floors: Representing altitude in a form more relevant in buildings which have different floor-to-floor
dimensions. An altitude = 0.0 is meaningful even outside a building, and represents ground level at the
given latitude and longitude. Inside a building, 0.0 represents the floor level associated with ground level
at the main entrance.

Map Datum: The Map Datum is used for the coordinates given in these options:

WGS84: (Geographical 3D) - World Geodesic System 1984, CRS Code 4327, and Prime Meridian
Name: Greenwich.

NAD83/NAVD88: North American Datum 1983, CRS Code 4269, Prime Meridian Name: Greenwich;
the associated vertical datum is the North American Vertical Datum of 1988 (NAVD88). This datum
pair is to be used when referencing locations on land, not near tidal water (which would use Datum
= NAD83/MLLW).
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NADS83/MLLW: North American Datum 1983, CRS Code 4269, Prime Meridian Name: Greenwich;
the associated vertical datum is Mean Lower Low Water (MLLW). This datum pair is to be used when
referencing locations on water/sea/ocean.

Civic Address Location: IETF Geopriv Civic Address based Location Configuration Information (Civic
Address LCI).

Country code: The two-letter ISO 3166 country code in capital ASCII letters - Example: DK, DE or US.
State: National subdivisions (state, canton, region, province, prefecture).
County: County, parish, gun (Japan), district.

City: City, township, shi (Japan) - Example: Copenhagen.

City district: City division, borough, city district, ward, chou (Japan).
Block (Neighborhood): Neighborhood, block.

Street: Street - Example: Poppelve;.

Leading street direction: Leading street direction - Example: N.

Trailing street suffix: Trailing street suffix - Example: SW.

Street suffix: Street suffix - Example: Ave, Platz.

House no.: House number - Example: 21.

House no. suffix: House number suffix - Example: A, 1/2.

Landmark: Landmark or vanity address - Example: Columbia University.
Additional location info: Additional location info - Example: South Wing.
Name: Name (residence and office occupant) - Example: Flemming Jahn.
Zip code: Postal/zip code - Example: 2791.

Building: Building (structure) - Example: Low Library.

Apartment: Unit (Apartment, suite) - Example: Apt 42.

Floor: Floor - Example: 4.

Room no. : Room number - Example: 450F.

Place type: Place type - Example: Office.

Postal community name: Postal community name - Example: Leonia.
P.O. Box: Post office box (P.O. BOX) - Example: 12345,

Additional code: Additional code - Example: 1320300003.

Emergency Call Service: Emergency Call Service (e.g. E911 and others), such as defined by TIA or NENA.

Emergency Call Service: Emergency Call Service ELIN identifier data format is defined to carry the ELIN
identifier as used during emergency call setup to a traditional CAMA or ISDN trunk-based PSAP. This
format consists of a numerical digit string, corresponding to the ELIN to be used for emergency calling.

Policies: Network Policy Discovery enables the efficient discovery and diagnosis of mismatch issues with
the VLAN configuration, along with the associated Layer 2 and Layer 3 attributes, which apply for a set of
specific protocol applications on that port. Improper network policy configurations are a very significant
issue in VoIP environments that frequently result in voice quality degradation or loss of service.
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Policies are only intended for use with applications that have specific 'real-time' network policy
requirements, such as interactive voice and/or video services.

The network policy attributes advertised are:

1. Layer 2 VLAN ID (IEEE 802.1Q-2003)
2. Layer 2 priority value (IEEE 802.1D-2004)
3. Layer 3 Diffserv code point (DSCP) value (IETF RFC 2474)

This network policy is potentially advertised and associated with multiple sets of application types
supported on a given port. The application types specifically addressed are:

1. Voice

2. Guest Voice

3. Softphone Voice

4. Video Conferencing

5. Streaming Video

6. Control / Signalling (conditionally support a separate network policy for the media types above)

A large network may support multiple VoIP policies across the entire organization, and different policies
per application type. LLDP-MED allows multiple policies to be advertised per port, each corresponding to
a different application type. Different ports on the same Network Connectivity Device may advertise
different sets of policies, based on the authenticated user identity or port configuration.

It should be noted that LLDP-MED is not intended to run on links other than between Network
Connectivity Devices and Endpoints, and therefore does not need to advertise the multitude of network
policies that frequently run on an aggregated link interior to the LAN.

Delete: Check to delete the policy. It will be deleted during the next save.

Policy ID: ID for the policy. This is auto generated and is used when selecting the polices that will be
mapped to the specific ports.

Application Type: Intended use of the application; types include:
Application Type

Voice - for use by dedicated IP Telephony handsets and other similar appliances

supporting interactive voice services. These devices are typically deployed on a Voice Signaling v
separate VLAN for ease of deployment and enhanced security by isolation from data Voics
applications.
Guest Voice
Voice Signalling (conditional) - for use in network topologies that require a different Guest Voice Signaling
. . . . . . . . . Softphene Voica
policy for the voice signalling than for the voice media. This application type should Video Conferancing
not be advertised if all the same network policies apply as those advertised in the Streaming Video
Voice application policy. | Videa Signaling

Guest Voice - support a separate 'limited feature-set' voice service for guest users and visitors with their
own IP Telephony handsets and other similar appliances supporting interactive voice services.

Guest Voice Signalling (conditional) - for use in network topologies that require a different policy for
the guest voice signalling than for the guest voice media. This application type should not be advertised
if all the same network policies apply as those advertised in the Guest Voice application policy.

Softphone Voice - for use by softphone applications on typical data centric devices, such as PCs or
laptops. This class of endpoints frequently does not support multiple VLANS, if at all, and are typically
configured to use an 'untagged' VLAN or a single 'tagged' data specific VLAN. When a network policy is
defined for use with an 'untagged' VLAN (see Tagged flag below), then the L2 priority field is ignored
and only the DSCP value has relevance.

Video Conferencing - for use by dedicated Video Conferencing equipment and other similar appliances
supporting real-time interactive video/audio services.
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Streaming Video - for use by broadcast or multicast based video content distribution and other similar
applications supporting streaming video services that require specific network policy treatment. Video
applications relying on TCP with buffering would not be an intended use of this application type.

Video Signalling (conditional) - for use in network topologies that require a separate policy for the
video signalling than for the video media. This application type should not be advertised if all the same
network policies apply as those advertised in the Video Conferencing application policy.

Tag : Tag indicating whether the specified application type is using a 'tagged' or an 'untagged' VLAN.

Untagged indicates that the device is using an untagged frame format and as such does not include a tag
header as defined by IEEE 802.1Q-2003. In this case, both the VLAN ID and the Layer 2 priority fields are
ignored and only the DSCP value has relevance.

Tagged indicates that the device is using the IEEE 802.1Q tagged frame format, and that both the VLAN
ID and the Layer 2 priority values are being used, as well as the DSCP value. The tagged format includes
an additional field, known as the tag header. The tagged frame format also includes priority tagged
frames as defined by IEEE 802.1Q-2003.

VLAN ID : VLAN identifier (VID) for the port as defined in IEEE 802.1Q-2003.

L2 Priority: L2 Priority is the Layer 2 priority to be used for the specified application type. L2 Priority may
specify one of eight priority levels (0 through 7), as defined by IEEE 802.1D-2004. A value of O represents
use of the default priority as defined in IEEE 802.1D-2004.

DSCP: DSCP value to be used to provide Diffserv node behavior for the specified application type as
defined in IETF RFC 2474. DSCP may contain one of 64 code point values (0 through 63). A value of 0
represents use of the default DSCP value as defined in RFC 2475.

Port Policies Configuration: Every port may advertise a unique set of network policies or different
attributes for the same network policies, based on the authenticated user identity or port configuration.

Port: The port number to which the configuration applies.

Policy Id: The set of policies that will apply to a given port. The set of policies is selected by check
marking the checkboxes that corresponds to the policies.

Buttons

Adding New Policy: Click to add a new policy. Specify the Application type, Tag, VLAN ID, L2 Priority and
DSCP for the new policy. Click "Apply".

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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3-5.3 LLDP Neighbor

This page provides a status overview for all LLDP neighbors. The displayed table contains a row for each
port on which an LLDP neighbor is detected.
Web Interface
To show LLDP neighbors:
1. Click System, LLDP, and LLDP Neighbor.
2. Click Refresh to manually update the web page.

3. Click Auto-refresh to automatically update web page every 3 seconds.

N TRANSITION ™ [T T T W T T = 'S
\TRA,.NSITION =| = SRee Beny = = MO cC
NETWORKS
SM16TAT2SA LLDP Neighhor Information giHoms - System - LLDP - LLDP Nelghbar
Switch DMS
Auto-refresh Refresh
b System £
» System Information Local Port Management
P Add Port  ChassisID  PortID Description  System Name  System Capabilities System Description Address
» Address
e Bridge(-}, WLAN Access
v EEmE Port AC-CCBE- AC-CCBE- axis- = (s LA o : AXIS M3106-LVE Mk Il Metwork 192.168.0.90
eth0 Point(-}, Router(-), Station B
» LLDP ~ 3 AD-F8-ZA  AD-FB-2A acccBeadfg2a Only(2) Camera 8.30.1.1 (1Pv4)
y(+)
> LLDP Configuration
Port  00-CO-F2- Smart Managed Switch, 16-port 192.168.1.77
> LLDP-MED Configuration 18 Port #18 SM1GTAT2SA  Bridge(+) R ) & . P . N \u !
] 45-3E-F6 : Gigabit PoE+, 2-port 100/1000 SFP | (IPv4)
> LLDP Neighbar
. Part  00-CO-F2- X Smart Managed Switch, 16-port 192.168.1.77
> LLDP-MED Neighbor o Port #9 SM1GTAT2SA  Bridge(+) R R & . P . N \u !
18 45-3E-F6 : Gigabit PoE+, 2-port 100/1000 SFP | (IPv4)

> LLDP Statistics

Figure 3-5.3: LLDP Neighbor Information

@ Note: If your network device doesn’t support LLDP the table displays “"No LLDP neighbor
information found".

Parameter descriptions:

Local Port: The port on which the LLDP frame was received.

Chassis ID: The Chassis ID is the identification of the neighbor's LLDP frames.

Port ID: The Remote Port ID is the identification of the neighbor port.

Port Description: Port Description is the port description advertised by the neighbor unit.
System Name: System Name is the name advertised by the neighbor unit.

System Capabilities: System Capabilities describes the neighbor unit's capabilities. The possible
capabilities are:

=

. Other

. Repeater

. Bridge

. WLAN Access Point

. Router

. Telephone

. DOCSIS cable device
. Station only

. Reserved

W oo NOoOuU b~ WN
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When a capability is enabled, the capability is followed by (+). If the capability is disabled, the capability is
followed by a (-).

System Description: Displays the system description.

Management Address: The neighbor unit's address that is used for higher layer entities to assist
discovery by the network management. This could for instance hold the neighbor's IP address.

Auto-refresh ‘ Refresh J
Buttons —

Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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3-5.4 LLDP-MED Neighbor

This page provides a status overview of all LLDP-MED neighbors. The displayed table contains a row for
each port on which an LLDP neighbor is detected. This function applies to VoIP devices which support
LLDP-MED.

Web Interface

To show LLDP-MED neighbor:

1. Click System, LLDP, and LLDP-MED Neighbor.

2. Click Refresh to manually update web page.

3. Click Auto-refresh for auto-update web page.

LLDP-MED Neighbor Information @Home - System - LLOP - LLDP-MED Neighbor
Auto-refresh Refrest
Port5
Device Capabilities
Type
Endpoint e : Z Z
s LLDP-MED Capabilities, Network Policy, Extended Power via MDI - PD, Inventory
ass
Application Policy Tag VLANID Priority DSCP
Type
Voice
. . Unknown Untagged
Signaling
Auto- Auto- Auto-negotiation Capabilities MAU Type

negotiation negotiation
status

1000BASE-T half duplex mode, 1000BASE-X, -LX, -SX, -CX full duplex mode 100BaseTXFD - 2 pair
Supported Enabled Asymmetric and Symmetric PAUSE for full-duplex inks, Symmetric PAUSE for full- category 5 UTP, full duplex
duplex links mode

Figure 3-5.4: LLDP-MED Neighbor Information page

@ NoTe: If your network has no devices that support LLDP-MED then the table will show
"No LLDP-MED neighbor information found".

Parameter descriptions
Port: The port on which the LLDP frame was received.

Device Type: LLDP-MED Devices are comprised of two primary Device Types: Network Connectivity
Devices and Endpoint Devices.

LLDP-MED Network Connectivity Device Definition: LLDP-MED Network Connectivity Devices, as
defined in TIA-1057, provide access to the IEEE 802 based LAN infrastructure for LLDP-MED Endpoint
Devices. An LLDP-MED Network Connectivity Device is a LAN access device based on any of these
technologies:

1. LAN Switch/Router

2.IEEE 802.1 Bridge

3. IEEE 802.3 Repeater (included for historical reasons)

4. IEEE 802.11 Wireless Access Point

5. Any device that supports the IEEE 802.1AB and MED extensions defined by TIA-1057 and can relay
IEEE 802 frames via any method.
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LLDP-MED Endpoint Device Definition: LLDP-MED Endpoint Devices, as defined in TIA-1057, are located
at the IEEE 802 LAN network edge, and participate in IP communication service using the LLDP-MED
framework.

Within the LLDP-MED Endpoint Device category, the LLDP-MED scheme is broken into further Endpoint
Device Classes, as defined in the following.

Each LLDP-MED Endpoint Device Class is defined to build on the capabilities defined for the previous
Endpoint Device Class. For-example will any LLDP-MED Endpoint Device claiming compliance as a Media
Endpoint (Class II) also support all aspects of TIA-1057 applicable to Generic Endpoints (Class I), and any
LLDP-MED Endpoint Device claiming compliance as a Communication Device (Class III) will also support
all aspects of TIA-1057 applicable to both Media Endpoints (Class II) and Generic Endpoints (Class I).

LLDP-MED Generic Endpoint (Class I): The LLDP-MED Generic Endpoint (Class I) definition is applicable
to all endpoint products that require the base LLDP discovery services defined in TIA-1057, however do
not support IP media or act as an end-user communication appliance. Such devices may include (but are
not limited to) IP Communication Controllers, other communication related servers, or any device
requiring basic services as defined in TIA-1057.

Discovery services defined in this class include LAN configuration, device location, network policy, power
management, and inventory management.

LLDP-MED Media Endpoint (Class II): The LLDP-MED Media Endpoint (Class II) definition is applicable to
all endpoint products that have IP media capabilities however may or may not be associated with a
particular end user. Capabilities include all of the capabilities defined for the previous Generic Endpoint
Class (Class I), and are extended to include aspects related to media streaming. Example product
categories expected to adhere to this class include (but are not limited to) Voice / Media Gateways,
Conference Bridges, Media Servers, and similar.

Discovery services defined in this class include media-type-specific network layer policy discovery.

LLDP-MED Communication Endpoint (Class III): The LLDP-MED Communication Endpoint (Class III)
definition is applicable to all endpoint products that act as end user communication appliances
supporting IP media. Capabilities include all of the capabilities defined for the previous Generic Endpoint
(Class I) and Media Endpoint (Class II) classes, and are extended to include aspects related to end user
devices. Example product categories expected to adhere to this class include (but are not limited to) end
user communication appliances, such as IP Phones, PC-based softphones, or other communication
appliances that directly support the end user.

Discovery services defined in this class include provision of location identifier (including ECS / E911
information), embedded L2 switch support, inventory management.

LLDP-MED Capabilities: Describes the neighborhood unit's LLDP-MED capabilities. The possible
capabilities are:

1. LLDP-MED capabilities

2. Network Policy

3. Location Identification

4. Extended Power via MDI - PSE
5. Extended Power via MDI - PD
6. Inventory

7. Reserved
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Application Type: Indicates the primary function of the application(s) defined for this network policy,
advertised by an Endpoint or Network Connectivity Device. The possible application types are:

Voice - for use by dedicated IP Telephony handsets and other similar appliances supporting
interactive voice services. These devices are typically deployed on a separate VLAN for ease of
deployment and enhanced security by isolation from data applications.

Voice Signalling - for use in network topologies that require a different policy for the voice
signalling than for the voice media.

Guest Voice - to support a separate limited feature-set voice service for guest users and visitors with
their own IP Telephony handsets and other similar appliances supporting interactive voice services.

Guest Voice Signalling - for use in network topologies that require a different policy for the guest
voice signalling than for the guest voice media.

Softphone Voice - for use by softphone applications on typical data centric devices, such as PCs or
laptops.

Video Conferencing - for use by dedicated Video Conferencing equipment and other similar
appliances supporting real-time interactive video/audio services.

Streaming Video - for use by broadcast or multicast based video content distribution and other
similar applications supporting streaming video services that require specific network policy
treatment. Video applications relying on TCP with buffering would not be an intended use of this
application type.

Video Signalling - for use in network topologies that require a separate policy for the video
signalling than for the video media.

Policy: Indicates that an Endpoint Device wants to explicitly advertise that the policy is required by the
device. Can be either Defined or Unknown

Unknown: The network policy for the specified application type is currently unknown.

Defined: The network policy is defined.

TAG: Indicates whether the specified application type is using a tagged or an untagged VLAN. Can be
Tagged or Untagged.

Untagged: The device is using an untagged frame format and as such does not include a tag
header as defined by IEEE 802.1Q-2003.
Tagged: The device is using the IEEE 802.1Q tagged frame format.
VLAN ID: The VLAN identifier (VID) for the port as defined in IEEE 802.1Q-2003. A value of 1 through 4094
is used to define a valid VLAN ID. A value of O (Priority Tagged) is used if the device is using priority tagged

frames as defined by IEEE 802.1Q-2003, meaning that only the IEEE 802.1D priority level is significant and
the default PVID of the ingress port is used instead.

Priority: The Layer 2 priority to be used for the specified application type. One of the eight priority levels
(0 through 7).

DSCP: The DSCP value to be used to provide Diffserv node behavior for the specified application type as
defined in IETF RFC 2474. Contain one of 64 code point values (0 through 63).

Auto-negotiation: Identifies if MAC/PHY auto-negotiation is supported by the link partner.

Auto-negotiation status: identifies if auto-negotiation is currently enabled at the link partner.
If Auto-negotiation is supported and Auto-negotiation status is disabled, the 802.3 PMD operating mode
will be determined the operational MAU type field value rather than by auto-negotiation.

Auto-negotiation Capabilities: shows the link partners MAC/PHY capabilities.
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Buttons

Auto-refresh: Check to refresh the page automatically every 3 Auto-refresh | S J
seconds.

Refresh: Click to manually refresh the page immediately.
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Two types of counters are shown. Global counters are counters that refer to the whole switch, while Local

counters refer to per port counters for the switch.

Web Interface

To show LLDP Statistics:

1

2
3.
4

Click System, LLDP, and LLDP Statistics.

Click Refresh to manually update the web screen.

Click Auto-refresh to auto-update the web screen.

Click Clear to clear all counters.

—
JensITION

SM16TAT2SA
Switch DMS

System

ormation

Port Management
PoE Management
VLAN Management
Quality of Service
Spanning Tree
MAC Address Table
Multicast

DHCP

Security

Access Control
SNMP

Event Notification

Diagnostics

Il
(

LLDP Statistics

Auto-refresh

LLDP Global Counters

Neighbor entries were last changed

Total Neighbors Entries Added

Total Neighbors Entries Deleted

Total Neighbars Entries Dropped

Total Neighbors Entries Aged Qut

LLDP Statistics Local Counters

Local Port

1

2

3

@

@

w

10

Parameter descriptions:

Global Counters

Tx Frames

311

Rx Frames Rx Errors

0 0
0 0
] 0
0 0
0 0
0 0
0 0
0 0
262 0
0 0

0 days, 0:00:30 (30 sec. ago)

[}

=

26

0

85

Frames Discarded

0

0

0

0

TLVs Discarded

0

0

0

0

Figure 3-5.5: LLDP Statistics

TLVs Unrecognized
0
0

0

@ Home

H oG

System - LLDP - LLDP Statistics

Org. Discarded Age-Outs

0

Q

0

Neighbor entries were last changed: Shows the time when the last entry was last deleted or added. It
also shows the time elapsed since the last change was detected.

Total Neighbors Entries Added: Shows the number of new entries added since switch reboot.

Total Neighbors Entries Deleted: Shows the number of new entries deleted since switch reboot.

Total Neighbors Entries Dropped: Shows the number of LLDP frames dropped due to the entry table
being full.
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Total Neighbors Entries Aged Out: Shows the number of entries deleted due to Time-To-Live expiring.

Local Counters: The displayed table contains a row for each port. The columns hold the following
information:

Local Port: The port on which LLDP frames are received or transmitted.

Tx Frames: The number of LLDP frames transmitted on the port.

Rx Frames: The number of LLDP frames received on the port.

Rx Errors: The number of received LLDP frames containing some kind of error.

Frames Discarded: If an LLDP frame is received on a port, and the switch's internal table has run full, the
LLDP frame is counted and discarded. This situation is known as "Too Many Neighbors" in the LLDP
standard. LLDP frames require a new entry in the table when the Chassis ID or Remote Port ID is not
already contained within the table. Entries are removed from the table when a given port's link is down, an
LLDP shutdown frame is received, or when the entry ages out.

TLVs Discarded: Each LLDP frame can contain multiple pieces of information, known as TLVs (TLV is short
for "Type Length Value"). If a TLV is malformed, it is counted and discarded.

TLVs Unrecognized: The number of well-formed TLVs, but with an unknown type value.
Org. Discarded: The number of organizationally received TLVs.

Age-Outs: Each LLDP frame contains information about how long time the LLDP information is valid (age-
out time). If no new LLDP frame is received within the age out time, the LLDP information is removed, and
the Age-Out counter is incremented.

Buttons Auto-refresh

Auto-refresh: Check to refresh the page automatically every 3
seconds.

Refresh: Click to manually refresh the page immediately.

Clear: Clears the counters for the selected port.
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3-6 UPnP

The goals of UPnP (Universal Plug and Play) are to allow devices to connect seamlessly and to simplify the
implementation of networks in the home (data sharing, communications, and entertainment) and in
corporate environments for simplified installation of computer components.

Web Interface

To configure the UPnP Configuration in the web interface:
Click System and UPnP.

2. Scroll to select the mode to enable or disable.
3. Specify the parameters in each field.
4. Click the Apply button to save the setting.
5. To cancel the setting click the Reset button to revert to previously saved values.
e —
TR ITI N — &NSITION
\.—-’ r‘,§ J}O'\\.) = :
SM16TAT2SA UPnP Configuration arme @ L
Switch DMS :
Mode ﬁ
» System e '
> System Information Interface VLAN .
» |P Address <
> System Time TTL 4
» LLDP < - -
Advertising Duration 100
> UPnP
» Port Management g | Apply H Reset
A DalC Manacamant L4

Figure 3-6: UPnP Configuration page
Parameter descriptions:
Mode: Indicates the UPnP operation mode. Possible modes are:

Enabled: Enable UPnP mode operation.
Disabled: Disable UPnP mode operation.

When Mode is enabled, two ACEs are added automatically to trap UPNP related packets to the CPU. The
ACEs are automatically removed when the mode is disabled.

Interface VLAN: The Interface VLAN value is used by UPnP to send SSDP advertisement messages for the
Interface VLAN. Valid values are VIDs 1 - 4095.

TTL: The Time To Live (TTL) value is used by UPnP to send SSDP advertisement messages. Valid values are
1 - 255 seconds.

Advertising Duration: The duration, carried in SSDP packets, is used to inform a control point or control
points how often it or they should receive an SSDP advertisement message from this switch. If a control
point does not receive any message within the duration, it will think that the switch no longer exists. Due
to the unreliable nature of UDP, in the standard it is recommended that such refreshing of advertisements
to be done at less than one-half of the advertising duration. In the implementation, the switch sends SSDP
messages periodically at the interval one-half of the advertising duration minus 30 seconds. Valid values
are 100 - 86400 seconds.
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Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Chapter 4 - Port Management

This page lets you configure the Port parameters of the switch, and enable or disable a switch Port.
You can also monitor the ports’ speed and flow control status here.

4-1 Port Configuration

This page lets you view and configure current port parameters.

Web Interface

To configure a current Port Configuration in the web interface:

1. Click Port Management and Port Configuration.

2. Specify the Speed Configured, Flow Control, and Power Control.

3. Specify the detail Port alias or description an alphanumeric string describing the full name and version
identification for the system'’s hardware type, software version, and networking application.

4. Click the Apply button.

— | JRansmON® 2 :
TRANSITION ® =| wer — - MO
VNETWORKS 3
SMI16TAT2SA Port conﬁguration @Home =~ Port Management - Port Configurstion
Switch DMS
| Refresh
» System <
» PortManagement w Speed Flow Control
» anitraig TN Port Link  Status Mode Rx Status  Tx Status Mode  Description
> Port Statistics
» SFP Port Information 1 . down Auta Y| off Off O
> Energy Efficient Ethernet
i e |2 ®  1oomfdx Auta v || off off O
» Loop Protection <
3 ®  1oomfdx Auto v off off O
» PoE Management <
» VLAN Manage <
VLAN Management 4 ®  oowmfdx Auto v| Off off O
b Quality of Service <
» Spanning Tree & 5 . 1Gfdx Auto Y On Oon O
» MAC Address Table <
T < |6 ®  1oomfdx Auto v off off O
» DHCP <
7 ®  cfdx Auto v on on O
b Security &
SR <
D frwes Conil 8 ® icidk auts v off off O

Figure 4-1: Port Configuration page
Parameter descriptions:
Port: This is the logical port number for this row.
Link: The current link state is displayed graphically. Green means the link is up and red means it is down.

Status: Provides the current link speed of the port.
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Mode: (Configured Link Speed) Select any available link speed for the given switch port. Only speeds
supported by the specific port are shown. Possible speeds are:
Disabled - Disables the switch port operation.

Auto - Port auto negotiating speed with the link partner and selects the highest speed that is
compatible with the link partner.

10Mbps HDX - Forces the cu port in 10Mbps half-duplex mode. Mode
10Mbps FDX - Forces the cu port in 10Mbps full duplex mode.
100Mbps HDX - Forces the cu port in 100Mbps half-duplex mode.
100Mbps FDX - Forces the cu port in 100Mbps full duplex mode.
1Gbps FDX - Forces the port in 1Gbps full duplex

2.5Gbps FDX - Forces the Serdes port in 2.5Gbps full duplex mode.

SFP_Auto_AMS - Automatically determines the speed of the SFP. Note: There is no standardized way
to do SFP auto detect, so here it is done by reading the SFP rom. Due to the missing standardized way
of doing SFP auto detect some SFPs might not be detectable. The port is set in AMS mode. Cu port is
set in Auto mode.

100-FX - SFP port in 100-FX speed. Cu port disabled.

100-FX_AMS - Port in AMS mode. SFP port in 100-FX speed. Cu port in Auto mode.

1000-X - SFP port in 1000-X speed. Cu port disabled.

1000-X_AMS - Port in AMS mode. SFP port in 1000-X speed. Cu port in Auto mode. Ports in AMS

mode with 1000-X speed have Cu port preferred. Ports in AMS mode with 100-FX speed have fiber
port preferred.

Flow Control: When Auto Speed is selected on a port, this section indicates the flow control capability that
is advertised to the link partner. When a fixed-speed setting is selected, that is what is used.

The Current Rx column indicates whether pause frames on the port are obeyed, and the Current Tx column
indicates whether pause frames on the port are transmitted. The Rx and Tx settings are determined by the
result of the last Auto-Negotiation.

Check the configured column to use flow control. This setting is related to the setting for Configured Link
Speed.

Description: Enter up to 63 characters to be descriptive name for identifies this port.

Buttons
Refresh: Click to refresh the Port link Status manually.
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

33717 Rev.D https://www.transition.com Page 44 of 284



https://www.transition.com/
http://192.168.1.1/help/glossary.htm#autoneg

Transition Networks SMXTAT2SA Web User Guide
4-2 Port Statistics

The section describes the Port statistics information and provides an overview of general traffic statistics
for all switch ports.

Web Interface

To display the Port Statistics Overview in the web interface:

1. Click Port Management and Port Statistics.

2. To automatically refresh select “Auto-refresh”.

3. Click " Refresh” to refresh the port statistics or clear all information when you click “ Clear”.

4

To view detailed port statistics, click that port.

= -
TRANSITION © =/ wens =T - H oG
N NETWORKS
SM16TAT2SA Port Statistics Overview @Home - Port Management - Port Statistics
Switch DMS
Auto-refresh
» System <
, " Packets Bytes Errors Drops
Port Received Transmitted Received Transmitted Received Transmitted Received Transmitted
’ 1 15723 715820109 2836438 912124418669 0 0 751 0
L % 2 0 0 0 0 0 0 0 0
cient nernet
< 3 357107 73391126 229401144 91784832464 0 0 36 0
SEder S 4 28779 73528304 2624141 91719851355 0 259 67 259
L POl e C s 762 73565720 263652 91770997826 0 0 0 0
» VLAN Manage <
VLAN Management 5 15172 73567443 10084124 91771589583 0 0 240 0
» Quality of Service <
7 0 0 0 0 0 0 0 0
» Spanning Tree <
] 0 715802368 0 918114610755 0 0 0 0
¥ MAC Address Table <
— . 5 737200468 740533268 917648055213 917613523440 0 0 125688 0
Multicast
» DHCP < 10 16809 73569288 11418326 91774049150 0 0 235 ]

Figure 4-2: Port Statistics Overview page

Parameter descriptions:

Port: The logical port for the settings contained in the same row.

Packets: The number of received and transmitted packets per port.

Bytes: The number of received and transmitted bytes per port.

Errors: The number of frames received in error and the number of incomplete transmissions per port.

Drops: The number of frames discarded due to ingress or egress congestion.

Buttons
Auto-refresh: Click to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.

{ Clear J

Auto-refresh [ Refresh

Clear: Clears the counters for all ports.
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Click a linked port to see its detailed port statistics. The displayed counters are the totals for receive and
transmit, the size counters for receive and transmit, and the error counters for receive and transmit.

Figure 4-2: Detailed Port Statistics page

Parameter descriptions:

== — ‘
TRANSITION — H @ &
N NETWORKS = L G
SM16TAT25A Detailed Port 2 Statistics #roms - PorMansgement - Far: Statistics
Switch DMS —
Auto-refresh Refresh ‘ Clear | Port2 [v]
» System
» Port Management Receive Total Transmit Total
» EIET T Rx Packets 10442 Tx Packets 128330
ort 5t ics
Rx Octets 3020304 Tx Octets 19184966
Rx Unicast 14543 Tx Unicast 11274
Rx Multicast 22 Tx Multicast 12664
Rx Broadcast 4877 Tx Broadcast 104401
» PoE Management
Rx Pause i} Tx Pause 0
» VLAN Management
» Quality of Service Receive Size Counters Transmit Size Counters
o :
SPEMTIEES Rx 64 Bytes 13855 Tx 64 Bytes 99311
» MAC Address Table
R 65-127 Bytes 1178 Tx65-127 Bytes 16121
» Multicast
Rx 128-255 Bytes 1 Tx 128-255 Bytes 1329
» DHCP
i R 256-511 Bytes 4323 Tx256-511 Bytes 5223
» Security
» Access Control Rx 512-1023 Bytes 12 Tx 512-1023 Bytes 556
» SNMP Roc 1024-1518 Bytes 3 Tx1024-1518 Bytes 5799
» Event Notification Rx 1519-2047 Bytes i} Tx 1519-2047 Bytes 0
> DEEEE Rx 2048-4095 Bytes 0 Tx2048-4095 Bytes 0
r l\1aiﬂtenaﬂEE e AAAE A5 Db n Tar AROS OO S Db n

Upper left scroll bar: To scroll which port to display the Port statistics with “Port-1", “Port-2", ...

Receive Total and Transmit Total

Rx and Tx Packets: The number of received and transmitted (good and bad) packets.

Rx and Tx Octets: The number of received and transmitted (good and bad) bytes. Includes FCS but excludes

framing bits.

Rx and Tx Unicast: The number of received and transmitted (good and bad) unicast packets.

Rx and Tx Multicast: The number of received and transmitted (good and bad) multicast packets.
Rx and Tx Broadcast: The number of received and transmitted (good and bad) broadcast packets.

Rx and Tx Pause: A count of the MAC Control frames received or transmitted on this port that have an
opcode indicating a PAUSE operation.

Receive and Transmit Size Counters: The number of received and transmitted (good and bad) packets
split into categories based on their respective frame sizes.
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Receive Error Counters

Rx Drops: The number of frames dropped due to lack of receive buffers or egress congestion.
Rx CRC/Alignment: The number of frames received with CRC or alignment errors.

Rx Undersize: The number of short 1 frames received with valid CRC.

Rx Oversize: The number of long 2 frames received with valid CRC.

Rx Fragments: The number of short 1 frames received with invalid CRC.

Rx Jabber: The number of long 2 frames received with invalid CRC.

Rx Filtered: The number of received frames filtered by the forwarding process.
Short frames are frames that are smaller than 64 bytes.
Long frames are frames that are longer than the configured maximum frame length for this port.

Transmit Error Counters
Tx Drops: The number of frames dropped due to output buffer congestion.

Tx Late/Exc. Coll.: The number of frames dropped due to excessive or late collisions.

U

Known counters limitation: Jumbo frames are forwarded correctly, but are counted in the “1519-max’
frame-size buckets and also counted in the “Oversize” buckets.

Auto-refresh Refresh || Clear |

Buttons
Auto-refresh: Click to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.

Clear: Clears the counters for the selected port.
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4-3 SFP Port Info

This section describes the SFP module detail information when connected to the switch. The information
includes Connector type, Fiber type, wavelength, bit rate, Vendor OU], etc.

Web Interface
To display the SFP information in the web interface:
1. Click Port Management and SFP Port Info.

2. View the displayed SFP Information.

> SFP Port Information

Tx Central Wavelength

850

> Efficient Ethernet
* Bit Rate 1000 Mbps
s Vendor QUI 00-c0-12
* PoE Management .
Vendor Name Transition
» VLAN Management
Vendor P/N TN-SFP-SXD
¥ Quality of Service
Vendor Revision 0000
» Spanning Tree
» MAC Address Table Vendor Serial Number 8672322
» Multicast Date Code 110508
» DHCP Temperature 41.69¢C
¥ Security Vee 3.28V
b A .
Access Control Mon (Bias) AmA
» SNMP
Mon2 (TX PWR) -6.48 dBm
» Event Notification
Mon3 (RX PWR) none

ey, ——
TR SITION .E-:II.‘.IIIrJrn »
N NETWORKS - o
SM16TAT25A SFP Port Information @ Home - ForMansgsment - 579 PortInformation
Switch DMS ——
Auto-refresh | Refresh |
» System < -
» Port Management port 18
» Port Configuration Connector Type SFPorSFP Plus-LC
> Port Statistics .
Fiber Type Multi-mode (MM}

» Diagnostics €

Figure 4-3: SFP Port Information page
Port select scroll bar: Use to scroll to the port to display its Port statistics (e.g., Port 17 or Port 18).
Connector Type: Display the connector type, for instance, SFP, SFP Plus, Reserved - LC, SC, ST, LC, etc..
Fiber Type: Display the fiber mode, for instance, Multi-Mode (MM) or Single-Mode (SM).

Tx Central Wavelength: Display the fiber optical transmitting central wavelength, for instance, 850nm,
1310nm, 1550nm, etc.

Bit Rate: Displays the nominal bit rate of the transceiver.

Vendor OUI: Displays the Manufacturer's OUI (Organizationally Unique Identifier) code which is assigned
by IEEE.

Vendor Name: Displays the company name of the module manufacturer.
Vendor P/N: Displays the product name of the naming by module manufacturer.
Vendor Revision: Displays the module revision.

Vendor Serial Number: Shows the serial number assigned by the manufacturer.

Date Code: Shows the date this SFP module was made.
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Temperature: Shows the current temperature of SFP module.

Vcc: Shows the working DC voltage of SFP module.

Mon1(Bias) mA: Shows the Bias current of SFP module in milliamps.

Mon2(TX PWR): Shows the transmit power of SFP module in dBm.

Mon3(RX PWR): Shows the receiver power of SFP module in dBm.

Buttons Auto-refresh

Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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4-4 Energy Efficient Ethernet

This page lets you view and configure the current EEE port settings.

EEE (Energy Efficient Ethernet) is defined in IEEE 802.3az as a power saving option that reduces the power
usage when there is very low traffic utilization (or no traffic).

EEE works by powering down circuits when there is no traffic. When a port gets data to be transmitted all
circuits are powered up. The time it takes to power up the circuits is named wakeup time. The default
wakeup time is 17 us for 1Gbit links and 30 us for other link speeds. EEE devices must agree upon the
value of the wakeup time in order to make sure that both the receiving and transmitting device has all
circuits powered up when traffic is transmitted. The devices can exchange information about the devices
wakeup time using the LLDP protocol.

Web Interface

To configure Energy Efficient Ethernet in the web interface:
1. Click Port Management and Energy Efficient Ethernet.
2. The port to select enable or disable Energy Efficient Ethernet.
3. Click the Apply button to save the settings.
4. To cancel the setting click the Reset button to revert to previously saved values.

—— - —
TRANSITION \ = | wers >
N NETWORKS - w 9 C
SM16TAT2SA Energy Efficient Ethernet Configuration @Home - Port Management - Energy Efficient Ethernet
Switch DMS
Port Energy Efficient Ethernet Configuration
» System
» Port Management & Port Configure
> Port Configuratic
ort Configuration ) oisabied]
> Port Statistics
> SFP Port Information 2 Disabled V|
> Energy Efficient Ethernet
3 )\saaledﬂ
% Link Aggregation <
» Loop Protection < 4 Disabled ||
<
» PoE Management s Disabled|v]
» VLAN Management <
3 c 6 Disabled v
» Quality of Service E &
» Spanning Tree < 7 Disabled|v|
» MAC Address Table a
8 Disabled v\

Figure 4-4: Energy Efficient Ethernet Configuration page

Parameter descriptions:
Port: The switch port number of the logical EEE port.

Configure: Controls whether EEE is enabled for this switch port.
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Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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This section describes Port setting/status used to configure the trunk property of each port.

Web

Interface

To configure the trunk property of each and every port in the web interface:

1

2.
3.
4

Click Port Management > Link Aggregation > Port Configuration.
Specify the Method, Group, LACP Role and LACP Timeout.

Click the Apply button to save the setting.

To cancel the setting click the Reset button to revert to previously saved values.

TRANSITION © =/ awens

" NETWORKS

S

Swits

» Loo

M16TAT2SA Trunk Port Configuration/Status

ch DMS
Trunk Port Configuration/Status

w Trunk Port Configuration
Port Method Group

1 LACP ¥ 1 v

2 Static ¥ 1

W
53
5
o
4
-

P

» PoE Management <

» VLAN Management <

Figure 4-5.1: Trunk Port Configuration/Status page

Parameter description :

LACP Role

LACP Timeout

Fast

v

ast v

Port: The logical port for the settings contained in the same row.

: v

@@Home

H OocC

PortManagament - Link Agzragstion -~ Configuration

Trunk Port Status

Aggr Status

1 Ready

2

3 Ready

4 Ready

5 Ready

-

[l

Method: This determines the method a port uses to aggregate with other ports.

None: A port does not want to aggregate with any other port should choose this default setting.

LACP: A port use LACP as its trunk method to get aggregated with other ports also using LACP.

Static: A port use Static Trunk as its trunk method to get aggregated with other ports also using Static

Trunk.

Group: Ports choosing the same trunking method other than "None” must be assigned a unique Group
number (i.e. Group ID, valid value is from 1 to 8) in order to declare that they wish to aggregate with each

other.
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LACP Role: This field is only referenced when a port's trunking method is LACP.

Active: An Active LACP port begins to send LACPDU to its link partner right after the LACP protocol
entity started to take control of this port.

Passive: A Passive LACP port will not actively send LACPDU out before it receives an LACPDU from its
link partner.

LACP Timeout: The Timeout controls the period between BPDU transmissions.
Fast: 1t will transmit LACP packets each second,
Slow: It will wait for 30 seconds before sending a LACP packet.

Aggtr: Aggtr is an abbreviation of “aggregator”. Every port is also an aggregator, and its own aggregator
ID is the same as its own Port No. We can regard an aggregator as a representative of a trunking group.
Ports with same Group ID and using same trunking method will have the opportunity to aggregate to a

particular aggregator port. This aggregator port is usually the port with the smallest Port No. within the
trunking group.

Status: This field represents the trunking status of a port which uses a trunking method other than "None”.
It also represents the management link status of a port which uses the "None” trunking method. “---" means
“not ready”

Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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4-5.2 Aggregator View

This page displays the current port trunking information from the aggregator point of view.

Web Interface
To see the LACP detail in the web interface:

1. Click Port Management, Link Aggregation, and Aggregator View.
2. Click the LACP Detail radio button.
3. Click the LACP Detail button.

TRANSITION ' =| s g e c
=| =" "L -
N NETWORKS
SM16TAT25A Aggregator View #iHoms - PortManagement - linkAggregetion - AzgregetarVisw
Switch DMS
Aggregator View
b System
» Port Management w Aggregator Method Member Ports Ready Ports LACP Detail
1 None 1
2 None 2
3 None 3 3 C]
4 None 4
5 None 5
i} None i} g
N T None T T
# Loop Protection <
» PoE Management < a None a e
P VLAN Management < 9 None 9 9
e <
» Quality of Service 10 None 10 10
» Spanning Tres <

1 None 1
Figure 4-5.2: Aggregator View page
Parameter descriptions:

Aggregator: Shows the aggregator ID of every port. In fact, every port is also an aggregator, and its own
aggregator ID is the same as its own Port No.

Method: Show the method a port uses to aggregate with other ports.
Member Ports: Show all member ports of an aggregator (port).
Ready Ports: Show only the ready member ports within an aggregator (port).

LACP Detail: Lets you select the port that you want to see the LACP Detail.
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Buttons
LACP Detail: Click this button to display the aggregator information, as described below.

TR i ey )
TRANSITION © = | s = >
N NETWORKS - w 9 C
SMleTATZSA Aggregator 2 |nf0 rmation #Home - Port Management - Link Aggregation - Aggregator View
Switch DMS
Aggregator Information
b System
» Port Management h Actor Partner
> Port Configuration
L System Priority Mac Address System Priority Mac Address
> Port Statistics
> SFP Port Information 32768 00-40-C7-1C-CB-6E 32768 00-00-00-00-00-00
> Energy Efficient Ethernet
» Link Aggregation v Actor Port Actor Key Trunk Status Partner Port Partner Key
> Port Configuration
2 259 Ready 2 1]
> Aggregator View
> Aggregation Hash Mode —
| Back|

> LACP System Priority

Figure 4-5.2: LACP Detail page
Parameter descriptions:
Actor
System Priority: Show the System Priority part of the aggregation Actor. (1-65535).
Mac Address: The system ID of the aggregation Actor.
Actor Port: The actor's port number connected to this port.

Actor Key: The Key that the actor has assigned to this aggregation ID.

Partner

System Priority: Show the System Priority part of the aggregation partner. (1-65535)
Mac Address: The system ID of the aggregation partner.

Partner Port: The partner's port number connected to this port.

Partner Key: The Key that the partner has assigned to this aggregation ID.

Trunk Status: This field represents the trunking status of a port which uses a trunking method other than
“None”. It also represents the management link status of a port which uses the “None” trunking method. “-
--" means "not ready”

Button

Back: Click to undo any changes made locally and return to the Aggregator View page.

Messages: Method must be LACP and Member Ports must have a port at least.
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4-5.3 Aggregation Hash Mode

Web Interface

To configure the Aggregation hash mode in the web interface:
1. Click Port Management, Link Aggregation, and Aggregation Hash Mode.
2. Click Hash Code Contributors to select the mode.
3. Click the Apply button to save the setting.
4. To cancel the setting, click the Reset button to revert to previously saved values.

e — -
TRANSITION ° =| s : B M Q G
] N 1 A : o ™ .
\JRANSTTTON i - -
SM16TAT25A Aggrega tion Mode Co nﬂgu ration @Home - Fort Management = Link Agzrezstion - Aggregation Hash Made
Switch DMS
Aggregation Mode Configuration
¥ System
» Port Management v Hash Code Contributors
» Port Configuration
src-dst-mac v

» Port Statistics —

> 5FP Port Information 7 dst-mac

| e |
» Energy Efficient Ethemet 1 srcip
dst-ip

» Link Aggregation

sre-dst-ip

» Configuration

» Aggregator View

» Aggregation Hash Mo
» LACP Svstem Priority

Figure 4-5.3: Aggregation Hash Mode
Parameter descriptions:
Hash Code Contributors

src-mac: The Source MAC address can be used to calculate the destination port for the frame. Check to
enable the use of the Source MAC address, or uncheck to disable. By default, Source MAC Address is
enabled.

dst-mac: The Destination MAC Address can be used to calculate the destination port for the frame. Check
to enable the use of the Destination MAC Address, or uncheck to disable. By default, Destination MAC
Address is disabled.

ip: The IP address can be used to calculate the destination port for the frame. Check to enable the use of
the IP Address, or uncheck to disable. By default, IP Address is enabled.

src-dst-mac: Source MAC Address + Destination MAC Address.

src-ip: Source MAC Address + IP Address.

dst-ip: Destination MAC Address + IP Address.

src-dst-ip: Source MAC Address + Destination MAC Address + IP Address.

Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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4-5.4 LACP System Priority

This page lets you set the priority part of the LACP system ID. LACP will only aggregate together the
ports whose peer link partners are all on a single system. Each system that supports LACP will be
assigned a globally unique System Identifier for this purpose. A system ID is a 64-bit field comprising a
48-bit MAC Address and 16-bit priority value. The System Priority is configurable; its range is 1 - 65535.
The default is 32768.

Web Interface

To configure the LACP System Priority in the web interface:

1 Click Port Management, Link Aggregation, and LACP System Priority.
2. Specify the LACP System Priority.
3. Click the Apply button to save the setting.
4, To cancel the setting click the Reset button to revert to previously saved values.
JRANSITION ™ | e °®
SM16TAT2SA LACP System Priority @Home - PartMansgement - Link Aggregation - LACP Sycter Priosity
Switch DMS

LACP System Priority
» System <

stem Priori 276
» Port Management e Sy ty e

Reset

Figure 4-5.4: LACP System Priority page

Parameter descriptions:

System Priority: Show the System Priority part of a system ID (1-65535).

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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4-6 Loop Protection
4-6.1 Configuration

Loop Protection is used to detect the presence of traffic. When the switch receives packet's (looping
detection frame) MAC address the same as oneself from port, Loop Protection is shown. The port will be
locked when it receives the looping Protection frames. If you want to resume the locked port, find and
remove the looping path, then select resume the locked port and click on “Resume” to turn on the locked
ports.
Web Interface
To configure the Loop Protection parameters in the web interface:

Click Port Management, Loop Protection, and Configuration.

Select “on” to enable port Loop Protection globally.

1.
2.
3. Click the Apply button to save the setting.
4.

To cancel the setting, click the Reset button to revert to previously saved values

e e ‘ ]
TR ITION = wNSHIUN H »
N NETWORKS = > @c
SM16TAT2SA Loop Protection Configuration SeHome - Port Management - Loop Proteetion - Configuration
Switch DMS
Global Configuration
» System
» Port Management Xz Enable Loop Protection ﬂ )
> Port Configuration
Transmission Time 5 seconds

> Port Statistics

SFP Port Informatio! .
g Eeniupnaton Shutdown Time 180 seconds
> Energy Efficient Ethernet

Port Configuration
» Loop Protection ~

> Configuration Port Enable Action TxMode
> Status
1 Shutdown Port v Enable V]
» PoE Management «
» VLAN Management < 2 togonly v Enable [v]
» Quality of Service < 3 Shutdown Port and Log[V| Disable[V]
» Spanning Tree <
¥ E 4 Shutdown Port v Enable [w]
» MAC Address Table <
» Multicast < 5 Shutdown Port v Enable [V]
» DHCP ¢ 6 Shutdown Port ﬂ Enable ﬂ
» Security <
7 Shutdown Port ﬂ Enable ﬂ
» Access Control ¢
L cnman < 8 (v shutdown Port v| enable [V]

Figure 4-6.1: Loop Protection Configuration page

Parameter descriptions:

Global Configuration
Enable Loop Protection: Controls whether loop protections is enabled (as a whole).

Transmission Time: The interval between each loop protection PDU sent on each port. Valid values are 1
to 10 seconds.

Shutdown Time: The period (in seconds) for which a port will be kept disabled in the event of a loop is
detected (and the port action shuts down the port). Valid values are 0 - 604800 seconds (7 days).
A value of zero will keep a port disabled (until next device restart).
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Port Configuration

Port: The switch port number of the port.
Action
Enable: Controls whether loop protection is enabled on this switch port.

Action: Configures the action performed when a loop is detected on a port. Shutdown Port and Log
Valid values are Shutdown Port, Shutdown Port and Log, or Log Only. Log Only

Tx Mode: Controls whether the port is actively generating loop protection PDUs, or whether it is just
passively looking for looped PDUs.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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4-6.2 Status

This section displays the loop protection port status.

Web Interface
To display the Loop Protection status in the web interface:

1. Click Port Management, Loop Protection, and Status.

2. To automatically refresh the information, select “Auto refresh”.

3. Click "Refresh” to refresh the Loop Protection Status.

SMXTAT2SA Web User Guide

—— i =
TRANSITION © = | et -
N NETWORKS - v 9 c

SM16TAT2SA LOOP Protection Status g Home  PortManagement — Loop Protection — Status
Switch DMS —
Auto-refresh ‘ Refresh ‘
b System <
} Port Management © Port Action Transmit Loops Status Loop Time of Last Loop
> Port Configuration 1 Shutdown Enabled 0 Down
> Port Statistics
2 Log Enabled 0 up
> SFP Port Information
> Ermey Eeme Eiea 3 Shutdown and Log Disabled 0 Down
» Link Aggregation < 4 Shutdown Enabled ] Down
» Loop Protection ~
P 5 Shutdown Enabled 0 Down
> Configuration
o 6 Shutdown Enabled 0 Down
> Status
» PoE Management < 7 Shutdown Enabled 0 Down
» VI AN Manacamant < 8 Shutdown Enabled 0 Down

Figure 4-6.2: Loop Protection Status

Parameter descriptions:

Port: The switch port number of the logical port.

Action: The currently configured port action (Shutdown Port, Shutdown Port and Log, Log Only).

Transmit: The currently configured port transmit mode.
Loops: The number of loops detected on this port.
Status: The current loop protection status of the port.
Loop: Whether a loop is currently detected on the port.

Time of Last Loop: The time of the last loop event detected.

Buttons

Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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Chapter 5-PoE Management » PoE Management

> PoE Configuration
PoE (Power over Ethernet) is used to transmit electrical power to remote devices over
standard Ethernet cable. PoE can be used for powering IP telephones, wireless LAN
access points and other equipment, where it would be difficult or expensive to connect
equipment to the main power supply.

> PoE Status

> PoE Power Delay

> PoE Auto Power Reset
> PoE Scheduling Profile

5-1 PoE Configuration

This page lets you view and configure current PoE port settings and show PoE Supply power.

Web Interface

To configure Power over Ethernet in the web interface:
1. Click PoE Management and PoE Configuration.
2. Specify Reserved Power, Capacitor Detection, Mode, PoE Schedule, Priority, and Maximum Power.
3. Click Apply to save the configuration.

ﬁ oy .
TRANSITION ' =| Zem sme _ H QG
N NETWORKS.
SM16TAT2SA Power Over Ethernet Configuration @iHome - Po lznsgament - Fof Canfiguration
Switch DMS
Primary Power Supply
» System < W] 250
¢
7 ot ST Reserved Power _ .
. (@) Class () Allocation
» PoE Management d determined by - -
> PoE Configuratio —
e Capacitor Detection O
>
> PoE Power Delay . .
PoE Port Configuration
> ito Power Reset
» PoE Scheduling Profile Port PoE Mode PoE Schedule Priority Maximum Power
()
» VLAN Management < w
» QualityofSewice < 1 Enabled ¥ Disabled v Critical ¥ 30
i g ¢
2 SPEmE e 2 Enabled ¥ 1 profilel v High v 30
» MAC Address Table <
3 Enabled ¥ 2 profile2 v Low v 25
» Multicast <
» DHCP < 4 Enabled ¥ Disabled v Low v 25
» Security <
5 Enabled ¥ Disabled v Low v 20 -

Figure 5-1: PoE Configuration
Parameter descriptions:
Primary Power Supply [W]: Displays the primary power supply power in watts (e.g., 130 Watts).

Reserved Power determined by: Radio button to select one of two modes for configuring how the
ports/PDs may reserve power:

Class: The PD will negotiate PD class then feed power if the PD request power complies with the
standard. If Maximum Power at the port is configured different then factory default value 30W, the
PD connects the port again; the PD cannot draw more power than the new configured Maximum
Power for the port. Class mode is the factory default mode. Note: Starting at FW v1.01.1195, when
the Maximum Power per port value is changed, it will change the mode to Allocation mode. When
Class mode is set, PoE allocated value will display after PoE negotiation.
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Allocation: The switch will only examine power in the Maximum Power field. So once the switch
receives PD request power, the switch will check Maximum Power configuration, and if the
configured value is smaller than PD request power, the switch will not feed power.

Capacitor Detection: Check to enable or uncheck to disable the capacitor configuration. The default is
disabled. Check to enable legacy IP phones support.

PoE Port Configuration

Port: This is the logical port number for this row.

PoE Mode: The PoE Mode represents the PoE operating mode for the port (Enabled, PoE Mode
Disabled, or Force), where:

Disabled: PoE disabled for the port (default).

Disabled

Enabled: Enables PoE IEEE 802.3at (Class 4 PDs limited to 30W) (default).
Force: The switch port powers up the linked PD without any detect/negotiate L Foree -
mechanism (PD limited to 30W). Note: Only connect PDs which support a power input of 48~56V to
prevent damage to PDs. When the port changes to Force mode, the port’'s PoE LED will light
immediately. Select Force mode for devices that do not do PoE negotiation (e.g., for a PoE DSRC
RSU). Note for first time use: PoE Force mode is disabled by default, so you must execute the
enable CLI command first. Once it's executed, Force mode displays in the Web UL

The PoE Force mode enable CLI command is shown below:

# configure terminal
(config)# Special ip-cam poe-force-mode on

Note: Execute the CLI command to enable Force mode; the switch reboots automatically, then Force
mode can start working. If you execute this command, the PoE Force mode will always be available.
See the CLI Reference for more information.

PoE Schedule: Disable PoE Scheduling or select a PoE Schedule profile for each port.

Priority: The Priority represents the ports priority. The three levels of power priority are Low, Priority
High and Critical. The priority is used in the case where the remote devices require more

power than the power supply can deliver. In this case the port with the lowest priority will be
turned off first starting from the port with the highest port number. High

| Critical

Maximum Power [W]: Indicates the maximum power in watts that can be delivered to a
remote device. The valid range is 1-30 Watts. The default is 30 Watts.

Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

Messages

Message: PoE Mode(Force): The switch port will power up the linked PD without any detect/negotiate
mechanism(PD limited to 30W). Do you want to change this setting?

Meaning: Confirmation message ensuring that you want to make this config change.

Action: Click the OK button only if you are sure you want to change this setting. See the "PoE Mode”
parameter description above. If you are not sure you want to change this setting, click the Cancel button.
Added at FW v 1.01.1209.
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5-2 PoE Status

rks

This page displays the current status of all PoE ports.

Web Interface

To display PoE Status in the web interface:
1. Click PoE Management and PoE Status.
2. Set Auto-refresh to on or off.

3. Click the Refresh button to refresh the page.

TRANSITION © =| cwsosr s
N NETWORKS. i
SM16TAT25A Power Over Ethernet Status
Switch DMS ———
Auto-refresh ‘ Refresh |
b System <
b Port Management < Local Port  PDClass  Power Allocated Power Override Power Used
» agement ! > 0w] 0 0[w]
»nfiguration 3 R 0wl 0 0wl
3 1 25 [W] 1 1.7 (W]
4 - 0wl 1 0 [w]
5 3 20 [W] 1 5.9 W]
FLAM M o < . .
» VLAN Management 5 1 4[W] 0 140
» Quality of Service < i
7 3 15.4 (W] 0 2.1 (W]
» Spanning Tree <
8 - 0w] 0 0[w]
» MAC Address Table <
» Multicast < 5 2 T L s
» DHCP ¢ 10 4 30 [W] 0 6.6 (W]
» Security < 11 - 0 [w] 0 0 [W]
» Access Control < 12 - 0w] 0 0wl
SNMP <
v =l 13 - 0w 0 0w
» Event Motification < ) )
14 - owl V] 0wl
» Diagnostics <
15 - 0wl 0 0[W]
» Maintenance <
16 - 0 [w] 0 0 [w]
Total 101.4 [W] 19.6 [W]
Balance PoE Power Available 148.6 [W]

Figure 5-2: PoE Status

Parameter descriptions:

Local Port: The logical port number for this row.

SMXTAT2SA Web User Guide

Current Used
0 [mA]

0 [ma]

35 [mA]

0 [ma]

108 [mA]

26 [mA]

0 [ma]
0 [mA]
0 [mA]
0 [ma]
0 [mA]
0 [ma]

381 [mA]

e c

@ Home © P Manegement - Pof Stetus

Priority  Port Status

Critical Mo PD detected

High Mo PD detected
Low PoE turned OM
Low No PD detected
Low PoE turned ON
Low PoE turned ON
Low PoE turned ON
Low Mo PD detected
Low PoE tumed ON
Low PoE turned ON
Low Mo PD detected
Low No PD detected
Low Mo PD detected
Low Mo PD detected
Low Mo PD detected
Low Mo PD detected

PD Class: Each PD is classified according to a class that defines the maximum power the PD will use.
PD Class will show by learning from the link partner no matter which “Reserved Power determined by”
mode is set. If Maximum Power at the port is configured different than the factory default value of 30W,

PD class still stays at the previous learned Class.

The PD Class field shows the PDs classes 0-4 where:

Class 0: Max
Class 1: Max
Class 2: Max
Class 3: Max
Class 4: Max
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Power Allocated: Shows the amount of power the switch has allocated for the PD. Power gets updated to
power negotiation by Class, the value assigned and displayed is forced. When Power override =1, the
value is the same as the value of “"Maximum Power (W)".

The Switch provides power to the PD if the power required by the PD is less than this value.

Power Override: Displays 0 (override disabled) or 1 (override the default power requirement specified
by the IEEE classification). The difference between the power requirement mandated by the IEEE
classification and what is actually needed by the PD is returned into the global power budget for use by
additional PDs. This lets you extend the switch power budget and use it more effectively. So, if you have
devices that use less power than the default that will be assigned based on class, by overriding a lower
value you avoid maxing out the calculated total allocation for the switch. Added at FW v 1.01.1171.
When "Power Allocated" configuration value is different from the default value, displays 1. Otherwise
displays 0.

Power override value indicates whether the maximum power at the port has ever changed.

If Maximum Power at the port is configured different than factory default value 30W, it displays “1.”

Power Used: The Power Used shows how much power the PD currently is using.
Current Used: The Current Used shows how much current the PD currently is using.
Priority: The Priority shows the port's priority currently configured (e.g., Critical, High, or Low).
Port Status: The Port Status shows the port's status. The status can be one of the following values:
PoE turned ON - PoE power is turned on and available.
PoE not available - No PoE chip found: PoE not supported for the port.
PoE turned OFF - PoE disabled: PoE is disabled by user.

PoE turned OFF - Power budget exceeded: The total requested or used power by the PDs exceeds
the maximum power the Power Supply can deliver, and port(s) with the lowest priority is/are
powered down. A port's PoE can be revoked for one of two reasons: 1) Port power budget exceeded,
or 2) Total power budget exceeded.

No PD detected: No Powered Device detected for the port.

PoE turned OFF - PD overload: The PD has requested or used more power than the port can deliver
and is powered down.

PoE turned OFF: PD is off.

Invalid PD: PD detected but is not working correctly.

PD overloaded: The PD consumed more power than the maximum limit configured for the port,
based on the default, user, or CDP configuration.

Balance PoE Power Available: Displays the remaining power that can be used (Total power of switch) —
(Sum of power allocated of all ports) in Watts. Added at FW v1.01.1195.

O 0 oW o [mA

15 o [W) 0 oW 0 [mA] Low
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Buttons
Auto-refresh ‘ Refresh ‘
Auto-refresh: Check to refresh the page automatically every 3 ‘ '
seconds.
Refresh: Click to manually refresh the page immediately.
Five PD Classes are defined by the IEEE standards:
Class Usage Classification Power Range Class
9 Current [mA] [W] Description
0 Default 0-4 0.44-12.94 Classification
unimplemented
Optional 9-12 0.44-3.84 Very Low power
Optional 17-20 3.84-6.49 Low power
Optional 26-30 6.49-12.95 Mid power
Valid for 802.3at (Type 2) devices, not .
4 allowed for 802.3af devices 3644 12.95-25.50 High power
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5-3 PoE Power Delay

This page lets you specify the auto detection parameters to check the link status between PoE ports and
PDs. When it detected the fail connect, will reboot remote PD automatically.

Web Interface

To configure Power over Ethernet Power Delay in the web interface:
Click PoE Management and PoE Power Delay.

2. Enable or Disable Delay Mode.
3. Specify the Delay Time.
4.  Click Apply to apply the change.
= TRANSTITT™
TRANSITION =| = LI (2 I S
N 1 WORKS -
SM8TAT2SA PoE Power Delay @iHome  FoEManagement - PoE Power Delay
Switch DMS
Port PoE Power Delay
b System
» Port Management < Port Delay Mode Delay Time(0~300 sec)
» PoE Management v 1 Enabled v 10
> PoE Configuration
> PoE Status 2 Enabled v 10
> PoE Power Delay
3 Enabled
> PoE Auto P r Reset
> PoE Scheduling Profile 4 Disabled v o
» VLAN Management %
5 Disabled v 0
» Quality of Service &
» Spanning Tree < g Dissbled v 0
» MAC Address Table < 7 Enabled ¥ 0
» Multicast &
8 Disabled v 2
» DHCP <
- ¢ ———
» Security | Apply ” Reset ‘
b Arrnce Canteal < ; . : e

Figure 5-3: PoE Power Delay
Parameter descriptions:
Port: The port being configured; each port instance is represented by a line in the table.
Delay Mode: At the dropdown, select Enabled. The default is Disabled.

Delay Time(0~300 sec): Enter the amount of delay time (0~300 seconds). The default is 0 seconds.

If Port 1 PoE Power Delay time setting is 30 seconds, it means the switch will wait 30 seconds to provide
power to port 1 after the switch reboots.

Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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5-4 PoE Auto Power Reset

This page lets you specify the auto detection parameters to check the link status between PoE ports and
PDs. When it detects a failed connection, it will reboot the remote PD automatically.

Web Interface

To configure Power over Ethernet Auto Power Reset in the web interface:

1.  Click PoE Management and PoE Auto Power Reset.
2. Enable the Ping Check function.
3. Specify the PD's IP address, startup time, interval time, retry time, failure action and reboot time.
4.  Click Apply to apply the change.
T SR .
TRANSITION \ = | wera 3
N NETWORKS = v M @ C
SM16TAT2SA PoE Auto Power Reset Configuration gHome - PoE Management - PoE Auto Power Reset
Switch DMS
Ping Check ﬁ
» System
» Port Management <
PoE Port Configuration
» PoE Management ~
> EelEErig e Port PingIP Address  Startup Time Interval Time Retry Time Failure Log  Failure Reboot Time
> PoE Status (sec) Action (sec)
> PoE Power Delay
. 1 0.0.0.0 60 30 3 errorg, Nothin|v/] 15
> PoE Auto Power Reset total:0
> PoE Scheduling Profile
error:0,
2 0.0.0.0 60 30 3 Nothin[V/] 15
» VLAN Management < total:0
¥ Quality of Service < error:0
3 0.0.0.0 60 30 3 . Nothin|[¥] 15
» Spanning Tree < total:0
» MAC Address Table S ’ 0.0.0.0 . 0 5 error:0, Nothin[7] 15
total:0
» Multicast <
DHCP < 5 3 3 error:o, othi
4 5 0.0.0.0 60 0 ‘otalo Nothin %] 15
P Security <
» A C { & 6 0.0.0.0 60 30 3 errorg, Nothin|v/] 15
ccess Control total:0
» SNMP &
arrar n

Figure 5-4: PoE Auto Power Reset
Parameter descriptions:

Ping Check: Enable the Ping Check function to detect the connection between PoE port and power
device. Disable will turn off the detection.

Port: This is the logical port number for this row.
Ping IP Address: The PD's IP Address the system should ping.
Startup Time: After startup time, device will enable auto checking. Default: 30; range: 30-60 seconds.

Interval Time(sec): Device will send checking message to PD each interval time. Default: 30; range: 10-
120 seconds.

Retry Time: When PoE port can't ping the PD, it will retry to send detection again. When ping fails the
third time, it will trigger the configured Failure Action. Default: 3; range: 1-5.

Failure Log: Failure loggings counter.
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Failure Action: The action when the third fail detection.

Nothing: Keep Pinging the remote PD but do nothing further.
Reboot: Cut off the power of the PoE port, make PD reboot.

Reboot time(sec): When PD has been rebooted, the PoE port restore power after the specified time.
Default: 15, range: 3-120 seconds.

Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.

33717 Rev.D https://www.transition.com Page 68 of 284



https://www.transition.com/

Transition Networks SMXTAT2SA Web User Guide
5-5 PoE Scheduling Profile

This page lets you define profiles for PoE scheduling.

— = 4
TRANSITION © = | e .
N NETWORKS = v @ G

SM16TAT2SA PoE Scheduling Profile @Home  Fof Mansgement  PoF Scheduling Profile
Switch DMS
Profile 1 [w]

P System <

» Port Management < Name MyName

» PoE Management e

> PoE Configuration Start Time End Time
> PoE Status
Week Day HH MM HH MM

v

PoE Power Delay

> PoE Auto Power Reset . ﬂ = ﬂ = ﬂ - ﬂ
> PoE Scheduling Profile Menday o ﬂ 0 ﬂ o ﬂ 0 ﬂ
» VLAN Management <
Tuesday 0 [w] 0 v 0 ™ 0 ™
¥ Quality of Service <
» Spanning Tree < Wednesday 0 M 0 v 0 ] 0 V]
» MAC Address Table < Thursday . ﬂ 0 ﬂ 0 ﬂ 0 ﬂ
» Multicast <
Friday 0 v 0 v 0 v 0 v
» DHCP . ~ ™ M g
» Security < Saturday 0 [v] 0 v 0 [v] 0 [v]
¢
» Access Control Sunday o [v] 0 v 0 ™ 0 ™
» SNMP .
» Event Notification ¢ | Apply J
Figure 5-5: PoE Scheduling Profile
Parameters:

Profile: The index of profile. You can configure up to 16 profiles.

Name: The name of profile. The default name is "Profile 1". You can define the name for identifying the
profile.

Week Day: The day to schedule PoE.
Start Time: The time to start PoE. The time 00:00 means the first second of this day.

End Time: The time to stop PoE. The time 00:00 means the last second of this day.

Buttons

Apply: Click to save changes.
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Chapter 6 - VLAN Management

» VLAN Management

6-1 VLAN Configuration > VLAN Config
This page lets you assign a specific VLAN for management purpose. The management VLAN » A

is used to establish an IP connection to the switch from a workstation connected to a port in > VLAN Port Status
the VLAN. This connection supports a VSM, SNMP, and Telnet session. By default, the active > VLA

management VLAN is VLAN 1, but you can designate any VLAN as the management VLAN
using the Management VLAN window. Only one management VLAN can be active at a time.

When you specify a new management VLAN, your HTTP connection to the old management > IP Subnet-based VLAN

VLAN is lost. For this reason, you should have a connection between your management > Private VLAN
station and a port in the new management VLAN or connect to the new management VLAN A w—

through a multi-VLAN route.

Web Interface

To configure VLAN membership configuration in the web interface:

1. Click VLAN Management and VLAN Configuration.

2. Configure for existing VLANSs, Ethertype, port types, ingress/egress, and allowed VLANS.
3. Click the Apply button.

[ _l"||\'|.—'\.‘" |
w’“ :5 ITI 'D-N E | = ] L 4 J g - - | g C‘
SM16TAT25A VLAN Configuration Soaa > VoA Makagarenit > Yl Ctllguertia

Glebal VLAN Configuration
b Fort Management L Allowed Acooss VLANS

Ethertype for Custom S-ports

Puort VLAN :_'-'_-l':'i_:_.r._'- tion

Ingress
Port  Mode Port VLAN Part Type Filtering Ingress Acceptance Egress Tagging Albowred VILANS

v 5 - T Teamsdandinisam ¥

L 1 ort ¥ -

Figure 6-1: VLAN Configuration page
Parameter descriptions:
Global VLAN Configuration

Allowed Access VLANSs: This field shows the VLANSs that are created on the switch. By default, only VLAN
1 exists. More VLANs may be created by using a list syntax where the individual elements are separated by
commas. Ranges are specified with a dash separating the lower and upper bound.

The following example will create VLANs 1, 10, 11, 12, 13, 200, and 300: 1,10-13,200,300. Spaces are
allowed in between the delimiters.
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Ethertype for Custom S-ports: This field specifies the Ethertype/TPID (specified in hexadecimal) used for
Custom S-ports. The setting is in force for all ports whose Port Type is set to S-Custom-Port.

Port VLAN Configuration
Port: This is the logical port number of this row.

Mode: The port mode (default is Access) determines the fundamental behavior of the port in question.
A port can be in one of three modes as described below. Whenever a particular mode is selected, the
remaining fields in that row will be either grayed out or made changeable depending on the mode in
question. Grayed out fields show the value that the port will get when the mode is applied.

Access: Access ports are normally used to connect to end stations. Dynamic features like Voice VLAN
may add the port to more VLANs behind the scenes. Access ports have these characteristics:

» Member of exactly one VLAN, the Port VLAN (a.k.a. Access VLAN), which by default is 1,

« accepts untagged frames and C-tagged frames,

« discards all frames that are not classified to the Access VLAN,

« on egress all frames are transmitted untagged.

Trunk: Trunk ports can carry traffic on multiple VLANs simultaneously and are normally used to connect
to other switches. Trunk ports have these characteristics:

« By default, a trunk port is member of all existing VLANSs. This may be limited by the use of Allowed
VLANS,

« unless VLAN Trunking is enabled on the port, frames classified to a VLAN that the port is not a
member of will be discarded,

* by default, all frames but frames classified to the Port VLAN (a.k.a. Native VLAN) get tagged on
egress. Frames classified to the Port VLAN do not get C-tagged on egress,

« egress tagging can be changed to tag all frames, in which case only tagged frames are accepted on
ingress,

« VLAN trunking may be enabled.

Hybrid: Hybrid ports resemble trunk ports in many ways but adds additional port configuration
features. In addition to the characteristics described for trunk ports, hybrid ports have these abilities:
« Can be configured to be VLAN tag unaware, C-tag aware, S-tag aware, or S-custom-tag aware,

« ingress filtering can be controlled,

« ingress acceptance of frames and configuration of egress tagging can be configured independently.

Port VLAN: Determines the port's VLAN ID (a.k.a. PVID). Allowed VLANSs are in the range 1 through 4095;
the default is 1.

On ingress, frames get classified to the Port VLAN if the port is configured as VLAN unaware, the frame is
untagged, or VLAN awareness is enabled on the port, but the frame is priority tagged (VLAN ID = 0).

On egress, frames classified to the Port VLAN do not get tagged if Egress Tagging configuration is set to
untag Port VLAN.

The Port VLAN is called an "Access VLAN" for ports in Access mode and “Native VLAN" for ports in Trunk
or Hybrid mode.

Port Type : Ports in hybrid mode allow for changing the port type, that is, whether a frame's VLAN tag is
used to classify the frame on ingress to a particular VLAN, and if so, which TPID it reacts on. Likewise, on
egress, the Port Type determines the TPID of the tag, if a tag is required.

Unaware: On ingress, all frames, whether carrying a VLAN tag or not, get classified to the Port VLAN,
and possible tags are not removed on egress.

C-Port: On ingress, frames with a VLAN tag with TPID = 0x8100 get classified to the VLAN ID
embedded in the tag. If a frame is untagged or priority tagged, the frame gets classified to the Port
VLAN. If frames must be tagged on egress, they will be tagged with a C-tag.

33717 Rev.D https://www.transition.com Page 71 of 284



https://www.transition.com/
http://192.168.1.102/help/help_vlan.htm#AllowedVIDs
http://192.168.1.102/help/help_vlan.htm#AllowedVIDs
http://192.168.1.102/help/help_vlan.htm#Trunking
http://192.168.1.102/help/help_vlan.htm#EgressTagging

Transition Networks SMXTAT2SA Web User Guide

S-Port: On ingress, frames with a VLAN tag with TPID = 0x8100 or 0x88A8 get classified to the VLAN ID
embedded in the tag. If a frame is untagged or priority tagged, the frame gets classified to the Port
VLAN. If frames must be tagged on egress, they will be tagged with an S-tag.

S-Custom-Port: On ingress, frames with a VLAN tag with a TPID = 0x8100 or equal to the Ethertype
configured for Custom-S ports get classified to the VLAN ID embedded in the tag. If a frame is untagged
or priority tagged, the frame gets classified to the Port VLAN. If frames must be tagged on egress, they
will be tagged with the custom S-tag.

Ingress Filtering: Hybrid ports allow for changing ingress filtering. Access and Trunk ports always have
ingress filtering enabled.

If ingress filtering is enabled (checkbox is checked), frames classified to a VLAN that the port is not a
member of get discarded.

If ingress filtering is disabled, frames classified to a VLAN that the port is not a member of are accepted
and forwarded to the switch engine. However, the port will never transmit frames classified to VLANs
that it is not a member of.

VLAN Trunking: Trunk and Hybrid ports allow for enabling VLAN trunking. When VLAN trunking is
enabled, frames classified to unknown VLANs are accepted on the port whether ingress filtering is
enabled. This is useful in scenarios where a cloud of intermediary switches must bridge VLANSs that haven't
been created. By configuring the ports that connect the cloud of switches as trunking ports, they can
seamlessly carry those VLANs from one end to the other.

Ingress Acceptance: Hybrid ports allow for changing the type of frames that are accepted on ingress.

Tagged and untagged: both tagged and untagged frames are accepted.
Tagged Only: Only tagged frames are accepted on ingress. Untagged frames are discarded.
Untagged Only: Only untagged frames are accepted on ingress. Tagged frames are discarded.

Egress Tagging: Ports in Trunk and Hybrid mode may control the tagging of frames on egress.

Untag Port VLAN: Frames classified to the Port VLAN are transmitted untagged. Other frames are
transmitted with the relevant tag.

Tag All: All frames, whether classified to the Port VLAN or not, are transmitted with a tag.

Untag All: All frames, whether classified to the Port VLAN or not, are transmitted without a tag. This
option is only available for ports in Hybrid mode.

Allowed VLANSs: Ports in Trunk and Hybrid mode may control which VLANs they are allowed to become
members of. Access ports can only be member of one VLAN, the Access VLAN.

The field's syntax is identical to the syntax used in the Existing VLANSs field. By default, a port may become
member of all possible VLANSs, and is therefore set to 1-4095.

The field may be left empty, which means that the port will not be member of any of the existing VLANS,
but if it is configured for VLAN Trunking it will still be able to carry all unknown VLANSs.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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6-2 VLAN Membership

This page provides an overview of membership status of VLAN users.

Web Interface

To configure VLAN membership configuration in the web interface:
1. Click VLAN Management and VLAN membership.
2. Scroll the bar to choose which VLANSs to be displayed.
3. Click Refresh to update the state.

e — n
TRANSITION =| T ] @ =
N NETWORKS -

SM16TAT2SA VLAN Membership Status @Home - VLAN Mansgement - VLAN Membership
Switch me Auto-refresh ‘ Refresh H Cleal ‘

b System &

» Port Management < Show| 1] |entries Search:

» PoE Management & Port Members

VLANID *

» VLAN Management 1 2 3 4 5 6 T 8 9 10 11 12 13 14 15 16 17 18

1 yu Vv v v v v v v u v v v v v v v u v

Figure 6-2: VLAN Membership Status page
Parameter descriptions:
Show entries: At the dropdown you can choose how many items you want to show up (10, 25, 60, or All).

VLAN USER: VLAN User module uses services of the VLAN management functionality to configure VLAN
memberships and VLAN port configurations such as PVID and UVID. These VLAN user types are currently
supported: Combined, Admin, MVR, Voice, VLAN, and MSTP.

Combined: A combination of VLAN User types. Admin

MVR: Multicast VLAN Registration (MVR) is used to eliminate the need to duplicate Combined
multicast traffic for subscribers in each VLAN. Multicast traffic for all channels is sent Admin_____

only on a single (multicast) VLAN. HUR
Voice VLAN: Voice VLAN is a VLAN configured specially for voice traffic typically Vaice VLAN
originating from IP phones. METE

DMS3
MSTP: The 802.1s Multiple Spanning Tree protocol (MSTP) uses VLANSs to create
multiple spanning trees in a network, which significantly improves network resource utilization while
maintaining a loop-free environment.

DMS: Shows DMS VLAN membership status.

VLAN ID: VLAN ID for which the Port members are displayed.
Port Members: A row of check boxes for each port is displayed for each VLAN ID.

If a port is included in a VLAN, an image will be displayed.

If a port is included in a Forbidden port list, an image < will be displayed.

If a port is included in a Forbidden port list and dynamic VLAN user register VLAN on same Forbidden
port, then conflict port will be displayed as >«.
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VLAN Membership: The VLAN Membership Status Page shows the current VLAN port members for all
VLANSs configured by a selected VLAN User by using the combo box.

When ALL VLAN Users are selected, it shows this information for all the VLAN Users, and this is by default.
VLAN membership allows the frames classified to the VLAN ID to be forwarded on the respective VLAN
member ports.

Show entries: You can choose how many items you want to view.

Search: You can search for the information that you want to view.

Buttons Auto-refresh
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.

Clear: Click to clear the page.

Next: Updates the system log entries, turn to the next page.

Previous: Updates the system log entries, turn to the previous page.

Messages:
ERROR: Invalid allowed VLAN list (1.30)
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The Port Status function gathers the information of all VLAN status and reports it by the order of

Combined, Admin, NAS, GVRP, MVR, Voice VLAN, MSTP, DMS, and VCL.

Web Interface
To Display VLAN Port Status in the web interface:
1. Click VLAN Management and VLAN Port Status.

2. At the dropdown, specify the user type.

3. Click Refresh to display the current Port Status information.

ﬁ — )
TRANSITION © =| msos ssc -] ROOG
N NETWORKS
SMI16TAT2SA VLAN Port Status @@ Home - WLAN Manzgement ~ VLAN Port Status
Switch DMS
Auto-refresh Refresh | Clear | Combined ¥
b System <
D Er N EIETETen ¢ Port  PortType Ingress Filter Frame Type Port VLAN 1D Tx Tag
» PoE Management < 1 C-Port true All 1 Nona
¥ VLAM Management hd 2 C-Port true All 1 All except-native
» WLAN Configuration )
- 3 C-Port true All 1 All except-native
> VLAN Membership
, 4 5-Port false Tagged 1 All except-native
5 S-Custom-Port false Untagged 1 All
< 5 C-Port true All 1 Mone
<
7 C-Port true All 1 MNone
All 1 None

s PrivataVl AN 8 C-Port true

Figure 6-3: VLAN Port Status page

Parameter descriptions:

Combined v

VLAN USER: Various internal software modules may use VLAN services to configure
VLAN memberships on the fly. The drop-down list on the right allows for selecting | s02ix

between showing VLAN memberships as configured by an administrator (Admin) or as e
configured by one of these internal software modules. These VLAN User types are G::E: o

currently supported:

DMS

Combined: A combination of the administrator and internal software modules configuration, and

basically reflects what is actually configured in hardware.

Admin: VLAN memberships as configured by an administrator.

NAS: NAS provides port-based authentication, which involves communications between a Supplicant,

Authenticator, and an Authentication Server.

GVRP: GVRP (GARP VLAN Registration Protocol or Generic VLAN Registration Protocol) facilitates
control of VLANSs within a larger network. GVRP conforms to the IEEE 802.1Q specification, which
defines a method of tagging frames with VLAN configuration data.

MVR: Multicast VLAN Registration (MVR) is used to eliminate the need to duplicate multicast traffic for
subscribers in each VLAN. Multicast traffic for all channels is sent only on a single (multicast) VLAN.

Voice VLAN: Voice VLAN is a VLAN configured specially for voice traffic typically originating from IP

phones.
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MSTP: The 802.1s Multiple Spanning Tree protocol (MSTP) uses VLANSs to create multiple spanning trees
in a network, which significantly improves network resource utilization while maintaining a loop-free
environment.

DMS: Transition Networks’ DMS (Device Management System) is an intelligent management tool
embedded in the switch to intuitively help reduce support time, cost, and effort.

Port: The logical port for the settings contained in the same row.

Port Type: Shows the Port Type, which can be Unaware, C-port, S-port, or Custom S-port. If Port Type is
Unaware, all frames are classified to the Port VLAN ID and tags are not removed. C-port is Customer Port.
S-port is Service port. Custom S-port is S-port with Custom TPID.

Ingress Filter: Shows the ingress filtering on a port. This parameter affects VLAN ingress processing.
If ingress filtering is true (enabled) and the ingress port is not a member of the classified VLAN, then the
frame is discarded.

Frame Type: Shows whether the port accepts all frames or only tagged frames. This parameter affects
VLAN ingress processing. If the port only accepts tagged frames, then untagged frames received on that
port are discarded.

Port VLAN ID: Shows the Port VLAN ID (PVID) that a given user wants the port to have. The field is empty
if not overridden by the selected user.

Tx Tag: Shows egress filtering frame status whether None, All, or All except-native.

Auto-refresh [ Refresh H Clear ‘

Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.

Clear: Click to clear the page.
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6-4 VLAN Selective QinQ

A Q-in-Q VLAN tunnel enables a service provider to segregate the traffic of different customers in their
infrastructure, while still giving the customer a full range of VLANSs for their internal use by adding a
second 802.1Q tag to an already tagged frame.

Navigate to Switch > VLAN Management > VLAN Selective QinQ to create new and edit existing entries.

T e

TRANSITION =| s - ” e
N NETWORKS: i C
SM16TAT2SA VLAN Selective QinQ Configuration @Home - VLAN Management - VLAN Selective QinG

Switch DMS

Port Members

b System <
Delete €VID SPID 1 2 3 4 5 3 7 ] 9 10w 11 12 1F 14 15 16 17 18

¥ Port Management <
» PoE Management « O oo o0 o oo o0 oo O o o o o
P S| |@ o O 0o 0O o o o o0 o O 0o O O
] o o o 0o o o 0O o 0o 0 o0 -

Parameter descriptions:

Delete: To delete a private VLAN entry, check this box. The entry will be deleted during the next apply.
CVID: 1-4095; the Customer VLAN ID List to which the tagged packets will be added.

SPID: 1-4095; this configures the VLAN to join the Service Providers VLAN as a tagged member.

Port Members: Checkmarks indicate which ports are members of the entry. Check or uncheck as needed
to modify the entry.

Buttons

Add New Entry: Click the button to add a new instance. An empty row is added to the table, and the new
member can be configured as needed. Initially displays “Table is Empty".

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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6-5 MAC-based VLAN

This page lets you view and configure MAC-based VLAN Memberships.

MAC address-based VLAN decides the VLAN for forwarding an untagged frame based on the source MAC
address of the frame. A most common way of grouping VLAN members is by port, hence the name port-
based VLAN. Typically, the device adds the same VLAN tag to untagged packets that are received through
the same port. Later on, these packets can be forwarded in the same VLAN. Port-based VLAN is easy to
configure and applies to networks where the locations of terminal devices are relatively fixed. As mobile
office and wireless network access gain more popularity, the ports that terminal devices use to access the
networks are very often non-fixed. A device may access a network through Port A this time, but through
Port B the next time. If Port A and Port B belong to different VLANSs, the device will be assigned to a
different VLAN the next time it accesses the network. As a result, it will not be able to use the resources in
the old VLAN. On the other hand, if Port A and Port B belong to the same VLAN, after terminal devices
access the network through Port B, they will have access to the same resources as those accessing the
network through Port A do, which brings security issues. To provide user access and ensure data security
in the meantime, the MAC-based VLAN technology is developed. MAC-based VLANs group VLAN
members by MAC address. With MAC-based VLAN configured, the device adds a VLAN tag to an
untagged frame according to its source MAC address. MAC-based VLANs are mostly used in conjunction
with security technologies such as 802.1X to provide secure, flexible network access for terminal devices.

Navigate to Switch > VLAN Management > MAC-based VLAN > Configuration to configure new entries
and view the status of existing entries.

6-5.1 Configuration

&« C | ® 192.168.1.77/mac_based_vlan.htm ad @
2=t Apps 3 Internet Explorer can . Official Usability, Us=r [ Personal Dashboard [ Cognition Cockpit [ Transition EMS (2) [ CSI-Communicatio »
e I
TRANSITION =| o B © ®
N NETWORKS.  — v |
SM16TAT2SA MAC-based VLAN Membership Configuration  gesems - viantsnsgement - 1ac-baseavian - Configurstion
Switch DMS
Delete MAC Address VLAN ID
¥ System < _
] 0C-22-33-44-55-66 10
» Port Management <
[ 1C-2D-3F-44-55-66 100
» PoE Management <
» VLAN Management > H e ” T ,
> : nfiguration
>
>
>
» MAC-base AN

Parameter descriptions:

Delete: To delete a private VLAN entry, check this box. The entry will be deleted during the next apply.
MAC Address: Enter the MAC address for the entry. Must be a valid unicast MAC address.

VLAN ID: Enter the VLAN ID (VID) for the entry (1-4095).
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Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Add New Entry: Click the button to add a new MAC-based VLAN member. An empty row is added to the
table, and the new member can be configured as needed.

Any unicast MAC address can be configured for the MAC-based VLAN entry. No broadcast or multicast
MAC addresses are allowed. Valid VLAN ID values are 1-4095.
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6-5.2 Status
Navigate to Switch > VLAN Management > MAC-based VLAN > Status to view existing members’ status.

\ TRANSITION - 0
TRANSITIO =| TR 0 =
N NETWORKS - -
SM16TAT2SA MAC-based VLAN Membership Status @eHoms - VLANMsnsgsment - MACbssedVLeN - Ststus
Switch DMS m—
Auto-refresh ‘ Refresh |
» System <
MAC Address VLAN ID User
» Port Management <
0(C-22-33-44-55-66 10 Static
» PoE Management g
» VLAN Management 2 1C-2D-3F-44-55-66 100 Static
> VLAN Configuration
> VLAN Membership
> VLAN Port Status
*» VLAN Selective QinQ
» MAC-based VLAN v
> Configuration
> Status -

Parameter descriptions:
MAC Address: Displays the MAC address for the entry.
VLAN ID: Displays the VLAN ID (VID) for the entry.

User: Displays User Type for the entry (Combined, Admin, NAS, GVRP, MVR, Voice, VLAN, MSTP, DMS, or
VCL).

Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.

33717 Rev.D https://www.transition.com Page 80 of 284



https://www.transition.com/

Transition Networks SMXTAT2SA Web User Guide
6-6 Protocol-based VLAN
6-6.1 Protocol to Group Mapping Table

This page lets you add new protocols to Group Name (unique for each Group) mapping entries as well as
allow you to see and delete already mapped entries for the switch.

Navigate to Switch > VLAN Management > Protocol-based VLAN > Protocol to Group to display the
Protocol to Group Mapping Table. Here you can add new entries and view or edit existing table entries.

— K y
TR SIT[ON = \Tﬂ_’ANS\TIOH >
\-—’M_ WORKS - L J 9 c
SM16TAT2SA PrOtOCOl to Group Mapplng Table @&Home - VLAN Management - Protocol-based VLAN - Protocol to Group
Switch DMS
Delete Frame Type Value Group Name
» System
» Port Management < | Delete ‘ Ethernet[v| Etype: 0x o000
i <
b el et | Delete ‘ Ethernet[V| Etype: 0x 0800
» VLAN Management e
> VLAN Configuration | Delete ‘ Ethernet[V| Etype: 0x| o0z00
> VLAN Membership

> VLAN Port Status

> VLAN Selective QinQ

» MAC-base

» Protocol-bas

> Protocol to Group

> Groun toVIAN
Parameter descriptions:
Delete: To delete an entry, check this box. The entry will be deleted during the next apply.

Frame T
Frame Type: At the dropdown, select the Ethernet frame type (Ethernet, SNAP, or LLC). rame Type

Value: Displays a value for the frame type. Valid value that can be entered in this text field AP
depends on the option selected from the preceding Frame Type selection menu. Below are the -

criteria for the three different Frame Types:

Ethernet: Values in the text field when Ethernet is selected as a Frame Type is called etype.
Valid etype values are 0x0600-0xffff

SNAP: Valid value in this case also is comprised of two different sub-values.

a. OUL OUI (Organizationally Unique Identifier) is value in format of xx-xx-xx where each pair
(xx) in string is a hexadecimal value 0x00-0xff.

b. PID: If the OUI is hexadecimal 000000, the protocol ID is the Ethernet type (EtherType) field
value for the protocol running on top of SNAP; if the OUI is an OUI for a particular

organization, the protocol ID is a value assigned by that organization to the protocol running
on top of SNAP.

LLC: Valid value in this case is comprised of two different sub-values.

a. DSAP: 1-byte long string (0x00-0xff)
b. SSAP: 1-byte long string (0x00-0xff)

Group Name: Displays the assigned group name for each entry.

Buttons

Apply: Click to save changes.
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Reset: Click to undo any changes made locally and revert to previously saved values.

Add New Entry: Click the button to add a new entry. An empty row is added to the table, and the new
member can be configured as needed.

A saved Protocol to Group Mapping Table is shown below:

— —_
TRANSITION = | o : A =
N NETWORKS - : TeYw veww = = 9 C
SM16TAT2SA Protocol to G roup Mapplng Table #eHome - VLAM Management - Protocol-based VLAN - Protocol to Group '
Switch DMS
Delete Frame Type Value Group Name
» System
Ethernet 0800 EthFT1
» Port Management € O
» PoE Management < 0 SNAP 000000-0001 SnapType2
» VLAN Management v @] LLC ff-ff LlcType3

> VLAN Configuration

> VLAN Membership [ Apply “ Reset

Add New Entry

> VLAN Port Status

> VLAN Selective QinQ

» MAC-based VLAN <
» Protocol-based VLAN ~

> Protocol to Group

> Group to VLAN
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6-6.2 Group Name to VLAN mapping Table
This page lets you map an already configured Group Name to a VLAN for the switch.

Navigate to Switch > VLAN Management > Protocol-based VLAN > Group to VLAN to display the Group
Name to VLAN mapping Table. Add new entries and view or edit existing table entries.

SM16TAT2SA Group Name to VLAN mapping Tablesrome  vuanvanseement - protocotoased il - cf@beo (8
Switch DMS
Port Members
» System <
Group VLAN
» Port Management ¢ Delete Name ID 1 2 3 4 5 E 7 8 9 10
» POE Management <
O 61100 U » ¥ @M ¥ » O 0O 0O O
» VLAN Management e
> VLAN Configuration
A Mo O egp2 200 J O O O 0O
VLAN Membership
> VLAN Port Status
_ O ep3 300 O O O O C O O O 0O ™
> VLAN Selective QinQ
» MAC-based VLAN < < >
» Protocol-based VLAN ~ | Apply || Reset | Add New Entry
> Protocol to Group ‘ '
> Group to VLAN v

Parameter descriptions:

Delete: To delete a private VLAN entry, check this box. The entry will be deleted during the next apply.
Group Name: A valid Group Name is a string of almost 16 characters.

VLAN ID: Indicates the ID to which Group Name will be mapped. A valid VLAN ID ranges from 1-4095.

Port Members: A row of check boxes for each port is displayed for each Group Name to VLAN ID
mapping. To include a port in a mapping, check the box. To remove or exclude the port from the
mapping, make sure the box is unchecked. By default, no ports are members, and all boxes are unchecked.

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Add New Entry: Click to add a new entry in the mapping table. An empty row is added to the table; the
Group Name, VLAN ID and port members can be configured as needed. Valid values for a VLAN ID are 1 -
4095. The Reset button can be used to undo the addition of a new entry.
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6-7 IP Subnet-based VLAN

Navigate to Switch > VLAN Management > Protocol-based VLAN > IP Subnet-based VLAN to display the
IP Subnet-based VLAN Membership Configuration table. Here you can add new entries and view or edit
existing table entries.

SM16TAT2SA IP Subnet-based VLAN Membership Configuration Eiome - VLA Mansgamers - 1P Susnet bazed VLAN
Switch DMS
Delete IP Address Mask Length VLAN ID
» System < JR—
| Delete | 24 1
» Port Management € —
» PoE Management €

» VLAN Management

Configuration

> Private VLAN

Parameter descriptions:

Delete: To delete an entry, check this box. The entry will be deleted during the next apply.
IP Address: Enter an IP address for each entry.

Mask Length: Enter the mask length for each entry.

VLAN ID: Enter the VID for this new entry (1-4095).

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Add New Entry: Click the button to add a new entry. An empty row is added to the table, and the new
member can be configured as needed.
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6-8 Private VLAN

The Private VLAN membership configurations for the switch can be monitored and modified here.
Private VLANs can be added or deleted here. Port members of each Private VLAN can be added or
removed here.

Private VLANSs are based on the source port mask, and there are no connections to VLANs. This means
that VLAN IDs and Private VLAN IDs can be identical.

A port must be a member of both a VLAN and a Private VLAN to be able to forward packets.
By default, all ports are VLAN unaware and members of VLAN 1 and Private VLAN 1.

A VLAN unaware port can only be a member of one VLAN, but it can be a member of multiple Private
VLANSs.

Web Interface

To configure Port Isolation configuration in the web interface:

1. Click VLAN Management and Private VLAN.

2. Configure the Private VLAN port members for the switch.

3. Click the Apply button.

e, —
R - 2 @
wilapis o | z
SM16TAT2SA Private VLAN Membership Configuration oriome - VLA anagement - Frivate VLAN
Switch DMS
Port Members
b System <
PVLAN
» Port Management ¢ Delete  ID 1 2 3 4 5 [ 7 8 9 0 11 12 13 14 15 16 17 18
» PoE Management € —
| ‘ I e I e e e o e e T o e e I O R A R O |

> PortIsolation

Figure 6-4: Private VLAN Membership Configuration
Parameter descriptions:
Delete: To delete a private VLAN entry, check this box. The entry will be deleted during the next apply.
PVLAN ID: Indicates the ID of this particular private VLAN.

Port Members: A row of check boxes for each port is displayed for each private VLAN ID. To include a
port in a Private VLAN, check the box. To remove or exclude the port from the Private VLAN, make sure
the box is unchecked. By default, no ports are members, and all boxes are unchecked.

Adding New Private VLAN: Click the Add New Entry button to add a new private VLAN ID. An empty
row is added to the table, and the private VLAN can be configured as needed.

The Private VLAN is enabled when you click "Apply". The Reset button can be used to undo the addition
of new Private VLANSs.

Buttons

Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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6-9 Port Isolation

Port Isolation provides for an apparatus and method to isolate ports on layer 2 switches on the same
VLAN to restrict traffic flow. The apparatus comprises a switch having said plurality of ports, each port
configured as a protected port or a non-protected port. An address table memory stores an address
table having a destination address and port number pair.

A forwarding map generator generates a forwarding map which is responsive to a destination address of
a data packet. The method for isolating ports on a layer 2 switch comprises configuring each of the ports
on the layer 2 switch as a protected port or a non-protected port. A destination address on a data packet
is matched with a physical address on said layer 2 switch and a forwarding map is generated for the data
packet based upon the destination address on the data packet. The data packet is then sent to the
plurality of ports pursuant to the forwarding map generated based upon whether the ingress port was
configured as a protected or non-protected port.

This page is used for enabling or disabling port isolation on ports in a Private VLAN.A port member of a
VLAN can be isolated to other isolated ports on the same VLAN and Private VLAN.

Web Interface

To configure Port Isolation configuration in the web interface:

1. Click VLAN Management and Port Isolation.
2. Select which port(s) on which you want to enable Port Isolation.
3. Click the Apply button.

- . . ~
SM16TAT2SA Port Isolation Configuration ihame - WA Manazemen - Far alasian
Switch DMS
Port Number
» System <
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18

» Port Management &
» PoE Management < — — — — — — - - L L L LJ [ ]

» VLAN Management e ‘T”T|

Figure 6-5: Port Isolation Configuration page

Parameter descriptions:

Port Number: A check box is provided for each port of a private VLAN. When checked, port isolation is
enabled on that port. When unchecked, port isolation is disabled on that port. By default, port isolation is
disabled (unchecked) on all ports.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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6-10 Voice VLAN

The Voice VLAN feature enables voice traffic forwarding on the Voice VLAN; the switch can then classify
and schedule network traffic. It is recommended that there be two VLANSs on a port - one for voice, one
for data. Before connecting the IP device to the switch, the IP phone should configure the voice VLAN ID
correctly. It should be configured through its own GUL

6-6.1 Voice VLAN Configuration Table

This page lets you configure the Voice VLAN feature parameters.

Web Interface

To configure Port Isolation configuration in the web interface:

1. Click Voice VLAN and Configuration.
2. Click the Add New Entry button.
3. Select which port(s) on which you want to configure Voice VLAN.
4.  Enter VLAN ID and Aging Time and select Traffic.
5. For each Port select Mode, Security, and Discovery Protocol.
6. Click the Apply button.
e, —
TRANSITION  =| @ - H O G
N NETWORKS: o i
SM16TAT2SA Voice VLAN Configuration @Home - VLA Management - Uoice VLA - Configuration
Switch DMS
Port Members
» System &
Delete VLAN ID Aging Time Traffic 1 2 3 4 5 [ T B 9 10 11 12
» Port Management &
» PoE Management < ] 1000 £6400 3 4] =] (] (] O O [l [l ] ] (] (]
» VLAN Ma v |O 2000 86400 § O 0O ¥ @ @M & @ O O O O
| [;el;',5| 1000 26400 ey v OO ) O O O 0O O O 0O o O

< Port Configuration

Port Mode Security Discovery Protocol

1 Forced ¥ Disabled ¥ ou A

Quiality of Service
Spanning Tree

MAC Address Table

= w
-
-
“

Multicast

Figure 6-5: Voice VLAN Configuration page

Parameter descriptions:

Voice VLAN Configuration

VLAN ID: Indicates the Voice VLAN ID. It should be a unique VLAN ID in the system and cannot equal
each port PVID. It is a conflict in configuration if the value equals management VID, MVR VID, PVID etc.
The allowed range is 1 to 4095.

Aging Time: Indicates the Voice VLAN secure learning aging time. The allowed range is 10 to 10000000
seconds. It is used when security mode or auto detect mode is enabled. In other cases, it will be based on
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hardware aging time. The actual aging time will be situated between the [age_time; 2 * age_time] interval.
Traffic: Indicates the Voice VLAN traffic class. All traffic on the Voice VLAN will apply this class.

Port Members: Indicates the Voice VLAN port mode operation. You must disable the MSTP feature before
you enable Voice VLAN. It can avoid the conflict of ingress filtering. Select which port that you want to
enable the Voice VLAN mode operation.

Port Configuration

Port: The switch port number of the Voice VLAN port.

Mode: Indicates the Voice VLAN port mode. When the port mode isn't equal disabled, we must disable
MSTP feature before we enable Voice VLAN. It can avoid the conflict of ingress filtering. Possible port
modes are:

Auto: Enable auto detect mode. It detects whether there is VoIP phone attached to the specific port

and configures the Voice VLAN members automatically.

Forced: Force join to Voice VLAN.

Security: Indicates the Voice VLAN port security mode. When the function is enabled, all non-telephonic
MAC addresses in the Voice VLAN will be blocked for 10 seconds. Possible security modes are:

Enabled: Enable Voice VLAN security mode operation.

Disabled: Disable Voice VLAN security mode operation.

Discovery Protocol: Indicates the Voice VLAN port discovery protocol. It will only work when auto detect
mode is enabled. We should enable LLDP feature before configuring discovery protocol to "LLDP" or
"Both". Changing the discovery protocol to "OUI" or "LLDP" will restart the auto detect process. Possible
discovery protocols are:

OUI: Detect telephony device by OUI address.
LLDP: Detect telephony device by LLDP.
Both: Both OUI and LLDP.

Buttons

Save: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
Delete: Click to do delete an existing Voice VLAN entry.

Add New Entry: Click to add a new entry in Voice VLAN configuration table.

Apply: Click to save changes.
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6-6.1 Voice VLAN OUI Configuration Table

The section describes how to configure the Voice VLAN OUI table. The maximum entry number is 16.
Modifying the OUI table will restart auto detection of the OUI process. An Organizationally Unique
Identifier (OUI) is a 24-bit number that uniquely identifies a vendor, manufacturer, or other organization.
The IEEE Public OUI list is at http://standards-oui.ieee.org/oui/oui.txt.

Web Interface

To configure Port Isolation configuration in the web interface:

1. Click Voice VLAN and OUL
2. Click the Add New Entry button.
3. Enter a Telephony OUI and Description for each instance.
4.  Click the Apply button.
JRANSITION™ | e : °c
SM16TAT2SA Voice VLAN QUI Table BHome - VLAN Management - VsiceULAN - OU
Switch DMS
Delete Telephony oul Description
b System <
» Port Management € |i‘

» PoE Management i | Delete ‘

» VLAN Management

> Configuration

> OU

b Auinlibeaf Candien <

Figure 6-6: Voice VLAN OUI Table

Parameter descriptions:

Telephony OUI: A telephony OUI address is a globally unique identifier assigned to a vendor by IEEE.
It must be 6 characters long and the input format is "xx-xx-xx" (where x is a hexadecimal digit).

Description: The description of OUI address. Normally, it describes which vendor telephony device it
belongs to. The allowed string length is 0 to 32.

Delete: Click to delete an existing Voice VLAN OUI entry.

Add New Entry: Click to add a new entry in Voice VLAN OUI table. An empty row is added to the table to
configure the Telephony OUI and Description.

Buttons
Save: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Chapter 7 - Quality of Service

» Quality of Service

7-1 Global Settings
Use the QoS Global Settings page to set the trust behavior for QoS basic mode.

> Port Policing
This configuration is active when the switch is in QoS basic mode. Packets entering R
a QoS domain are classified at the edge of the QoS domain. s storm

Web Interface
To configure the Global Settings in the web interface:

1. Click Quality of Service and Global Settings.

2. Select the trust mode when the switch is in QoS basic mode. If a packet CoS
level and DSCP tag are mapped to separate queues, the trust mode determines > DSCP Remarking
the queue to which the packet is assigned.

3. Click Apply to save the configuration.

4. To cancel the setting, click the Reset button to revert to previously saved values.

SM16TAT2SA QoS Global Settings @bome - QualiyafSenvics - Clobal Settings

Switch DMS -
Trust Mode (@ cosfanzip

» System &

» Port Management < ~
() cosfanz.1p-05cP
» PoE Management &
» VLAN Management & | Apply ” ::e:e:|
» Quality of Service h

» Global Settings

> Part Settinas

Figure 7-1: QoS Global Settings page
Parameter descriptions:
Trust Mode

CoS/802.1p: Traffic is mapped to queues based on the VPT field in the VLAN tag, or based on the per-
port default CoS/802.1p value (if there is no VLAN tag on the incoming packet), the actual mapping of the
VPT to queue can be configured on the CoS/802.1p to Queue page.

DSCP: All IP traffic is mapped to queues based on the DSCP field in the IP header. The actual mapping of
the DSCP to queue can be configured on the DSCP to Queue page. If traffic is not IP traffic, it is mapped
to the best effort queue.

IP Precedence: Traffic is mapped to queues based on the IP precedence. The actual mapping of the IP
precedence to queue can be configured on the IP Precedence to Queue page.

Co0S/802.1p-DSCP: Uses the trust CoS mode for non-IP traffic and trust DSCP mode for IP traffic.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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7-2 Port Settings

Web Interface
To configure the QoS Port Setting in the web interface:

1. Click Quality of Service and Port Settings.
2. Select Mode, Default CoS, and Source CoS, for each port.

3. Check which port(s) on which you want to enable the Remark Cos, Remark DSCP, and Remark IP
Precedence.

4. Click Apply to save the configuration.
5. To cancel the setting, click the Reset button to revert to previously saved values.

ey, ——
TRANSITION =| e ] e =
N NETWORKS -
SM16TAT2SA QoS Port Settings erioms - QuaityofService - PorsSentings
Switch DMS

Port Mode Default Cos Source CoS Remark CoS Remark DSCP Remark IP Precedence

b System < - - -

1 untrust[™| ofv] c-TAG[v] ] [l O

» Port Management &

» PoE Management <2 untrust]v] ] oA O O O

» VLAN Management & 3 untrust] ~ cTaalv] (] O O

» Quality of Service e - - -

» Global Settings 4 ntrust[™] [v] cTAG[] L (] J

Port Settings 5 ervet[] ~ cracl] ] =] O

6 trust[] ] cTaG[v] O O O

7 trust]~| ] cTAG[v] O (] O

8 rust[~] ~ cag[~] (] O O

9 trust[™] v cTaG[v ] O O

10 untrust[+] v] cTaG[v| ] O O

- 11 untrust]v| [v] c-TAG[v] (] O 0O

Figure 7-2: QoS Port Settings page
Parameter descriptions:
Port: The logical port for the settings contained in the same row.
Mode: Select to Trust or Untrust, where:

untrust: All ingress traffic on the port is mapped to the best effort queue and no
classification/prioritization takes place.

trust: Port prioritize ingress traffic is based on the system wide configured trusted mode, which is
either CoS/802.1p trusted mode, IP Precedence trusted mode, or DSCP trusted mode.

Default CoS: Select the default CoS value to be assigned to incoming untagged packets (0 - 7).
Source CoS: The CoS value is determined based on C-Tag or S-Tag for incoming tagged packets
Remark CoS: Click the checkbox to remark the CoS/802.1p priority for egress traffic on this port.
Remark DSCP: Click the checkbox to remark the DSCP value for egress traffic on this port.

Remark IP Precedence: Click the checkbox to remark the IP precedence for egress traffic on this port.

Note: The CoS/802.1p priority and IP Precedence, or the CoS/802.1p priority and DSCP value can be
remarked simultaneously for egress traffic on a port, but the DSCP value and IP Precedence cannot be
remarked simultaneously.
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Buttons

Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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7-3 Port Policing

This section provides an overview of QoS Ingress Port Policers for all switch ports. Port Policing is useful in
constraining traffic flows and marking frames above specific rates. Policing is primarily useful for data
flows and voice or video flows because voice and video usually maintains a steady rate of traffic.

Web Interface
To configure the QoS Port Policers in the web interface:
1. Click Quality of Service and Port Policing.
Click which port need to enable the QoS Ingress Port Policers, and configure the Rate limit condition.

2
3. Click Apply to save the configuration.
4. To cancel the setting, click the Reset button to revert to previously saved values.

A RANSITIN ™ -
TRANSITION =| 2= B e "
cRReI L =
SM16TAT2SA Qos Ingress Port Policers @ubome - QusisyofSemies - PerPoicng
Switch DMS
Port Enable Rate (kbps)
» System < -
1 [} 1000000
» Port Management €
» PoE Management < |2 O 1000000
» VLAN Management & 3 O 100000
» Quality of Service h -
> Global Settings 4 U 1000000
> Port Settings 5 I:I P
& O 1000000
7 O 1000000
2 O 1000000
9 ] 1000000

Figure 7-3: QoS Ingress Port Policers page
Parameter descriptions:

Port: The logical port for the settings contained in the same row. Click on the port number to configure
its schedulers.

Enable: Check to enable for each Port you on which you want to enable the QoS Ingress Port Policers
function.

Rate (kbps): To set the Rate limit value for this port, the default is 1000000 kbps.

Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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7-4 Port Shaper

This section provides an overview of QoS Egress Port Shapers for all switch ports.

Web Interface
To configure the QoS Port Shapers in the web interface:

Click Quality of Service and Port Shaper.

2. Select the port to configure QoS Egress Port Shaper.
3. Click the port to enable, and configure the Rate limit condition.
4. Click Apply to save the configuration.
5. To cancel the setting, click the Reset button to revert to previously saved values.
— —
= &HSWIGN F 1 H E»
IRANSITIO™ = B ©
SM16TAT2SA QoS Egress Port Shaper for @Home - Quality of Service - Port Shaper
Switch DMS
Port Portl v
» System <
» Port Management < Queue Shaper
» PoE Management «
b VLAN Management ¢ Queue Enable Rate (kbps)
» Quality of Service v 0 O 1000000
> Global Settings .
> Port Settings ! U 1000000
> Port Policing 5 0 000000
> Port Shaper
> Storm Control 3 1000000
> Port Schedulei
4 U 1000000
> CoS/802.1p Mapping
> CoS/802.1p Remarking 5 O 1000000
6 ‘:‘ 1000000
’ 7 O 1000000
> DSCP Remarking
» Spanning Tree % Port Shaper
» MAC Address Table &
Enable Rate (kbps)
» Multicast <
» MVR < ) 1000000
» DHCP < —
Apply | Reset ‘
» Security © -

Figure 7-4: The QoS Egress Port Shaper page
Parameter descriptions:

Port : The logical port for the settings contained in the same row. Click on the port number to configure
the shapers.

Queue Shaper
Queue : The queue number of the queue shaper on this switch port.
Enable : Controls whether the queue shaper is enabled for this queue on this switch port.

Rate(kbps) : Controls the rate for the queue shaper. The default value is 1000000.

Port Shaper
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Enable : Controls whether the port shaper is enabled for this switch port.

Rate(kbps) : Controls the rate for the port shaper. The default value is 1000000.

Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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7-5 Storm Control

The section allows user to configure the Storm control for the switch. There is a destination lookup failure
storm rate control, multicast storm rate control, and a broadcast storm rate control. These only affect
flooded frames, i.e. frames with a (VLAN ID / DMAC) pair not present on the MAC Address table.

The configuration indicates the permitted packet rate for unicast, multicast or broadcast traffic across the
switch.

Web Interface
To configure the Storm Control Configuration parameters in the web interface:

1. Click Quality of Service and Storm Control.

2. Click the port to be enabled, and configure the Rate limit condition.

4. Click the Apply button to save the setting.

5. To cancel the setting, click the Reset button to revert to previously saved values.

—— ——
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Figure 7-5: Storm Configuration page
Parameter descriptions:

Port : The logical port for the settings contained in the same row. Click on the port number to configure
storm control.

Frame Type : The settings in a particular row apply to the frame type listed here: Broadcast, Multicast or
Unknown Unicast.

Enable : Enable or disable the storm control status for the given frame type.

Rate : The rate unit is packets per second (pps). Valid values are: 1, 2, 4, 8, 16, 32, 64, 128, 256, 512, 1K, 2K,
4K, 8K, 16K, 32K, 64K, 128K, 256K, 512K or 1024K, 1024K, 2048K, 4096K, 8192K, 16384K or 32768K.

The 1 kpps is actually 1002.1 pps.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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7-6 Port Scheduler

This section provides an overview of QoS Egress Port Scheduler for all switch ports.

Web Interface

To configure the QoS Port Schedulers in the web interface:

1. Click Quality of Service and Port Scheduler.
2. Select Scheduler Mode for each port.

SMXTAT2SA Web User Guide

3. If you select WRR (Weighted round robin) or WFQ (Weighted fair queueing), you can configure

weight.

4. Click the Apply button to save the setting.

5. To cancel the setting, click the Reset button to revert to previously saved values.

Figure 7-6: QoS Egress Port Scheduler

Parameter descriptions:

e AN
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Port: The logical port for the settings contained in the same row.
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Q5

@ Home

Scheduler Mode: Controls whether the scheduler mode is "Strict Priority”, "WRR" or

"WFQ" on this switch port.

WFQ allows specifying, for each flow, which fraction of the capacity will be

given.

WRR serves a number of packets for each nonempty queue.

M G

Quelity of Seniice - Port Schaduler

Q6 Q71

Scheduler Mode

WRR

LAl 4

In a Strict Priority queue, an element with high priority is served before an element with low

priority.

If two elements have the same priority, they are served according to their order in the queue.

Weight: Controls the weight for this queue. The default value is "0". This value is restricted to 0-127. This
parameter is only shown if "Scheduler Mode" is set to "Weighted" (WRR or WFQ).
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Buttons

Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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7-7 CoS/802.1p Mapping

Use the CoS/802.1p to Queue page to map 802.1p priorities to egress queues. The CoS/802.1p to Queue
table determines the egress queues of the incoming packets based on the 802.1p priority in their VLAN
tags. For incoming untagged packets, the 802.1p priority will be the default CoS/802.1p priority assigned
to the ingress ports.

Web Interface
To configure the Cos/802.1p Mapping in the web interface:

1. Click Quality of Service and Cos/802.1p Mapping.

2. Select a Queue ID.

3. Click the Apply button to save the setting.

4. To cancel the setting, click the Reset button to revert to previously saved values.

e ——
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Figure 7-7: QoS Ingress CoS/802.1p to Queue Mapping

Parameter descriptions:

CoS/802.1p: Displays the 802.1p priority tag values to be assigned to an egress queue, where 0 is the
lowest and 7 is the highest priority.

Queue ID: Select the egress queue to which the 802.1p priority is mapped. Eight egress queues are
supported, where Queue 8 is the highest priority egress queue and Queue 1 is the lowest priority egress
queue.

Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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7-8 CoS/802.1p Remarking

Use the Queues to CoS/802.1p page to remark the CoS/802.1p priority for egress traffic from each queue.

Web Interface

To configure the Cos/802.1p Remarking in the web interface:
1. Click Quality of Service and Cos/802.1p Remarking.

2. Select CoS/802.1p.

3. Click the Apply button to save the setting.

4

To cancel the setting, click the Reset button to revert to previously saved values.

e, —— ]
TRANSITION =|| e i e "
S NETWORKS =
SM16TAT2SA QoS Egress Queue to CoS5/802.1p Remarking @ttome - Quality of Sevice  CaS/B02.1p Remarking
Switch DMS
Queue ID CoS/802.1p
» System €
0 o[+
» Port Management @
» POE Management < 1 1[¥]
» VLAN Management = 5 2[v]
¥ Quality of Service e
> Global Settings 3 3ﬂ
4 av]
5 s¥]
6 s[v]
7 v
. Apply ” F'e-s-:t.
L I\ J v

Figure 7-8: QoS Egress Queue to CoS/802.1p Remarking

Parameter descriptions:

Queue ID: Displays the Queue ID, where Queue 8 is the highest priority egress queue and Queue 1 is the
lowest priority egress queue.

Co0S/802.1p: For each output queue, select the CoS/802.1p priority to which egress traffic from the queue
is remarked.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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7-9 IP Precedence Mapping

This page lets you map an IP precedence to an egress queue.

Web Interface

To configure the IP Precedence Mapping in the web interface:
1. Click Quality of Service and IP Precedence Mapping.

2. Select Queue ID.

3. Click the Apply button to save the setting.

4

To cancel the setting, click the Reset button to revert to previously saved values.

— T T A
TRANSITION =| & ] e &
M NETWORKS =
SM16TAT2SA QoS Ingress IP Precedence to Queue Mapping @Home - QualiyofSenice - 12 recedance s
Switch DMS
IP Precedence Queue ID
» System K
0 ol
» Port Management @
» PoE Management < 1 1+
A A, €
» VLAN Management 2 2]
» Quality of Service h
» Global Settings 3 gﬂ
4 2|
5 s[¥]
6 slv]
7 v
Apply | Reset

L ] W

Figure 7-9: QoS Ingress IP Precedence to Queue Mapping

Parameter descriptions:

IP Precedence: Displays the IP Precedence priority tag values to be assigned to an egress queue, where 0
is the lowest and 7 is the highest priority.

Queue ID: Select the egress queue to which the IP precedence priority is mapped. Eight egress queues
are supported, where Queue 8 is the highest priority egress queue and Queue 1 is the lowest priority
egress queue.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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7-10 IP Precedence Remarking

This page lets you map egress queue to IP precedence.

Web Interface

To configure the IP Precedence Remarking in the web interface:
1. Click Quality of Service and IP Precedence Remarking.

2. Select IP Precedence.

3. Click the Apply button to save the setting.

4

To cancel the setting, click the Reset button to revert to previously saved values.

T pANSITIO™ .
TRANSITION =| S 1 e »"
N NETWORKS =
SM16TAT25A QoS Egress Queue to IP Precedence Remarking fbriome - Quelicyof Service - [P Precedence Remerking
Switch DMS
Queue ID IP Precedence
» System =
0 oM
» Port Management &
» PoE Management € 1 B
A <
» VLAN Management 5 I~
» Quality of Service ™
> Global Settings 3 3v
4 i~
5 M
6 &l
7 v
Apply ” Reset

Figure 7-10: QoS Egress Queue to IP Precedence Remarking

Parameter descriptions:

Queue ID: Displays the Queue ID, where Queue 8 is the highest priority egress queue and Queue 1 is the
lowest priority egress queue.

IP Precedence: For each output queue, select the IP Precedence priority to which egress traffic from the
queue is remarked.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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7-11 DSCP Mapping

Use the DSCP to Queue page to map IP DSCP to egress queues. The DSCP to Queue table determines the
egress queues of the incoming IP packets based on their DSCP values. The original VLAN Priority Tag
(VPT) of the packet is unchanged.

It is possible to achieve the desired QoS in a network by simply changing the DSCP to Queue mapping,
the queue schedule method, and bandwidth allocation.

Web Interface

To configure the DSCP Mapping in the web interface:

1. Click Quality of Service and DSCP Mapping.

2. Select Queue ID.

3. Click the Apply button to save the setting.

4

To cancel the setting, click the Reset button to revert to previously saved values.

= ——
TR SITION - J_F::N.‘.I\If]h [ 1 9 E‘
\-—"’[. TWORKS —
SM16TAT2SA QoS Ingress DSCP to Queue Mapping @kome - Qualiey of Senvice - DSCF Magging
Switch DMS
DSCP Queue ID DSCP QueueID DSCP Queue D DsSCP Queue D
» System €
0(BE) o] 16(Cs2) 2[v] 32 (C34) 4[v] 48 (C36) o[
» Port Management €
» POE Management < 1 o[v] 17 2v] 33 V] 49 5[]
ILAN <
> S AR 2 ofv] 18 (AF21) 2] 34 (AF41) <] 50 i
» Quality of Service ™
> Global Settings 3 olv] 18 2[v] 35 4] 51 &e[v]
4 o] 20 (AF22) 2~ 36 (AF42) 4[v] 52 o[
5 o] 21 2~ 37 4[v] 53 o[
6 o] 22 (AF23) 2v] 38 (AF43) 4[] 54 o]
7 o] 23 v 38 4[v] 55 o[
2(cs1) 1] 24(C53) afv] 40 (C35) i~ 56 (C57) 7~
9 1[~] 25 3[v] 41 s[v] 57 7[v]
Mapping
 becr Rt 10 [AF11) 1v] 26 (AF31) av] 42 sl 58 7]

Figure 7-11: QoS Ingress DSCP to Queue Mapping

Parameter descriptions:
DSCP: Displays the DSCP value in the incoming packet and its associated class.

Queue ID: Select the traffic forwarding queue from the Output Queue drop-down menu to which the
DSCP value is mapped.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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7-12 DSCP Remarking

Use the Queues to DSCP page to remark DSCP value for egress traffic from each queue.
Web Interface

To configure the DSCP Remarking in the web interface:

1. Click Quality of Service and DSCP Remarking.

2. Select DSCP.

3. Click the Apply button to save the setting.

4

To cancel the setting, click the Reset button to revert to previously saved values.

> DSCP Mapping

» DSCP Remarking

Figure 7-12: QoS Egress Queue to DSCP Remarking

Parameter descriptions:

Queue ID: Displays the Queue ID, where Queue 8 is the highest priority egress queue and
Queue 1 is the lowest priority egress queue.

DSCP: For each output queue, select the DSCP priority to which egress traffic from the queue is
remarked. For example Expedited Forwarding (EF) for low-loss, low-latency traffic or Assured
Forwarding (AF) which assures delivery under prescribed conditions.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

SM16TAT2SA QoS Egress Queue to DSCP Remarking @reme -+ Queieyarsensce - O5ce remanong
Switch DMS
Queue ID DSCP
» System €
0 ofgg) [v]
» Port Management €
» PoE Management < 1 acst [v]
» VLAN Management € 5 1scs2) [v]
¥ Quality of Service e
> Global Settings 3 2(cs3) [¥]
4 32(cs4) [v]
5 0css) [V
6 sz icss) [v]
P
C 1p Mapping T s ics7) [v]
C 1p Remarking
IP e Mapping Apply ” Reset
> IP e Remarking

DSCP
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Chapter 8 - Spanning Tree

The Spanning Tree Protocol (STP) can be used to detect and disable network loops, and to provide backup
links between switches, bridges or routers. This allows the switch to interact with other bridging devices
(that is, an STP-compliant switch, bridge or router) in your network to ensure that only one route exists
between any two stations on the network, and provide backup links which automatically take over when a
primary link goes down.

STP uses a distributed algorithm to select a bridging device (STP- compliant switch, bridge or router) that
serves as the root of the spanning tree network. It selects a root port on each bridging device (except for
the root device) which incurs the lowest path cost when forwarding a packet from that device to the root
device. Then it selects a designated bridging device from each LAN which incurs the lowest path cost
when forwarding a packet from that LAN to the root device. All ports connected to designated bridging
devices are assigned as designated ports. After determining the lowest cost spanning tree, it enables all
root ports and designated ports, and disables all other ports. Network packets are therefore only
forwarded between root ports and designated ports, eliminating any possible network loops.

Designated .,
/ Root.

Designated Root.

Designated ., rort., Port..
X : 3 Bridge DDDD

Figure 8: Spanning Tree Protocol

Once a stable network topology has been established, all bridges listen for Hello BPDUs (Bridge Protocol
Data Units) transmitted from the Root Bridge. If a bridge does not get a Hello BPDU after a predefined
interval (Maximum Age), the bridge assumes that the link to the Root Bridge is down. This bridge will then
initiate negotiations with other bridges to reconfigure the network to reestablish a valid network
topology.
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8-1 State

This page lets you enable or disable MSTP; you can also select what protocol version you want. The
default is Spanning Tree enabled.

Web Interface
To configure the Spanning Tree Protocol version in the web interface:

1. Click Spanning Tree and state.

2. Select “on” to enable Spanning Tree Protocol.
3. Select the Spanning Tree Protocol version.

4. Click the Apply button to save the setting.
5

To cancel the setting, click the Reset button to revert to previously saved values.

o ——
TRANSITION = | e o @ =
N NETWORKS —
SM16TAT25A MSTP State FeHoms - SpanmingTree - Stats
Switch DMS
Multiple Spanning Tree Protocol
» System e
» Port Management < Force Version MsTR[v]
» PoE Management e — -
| Apply ” Reset

» VLAN Management < /
» Quality of Service <

» Spanning Tree

» State

Figure 8-1: MSTP State page

Parameter descriptions:
Multiple Spanning Tree Protocol: You can select on to enable MSTP or off to disable MSTP.

Force Version: The STP protocol version setting. Valid values are STP, RSTP and MSTP.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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This page lets you configure the basic identification of a MSTP bridge. Bridges participating in a common

MST region must have the same Region Name and Revision Level.

Web Interface
To configure the Region Config in the web interface:

1. Click Spanning Tree and Region Config.

2. Specify the Region Name and Revision Level.
3. Click the Apply button to save the setting.
4

To cancel the setting, click the Reset button to revert to previously saved values.

T AT
TRANSITION =| e -
N [} TWORKS —
SM16TAT2SA MSTP Region Config
Switch DMS
Region Name {0~32 characters) 00-40-C7-1C-CB-6E
» System <
Revision Level (0-65535)
» Port Management <
» PoE Management D e T
| Apply ” Reset
» VLAN Management < e
» Quality of Service <

» Spanning Tree
> State

» Region Config

> Instance View

Figure 8-2: MSTP Region Config

Parameter descriptions:

B & =

@@Home - Spenning Tree -~ Region Config

Region Name (0~32 characters): The name identifying the VLAN to MSTI mapping. Bridges must share
the name and revision (see below), as well as the VLAN-to-MSTI mapping configuration in order to share

spanning trees for MSTI's (Intra-region). Enter up to 32 characters.

Revision Level (0-65535): The revision of the MSTI configuration named above. This must be an integer

between 0 and 65535.

Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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8-3 Instance View

This page provides an MST instance table which includes information (VLAN membership of a MSTI ) of all
spanning tree instances provisioned in the particular MST region which the bridge belongs to. Through
this table, additional MSTP configuration data can be applied and MSTP status can be retrieved.

Web Interface
To configure the MSTP Instance in the web interface:

1. Click Spanning Tree and Instance View.

2. Click the Add VLAN button.

3. Specify the Instance and Port.

4. Click Instance Status and Port Status to see the detail.
5. To cancel the settings click the Delete button.

Aﬁ R
TRANSITION ' =| wsmon = > B
\—' NETWORKS
SM16TAT2S5A MSTP Instance Config @Home - Spanning Tree - Instance View
Switch DMS
Instance ID  Corresponding Vlans
} System <
] 0 1-3,10-19,21-4084

» Port Management <
» PoE Management & UJ 1 20
P VLAN Management < O 2 4.9
» Quality of Service <

Figure 8-3: MSTP Instance Config

Parameter descriptions:

Instance ID: Every spanning tree instance must have a unique instance ID within 0~4095. Instance 0
(CIST) always exists and cannot be deleted. Additional spanning instances (MSTIs) can be added or
deleted. At least one VLAN must be provisioned for an MSTI to declare the need for the MSTI to exist.

Corresponding Vlans: 1-4095. Multiple VLANs can belong to an MSTIL. All VLANSs that are not provisioned
through this will be automatically assigned to Instance 0 (CIST).
Buttons

Add Vlan: Click to add an MSTI and provide its VLAN members or modify VLAN members for a specific
MSTL you can add up to 63 for a total of 64.

Delete: Click to delete a selected MSTL

Instance Config: Click to provision spanning tree performance parameters per instance.
Port Config: Click to provision spanning tree performance parameters per instance per port.
Instance Status: Click to show the status report of a particular spanning tree instance.

Port Status: Click to show the status report of all ports regarding a specific spanning tree instance.
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SM16TAT2SA
Switch DMS

Instance ID

b System @
Vlan Mappi

» Port Management © nHapping

» PoE Management S — . -
|_ Apply || Reset | Cancel

» VLAN Management =
» Quality of Service <

» Spanning Tree
> State
> Region Config

» Instance View
Parameter descriptions:

Instance ID: Thevalid rRange is 1-4094.

MSTP Create MSTI/Add Vlan Mapping

Vlan Mapping: The list of VLANs mapped to the MSTL The VLANSs can be given as a single (xx, xx being
between 1 and 4094) VLAN, or a range (xx-yy), each of which must be separated with comma and/or
space. A VLAN can only be mapped to one MSTL An unused MSTI should just be left empty (i.e., not
having any VLANs mapped to it). For example: 2,5,20-40.

Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

Cancel: Click to undo any changes made locally and return to the Users.

Instance Config of Instance 0 :

M 0 &

TRANSITION © =| s zzax
N NETWORKS:
SM16TAT2SA Instance Configuration (ID=0)
Switch DMS
Priority 32768 ¥
» System <
» Port Management < Max. Age 20 |seconds
= = £
» PoE Management Forward Delay = |seconds
» VLAN Management <
Max. Hops 1 seconds
» Quality of Service <
» Spanning Tree
Apply || Reset | Back

> State

» Region Config

> Instance View

§@Home -~ Spanning Tree - Instance View

Figure 8-3: Instance Config of Instance 0
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Parameter descriptions:

Priority: The priority parameter used in the CIST (Common and Internal Spanning Tree) connection:

0/4096 /8192 /12288 /16384 / 20480 / 24576 / 28672 / 32768 / 36864 / 40960 / 45056 / 49152 /
53248 / 57344 / 61440

MAX. Age: 6-40sec. The same definition as in the RSTP protocol.
Forward Delay: 4-30sec. The same definition as in the RSTP protocol.

MAX. Hops: 6-40sec. It's a new parameter for the multiple spanning tree protocol. It is used in the
internal spanning tree instances. "CIST Remaining Hops” or "MSTI Remaining Hops” in the Spanning tree
protocol message would decreased by one when the message is propagated to the neighboring bridge. If
the Remaining Hops in a message is zero, the message (BPDU) would be regarded as invalid. Max Hops is
used to specify the initial value of the Remaining Hops for Regional Root Bridge (Either CIST Regional
Root or MSTI Regional Root).

Buttons
Apply : Click to save changes.
Reset : Click to undo any changes made locally and revert to previously saved values.

Back : Click to undo any changes made locally and return to the Users.

Port Config of Instance 0:

I SITION
TRANSITION ' =| Zwsmo 2 - (> I
VNETWOPKS
SM16TAT2SA Port Config of Instance 0 @Home - Spening Tres - Instance View
Switch DMS
Port Config Migration
» System < Check
» Port Manage < - . . : :
SO E P Port STP Path Cost Priority Admin Admin Restricted Restricted | Mcheck |
» PoE Management < Enable Edge P2p Role TCN —
¥ VLAN Management ¢ 1 5] Auto v 128 ¥ Yez ¥ Auts ¥ Ho ¥ No ¥ v
» Quality of Service <
2 5] Auta v 02 v Yes ¥ Aute ¥ Ne ¥ No ¥ v
» Spanning Tree M
> State 3 5] Auto v 1028 ¥ Yes ¥ Aute ¥ Ne ¥ No ¥ v
Config
4 W Auto v v Yes ¥ ute ¥ o ¥ o ¥ v
» MAC Address Table < 5 3l Aute v 28 ¥ Yes ¥ Aute ¥ No ¥ Ne ¥ v
» Multicast <
lulticast 6 [Z| Auto v 128 ¥ Yes ¥ Auto ¥ Ho ¥ No ¥ v
» DHCP <
) T /7| uto v v ¥ v ute T | T [l T v
» Security <

Figure 8-3: Port Config of Instance 0
Parameter descriptions:
Port: The logical port for the settings contained in the same row.

Path Cost: 1 — 200,000,000 or Auto. The same definition as in the RSTP specification. But in MSTP, this
parameter can be respectively applied to ports of CIST and ports of any MSTL

Priority: 0/16/32/48/64/80/96/112 /128 /144 /160/176 /192 /208 /224 /240 . The same
definition as in the RSTP specification. But in MSTP, this parameter can be respectively applied to ports of
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CIST and ports of any MSTL

Admin Edge: Yes / No. The same definition as in the RSTP specification for the CIST ports. The factory
default setting is No (Non-Edge).

Admin P2P: Auto / True / False. The same definition as in the RSTP specification for the CIST ports.

Restricted Role: Yes / No. If “Yes” causes the Port not to be selected as Root Port for the CIST or any
MSTI, even it has the best spanning tree priority vector. Such a Port will be selected as an Alternate Port
after the Root Port has been selected. This parameter is “No” by default. If set, it can cause lack of
spanning tree connectivity. It is set by a network administrator to prevent bridges external to a core region
of the network influencing the spanning tree active topology, possibly because those bridges are not
under the full control of the administrator.

Restricted TCN: Yes / No. If “Yes” causes the Port not to propagate received topology change
notifications and topology changes to other Ports. This parameter is “No” by default. If set it can cause
temporary loss of connectivity after changes in a spanning trees active topology as a result of persistent
incorrectly learned station location information. It is set by a network administrator to prevent bridges
external to a core region of the network, causing address flushing in that region, possibly because those
bridges are not under the full control of the administrator, or the status of MAC operation for the attached
LANs transitions frequently.

Mcheck: The same definition as in the RSTP specification for the CIST ports. The STP mCheck (Migration
Check) variable. Automatically migrate from RSTP or MSTP to STP-compatible mode.

Buttons
Apply : Click to save changes.

Back : Click to undo any changes made locally and return to the MSTP Instance Config table.
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Instance Status of Instance 0 :

—— — A
TRANSITION | e G
NETWORKS — L J c
SM16TAT2SA Instance Status (ID=0) @Home - Spanning Tree - Instance View
Switch DMS —
| Back | Refresh |
b System < - -
» Port Management < MSTP State Enabled
» POE Management < Force Version STP
» VLAN Management < Bridge Max Age 20
» Quality of Service < Bridge Forward Delay 15
L ing T h .
panning free Bridge Max Hops 20
> State
S D Instance Priority 32768
* Instance View Bridge Mac Address 00-40-C7-1C-CB-6E
» MAC Address Table < CIST ROOT PRIORITY 32768
Multi <
> (e CIST ROOT MAC 00-40-C7-1C-CB-6E
» DHCP <
CIST EXTERMAL ROOT PATH COST 0
¥ Security .
CIST ROOT PORTID ]
¥ Access Control <
CIST REGIONAL ROOT PRIORITY 32768
» SNMP <
» Evenit Notification < CIST REGIONAL ROOT MAC 00-40-CT-1C-CB-6E
b Diagnostics < CISTINTERNAL ROOT PATH COST 0
» Maintenance < CIST CURRENT MAX AGE 20
CIST CURRENT FORWARD DELAY 15
TIME SINCE LAST TOPOLOGY CHANGE
247057
(SECs)
W
TOPOLOGY CHANGE COUNT (SECs) 0

Figure 8-3: Instance Status of Instance 0

Parameter descriptions:

MSTP State : MSTP protocol is Enable or Disable.

Force Version : Shows the current spanning tree protocol version configured.

Bridge Max Age : Shows the Max Age setting of the bridge itself.

Bridge Forward Delay : Shows the Forward Delay setting of the bridge itself.

Bridge Max Hops : Shows the Max Hops setting of the bridge itself.

Instance Priority : Spanning tree priority value for a specific tree instance (CIST or MSTI)
Bridge Mac Address : The Mac Address of the bridge itself.

CIST ROOT PRIORITY : Spanning tree priority value of the CIST root bridge

CIST ROOT MAC : Mac Address of the CIST root bridge

CIST EXTERNAL ROOT PATH COST : Root path cost value from the point of view of the bridge’s MST
region.

CIST ROOT PORT ID : The port ID of the bridge's root port. In MSTP, peer port of a root port may reside
in different MST region or in the same MST region. The first case indicates that the root port's owner is the
CIST regional root bridge.

CIST REGIONAL ROOT PRIORITY: Spanning tree priority value of the CIST regional root bridge. Note that
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CIST Regional Root bridge is different from CIST Root bridge. One exception is that when a bridge
belonging to an MST region happens to be the root bridge of the CST (Common Spanning Tree). An MST
Region in the CST can be regarded as a common RSTP bridge. The IST (Internal Spanning Tree) and MSTIs
are transparent to bridges outside this region.

CIST REGIONAL ROOT MAC : Mac Address of the CIST regional root bridge.

CIST INTERNAL ROOT PATH COST : Root path cost value from the point of view of the bridges inside the
IST.

CIST CURRENT MAX AGE : Max Age of the CIST Root bridge.
CIST CURRENT FORWARD DELAY : Forward Delay of the CIST Root bridge.

TIME SINCE LAST TOPOLOGY CHANGE (SECs) : Time Since Last Topology Change is the elapsed time in
unit of seconds for a bunch of “Topology Change and(or) Topology Change Notification receiving” to
occur. When new series of Topology Changes occur again, this counter will be reset to 0.

TOPOLOGY CHANGE COUNT (SECs) : The per spanning tree instance Topology Change Count expresses
the time spent in unit of seconds since the beginning of the Spanning Tree Topology Change to the end of
the STP convergence. Once there is no topology change occurring and no more topology change
notification received, the Topology Change count will be reset to 0.

Buttons
Back : Click to undo any changes made locally and return to the Users page.

Refresh : Click to manually refresh the page immediately.
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Port Status of Instance 0 :

—— —
TRANSITION EH == " ” Mo G
SM16TAT25A Port Status of Instance 0 @Home - SpenningTree - Insterce View
Switch DMS ——
| Back || Refresh |
» System g
O B < Port No Status Role Path Cost Priority Hello Oper. Edge Oper. P2P Restricted Role Restricted Ten
» POE Management < |1 DISCARDING disable | 20000000 128 2 v
b VLAN Management ¢ 2 FORWARDING DSGN 20000 128 2 v v
» Quality of Service s DISCARDING disable 20000000 128 2 v
» i h
Spanning Tree 4 DISCARDING disable 20000000 128 2 v
> State
g 5 DISCARDING disable 20000000 128 2 v
6 DISCARDING disable 20000000 128 2 v
» MAC Address Table < 7 DISCARDING disable 20000000 128 2 v
N <
> Mines: 8 DISCARDING disable 20000000 128 2 v
» DHCP <
9 DISCARDING disable 20000000 128 2 v
» Security €
10 DISCARDING disable 20000000 128 2 v
» Access Control ‘
11 DISCARDING disable 20000000 128 2 v
» SNMP <
e — < |12 DISCARDING disable | 20000000 128 2 v
» Diagnostics < 13 DISCARDING disable | 20000000 128 2 v
» Maintenance < 14 DISCARDING disable 20000000 128 2 v
15 DISCARDING disable | 20000000 128 2 v
16 DISCARDING disable | 20000000 128 2 v
17 DISCARDING disable | 20000000 128 2 v
18 DISCARDING disable | 20000000 128 2 v

Figure 8-3: Port Status of Instance 0
Parameter descriptions:
Port No: The port number to which the configuration applies.

Status: The forwarding status. Same definition as of the RSTP specification. Possible values are
"FORWARDING", “LEARNING", "DISCARDING".

Role: The role that a port plays in the spanning tree topology. Possible values are “disable”(disable
port) , "alternate” (alternate port), “backup” (backup port), "ROOT" (root port) , “DSGN" (designated
port) , and "MSTR" (master port). The last 3 are possible port roles for a port to transit to FORWARDING
state

Path Cost: Displays currently resolved port path cost value for each port in a particular spanning tree
instance.

Priority: Displays port priority value for each port in a particular spanning tree instance.

Hello: Per port Hello Time display. It takes the following form: Current Hello Time/Hello Time Setting
Oper. Edge: Whether or not a port is actually an Edge Port.

Oper. P2P: Whether or not a port is actually a Point-to-Point port.

Restricted Role: Yes / No. If “Yes” causes the Port not to be selected as Root Port for the CIST or any
MSTI even it has the best spanning tree priority vector. Such a Port will be selected as an Alternate Port
after the Root Port has been selected. This parameter is “No” by default. If set, it can cause lack of
spanning tree connectivity. It is set by a network administrator to prevent bridges external to a core region
of the network influencing the spanning tree active topology, possibly because those bridges are not
under the full control of the administrator.

Restricted TCN: Yes / No. “Yes" causes the Port not to propagate received topology change notifications
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and topology changes to other Ports. This parameter is “No” by default. If set it can cause temporary loss
of connectivity after changes in a spanning trees active topology as a result of persistent incorrectly
learned station location information. It is set by a network administrator to prevent bridges external to a
core region of the network, causing address flushing in that region, possibly because those bridges are
not under the full control of the administrator, or the status of MAC operation for the attached LANs
transitions frequently.

Buttons
Back : Click to undo any changes made locally and return to the Users.

Refresh : Click to manually refresh the page immediately.

Messages
Message: MSTP disabled or force version is not MSTP
Recovery: Click OK to clear, change the Instance Status parameter, and continue.

x

192.168.1.77 says:

I MSTP disabled or force version is not MSTP ‘

e e e e
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Chapter 9 - MAC Address Tables

9-1 Configuration

SMXTAT2SA Web User Guide

Switching of frames is based on the DMAC address contained in the frame. The switch builds a table that
maps MAC addresses to switch ports for knowing which ports the frames should go to (based upon the
DMAC address in the frame). This table contains both static and dynamic entries. The static entries are
configured by the network administrator if the administrator wants to do a fixed mapping between the

DMAC address and switch ports.

The frames also contain a MAC address (SMAC address), which shows the MAC address of the equipment
sending the frame. The SMAC address is used by the switch to automatically update the MAC table with
these dynamic MAC addresses. Dynamic entries are removed from the MAC table if no frame with the

corresponding SMAC address is been seen after a configurable age time.

Web Interface
To configure MAC Address Table in the web interface:

1. Click MAC Address Table and Configuration.
2. Specify the Disable Automatic Aging and Aging Time.
3. Configure the Port Members (Auto, Disable, Secure).
4. Click the Add New Static Entry button, and specify the VLAN ID, Mac address, Block, and Port
Member parameters.
5. Click Apply.
Jﬁ —
TRANSITION ® =/ merss eg °c
N NETWORKS. » T
SM16TAT2SA MAC Table Configuration @Home - MAL AddressTable - Configurstion
Switch DMS
Aging Configuration
b System
» Port Management < Disable Automatic Aging [}
» PoE Management o Aging Time 300 seconds
» VLAN Management 3
b Quality of Service < MAC Table Learning
» Spanning Tree <
Port Member
1 2 2 4 5 5 7 8 9 10 1 15 16 1T 18
> Information Learning (@ ® (O] (O] (O] (O] @ (O] (O] (O] ® @® ® ® @ @ ® ®
D (riess: ¢ pisable  (C - - - - D C _ _ _ o O O O C o C _
» DHCP < - - - - - - - - - - - - - - - - - -
Secure _ _ B _ _ 3 _ 8 8 3 B (@] (@] O 3 D) 8 8
» Security <
b Access Control ¢ Static MAC Table Configuration
» SNMP <
- Delete VLAN ID MAC Address Port Member
» Event Notification <
» Diagnostics < | I:;_I—::e‘ 1 00-00-00-00-00-00 Forti ¥
» Maintenance <

‘ Add New Static Entry |

Figure 9-1: MAC Table Configuration
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Parameter descriptions:

Aging Configuration: By default, dynamic entries are removed from the MAC table after 300 seconds.
This removal is also called aging. Configure aging time by entering a value here in seconds. The valid
range is 10 - 1000000 seconds. Disable the automatic aging of dynamic entries by checking the Disable
Automatic Aging checkbox.

MAC Table Learning

If the learning mode for a given port is greyed out, another module is in control of the mode, so that it
cannot be changed by the user. An example of such a module is the MAC-Based Authentication under
802.1X. Each port can do learning based upon the following settings:

Learning: Learning is done automatically as soon as a frame with unknown SMAC is received.
Disable: No learning is done.

Secure: Only static MAC entries are learned; all other frames are dropped.

@ NoTe: Make sure that the link used for managing the switch is added to the Static
MAC Table before changing to secure learning mode, otherwise the management
link is lost and can only be restored by using another non-secure port or by
connecting to the switch via the Telnet interface.

Static MAC Table Configuration

The static entries in the MAC table are shown in this table. The static MAC table can contain 64 entries.
The MAC table is sorted first by VLAN ID and then by MAC address.

Delete: Check to delete the entry. It will be deleted during the next save.

VLAN ID: The VLAN ID of the entry.

MAC Address: The MAC address of the entry.

Block: Click it, if you want block this mac address.

Port Member: Check radio buttons to set which ports are members of the entry. Check or uncheck as
needed to modify the entry.

Buttons

Add New Static Entry: Click to add a new entry to the static MAC table. Specify the VLAN ID, MAC
address, and port members for the new entry. Click "Apply".

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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9-2 Information

Entries in the MAC Table are shown on this page. The MAC Table contains up to 8192 entries, and is
sorted first by VLAN ID, then by MAC address.

Web Interface

To display the Dynamic MAC Table in the web interface:
1. Click MAC Address Table and Information.
2. View the displayed MAC Address Table.

TRANSITION = | awsoar . ” (-
3 o L ]
N NETWORKS
SM16TAT2SA MAC Table Information BFome - MAC Address Table - Information
Switch DMS —
Auto-refresh ‘ Refresh H Cleal |
b System <
» PortManagement < Show 1w ¥ entries Search:
» PoE Management < Port Members
L A <
b UL T Type ~ VLAM MACAddress “ Block cPU 1 2 2 4 5 & 7 8 9 10 11 12 13 14 15 16 17 18
» Quality of Service &
Dynamic 1 00-16-6C-D4-DD-C2 Mo
<

» Spanning Tree
: Dynamic 00-1B-11-B2-6D-4B Mo
Table

Static 00-CO-F2-49-3E-F6  No

nfol

AC-CC-BE-AD-FE-2A Mo

1
1
Dynamic 1
1

b Multicast Dynamic F0-55-3D-84-A2-96  No

=
Figure 9-2: MAC Table Information

Parameter descriptions:

Show x entries: At the dropdown, select how many lines to display per page (10, 25, 60, 100, or 500).

Type: Indicates whether the entry is a Static or a Dynamic entry, 802.1x, DMS.

VLAN: The VLAN ID of the entry.

MAC address: The MAC address of the entry.

Block: Whether the mac address is blocked or not.

Port Members: The ports that are members of the entry.

Auto-refresh Refresh || Clear |

Buttons

Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page. immediately

Clear: Click to clear the page.

Previous: Updates the system log entries, turn to the previous page.

Next: Updates the system log entries, turn to the next page.

@ NOTE: 00-40-C7-73-01-29 : your switch MAC address (for IPv4)

33-33-00-00-00-01 : Destination MAC (for IPv6 Router Advertisement) (reference IPv6 RA.JPG)
33-33-00-00-00-02 : Destination MAC (for IPv6 Router Solicitation) (reference IPv6 RS.JPG)
33-33-FF-73-01-29 : Destination MAC (for IPv6 Neighbor Solicitation) (reference IPv6 DAD.JPG)
33-33-FF-A8-01-01: your switch MAC address (for IPv6 global IP)

FF-FF-FF-FF-FF-FF: for Broadcast.
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» 1GMP Snooping <
10-1 IGMP Snooping R .
IGMP Snooping is used to establish the multicast groups to forward the multicast packet » Multicast Filtering Profile <
to the member ports, and, in nature, avoids wasting the bandwidth while IP multicast packets are running

over the network. This is because a switch that does not support IGMP or IGMP Snooping cannot tell a
multicast packet from a broadcast packet, so it can only treat them all as a broadcast packet. Without

IGMP Snooping, a multicast packet forwarding function is plain and nothing is different from a broadcast
packet.

The switch supports IGMP Snooping functions of query, report and leave, a type of packet exchanged
between IP Multicast Router/Switch and IP Multicast Host, can update the information of the Multicast
table when a member (port) joins or leaves an IP Multicast Destination Address. With this function, once a
switch receives an IP multicast packet, it will forward the packet to the members who joined in a specified
IP multicast group before.

The packets will be discarded by the IGMP Snooping if the user transmits multicast packets to the
multicast group that had not been built up in advance. IGMP mode enables the switch to issue IGMP
function that you enable IGMP proxy or snooping on the switch, which connects to a router closer to the
root of the tree. This interface is the upstream interface. The router on the upstream interface should be
running IGMP.

10-1.1 Basic Configuration

This webpage lets you set the basic IGMP snooping on the switch, which connects to a router closer to the
root of the tree. This interface is the upstream interface. The router on the upstream interface should be
running IGMP.

Web Interface
To configure the IGMP Snooping parameters in the web interface:

Click Multicast, IGMP Snooping, and Basic Configuration.

Enable or disable which Global configuration.

Select the port you want to become a Router Port or enable/ disable the Fast Leave function.
Scroll to set the Throttling and Profile.

Click the Apply button to save the setting.

o v A w N

To cancel the setting, click the Reset button to revert to previously saved values.
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= ——
TRANSITION © = | . ® ®
N NE WORKS -
SM16TAT2SA IGMP Snooping Configuration @ Home - Multicast - IGMP Snooping - Basic Configuration
Switch DMS
Global Configuration
» System ¢
» Port Management < Snooping Enabled ﬁl
» PoE Management <

Unregistered IPMCv4 Flooding

v
» VLAN Management « Enabled
» Quality of Service < IGMP SSM Range 232.0.0.0
» Spanning Tree <
Proxy Enabled ]
» MAC Address Table «
b Nuirzmst Port Related Configuration
#» IGMP Snooping w
Port Router Port Fast Leave Throttling Profile
> Vlan Configuration — —
1 O ] unlimited v
> Status
> Group Information 2 [w) O 4 v
> IGMP SFM Information - o
3 vl ) 10 v

» ML

100p

» Multicast Filtering Profile < 0 (B unlimited ¥

b MVD < -

Figure 10-1.1: IGMP Snooping Configuration

Parameter descriptions:

Global Configuration
Snooping Enabled: Enable the Global IGMP Snooping.

Unregistered IPMCv4 Flooding enabled: Enable unregistered IPMCv4 traffic flooding. Unregistered
IPMCv4 traffic is also called “unknown multicast”. After selected, the unregistered multicast stream will be
forwarded like normal packets. Once you un-selected it, an unregistered multicast stream will be
discarded.

IGMP SSM Range: SSM (Source-Specific Multicast) Range lets the SSM-aware hosts and routers run the
SSM service model for the groups in the address range. Format: (IP address/ sub mask).

Per IETF RFC 4607, IP version 4 (IPv4) addresses in the 232/8 (232.0.0.0 t0232.255.255.255) range are
designated as source-specific multicast (SSM) destination addresses and are reserved for use by source-
specific applications and protocols. For IP version 6 (IPv6), the address prefix FF3x::/32 is reserved for
source-specific multicast use.

Proxy Enabled: Enable IGMP Proxy. This feature can be used to avoid forwarding unnecessary join and
leave messages to the router side.

Port Related Configuration

Port: It shows the physical Port index of switch.

Router Port: Specify which ports act as router ports. A router port is a port on the Ethernet switch that
leads towards the Layer 3 multicast device or IGMP querier. If an aggregation member port is selected as a
router port, the whole aggregation will act as a router port.

Fast Leave: Enable the fast leave on the port.
Throttling: Enable to limit the number of multicast groups to which a switch port can belong.

Profile: You can select profile when you edit in Multicast Filtering Profile.
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10-1.2 VLAN Configuration

The section describes the VLAN configuration setting process integrated with IGMP Snooping function.
Each page shows up to 99 entries from the VLAN table, default being 20, selected through the "entries per
page" input field. When first visited, the web page will show the first 20 entries from the beginning of the
VLAN Table. The first displayed will be the one with the lowest VLAN ID found in the VLAN Table. The
"VLAN" input fields allow the user to select the starting point in the VLAN Table.

Web Interface
To configure the IGMP Snooping VLAN Configuration in the web interface:
1. Click Multicast, IGMP Snooping, and VLAN Configuration.
2. Click the Add New IGMP VLAN button to add a new row to the table.
3. Click the Apply button to save the setting.
4

To cancel the setting, click the Reset button to revert to previously saved values.

i ——
TRANSITION =| e »’
N NETWO = - Hec

SM16TAT2SA IGMP Snooping Vlan Configuration Srome - Matcest - IGHP Snaoping - Vien Corfiguraion
Switch DMS
Delete  VIANID  SnoopingEnabled IGMP Querier Compatibility RV Qlfseq) QRI(0.15ec) LLQI(0.1 sec) URI(sec)

> System

> RORErE m] m] oo [¥] | || 2 s 100 JC 1

2 ReElETEEAE [m] [m] oupae [ ||| 2 125 100 10 1

» VLAN Management

O O e 125 100 10 1

» Quality of Service
» Spanning Tree

» MAC Address Table

& A A A A A A A

P Multicast

Figure 10-1.2: IGMP Snooping VLAN Configuration

Parameter descriptions:

Start from Vlan: Click to refresh the displayed table starting from the "VLAN" input fields.

Delete: Check to delete the entry. The designated entry will be deleted during the next save.

VLAN ID: Displays the VLAN ID (VID) of the entry.

Snooping Enabled: Enable the per-VLAN IGMP Snooping. Only up to 32 VLANSs can be selected. .

IGMP Querier: Enable to join IGMP Querier election in the VLAN. Disable to act as an IGMP Non-Querier.

Compatibility: Compatibility is maintained by hosts and routers taking appropriate Compatibility
actions depending on the versions of IGMP operating on hosts and routers within a

network. The allowed selections are IGMP-Auto, Forced IGMPv1, Forced IGMPv2, Forced
IGMPv3. The default is IGMP-Auto. S

Forced IGMPv1
Forced IGMPv2

IGMP v1 is specified in RFC-1112; it was the first widely-deployed version and the first |_forced IGMPv3___|
version to become an Internet Standard.

IGMP v2, specified in RFC-2236, added the ability for a host to signal desire to leave a multicast group.
IGMP v3, specified in RFC 3376, adds support for "source filtering”, that is, the ability for a system to
report interest in receiving packets *only* from specific source addresses, or from *all but* specific source
addresses, sent to a particular multicast address.

Rv: Robustness Variable. The Robustness Variable allows tuning for the expected packet loss on a network.
The allowed range is 1 to 255; default RV value is 2.
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QI(sec): Query Interval. The Query Interval is the interval between General Queries sent by the Querier.
The allowed range is 1 to 31744 seconds; default query interval is 125 seconds.

QRI(0.1 sec): Query Response Interval. The Max Response Time used to calculate the Max Resp Code
inserted into the periodic General Queries. The allowed range is 0 to 31744 in tenths of seconds; default
query response interval is 100 in tenths of seconds (10 seconds).

LLQI (0.1 sec): Last Member Query Interval. The Last Member Query Time is the time value represented
by the Last Member Query Interval, multiplied by the Last Member Query Count.

The allowed range is 0 to 31744 in tenths of seconds; the default last member query interval is 10 in
tenths of seconds (1 second).

URI(sec): Unsolicited Report Interval. The Unsolicited Report Interval is the time between repetitions of a
host's initial report of membership in a group. The allowed range is 0 to 31744 seconds, default
unsolicited report interval is 1 second.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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10-1.3 Status

After you complete the IGMP Snooping configuration, you can view the IGMP Snooping Status. This page
displays the IGMP Snooping detail status.

Web Interface

To display the IGMP Snooping status in the web interface:

1. Click Multicast, IGMP Snooping, and Status.

2. To auto-refresh the information, set “Auto-refresh” to On.

3. Click “Refresh” to refresh the IGMP Snooping Status.

|
TRANSITION © = et - e » ||
N [E WORKS -
SM16TAT2SA IGMP Snooping Status @Home - Multicast - IGMP Snooping -~ Status
Switch DMS —
Auto-refresh ‘ Refresh ‘
b System <
Statistics
» Port Management
» PoE Management < Vi V2 V3 V2 |
b LAY p VLAN Querier Host Querier Queries Queries  Reports Reports Reports Leaves
REICEEIUEL ID Version Version Status Transmitted Received Received Received Received Received
» Quality of Service <
» Spanning Tree ¢ Router Port
» MAC Address Table < |
Port Status
» Multicast e
» IGMP Snooping v 1 |
|
> Basic Configuration 2 Static
> Vlan Configuration i |
3 Static |
> Status
> Group Information 4
A ICMD CEM Infarmatinm - -

Figure 10-1.3: IGMP Snooping Status

Parameter descriptions:

Statistics

VLAN ID: The VLAN ID of the entry.

Querier Version: Working Querier Version currently.
Host Version: Working Host Version currently.

Querier Status: Shows the Querier status is "ACTIVE" or "IDLE". "DISABLE" denotes the specific interface is
administratively disabled.

Queries Transmitted: The number of Transmitted Queries.
Queries Received: The number of Received Queries.

V1 Reports Received: The number of Received V1 Reports.
V2 Reports Received: The number of Received V2 Reports.
V3 Reports Received: The number of Received V3 Reports.

V2 Leaves Received: The number of Received V2 Leaves.
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Router Port: Displays which ports act as router ports. A router port is a port on the Ethernet switch that
leads towards the Layer 3 multicast device or IGMP querier. Static denotes the specific port is configured
to be a router port. Dynamic denotes the specific port is learnt to be a router port. Both denote the
specific port is configured or learnt to be a router port.

Port: Switch port number.

Status: Indicate whether specific port is a router port or not.

Auto-refresh ‘ Refresh ‘

Buttons

Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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10-1.4 Group Information

After you complete setting the IGMP Snooping function, you can view the IGMP Snooping Group
Information. Entries in the IGMP Group Table are shown on this page. The IGMP Group Table is sorted first
by VLAN ID, and then by group. When the end is reached the text "No more entries" is shown in the
displayed table.

Group Member Behavior: in order to be compatible with older version routers, IGMPv3 hosts must
operate in version 1 and version 2 compatibility modes. IGMPv3 hosts MUST keep state per local interface
regarding the compatibility mode of each attached network. A host's compatibility mode is determined
from the Host Compatibility Mode variable which can be in one of three states: IGMPv1, IGMPv2 or
IGMPv3. This variable is kept per interface and depends on the version of General Queries heard on that
interface as well as the older querier present timers for the interface.

Web Interface

To display the IGMP Snooping Group Information in the web interface:
Click Multicast, IGMP Snooping, and Groups Information.

2. Specify how many entries to show in one page.
3. To auto-refresh the information click the “Auto-refresh” button.
4. Click "Refresh” to refresh an entry of the IGMP Snooping Groups Information.
5. Click Previous or Next to change pages.
—— — .
JRANSITION™ = = 5 5555 - Hoeo
SM16TAT2SA IGMP Snooping Groups Information @¥Home - Multicast - 1GMP Snooping - Groups Infarmation
Switch DMS Atorerech ﬂ |T
P System & E—
» Port Management < Show | v entries Search:
b PoE Management < Port Members

-

VLA B E AT VLANID® Group 1 2 3 4 5 6 T & 8 10 11 12 13 14 15 16 17 18

» Quality of Service <

Mo data available in table
» Spanning Tree &
» MAC Address Table <

» Multicast

Figure 10-1.4: IGMP Snooping Groups Information

Parameter descriptions:
Navigating the IGMP Group Table

Each page shows up to 99 entries from the IGMP Group table, default being 20, selected through the
"entries per page" input field. When first visited, the web page shows the first 20 entries from the
beginning of the IGMP Group Table. The "Start from VLAN", and "group" input fields let you select the
starting point in the IGMP Group Table.

Search: You can search for the information that you want to see.

Show entries: You can choose how many items you want to view.
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VLAN ID: VLAN ID of the group.
Groups: Group address of the group displayed.

Port Members: Ports under this group.

Buttons Auto-refresh ‘ Refresh ‘

Auto-refresh : Check this box to refresh the page automatically every
3 seconds.

Refresh : Click to manually refresh the page immediately.
Next : Updates the system log entries, turn to the next page.

Previous : Updates the system log entries, turn to the previous page.
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10-1.5 IGMP SFM Information

Entries in the IGMP SFM Information Table are shown on this page. The IGMP SFM (Source-Filtered
Multicast) Information Table also contains the SSM (Source-Specific Multicast) information. This table is
sorted first by VLAN ID, then by group, and then by Port. Different source addresses belong to the same
group are treated as single entry.

Web Interface

To display the IGMP SFM Information in the web interface:

1. Click Multicast, IGMP Snooping, and IGMP SFM Information.

2. To auto-refresh the information select “Auto-refresh”.

3. Click “Refresh” to refresh an entry of the IGMP Snooping Groups Information.
4

Click Previous/Next to change page.

TRANSITION * =/ wwenm H oo
e NETWORKS
SM16TAT25A IGMP SFM Information @Home - Multicast - IGMP Snooping - IGMP SFM Information
Switch DMS
Auto-refresh | Refresh

» System <
» Port Management < Show| o ¥ entries Search:
» PoE Management ¢ VLAN ID * Group Port Mode Source Address Type

-

LA B EFE T No data available in table

¥ Quality of Service <
» Spanning Tree <
» MAC Address Table &

» Multicast
» |GMP Snooping ~ -

Figure 10-1.5: IGMP SFM Information
Navigating the IGMP SFM Information Table

Each page shows up to 99 entries from the IGMP SFM Information table, default being 20, selected
through the "entries per page" input field. When first visited, the web page will show the first 20 entries
from the beginning of the IGMP SFM Information Table.

The "Start from VLAN", and "group” input fields allow the user to select the starting point in the IGMP SFM
Information Table. Clicking the Next button will update the displayed table starting from that or the
closest next IGMP SFM Information Table match. In addition, the two input fields will - upon a Previous
button click - assume the value of the first displayed entry, allowing for continuous refresh with the same
start address.

Parameter descriptions:

Search : You can search for the information that you want to see.

Show entries : You can choose how many items you want to show.

VLAN ID : VLAN ID of the group.

Group : Group address of the group displayed.

Port : Switch port number.

Mode : Indicates the filtering mode maintained per (VLAN ID, port number, Group Address) basis. It can

be either Include or Exclude.
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Source Address : IP Address of the source. Currently, system limits the total number of IP source
addresses for filtering to be 128.

Type : Indicates the Type. It can be either Allow or Deny.

Buttons Auto-refresh ‘ Refresh |

Auto-refresh : Check this box to refresh the page automatically every 3 seconds.
Refresh : Click to manually refresh the page immediately.
Previous : Updates the system log entries, turn to the previous page.

Next : Updates the system log entries, turn to the next page.
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10-2 MLD Snooping

Curiously enough, a network node that acts as a source of IPv6 multicast traffic is only an indirect
participant in MLD snooping - it just provides multicast traffic, and MLD doesn't interact with it. (Note,
however, that in an application like desktop conferencing a network node may act as both a source and an
MLD host; but MLD interacts with that node only in its role as an MLD host.)

A source node creates multicast traffic by sending packets to a multicast address. In IPv6, addresses with
the first eight bits set (that is, “FF” as the first two characters of the address) are multicast addresses, and
any node that listens to such an address will receive the traffic sent to that address. Application software
running on the source and destination systems cooperates to determine what multicast address to use.
(Note that this is a function of the application software, not of MLD.)

When MLD snooping is enabled on a VLAN, the switch acts to minimize unnecessary multicast traffic. If
the switch receives multicast traffic destined for a given multicast address, it forwards that traffic only to
ports on the VLAN that have MLD hosts for that address. It drops that traffic for ports on the VLAN that
have no MLD hosts.

MLD snooping enablad
Listener
(MLD hiost)
] L
— L[ — [ ]
[ =

|:| _ Switch

Source \
= A

[ |:| Listener
[ | (MLD host)

Figure 10-2: MLD Snooping enabled
10-2.1 Basic Configuration

This section let you configure the MLD Snooping basic configuration and the parameters.
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Web Interface

To configure the MLD Snooping Configuration in the web interface:

Click Multicast, MLD Snooping, and Basic Configuration.

Select “on” to enable Snooping globally and configure the parameters.
Select the port to join Router Port and Fast Leave.

Scroll to the Throttling mode dropdown and select unlimited or 1 to 10.
Click the Apply button to save the settings.

A T B

To cancel the settings, click the Reset button to revert to previously saved values.
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Figure 10-2.1: MLD Snooping Basic Configuration
Parameter descriptions:

Global Configuration
Snooping Enabled: Enable the Global MLD Snooping.

Unregistered IPMCv6 Flooding Enabled: Enable unregistered IPMCv6 traffic flooding.
Flooding control takes effect only when MLD Snooping is enabled. When MLD Snooping is disabled, then
unregistered IPMCv6 traffic flooding is always active in spite of this setting.

MLD SSM Range: SSM (Source-Specific Multicast) Range allows the SSM-aware hosts and routers run the
SSM service model for the groups in the address (using IPv6 Address) range.

Proxy Enabled: Enable MLD Proxy. This feature can be used to avoid forwarding unnecessary join and
leave messages to the router side.
Port Related Configuration

Router Port: Specify which ports act as router ports. A router port is a port on the Ethernet switch that
leads towards the Layer 3 multicast device or MLD querier. If an aggregation member port is selected as a
router port, the whole aggregation will act as a router port.
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Fast Leave: Check the box to enable Fast Leave on the port.
Throttling: Enable to limit the number of multicast groups to which a switch port can belong.

Profile: You can select profile when you edit in Multicast Filtering Profile.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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10-2.2 VLAN Configuration

When MLD snooping is enabled on a VLAN, the switch acts to minimize unnecessary multicast traffic. If
the switch receives multicast traffic destined for a given multicast address, it forwards that traffic only to
ports on the VLAN that have MLD hosts for that address. It drops that traffic for ports on the VLAN that
have no MLD hosts

Web Interface

To configure the MLD Snooping VLAN Configuration in the web interface:

1. Click Multicast, MLD Snooping and VLAN Configuration.
2. Click Add New MLD VLAN.

3. Specify the VLAN ID with entries per page.
SM16TAT2SA MLD Snooping Vlan Configuration rme - ukiam - M0 Srssing - Vi Cntigwton
Switch DMS
Start from Vlan with

» System <
» Port Management < VLAN  Snooping MLD LLQI{0.1
» PoE Management < Delete ID Enabled Querier  Compatibility RV Ql{sec) QRI{0.15ec) sec) URI{sec)
» VLAN Management < | Delete | O O 2 125 100 10 1
» Quality of Service <
» Spanning Tree & | Add New MLD VLAN |
» MAC Address Table < | oo |
» Multicast

» IGMP Snooping <

» MLD Snooping hd

Figure 10-2.2: MLD Snooping VLAN Configuration

Parameter descriptions:

Delete: Check to delete the entry. The designated entry will be deleted during the next save.

VLAN ID: It displays the VLAN ID of the entry.

Snooping Enabled: Enable the per-VLAN IGMP Snooping. Up to 32 VLANs can be selected.

MLD Querier: Enable to join IGMP Querier election in the VLAN. Disable to act as an IGMP Non-Querier.

Compatibility: Compatibility is maintained by hosts and routers taking appropriate actions
depending on the versions of IGMP operating on hosts and routers within a network. The
allowed selections are MLD-Auto, Forced MLD v1, Forced MLD v2. The default

compatibility value is MLD-Auto. Dvl

Forced MLDv2

Compatibility

RV: Robustness Variable. The Robustness Variable allows tuning for the expected packet
loss on a network. The allowed range is 1 to 255; the default robustness variable value is 2.

QI(sec): Query Interval. The Query Interval is the interval between General Queries sent by the Querier.
The allowed range is 1 to 31744 seconds; the default query interval is 125 seconds.

QRI(0.1sec): Query Response Interval. The Max Response Time used to calculate the Max Resp Code
inserted into the periodic General Queries. The allowed range is 0 to 31744 in tenths of seconds; default
query response interval is 100 in tenths of seconds (10 seconds).
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LLQI (LMQI for IGMP): Last Member Query Interval. The Last Member Query Time is the time value
represented by the Last Member Query Interval, multiplied by the Last Member Query Count. The allowed
range is 0 to 31744 in tenths of seconds; default last member query interval is 10 in tenths of seconds (1
second).

URI(sec): Unsolicited Report Interval. The Unsolicited Report Interval is the time between repetitions of a
host's initial report of membership in a group. The allowed range is 0 to 31744 seconds, default
unsolicited report interval is 1 second.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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10-2.3 Status

The section describes when you complete the MLD Snooping and how to display the MLD Snooping
Status and detail information. It will help you to find out the detail information of MLD Snooping status.

Web Interface

To display the MLD Snooping Status in the web interface:

1. Click Multicast, MLD Snooping, and Status.

2. To automatically refresh the information select “on” at "Auto-refresh”.

3. Click "Refresh” to refresh an entry of the MLD Snooping Status Information.

.-ﬁ o .
TRANSITION ° =| H 0 cC
e NETWORKS
SM16TAT2SA MLD Snooping Status @Home ~ Multicast - MLD Snooping - Status
Switch DMS —
Auto-refresh | Refresh
» System <
» Port Management < plalislcs
» PoE Management ( VLAN Querier Host Querier Queries Queries V1 Reports V2 Reports V1 Leaves
» VLAN Management ¢ 1D Version Version  Status Transmitted Received Received Received Received
» Quality of Service 4
Router Port
» Spanning Tree <
» MAC Address Table < Port Status
» Multicast b 1
# IGMP Snooping <
2
# MLD Snooping

w

Figure 10-2.3: MLD Snooping Status

Parameter descriptions:

VLAN ID: The VLAN ID of the entry.

Querier Version: Working Querier Version currently.
Host Version: Working Host Version currently.

Querier Status : Show the Querier status is "ACTIVE" or "IDLE". "DISABLE" denotes the specific interface is
administratively disabled.

Queries Transmitted: The number of Transmitted Queries.
Queries Received: The number of Received Queries.

V1 Reports Received: The number of Received V1 Reports.
V2 Reports Received: The number of Received V2 Reports.

V1 Leaves Received: The number of Received V1 Leaves.
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Router Port: Display which ports act as router ports. A router port is a port on the Ethernet switch that
leads towards the Layer 3 multicast device or MLD querier.

Static denotes the specific port is configured to be a router port.
Dynamic denotes the specific port is learnt to be a router port.
Both denote the specific port is configured or learnt to be a router port.

Port: Switch port number.

Status: Indicate whether specific port is a router port or not.

Buttons Auto-refresh | Refresh |

Auto-refresh: Check to on to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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10-2.4 Groups Information

The section describes user could set the MLD Snooping Groups Information. The "Start from VLAN", and
"group"” input fields allow the user to select the starting point in the MLD Group Table.

Web Interface

To display the MLD Snooping Group information in the web interface:
1. Click Multicast, MLD Snooping, and Group Information.

2. To auto-refresh the information select “on” at "Auto-refresh”.

3. Click “Refresh” to refresh an entry of the MLD Snooping Group Information.

.—ﬁ Ry s
TRANSITION " =| Zem H 0 cC
VNETWOPKS

SMI1ETAT2SA MLD Snooping Groups Information @Home - Multicast = MLD Snooping - Groups Informztion
Switch DMS —
Auto-refresh | Refresh

} System &
» Port Management < Show | 1 ¥ entries Search:
» PoE Management < Port Members

/LAN Manage <
b UL R TE VLANID * Group 1 2 3 4 5 6 7 8 8 10 11 12 13 14 15 16 17 18
» Quality of Service <

No data available in table

» Spanning Tree <
» MAC Address Table <
¥ Multicast "

» IGMP Snooping <

» MLD Snooping ~ 52

Figure 10-2.4: MLD Snooping Groups Information

Navigating the MLD Group Table: Each page shows up to 99 entries from the MLD Group table, default
being 20, selected through the "entries per page" input field. When first visited, the web page will show the
first 20 entries from the beginning of the MLD Group Table.

Parameter descriptions:

VLAN ID: VLAN ID of the group.

Groups: Group address of the group displayed.

Port Members: Ports under this group.

Show entries: Choose how many items you want to view per page.

Buttons Auto-refresh \ Refresh ‘

Auto-refresh: Check to refresh the page automatically every 3
seconds.

Refresh: Click to manually refresh the page immediately.
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10-2.5 MLD SFM Information

Entries in the MLD SFM Information Table are shown on this page. The MLD SFM (Source-Filtered
Multicast) Information Table also contains the SSM (Source-Specific Multicast) information. This table is
sorted first by VLAN ID, then by group, and then by Port.

Different source addresses belong to the same group are treated as single entry.

Web Interface
To display the MLD SFM Information in the web interface:

1. Click Multicast, MLD Snooping, and MLD SFM Information.
2. To auto-refresh the information click Auto-refresh “On".
3. Click “Refresh” to refresh an entry of the MLD SFM Information.

\ cImnn 1
TRANSITION * = | Imusmer a4 - H 0 ¢
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SM16TAT25A MLD SFM Information @hHome - Multicast - MLD Snooping - MLD SFM Information
Switch DMS
Auto-refresh | Refresh
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e T e < Show| = v entries Search:
ag|
b PoEManagement ¢ VLAN ID * Group Port Mode Source Address Type
/LAN Manage <
D LA e No data available in table
» Quality of Service &
» Spanning Tree <
¥ MAC Address Table &
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Figure 10-2.5: MLD SFM Information

Parameter descriptions:

VLAN ID: VLAN ID of the group.

Group: Group address of the group displayed.
Port: Switch port number.

Mode: Indicates the filtering mode maintained per (VLAN ID, port number, Group Address) basis.
It can be either Include or Exclude.

Source Address: The IP Address of the source. Currently, the system limits the total number of IP source
addresses for filtering to be 128.

Type: Indicates the Type. It can be either Allow or Deny.

Show entries: You can choose how many items you want to display.

Buttons Auto-refresh ‘ Refresh ‘

Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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10.3 Multicast Filtering Profile

ICMP (Internet Control Message Protocol) generates error response, diagnostic, or routing messages.
ICMP messages generally contain information about routing difficulties or simple exchanges such as
time-stamp or echo transactions.

IGMP Snooping is used to establish the multicast groups to forward the multicast packet to the member
ports. It avoids wasting the bandwidth when IP multicast packets are running over the network.

A switch that does not support IGMP or IGMP Snooping cannot tell the multicast packet from the
broadcast packet, so it can only treat them all as broadcast packets. Without IGMP Snooping, the
multicast packet forwarding function is inactive and all packets are treated as broadcast packets.

A switch that supports IGMP Snooping can query, report, and leave a packet exchanged between an IP
Multicast Router/Switch and an IP Multicast Host, and can update the information of the Multicast table
when a member (port) joins or leaves an IP Multicast Destination Address. With this function, once a
switch receives an IP multicast packet, it will forward the packet to the members who joined in a specified
IP multicast group previously.

The packets will be discarded by IGMP Snooping if the user transmits multicast packets to the multicast
group that was not built up in advance. IGMP mode enables the switch to issue IGMP function that you
enable IGMP proxy or snooping on the switch, which connects to a router closer to the root of the tree.
This interface is the upstream interface. The router on the upstream interface should be running IGMP.

10.3-1 Switch > Multicast > Multicast Filtering Profile > Filtering Profile Table

The IPMC profile is used to deploy the access control on IP multicast streams. You can create a
maximum of 64 Profiles and a maximum 128 corresponding rules for each at the Multicast Filtering Profile
Configuration table.

TRANSITION * =| Zwsmd s - 0 C
Na NETWORKS: r
SM16TAT2SA Multicast Filtering Profile Configuration @@Homs - Multicast - Multicast Fitering Profile - Filtering Profile Tasle
Switch DMS
Multicast Filtering Profile Mode Dizabled ¥
» System <
» Port Management < o . .
Filtering Profile Table Setting
» PoE Management “
» VLAN Manasement < Delete Profile Name Profile Description Rule
» Quality of Service <
| A ew Profile |
» Spanning Tree <
» MAC Address Table < | ApPly H Reset |

Click the Add New Profile button to display the configurable parameters.
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Switch DMS
Multicast Filtering Profile Mode Enabled [¥]

b System

b Port Management . .
Filtering Profile Table Setting

» PoE Management &

P VLAN Management < Delete Profile Name Profile Description Rule

» Quality of Service < | Delete | | |
» Spanning Tree &

» MAC Address Table

P Multicast

» IGMP Snooping

Parameter descriptions:

Multicast Filtering Profile Mode: Enable/Disable the Global IPMC Profile. The system starts to do
filtering based on profile settings only when the global profile mode is enabled. Select to Disable or
Enable globally. The default is Disabled.

Filtering Profile Table Setting

Delete: Click to delete the entry. The designated entry will be deleted during the next apply.

Profile Name: The name used for indexing the profile table. Each entry has the unique name which is
composed of at maximum 16 alphabetic and numeric characters. Enter a name for the new IPMC profile.
Avoid spaces between characters.

Profile Description: Enter a description of the new IPMC profile. Additional description, which is
composed of at maximum 64 alphabetic and numeric characters, about the profile. No blank or space
characters are permitted as part of description. Use "_" or "-" to separate the description sentence.

Rule: When the profile is created, click the edit button to enter the rule setting page of the designated
profile. Summary about the designated profile will be shown by clicking the view button. You can manage
or inspect the rules of the designated profile by using these buttons:

o List the rules associated with the designated profile.
o Adjust the rules associated with the designated profile.

Enter the parameters and click the Apply button, then click the Edit button, then click the Add Last Rule
button to display the MC Filtering Profile Rule Configuration Rule Settings table (In Precedence Order).

Buttons:

Add New Profile: Click to add new profile. Specify the name and configure the new entry.
Delete: Check to delete the entry. The designated entry will be deleted during the next save.
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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After you add a new profile and click Apply, the Multicast Filtering Profile Configuration page displays:
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At the Multicast Filtering Profile [4] Rule Settings page click the Edit button in the Rule column of the table
to display the Multicast Filtering Profile Rule Configuration table:
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The IPMC profile is used to deploy the access control on IP multicast streams. It is allowed to create at
maximum 64 Profiles with at maximum 128 corresponding rules for each.

Parameter descriptions:

Profile Name: The name of the designated profile to be associated. This field is not editable.

Entry Name: The name used in specifying the address range used for this rule. Only the existing profile
address entries will be chosen in the selected box. This field is not allowed to be selected as none ("-")
while the Rule Settings Table is committed.

Address Range: The corresponding address range of the selected profile entry. This field is not editable
and will be adjusted automatically according to the selected profile entry.

Action: Select the learning action upon receiving the Join/Report frame that has the group address
matches the address range of the rule.

Permit. Group address matches the range specified in the rule will be learned.
Deny: Group address matches the range specified in the rule will be dropped.
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Log: Select the logging preference upon receiving the Join/Report frame that has the group address
matches the address range of the rule.

Enable: Corresponding information of the group address, that matches the range specified in the
rule, will be logged.

Disable: Corresponding information of the group address, that matches the range specified in the
rule, will not be logged.

Buttons

Add Last Rule: Click to add a new rule in the end of the specific profile's rule list. Specify the address
entry and configure the new entry. Click "Apply".

Delete: Check to delete the entry. The designated entry will be deleted during the next save.
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Back to Filtering Profile Table: Click to return to previous page with no changes.

33717 Rev.D https://www.transition.com Page 141 of 284



https://www.transition.com/

Transition Networks SMXTAT2SA Web User Guide
10.3-1 Switch > Multicast > Multicast Filtering Profile > Filtering Address Entry

This page provides address range settings used in Multicast Filtering profile. The address entry is used to
specify the address range that will be associated with Multicast Filtering Profile. You can create up to 128
address entries in the system.

TRANSITION © =| wsu se H oG
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-

Spanning Tree
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¥ Multicast

Multicast Filtering Profile Table Setting parameters:

Delete: Click to delete the entry. The designated entry will be deleted during the next apply.

Entry Name: The name used for indexing the address entry table.
Each entry has the unique name which is composed of at maximum 16 alphabetic and numeric
characters.

Start Address: The starting IPv4/IPv6 Multicast Group Address that will be used as an address range.
End Address: The ending IPv4/IPv6 Multicast Group Address that will be used as an address range.

Buttons

Add New Address (Range) Entry: Click to add a new address range. Specify the name and configure
the addresses. Click "Apply".

Delete: Check to delete the entry. The designated entry will be deleted during the next save.
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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10.4 MVR PR

> Basic Configuration
Multi VLAN Registration allows switches to automatically discover some of the VLAN > EElrs
information that would otherwise need to be manually configured. The MVR feature > Group Information
enables multicast traffic forwarding on the Multicast VLAN. In a multicast television > MVRSFM Information

application, a PC or a television with a set-top box can receive the multicast stream.

Multiple set-top boxes or PCs can be connected to one subscriber port, which is a switch port configured
as an MVR receiver port. When a subscriber selects a channel, the set-top box or PC sends an IGMP join
message to Switch A to join the appropriate multicast. Uplink ports that send and receive multicast data to
and from the multicast VLAN are called MVR source ports.

10.4-1 Switch > MVR > Basic Configuration:

— SITION
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» MAC Address Table <
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: . Role B 0 B 0O O 0D 0D 0D OO oOoDonDoDonn
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MVR “ Add MVR VLAN |
Immediate Leave Setting
EQUURE ennclcups Port Immediate Leave
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; o 1 [l
» Multicast Filtering Profile <
» DHCP < |2 ]
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n ez ) < —
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5 [w]
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Parameter descriptions:

Global Setting

MVR Mode: Select on or off. The default is off. Enable/Disable the Global MVR. The Unregistered
Flooding control depends on the current configuration in IGMP/MLD Snooping. It is suggested to enable
Unregistered Flooding control when the MVR group table is full.

VLAN Interface Setting (Role [l:Inactive / S:Source / R:Receiver])

MVR VID: Enter the new VLAN ID for this new MVR VLAN. Caution: MVR source ports are not
recommended to be overlapped with management VLAN ports.

MVR Name: Enter a name for this new MVR VLAN. MVR Name is an optional attribute to indicate the
name of the specific MVR VLAN. Maximum length of the MVR VLAN Name string is 32. MVR VLAN
Name can only contain alphabets or numbers. MVR VLAN name can be edited for the existing MVR
VLAN entries or it can be added to the new entries.
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IGMP Address: e.g., 192.168.1.40. Define the IPv4 address as source address used in IP header for
IGMP control frames. The default IGMP address is not set (0.0.0.0). When the IGMP address is not set,
system uses IPv4 management address of the IP interface associated with this VLAN. When the IPv4
management address is not set, system uses the first available IPv4 management address. Otherwise,
system uses a pre-defined value. By default, this value will be 192.0.2.1.

Mode: At the dropdown select Dynamic or Compatible. The default is Dynamic. Specify the MVR mode
of operation. In Dynamic mode, MVR allows dynamic MVR membership reports on source ports. In
Compatible mode, MVR membership reports are forbidden on source ports. The default is Dynamic
mode.

Tagging: At the dropdown select Tagged or Untagged. The default is Tagged. Specify whether the
traversed IGMP/MLD control frames will be sent as Untagged or Tagged with MVR VID.

Priority: Enter O - 7. Specify how the traversed IGMP/MLD control frames will be sent in prioritized
manner. The default Priority is 0.

LLQI: Define the maximum time to wait for IGMP/MLD report memberships on a receiver port before
removing the port from multicast group membership. The value is in units of tenths of a seconds. The
range is 0 - 31744. The default LLQI is 5 tenths or one-half second.

Interface Channel Profile: At the dropdown select an existing Profile name. When the MVR VLAN is
created, select the profile to expand the corresponding multicast channel settings for the specific MVR
VLAN. The file established on Filtering Profile Table.

Port: The logical port for the settings.

Port Role: For each port choose a Role; each click displays the next role (I = Inactive, S = Source role,
and R = Receiver role). Configure an MVR port of the designated MVR VLAN as one of the following
roles.

Inactive: The designated port does not participate MVR operations.

Source: Configure uplink ports that receive and send multicast data as source ports. Subscribers
cannot be directly connected to source ports.

Receiver. Configure a port as a receiver port if it is a subscriber port and should only receive
multicast data. It does not receive data unless it becomes a member of the multicast group by
issuing IGMP/MLD messages.

Caution: MVR source ports are not recommended to be overlapped with management VLAN ports.
Select the port role by clicking the Role symbol to switch the setting. | indicates Inactive; S indicates
Source; R indicates Receiver. The default Role is Inactive.

Immediate Leave Setting

Port: The logical port for the settings.

Immediate Leave: Enable the fast leave on the port.

Buttons

Add New MVR VLAN: Click to add a new MVR VLAN entry to the table. Specify MVR VID, MVR Name,
IGMP Address, Mode, Tagging, Priority, LLQI, Interface Channel Profile. Click "Apply".

Delete: Check to delete the entry. The designated entry will be deleted during the next save.

Apply: Click to save changes.
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10.4-2 Switch > MVR > Statistics

The section describes the MVR detail Statistics that display after you have configured MVR on the switch.
It provides the detail MVR Statistics Information.
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MVR Statistics parameters:

VLAN ID: Displays the Multicast VID (VLAN ID).

IGMP/MLD Queries Received: The number of Received Queries for IGMP and MLD, respectively (e.g.,
xly).

IGMP/MLD Queries Transmitted: The number of Transmitted Queries for IGMP and MLD, respectively
(e.g., x1y).

IGMPv1 Joins Received: The number of Received IGMPv1 Joins (e.g., 1 Join received).

IGMPv2/MLDv1 Reports Received: The number of Received IGMPv2 Join's and MLDv1 Reports,
respectively (e.g., x/y).

IGMPv3/MLDv2 Reports Received: The number of Received IGMPv3 Join's and MLDv2 Report's,
respectively.(e.g., x/y).

IGMPv2/MLDv1 Leaves Received: The number of Received IGMPv2 Leave's and MLDv1 Dones,
respectively (e.g., x/y).

Buttons

Auto-Refresh: Check this box to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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10.4-3 Switch > MVR > Group Information

The section describes how to display the MVR Groups detail information on the switch. Entries in the
MVR Group Table are shown on this page. The MVR Group Table is sorted first by VLAN ID, and then by

group.
Navigating the MVR Channels (Groups) Information Table

Each page shows entries from the MVR Group table, default being 10, selected through the "entries per
page" input field. When first visited, the web page will show the first 10 entries from the beginning of the
MVR Channels (Groups) Information Table.

The "Search" input fields let you select the starting point in the MVR Channels (Groups) Information
Table. It will update the displayed table starting from that or the closest next MVR Channels (Groups)
Information Table match.

SM16TAT25A MVR Groups Information @Home - Multicest - MVR - MR Chennel Graups
Switch DMS —
Auto-refresh | Refresh |
» System .

» Port Management Show | 10 [v] entries Search:

» PoE Management Port Members

D SR P L VLANID “ Group 12 3 4°'5 6°7:°8°9 10 ‘1 12 °1 14 ‘15 16 - 17T ' 18

Mo data available in table
} Spanning Tree

» MAC Address Table

» Multicast

<

<

<

<

» Quality of Service <
<

<

v

» IGMP Snooping <
<

MLD Snooping

MVR Groups parameters:
VLAN ID: Displays the VID (VLAN ID) of the group.
Group: Displays the Group ID of the group displayed.

Port Members: Indicates which ports are members (the Ports under this group).

Buttons

Show entries: You can choose how many items you want to show up.
Search: You can search for the information that you want to see.
Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.

Previous: Updates the system log entries, turn to the previous page.

Next: Updates the system log entries, turn to the next page.
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10.4-4 Switch > MVR > SFM Information

The MVR SFM (Source-Filtered Multicast) Information Table also contains the SSM (Source-Specific
Multicast) information. This table is sorted first by VLAN ID, then by group, and then by Port. Different
source addresses belong to the same group are treated as single entry.

Navigating the MVR SFM Information Table

Each page shows up to many entries from the MVR SFM Information table, default being 10, selected
through the "entries per page" input field. When first visited, the web page will show the first 10 entries
from the beginning of the MVR SFM Information Table.

The "Search" input fields lets you select the starting point in the MVR SFM Information Table. It will
update the displayed table starting from that or the closest next MVR SFM Information Table match.

TRANSIT

— T

IC:;:'.‘.NF‘ 3 ” H e &

SM16TAT2SA MVR SFM Information #bHome - Multicast - MVR - MVR SFM Information.

Switch DMS
Auto-refresh | Refresh |

» System

b Port Management Show 1 [v] |entries Search:
b PoE Management VLAN ID * Group Port Mode Source Address Type Hardware Filter/Switch
2 LR PERE R No data available in table
» Quality of Service
» Spanning Tree

» MAC Address Table
P Multicast

» IGMP Snooping

A A ¢ A A A A A A A

» MLD Snooping
b

MVR SFM parameters:

VLAN ID: Displays the VID (VLAN ID) of the group.
Group: Displays the Group address of the group displayed.
Port: Indicates which ports are members.

Mode: Displays the filtering mode maintained per (VLAN ID, port number, Group Address) basis. It can be
either Include or Exclude.

Source Address: Displays the IP Address of the source. Currently, system limits the total number of IP
source addresses for filtering to be 128. When there is not any source filtering address, the text "None" is
shown in the Source Address field.

Type: Displays the type (either Allow or Deny).

Hardware Filter/Switch: Indicates whether data plane destined to the specific group address from the
source IPv4/IPv6 address could be handled by chip.

Buttons

Show entries: You can choose how many items you want to show up.
Search: You can search for the information that you want to see.
Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.

Previous: Updates the system log entries, turn to the previous page.

Next: Updates the system log entries, turn to the next page.
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Chapter 11 - DHCP

This chapter describes how to configure and display the DHCP Snooping parameters of
the switch.

11-1 Snooping > Configuration
» Snooping Table

11-1.1 Configuration - 1'_ o
» Detailed Statistics

DHCP Snooping is used to block intruder on the untrusted ports of the switch device * Relay

when it tries to intervene by injecting a bogus DHCP reply packet to a legitimate

conversation between the DHCP client and server.

> Server
» Server Status
The section describes how to configure the DHCP Snooping parameters of the switch.
DHCP Snooping can prevent attackers from adding their own DHCP servers to the network.
Web Interface
To configure DHCP snooping in the web interface:
1. Click DHCP, Snooping, and Configuration.
2. Select “Enabled” in the Mode of DHCP Snooping Configuration.
3. Select "Trusted” of the specific port in the Mode of Port Mode Configuration.
4. Click Apply.

—
TRANSITION =

I R a H e &

SM16TAT2SA DHCP Snooping Configuration Brom - oHCR  Secoping - Cantrato

Switch DMS
Snooping Mode ﬁ )

b System

» Port Management . i

Port Mode Configuration

» PoE Management

<
<
<
» VLAN Management « part Mode
» Quality of Service R 1 ted [v|
» Spanning Tree <
2 i [v]
» MAC Address Table <
d [w
b Multicast < 3 e [
» MVR < 4 ted [v]
» DHCP e
. 5 ted [
d A 6 rusted  [¥]
noc Tat
Jetaled stat 7 wd 4
8 ted [¥]
9 ted [V

Figure 11-1.1: DHCP Snooping Configuration

Parameter descriptions:
Snooping Mode : Indicates the DHCP snooping mode operation. Possible modes are:

Enabled: Enable DHCP snooping mode operation. When DHCP snooping mode operation is
enabled, the DHCP request messages will be forwarded to trusted ports and only allow reply packets
from trusted ports.

Disabled: Disable DHCP snooping mode operation.

Port Mode Configuration: Indicates the DHCP snooping port mode. Possible port modes are:
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Trusted: Configures the port as trusted source of the DHCP messages.

Untrusted: Configures the port as untrusted source of the DHCP messages.

Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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11-1.2 Snooping Table

This page displays the dynamic IP assigned information after DHCP Snooping mode is disabled. All DHCP
clients obtained the dynamic IP address from the DHCP server will be listed in this table except for local
VLAN interface IP addresses. Entries in the Dynamic DHCP Snooping Table are shown on this page.

Web Interface

To monitor a DHCP in the web interface:

1. Click DHCP, Snooping, and Snooping Table.

TR TRANSITIGN ™
JRANSION = | = ' °c
SM16TAT2SA Dynamic DHCP Snooping Table @ome -+ DHCE - Snoosing - Snoeping Table
Switch DI Auto-refresh ﬁ, | Refresh |
b System g —
b Port Managemant ” Show w0 [v] entries Search:
» PoE Management < MAC Address * VLANID Port IP Address IP Subnet Mask DHCP Server
» VLAN Management < Mo data available in table
» Quality of Service <
» Spanning Tree &
» MAC Address Table &
» Multicast <
» MVR <
» DHCP e
» Snooping
» Configuration
> Snooping Table
» Natailad Statictiee

Figure 11-1.2: Dynamic DHCP Snooping Table

Parameter descriptions:

Show entries: You can choose how many items you want to show.
Search: You can search for the information that you want to see.
MAC Address: User MAC address of the entry.

VLAN ID: VLAN-ID in which the DHCP traffic is permitted.

Port: Switch Port Number for which the entries are displayed.

IP Address : User IP address of the entry.

IP Subnet Mask: User IP subnet mask of the entry.

DHCP Server: DHCP Server address of the entry.

Auto-refresh ‘ Refresh ‘
Buttons =

Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.
Next: Updates the system log entries, turn to the next page.

Previous: Updates the system log entries, turn to the previous page.
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11-1.2 DHCP Detailed Statistics

This page provides statistics for DHCP snooping. Notice that the normal forward per-port TX statistics isn't
increased if the incoming DHCP packet is done by L3 forwarding mechanism. Also, a clear of the statistics
on specific port may not take effect on global statistics since it gathers the different layer overview.

Web Interface

To view detailed DHCP statistics via the web interface:

1. Click DHCP, Snooping, and Detailed Statistics.

T S
TRANSITION = T ] e G
N NETWORKS — G
SM16TAT2SA DHCP Detail Statistics Port 1
Switch DMS ]
Auto-refresh Refresh | Port1 v
» System &
Receive Packets Transmit Packets
» Port Management &
b PoE Management < Rx Discover 0 Tx Discover 0
» VLAN Management < RxOffer 0 Tx Offer 0
b Quality of Service < Rx Request 0 Tx Request 0
» Spanning Tree ¢ Rx Dacline 0 Tx Decline 0
MAC A c <
» MAC Address Table Rx ACK 0 Tx ACK 0
» Multicast €
Roc MAK 0 Tx NAK 4]
» MVR <
Rx Release 0 Tx Release 0
Rx Inform 0 Tx Inform 0
Rx Lease Query 0 Tx Lease Query 0
Rx Lease Unassigned 0 Tx Lease Unassigned 0
» Re . Rx Lease Unknow 0 Tx Lease Unknow 0
> Server Rx Lease Active 0 Tx Lease Active 0
> Sen
= Rx Discarded Checksum Error 0
b Security <
SEETIE Rx Discarded from Untrusted 0
» Access Control &

Figure 11-1.2: Dynamic DHCP Snooping Table

Parameter descriptions:

Rx and Tx Discover: The number of discover (option 53 with value 1) packets received and transmitted.
Rx and Tx Offer: The number of offer (option 53 with value 2) packets received and transmitted.

Rx and Tx Request: The number of request (option 53 with value 3) packets received and transmitted.
Rx and Tx Decline: The number of decline (option 53 with value 4) packets received and transmitted.
Rx and Tx ACK: The number of ACK (option 53 with value 5) packets received and transmitted.

Rx and Tx NAK: The number of NAK (option 53 with value 6) packets received and transmitted.

Rx and Tx Release: The number of release (option 53 with value 7) packets received and transmitted.
Rx and Tx Inform: The number of inform (option 53 with value 8) packets received and transmitted.

Rx and Tx Lease Query: The number of lease query (option 53 with value 10) packets received and
transmitted.

Rx and Tx Lease Unassigned: The number of lease unassigned (option 53 with value 11) packets received
and transmitted.
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Rx and Tx Lease Unknown: The number of lease unknown (option 53 with value 12) packets received and
transmitted.

Rx and Tx Lease Active: The number of lease active (option 53 with value 13) packets received and
transmitted.

Rx Discarded checksum error: The number of discard packet that IP/UDP checksum is error.

Rx Discarded from Untrusted: The number of discarded packets that are coming from untrusted port.

Buttons

Port1 hd
& : Use the Port select box to select the port that you want to display the DHCP Detailed
Statistics.
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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11-1.3 DHCP Relay Configuration

Navigate to the Switch > DHCP > Relay menu path to display the DHCP Relay Configuration table. Here
you can configure the DHCP Relay function.

A DHCP relay agent is used to forward and to transfer DHCP messages between the clients and the server
when they are not in the same subnet domain. It stores the incoming interface IP address in the GIADDR
field of the DHCP packet. The DHCP server can use the value of GIADDR field to determine the assigned
subnet. For such condition, please make sure the switch configuration of VLAN interface IP address and
PVID(Port VLAN ID) correctly.

_..-ﬂ - —
TRANSITION ©  =| & 0 ®
\-, NETWORKS - -
SM16TAT2SA DHCP Relay Configuration @roms - DHCP - Relay
Switch DMS
Relay Mode
» System <
» Port Management ¥ Relay Server pooe
» Pok Management ¥ Relay Information Mode
» VLAN Management <
Relay Information Policy Replace -
» Quality of Service R
» Spanning Tree :

| Apply || Reset |

» MAC Address Table g

» Multicast <
» MVR <
» DHCP ~

*» Snooping

Parameters:

Relay Mode: Select on or off. The default is off. Indicates the DHCP relay mode operation. Possible
modes are:

On: Enable DHCP relay mode operation. When DHCP relay mode operation is enabled, the agent
forwards and transfers DHCP messages between the clients and the server when they are not in the
same subnet domain. And the DHCP broadcast message won't be flooded for security
considerations.

Off: Disable DHCP relay mode operation.
Relay Server: Enter the DHCP Relay server IP address.

Relay Information Mode: Select on or off. The default is off. Indicates the DHCP relay information mode
option operation. The option 82 circuit ID format as "[vlan_id][module_id][port_no]". The first four
characters represent the VLAN ID, the fifth and sixth characters are the module ID (always 0), and the last
two characters are the port number. For example, "00030108" means the DHCP message receive form
VLAN ID 3, switch ID 1, port No 8. And the option 82 remote ID value is equal the switch MAC address.
Possible modes are:

Enabled: Enable DHCP relay information mode operation. When DHCP relay information mode
operation is enabled, the agent inserts specific information (option 82) into a DHCP message when
forwarding to DHCP server and removes it from a DHCP message when transferring to DHCP client.
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It only works when DHCP relay operation mode is enabled.
Disabled: Disable DHCP relay information mode operation.

Relay Information Policy: At the dropdown, select Replace, Keep, or Drop. Indicates the DHCP relay
information mode option operation. The option 82 circuit ID format as "[vlan_id][module_id][port_no]".
The first four characters represent the VLAN ID, the fifth and sixth characters are the module ID(in
standalone device it always equal 0, in stackable device it means switch ID), and the last two characters are
the port number. For example, "00030108" means the DHCP message receive form VLAN ID 3, switch ID 1,
port No 8. And the option 82 remote ID value is equal the switch MAC address.

Possible modes are:

Replace: Replace the original relay information when a DHCP message that already contains it is
received.

Keep: Keep the original relay information when a DHCP message that already contains it is received.

Drop: Drop the package when a DHCP message that already contains relay information is received.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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11-1.3 DHCP Relay Statistics

Navigate to the Switch > DHCP > Relay > Relay Statistics menu path to display the DHCP Relay Statistics
table. This page provides statistics for DHCP relay.

= ——
TRANSITION = || DT & @
SM16TAT25A DHCP Relay Statistics
Switch DMS )
Auto-refresh | Refresh H Cleal ‘
» System <
Server Statistics
» Port Management &
» PoE Management < Transmit to Transmit Receive from Receive Missing Agent Receive Missing Circuit ~ Receive Missing Remote
Server Error Server Option 1D 1D
» VLAN Management <
» Quality of Service < 0 0 0 0 0 0
» Spanning Tree &
Client Statistics
» MAC Address Table &
» Multicast < Transmit to Transmit Receive from Receive Agent Replace Agent Keep Agent Drop Agent
c Client Error Client Option Option Option Option
» MVR
V 0 0 0 0 0 0 0
<

Server Statistics Parameters:

Transmit to Server: The number of packets that are relayed from client to server.

Transmit Error: The number of packets that resulted in error while being relayed from client to server.
Receive from Server: The number of packets received from server.

Receive Missing Agent Option: The number of packets received without agent information options.
Receive Missing Circuit ID: The number of packets received with the Circuit ID option missing.

Receive Missing Remote ID: The number of packets received with the Remote ID option missing.

Client Statistics Parameters:

Transmit to Client: The number of relayed packets from server to client.

Transmit Error: The number of packets that resulted in error while being sent to servers.

Receive from Client: The number of received packets from server.

Receive Agent Option: The number of received packets with relay agent information option.

Replace Agent Option: The number of packets which were replaced with relay agent information option.
Keep Agent Option: The number of packets whose relay agent information was retained.

Drop Agent Option: The number of packets that were dropped which were received with relay agent
information.

Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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11-1.3 DHCP Server

Navigate to the Switch > DHCP > Server menu path to display the DHCP Server Configuration table. Here
you can add and configure new DHCP servers. Click the Add Interface button to start.

This page configures the mode (enable/disable) DHCP server per system and per VLAN, and configures
Start IP and End IP addresses. A DHCP server will allocate these IP addresses to the DHCP client, and
deliver configuration parameters to the DHCP client.

¢ C' | ® 192.168.1.77/dhcpd_intfhtm Qe ®
i Apps [3 Internet Explorercan: B Off

| Usability, Use: [ Personal Dashboard L [3 Cognition Cockpit [ Transition EMS (2) [} CSI-C [ hitp hemet?  [Y hitp--wwww.ciscocom

e ——
TRANSITION ©  =| @™ | ® 0 o
N 14 ORKS - i

SM16TAT2SA DHCP Server Configuration @tome - DHCP - Servar
Switch DMS
Interfaces
» System
Delete VLAN  Mode StartIP End IP Lease time  Subnet mask Default router DNS server

» Port Management
» PoE Management

VLAN Management

Spanning Tree

<
<

<

¢

Quality of Service e
¢

<

Multicast ©
<

»
»

»

» MAC Address Table
»

» MVR

» DHCP v
» Snooping

> Relay

> serve

Parameters:
Delete: Check to delete the entry. It will be deleted during the next save.

VLAN: Enter the VLAN ID (VID) for this instance. Configure the VLAN in which DHCP server is enabled or
disabled. Allowed VLAN are in the range 1 — 4095.

Mode: Indicates the operation mode per VLAN. Possible modes are: Enable: Enable DHCP server per
VLAN. Disable: Disable DHCP server per VLAN. The default is Disabled.

Start IP: Enter the starting IP address for the range. The Start IP must be smaller than or equal to the End
IP.

End IP: Enter the ending IP address for the range.

Lease time: Enter a valid DHCP lease time of the pool.

Subnet mask: Enter the Subnet mask.

Default router: Enter the default router IP address.

DNS server: Enter the destination IP network or host address of this route.

Subnet Mask: Configure subnet mask of the DHCP address.

Buttons

Add Interface: Click the button to create and configure an instance.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

11-1.3 DHCP Server Status
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Navigate to the Switch > DHCP > Server Status menu path to display the current DHCP Server Status.

TRANSITION = [ oo
N NETWORKS = w
SM16TAT2SA DHCP Server Status
Switch DMS —
Auto-refresh Refresh |
» System < -
» Port Management < nteriaces
» PoE Management < VLAN Type StartIP End IP Lease time

-

VLAN Management <

-

Quality of Service <

-

Spanning Tree <

MAC Address Table <

-

» Multicast <

» DHCP e
» Snooping <
» Relay <
> Server
> Server Status

» Soruritu <

Interfaces Parameters:

VLAN: The VLAN ID of the entry.

Type: Indicates the operation type per VLAN. Possible types are: Static and DMS.

Start IP and End IP: Display the Start IP and the End IP.
Lease Time: Displays lease time of the pool.

Subnet Mask: Displays subnet mask of the DHCP address.

Default router: Displays the destination IP network or host address of this route.

DNS Server: Displays DNS server.
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Chapter 12 - Security

» Security
This section lets you configure switch Security settings. You can use the Security features » Management
to restrict input to an interface by limiting and identifying MAC addresses. » |EEE 802.1X
% |P Source Guard
12-1 Management » ARP Inspection
12-1.1 Account » Port Security
This page provides an overview of the current users. By default there is one User (User » RADIUS
Name = admin, Privilege Level = 15). Currently the only way to login as another user on » TACACS+
the web server is to close and reopen the browser.
Web Interface
To configure a new User via the web interface:
Click Security, Management, and Account.
2. Click the Add New User button.
3. Specify the User Name parameters.
4. Click Apply.
_.—-\ I
TRANSITION ® =| owsr T oG
N NETWORKS: . ;i
SM16TAT2SA )E\dd User @Home - Sezcurity - Mznagement - Account
switch ) oms
User Settings
P Syste¥n <
» Port Management < User Name
» PoE Management < Password
» VLAN Management <
Confirm Password
» Quality of Service <
» Spanning Tree < Privilege Level 4
» MAC Address Table <
» Multicast < | Appl ” Rt ” Sance |

Figure 12-1.1: Account Configuration

Parameter descriptions:
User Name: The name identifying the user. This is also a link to Add/Edit User.

Password: Type the password. The allowed string length is 0 to 255, and the allowed content is the ASCII
characters from 32 to 126.

Password (again): Type the password again. You must type the same password again in the field.

Privilege Level: The privilege level of the user. The allowed range is 1 to 15. If the privilege level value is
15, it can access all groups, i.e. that is granted the fully control of the device. But others value must refer to
each group privilege level. User's privilege should be same or greater than the group privilege level to
have the access of that group. By default, most groups are at privilege level 5 and have read-only access
and privilege level 10 has the read-write access. The system maintenance (software upload, factory
defaults and etc.) need user privilege level 15. Generally, the privilege level 15 can be used for an
administrator account, privilege level 10 for a standard user account and privilege level 5 for a guest
account.
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Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

Cancel: Click to undo any changes made locally and return to the Users.

Delete User: Delete the current user. This button is not available for new configurations (Add New User).
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12-1.2 Privilege Level

The Security > Management > Privilege Level menu path displays the Privilege Level Configuration table.
Here you can assign Read-Only or Read-Write privilege levels for each of the major functions. This page
provides an overview of the privilege levels. The switch lets you set Group Name Privilege Levels from 0 to
15.

— ——— .
TRANSITION © | weerer . M -
N NETWORKS = 9 G

SM16TAT25A Privilege Level Configuration @Home > Security > Mansgement > Priviege Level
Switch DMS
Privilege Level
P System <
Group Name Read-Only Read-Write

» Port Management <

» PoE Management & access-mgmt s[4 1[v]

¥ VLAN Management = account 15[7] 15[+]

» Quality of Service <

! acl s [v] K4

» Spanning Tree <

» MAC Address Table < arp-inspection 5[] v

> Multicast ¢ auth-method = [v] ~

> MVR =

dhep-relay s [v] v

» DHCP <

b Security w dhcp-server s [v] v

b | ement
dhcp-snooping s [v] ¥
diagnostic s [v] ]
dotix 5 [v] v

Parameter descriptions:

Group Name: The name identifying the privilege group. In most cases, a privilege level group consists of
a single module (e.g. LACP, STP or QoS), but a few of them contains more than one. The following
description defines these privilege level groups in details: System: Contact, Name, Location, Timezone,
Daylight Saving Time, Log.

Privilege Levels: Every group has an authorization Privilege level for the following sub groups:
configuration read-only, configuration/execute read-write. User Privilege should be same or greater than
the authorization Privilege level to have the access to that group.

Read-Only: At the dropdown select a privilege level of 0-15 for any function (access-mgmt, account, arp-
inspection, etc.) that you want to change from the default value.

Read-Write: At the dropdown select a privilege level of 0-15 for any function (access-mgmt, account, arp-
inspection, etc.) that you want to change from the default value.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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12-1.3 Auth Method

The Security > Management > Auth Method menu path displays the Auth Method Configuration tables,
where you can configure an authentication method (none, local, or radius) for each client (telnet, ssh, http,
https). You can also configure a service port number for telnet, ssh, http, and https clients, and enable the
HTTPS Redirect function on this page. The page also provides the Command Authorization Method
Configuration table and the Accounting Method Configuration table.

T I .
TRANSITION = | e »
N NETWORKS - w 9 C
SM16TAT2SA Auth Method Configuration eHome - Security - Management - AuthMethad
Switch DMS
Authentication Method Configuration
» System
» Port Management < Client Methods Service Port
» PoE Management € telnet local | o [v] no  [v] 23
» VLAN Management <
ssh local [w] o [v] no  [v] 22
» Quality of Service <
» Spanning Tree < http local  [v] o [v] o [v] 0
» MAC Address Table ¢ https local [v] o [v] o [v] 443
» Multicast <
» DHCP ¢ Command Authorization Method Configuration
» Security e .
‘ Client Methods Cmd Lvl Cfg Cmd Fallback
» Management ~
> Account telnet no  [v] 0 O a
> Privile &
N ssh no  [v] 0 O O
Auth Metho
> Access WPH?E:‘W‘\?]T_
o (T ) Accounting Method Configuration
D [PEemEs e ¢ Client Methods Cmd Lvl Exec
» ARP Inspection <
» Port Security < telnet o ¥ o O
» RADIUS < ssh o [V 0 D
» TACACS+ <
» Access Control € Apply ” Reset

Section descriptions:

Authentication Method Configuration: The authentication section allows you to configure how a user is
authenticated when he logs into the switch via one of the management client interfaces. The table has
one row for each client type and several columns.

Command Authorization Method Configuration: The command authorization section allows you to
limit the CLI commands available to a user. The table has one row for each client type and several
columns.

Accounting Method Configuration: The accounting section allows you to configure command and exec
(login) accounting. The table has one row for each client type and several columns,
Parameter descriptions:

Methods: Select an authentication method (none, local, radius, or tacacs) for each client (telnet, ssh, http,
https). In the Command Authorization Method Configuration table and the Accounting Method
Configuration table, select a Method for telnet or ssh only (none or tacacs). The Method can be set to one
of the following values:

no: Authentication is disabled and login is not possible.

local: Use the local user database on the switch for authentication.
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radius: Use remote RADIUS server(s) for authentication. Remote Authentication Dial In User Service is a
networking protocol that provides centralized access, authorization and accounting management for
people or computers to connect and use a network service.

tacacs: Use remote TACACS+ server(s) for authentication. Terminal Access Controller Access Control
System Plus. It is a networking protocol which provides access control for routers, network access
servers and other networked computing devices via one or more centralized servers. TACACS+ provides
separate authentication, authorization and accounting services.

Methods that involve remote servers are timed out if the remote servers are offline. In this case, the next
method is tried. Each method is tried from left to right and continues until a method either approves or
rejects a user. If a remote server is used for ‘primary’ authentication, it is recommended to configure
secondary authentication as 'local'. This lets the management client login via the local user database if
none of the configured authentication servers are alive.

Service Port: Enter a service port number for telnet, ssh, http, and https clients as required.

Cmd Lvl: Authorize all commands with a privilege level higher than or equal to this level. Valid values are 0
- 15. Runs accounting for all commands at the specified privilege level. Specific command level that
should be authorized. Valid entries are 0 through 15.

Cfg Cmd: Check to also authorize configuration commands.
Fallback: Check the box to Enable the fallback mechanism.

Exec: Check the box to Enable exec (login) accounting. Runs accounting to determine if the user is allowed
to run an EXEC shell. This facility might return user profile information such as auto command information.

Method: Accounting Method can be set to one of the following values:
no : accounting is disabled and login is not possible.
tacacs : use a remote TACACS server for accounting.

Cmd Lvl: Runs accounting for all commands at the specified privilege level. Specific command level that
should be authorized. Valid entries are 0 through 15.

Exec: Runs accounting to determine if the user is allowed to run an EXEC shell. This facility might return
user profile information such as auto command information.

Note: Password encoding is changed in FW v1.02.1409. You cannot login if downgrading the switch to
older firmware versions or loading an old config file in new firmware.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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12-1.4 Access Management

This section shows you how to configure access management table of the Switch including HTTP/HTTPS,
SNMP, and TELNET/SSH. You can manage the Switch over an Ethernet LAN or over the Internet.

Web Interface

To configure an Access Management Configuration in the web interface:
1. Click Security, Management, Access Management.
2. Select “on"” in the Mode of Access Management Configuration.
3. Click "Add New Entry".
4. Checked Access Management method (HTTP/HTTPS, SNMP, and TELNET/SSH) in the entry.
5

Click Apply.
&« C | @ 192.168.1.77/access mgmthtm Q& | @
It Apps [ Internet Explorer canr  [EB| Official Usability, Ussr [ Personal Dashboard L [ Cognition Cockpit [ Transition EMS (2) [} CSI-Communication [ hitp--metroethernet »
—, p—
TRANSITION = Dem (2 B3
SM16TAT25A Access Management Configuration @toms ~ Security  Managsment ~ Access Managsment
Switch DMS
Mode
» System &
» Port Management <
Delete VLAN ID IP Address Mask Length HTTP/HTTPS SNMP TELNET/SSH
» PoE Management g - - - -
O 3 192.168.1.30 30 (v [w] ]
» VLAN Management <
» Quality of Service K ] : LzLEaLTT o ] &4 &

Spanning Tree &

‘ ["—:I%t+| 1 O ] [

MAC Address Table &

Multicast < ‘ Add New Entry |

» MVR ‘ Aoy | Reset.

‘ Apply H Reset ‘
» DHCP ‘ -
» Security ;

» Management v

>
>
>
>

» SNMP T

Figure 12-1.2: Access Management Configuration
Parameter descriptions:

Mode: Indicates the access management mode operation. Possible modes are:
On: Enable access management mode operation.

Off: Disable access management mode operation.
VLAN ID: Indicates the VLAN ID for the access management entry.
Delete: Check to delete the entry. It will be deleted during the next save.
IP address: Enter the source |IP address.
Mask Length: Enter the Mask Length (1-30).

HTTP/HTTPS: Indicates that the host can access the switch from HTTP/HTTPS interface if the host IP
address matches the IP address range provided in the entry.
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SNMP: Indicates that the host can access the switch from SNMP interface if the host IP address matches
the IP address range provided in the entry.

TELNET/SSH: Indicates that the host can access the switch from TELNET/SSH interface if the host IP
address matches the IP address range provided in the entry.
Note: Firmware v1.01.1209 modified authentication method behavior for telnet/ssh/http/https.

The connection is now closed if configuring the first field of Method to "none".

Note: Password encoding is changed in FW v1.02.1409. You cannot login if downgrading the switch to
older firmware versions or loading an old config file in new firmware.

Buttons
Add New Entry: Click to add a new access management entry.
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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12-2 IEEE 802.1X
12-2.1 Configuration

The section describes how to configure the 802.1X parameters of the switch. You can use 802.1X to

connect users to a variety of resources including Internet access, conference calls, printing documents on

shared printers, or by simply logging on to the Internet.

Web Interface

To configure the IEEE 802.1X in the web interface:

1. Click Security, IEEE 802.1X, Configuration.
Select “on” in the Mode of IEEE 802.1X Configuration.
Checked Reauthentication Enabled.
Set Reauthentication Period (default is 3600 seconds).
Select Admin State and displays Port State.
Click the Apply button to save the setting.

N o vk wN

To cancel the setting click the Reset button to revert to previously saved values.

==
TSN =

T 5" |

4
¢
L

0OooDo0oooo0ooooDoooDooDo0odDsg
0O o0o0oo0Do0oo0o0Oo0DoOoDoooooooao

SM1BTAT25A 802.1X Configuration B e S S

Figure 12-2.1: 802.1X Configuration
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Parameter descriptions:
System Configuration

Mode: Select on or off. Indicates if IEEE 802.1X is globally enabled or disabled on the switch. If globally
disabled, all ports are allowed forwarding of frames.

Reauthentication Enabled: If checked, successfully authenticated supplicants/clients are reauthenticated
after the interval specified by the Reauthentication Period. Reauthentication for 802.1X-enabled ports can
be used to detect if a new device is plugged into a switch port or if a supplicant is no longer attached.

For MAC-based ports, reauthentication is only useful if the RADIUS server configuration has changed. It
does not involve communication between the switch and the client, and therefore doesn't imply that a
client is still present on a port (see Aging Period below).

Reauthentication Period: Determines the period, in seconds, after which a connected client must be
reauthenticated. This is only active if the Reauthentication Enabled checkbox is checked. Valid values are in
the range 1 to 3600 seconds.

EAPOL Timeout: Determines the time for retransmission of Request Identity EAPOL frames. Valid values
are in the range 1 to 255 seconds. This has no effect for MAC-based ports.

RADIUS-Assigned VLAN Enabled : RADIUS-assigned VLAN provides a means to centrally control the
VLAN on which a successfully authenticated supplicant is placed on the switch. Incoming traffic will be
classified to and switched on the RADIUS-assigned VLAN. The RADIUS server must be configured to
transmit special RADIUS attributes to take advantage of this feature.

The "RADIUS-Assigned VLAN Enabled" checkbox provides a quick way to globally enable/disable RADIUS-
server assigned VLAN functionality. When checked, the individual ports' ditto setting determines whether
RADIUS-assigned VLAN is enabled on that port. When unchecked, RADIUS-server assigned VLAN is
disabled on all ports.

Guest VLAN Enabled: A Guest VLAN is a special VLAN - typically with limited network access - on which
802.1X-unaware clients are placed after a network administrator-defined timeout. The switch follows a set
of rules for entering and leaving the Guest VLAN as listed below.

The "Guest VLAN Enabled" checkbox provides a quick way to globally enable/disable Guest VLAN
functionality. When checked, the individual ports' ditto setting determines whether the port can be moved
into Guest VLAN. When unchecked, the ability to move to the Guest VLAN is disabled on all ports.

Guest VLAN ID: This is the value that a port's Port VLAN ID is set to if a port is moved into the Guest
VLAN. It is only changeable if the Guest VLAN option is globally enabled. Valid values are 1- 4094.

Max. Reauth. Count: The number of times the switch transmits an EAPOL Request Identity frame without
response before considering entering the Guest VLAN is adjusted with this setting. The value can only be
changed if the Guest VLAN option is globally enabled. Valid values are in the range [1; 255].

Allow Guest VLAN if EAPOL Seen: The switch remembers if an EAPOL frame has been received on the
port for the life-time of the port. Once the switch considers whether to enter the Guest VLAN, it will first
check if this option is enabled or disabled. If disabled (unchecked; default), the switch will only enter the
Guest VLAN if an EAPOL frame has not been received on the port for the life-time of the port. If enabled
(checked), the switch will consider entering the Guest VLAN even if an EAPOL frame has been received on
the port for the life-time of the port. The value can only be changed if the Guest VLAN option is

globally enabled.
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Port Configuration
Port: The port number for which the configuration below applies.

Admin State: If 802.1X is globally enabled, this selection controls the port's authentication mode.
These modes are available:

Force Authorized: In this mode, the switch will send one EAPOL Success frame when the port
link comes up, and any client on the port will be allowed network access without authentication.

Force Unauthorized: In this mode, the switch will send one EAPOL Failure frame when the port
link comes up, and any client on the port will be disallowed network access.

Port-based 802.1X: In the 802.1X-world, the user is called the supplicant, the switch is the
authenticator, and the RADIUS server is the authentication server. The authenticator acts as the
man-in-the-middle, forwarding requests and responses between the supplicant and the
authentication server. Frames sent between the supplicant and the switch are special 802.1X
frames, known as EAPOL (EAP Over LANs) frames. EAPOL frames encapsulate EAP PDUs
(RFC3748). Frames sent between the switch and the RADIUS server are RADIUS packets. RADIUS
packets also encapsulate EAP PDUs together with other attributes like the switch's IP address,
name, and the supplicant's port number on the switch. EAP is very flexible, in that it allows for
different authentication methods, like MD5-Challenge, PEAP, and TLS. The important thing is that
the authenticator (the switch) doesn't need to know which authentication method the supplicant
and the authentication server are using, or how many information exchange frames are needed
for a particular method. The switch simply encapsulates the EAP part of the frame into the
relevant type (EAPOL or RADIUS) and forwards it.

When authentication is complete, the RADIUS server sends a special packet containing a success
or failure indication. Besides forwarding this decision to the supplicant, the switch uses it to open
up or block traffic on the switch port connected to the supplicant

@ NoTE: Suppose two backend servers are enabled and that the server timeout is configured
to X seconds (using the AAA configuration page), and suppose that the first server in the list
is currently down (but not considered dead).

Now, if the supplicant retransmits EAPOL Start frames at a rate faster than X seconds, then it
will never get authenticated, because the switch will cancel on-going backend authentication
server requests whenever it receives a new EAPOL Start frame from the supplicant.

And since the server hasn't yet failed (because the X seconds haven't expired), the same
server will be contacted upon the next backend authentication server request from the
switch. This scenario will loop forever. Therefore, the server timeout should be smaller than
the supplicant's EAPOL Start frame retransmission rate.

Guest VLAN Enabled

When Guest VLAN is both globally enabled and enabled (checked) for a given port, the switch considers
moving the port into the Guest VLAN according to the rules outlined below.
This option is only available for EAPOL-based modes, i.e.:

. Port-based 802.1X
) Single 802.1X
. Multi 802.1X

For troubleshooting VLAN assignments, use the "Monitor>VLANs>VLAN Membership and VLAN Port"
pages. These pages show which modules have (temporarily) overridden the current Port VLAN
configuration.
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Guest VLAN Operation:

When a Guest VLAN enabled port's link comes up, the switch starts transmitting EAPOL Request Identity
frames. If the number of transmissions of such frames exceeds Max. Reauth. Count and no EAPOL frames
have been received in the meanwhile, the switch considers entering the Guest VLAN. The interval between
transmission of EAPOL Request Identity frames is configured with EAPOL Timeout. If Allow Guest VLAN if
EAPOL Seen is enabled, the port will now be placed in the Guest VLAN. If disabled, the switch will first
check its history to see if an EAPOL frame has previously been received on the port (this history is cleared
if the port link goes down or the port's Admin State is changed), and if not, the port will be placed in the
Guest VLAN. Otherwise it will not move to the Guest VLAN but continue transmitting EAPOL Request
Identity frames at the rate given by EAPOL Timeout.

Once in the Guest VLAN, the port is considered authenticated, and all attached clients on the port are
allowed access on this VLAN. The switch will not transmit an EAPOL Success frame when entering the
Guest VLAN.

While in the Guest VLAN, the switch monitors the link for EAPOL frames, and if one such frame is received,
the switch immediately takes the port out of the Guest VLAN and starts authenticating the supplicant
according to the port mode. If an EAPOL frame is received, the port will never be able to go back into the
Guest VLAN if the "Allow Guest VLAN if EAPOL Seen" is disabled.

Port State : The current state of the port. It can undertake one of the following values:
Globally Disabled: IEEE 802.1X is globally disabled.

Link Down: IEEE 802.1X is globally enabled, but there is no link on the port.

Authorized: The port is in Force Authorized or a single-supplicant mode and the supplicant is
authorized.

Unauthorized: The port is in Force Unauthorized or a single-supplicant mode and the
supplicant is not successfully authorized by the RADIUS server.

X Auth/Y Unauth: The port is in a multi-supplicant mode. Currently X clients are authorized
and Y are unauthorized.

Restart: Two buttons are available for each row. The buttons are only enabled when authentication is
globally enabled and the port's Admin State is in an EAPOL-based or MAC-based mode.

Clicking these buttons will not cause settings changed on the page to take effect.

Re-authenticate: Schedules a re-authentication whenever the quiet-period of the port runs out (EAPOL-
based authentication). For MAC-based authentication, re-authentication will be attempted immediately.
The button only has effect for successfully authenticated clients on the port and will not cause the clients
to get temporarily unauthorized.

Reinitialize: Forces a re-initialization of the clients on the port and thereby a re-authentication
immediately. The clients will transfer to the unauthorized state while the re-authentication is in progress.

Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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12-2.2 Status

The section describes how to show the each port 802.1X status information of the switch.
The status includes Admin State, Port State, Last Source, Last ID and Port VLAN ID.

Web Interface
To displays 802.1X Status in the web interface:
1. Click Security, IEEE 802.1X, Status.
2. Check "Auto-refresh” if desired.
3. Click "Refresh” to refresh the port detailed statistics.
4

Select which port that you want display 802.1X Statistics.

‘\ — ]
TRANSITION ° =| wsm — 2 B
=" NETWORKS )
SM16TAT2SA 802.1X Status @Home - Security - IEEE802.1X - Status
Switch DMS —
Auto-refresh | Refresh
b System < : :
» Port Manasement ¢ Port  Admin State Port State Last Source Last ID Port VLAN ID
(=}
» PoE Management < 1 Force Authorized Authorized
» VLAN Management S 2 Port-based 802.1X Link Down
3 A < . .
¥ Quality of Service 3 Force Authorized Authorized
» Spanning Tree E . .
P e 4 Force Authorized Authorized
» MAC Address Table E
5 Force Authorized Link Down
» Multicast <
6 Force Authorized Link Down
» DHCP <
L " 7 Force Authorized Link Down
¥ Security
» Management < 8 Faorce Unauthorized Link Down
» IEEE 802.1% v ) .
9 Force Authorized Link Down
> Configuration
> S 10 Force Authorized Link Down
» 1D Saurce Guard ‘ 11 Enrra Autharizad link Rawn

Figure 12-2.2: IEEE 802.1X Status
Parameter descriptions:
Port: The switch port number. Click to navigate to detailed 802.1X statistics for this port.

Admin State: The port's current administrative state. Refer to 802.1X Admin State for a description of
possible values.

Port State: The current state of the port. Refer to 802.1X Port State for a description of the individual
states.

Last Source: The source MAC address carried in the most recently received EAPOL frame for EAPOL-based
authentication, and the most recently received frame from a new client for MAC-based authentication.

Last ID: The user name (supplicant identity) carried in the most recently received Response Identity EAPOL
frame for EAPOL-based authentication, and the source MAC address from the most recently received
frame from a new client for MAC-based authentication.
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Port VLAN ID: The VLAN ID that 802.1X has put the port in. The field is blank, if the Port VLAN ID is not
overridden by 802.1X.

If the VLAN ID is assigned by the RADIUS server, "(RADIUS-assigned)" is appended to the VLAN ID. Read
more about RADIUS-assigned VLANSs here.

If the port is moved to the Guest VLAN, "(Guest)" is appended to the VLAN ID. Read more about Guest
VLANSs here.

Auto-refresh ‘ Refresh |
Buttons —

Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.

Example: display 802.1X Statistics for Port 1:

TRANSITION ' =| Zwsmar BE e c
= : -
N NETWORKS
SM16TAT25A 802.1X Status #bHome - Security - IEES EI2.1X - Suatuz
Switch DMS —
Auto-refresh Refresh |
» System E : :
» Port Management < Port Admin State Port State Last Source LastID Port VLAN ID
1
» PoE Management < 1 Force Authorized Authorized
|
» VLAN Management E 2 Port-based 802.1X Link Down
i i < 5
* Quality of Service 3 Force Authorized Autherized
» Spanning Ti <
panning free 4 Force Authorized Authorized
» MAC Address Table E
5 Force Authorized Link Down
» Multicast E
6 Force Authorized Link Down
» DHCP <
I o 7 Force Authorized Link Down
» Security
* Management < 8 Force Unauthorized Link Down
> |EEE 802.1X
9 Force Authorized Link Down
> Configuration
» Status 10 Force Authorized Link Down
» IP Source Guard < 11 Force Authorized Link Down
* ARPInspection ‘ 12 Force Authorized Link Down
» Port Security <
13 Force Authorized Link Down
® RADIUS <
3 TACACS+ . 14 Force Authorized Link Down
» Access Control < 15 Force Authorized Link Down
» SNMP < 16 Force Authorized Link Down
p i <
» Event Notification 17 Force Authorized Link Down
» Diagnostics E
g 18 Force Authorized Link Down
» Maintenance <

Figure 12-2.2: 802.1X Statistics Port 1

Parameter descriptions:
Port: You can select which port that you want display 802.1X Statistics.

Admin State: The port's current administrative state. Refer to 802.1X Admin State for a description of
possible values.

Port State: The current state of the port. Refer to 802.1X Port State for a description of the individual
states.
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12-3 Port Security
12-3.1 Configuration

This section shows you how to configure the Port Security settings of the Switch. You can use the Port
Security feature to restrict input to an interface by limiting and identifying MAC addresses.

Web Interface

To configure a Port Security Configuration in the web interface:

1. Click Security, Port Security, Configuration.
2. Select “"Enabled” in the System Configuration section.
3. Set Mode, Limit, and Action parameters for each port.
4. Click the Apply button to save the settings.
5. To cancel the settings click the Reset button to restore previously saved values.
oy —
TRANSITION ° =| Zwsmox = > e
N NETWORKS.
SM16TAT2SA Port Security Configuration @Homs - Sacurity - PortSecurlty - Configurstion
Switch DMS
System Configuration
» System <
» Port Management < Mode a:‘
» PoE Management 3
» VLAN Management < Port Configuration
» Quality of Service < . )
Port Mode MAC Limit Action State Re-open
» Spanning Tree <
1 Dissbled ¥ 4 Hene v Disabled ‘ |
» MAC Address Table < S —
b Multicast < 2 Enabled ¥ 4 Trap v Ready ‘ |
» DHCP < _
g 3 Ensbled ¥ 4 Trap v Ready ‘ |
¢ 4 Ensbled ¥ 4 Trap v Ready ‘ |
< 5 Ensbled ¥ e Trap v Ready ‘ |
‘ & Dissbled ¥ 4 Mene v Disabled ‘ |
HpUETE 7 Ensbled ¥ 4 Trap & Shutdown ¥ Ready ‘ |
atus
» RADIUS ¢ e Ensbled ¥ e Nene v Ready ‘ |
TACACS+ ¢ —
£l Enabled ¥ 4 Nene v Ready ‘ |
» Access Control < -
» SNMP < 10 Enabled ¥ & None v Ready ‘ |

Figure 12-3.1: Port Security Configuration
Parameter descriptions:

System Configuration

Mode: Indicates if Limit Control is globally enabled or disabled on the switch. If globally disabled, other
modules may still use the underlying functionality, but limit checks and corresponding actions are
disabled.

Port Configuration:

Port: The port number to which the configuration below applies.

Mode: Controls whether Limit Control is enabled on this port. Both this and the Global Mode must be set
to Enabled for Limit Control to be in effect. Notice that other modules may still use the underlying port
security features without enabling Limit Control on a given port.

33717 Rev.D https://www.transition.com Page 171 of 284



https://www.transition.com/
http://192.168.1.1/help/help_psec_limit.htm#GlblEna

Transition Networks SMXTAT2SA Web User Guide

Limit: The maximum number of MAC addresses that can be secured on this port. This number cannot
exceed 1024. If the limit is exceeded, the corresponding action is taken.

The switch is "born" with a total number of MAC addresses from which all ports draw whenever a new
MAC address is seen on a Port Security-enabled port. Since all ports draw from the same pool, it may
happen that a configured maximum cannot be granted, if the remaining ports have already used all
available MAC addresses.

Action: If Limit is reached, the switch can take one of the following actions:
None: Do not allow more than Limit MAC addresses on the port, but take no further action.

Trap: If Limit + 1 MAC addresses seen on the port, send an SNMP trap. If Aging is disabled, only one
SNMP trap will be sent, but with Aging enabled, new SNMP traps will be sent every time the limit
gets exceeded.

Shutdown: If Limit + 1 MAC addresses is seen on the port, shut down the port. This implies that all
secured MAC addresses will be removed from the port, and no new address will be learned. Even if
the link is physically disconnected and reconnected on the port (by disconnecting the cable), the
port will remain shut down. There are three ways to re-open the port:

1) Boot the switch,
2) Disable and re-enable Limit Control on the port or the switch,
3) Click the Reopen button.

Trap & Shutdown: If Limit + 1 MAC addresses is seen on the port, both the "Trap" and the
"Shutdown" actions described above will be taken.

State: This column shows the current state of the port as seen from the Limit Control's point of view.
The state takes one of four values:

Disabled: Limit Control is either globally disabled or disabled on the port.
Ready: The limit is not yet reached. This can be shown for all actions.

Limit Reached: Indicates that the limit is reached on this port. This state can only be shown if Action
is set to none or Trap.

Shutdown: Indicates that the port is shut down by the Limit Control module. This state can only be
shown if Action is set to Shut Down or Trap & Shutdown.

Buttons

Re-open: If a port is shut down by this module, you may reopen it by clicking this button, which will only
be enabled if this is the case. For other methods, refer to shut down in the Action section.

Note: Clicking the Re-open button causes the page to be refreshed, so non-committed changes will be
lost.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

Message: If the message “State has Shutdown and you must reopen it first." Displays, click the Re-open
button.
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This section shows the Port Security status. Port Security is a module with no direct configuration.
Configuration comes indirectly from other modules - the user modules. When a user module has enabled
port security on a port, the port is set-up for software-based learning. In this mode, frames from unknown
MAC addresses are passed on to the port security module, which in turn asks all user modules whether to
allow this new MAC address to forward or block it. For a MAC address to be set in the forwarding state, all
enabled user modules must unanimously agree on allowing the MAC address to forward. If only one
chooses to block it, it will be blocked until that user module decides otherwise. The status page is divided
into two sections - one with a legend of user modules and one with the actual port status.

Web Interface

To displays a Port Security Status in the web interface:
Click Security, Port Security, and Status.

2. Check "Auto-refresh” if desired.
3. Click "Refresh” to refresh the port detailed statistics.
4. Click the port number to see the status for this particular port.
e —
TRANSITION © =| wwsos === ° e
v NETWORKS i
SM16TAT2S5A Port Security Status @hHome - Secury - PorSecurtty - St
Switch DMS —
Auto-refresh | Refresh
» System <
» Port Management < HOILSLZuS
» PoE Management < Port State Mac Count
» VLAM Management < 1 Disabled
» Quality of Service < ) Ready o
» Spanning Tree <
3 Ready 0
» MAC Address Table <
4 Ready Q
» Multicast <
> EHEE ¢ 5 Ready 0
v [ Disabled
& 7 Ready 0
‘ 8 Ready 0
<
; 9 Limit Exceeded 4
10 Ready Q
11 Ready 0
o 12 Disabled
» RADIUS <
» TACACS+ < 13 Disabled
» Access Control < 14 Disabled
» SNMP < 13 Disabled
» Event Notification < 16 Disabled
» Diagnostics S 17 Ready 0
» Maintenance < 18 Ready 1

Figure 12-3.2: Port Security Status

Parameter descriptions:

Port: The port number for which the status applies. Click the port number to see the status for this

particular port.
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State: Shows the current state of the port. It can take one of four values:

Disabled: No user modules are currently using the Port Security service.

Ready: The Port Security service is in use by at least one user module and is awaiting frames from
unknown MAC addresses to arrive.

Limit Reached: The Port Security service is enabled by at least the Limit Control user module, and
that module has indicated that the limit is reached and no more MAC addresses should be taken in.
Shutdown: The Port Security service is enabled by at least the Limit Control user module, and that
module has indicated that the limit is exceeded. No MAC addresses can be learned on the port until
it is administratively re-opened on the Limit Control configuration Web-page.

MAC Count (Current, Limit): The two columns indicate the number of currently learned MAC addresses
(forwarding as well as blocked) and the maximum number of MAC addresses that can be learned on the
port, respectively. If no user modules are enabled on the port, the Current column will show a dash (-).

Buttons Auto-refresh | Refresh ‘

Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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12-3 1P Source Guard

The IP Source Guard security feature restricts IP traffic on untrusted Layer 2 ports by filtering traffic based
on the DHCP snooping binding database or manually configured IP source bindings. This feature helps
prevent IP spoofing attacks.

12-3.1 Configuration

Navigate to Security > IP Source Guard > Configuration to configure IP Source Guard mode and port
mode settings and the max dynamic clients.

TR AT
TRANSITION = “ e B | e c
SM16TAT25A IP Source Guard Configuration Sriome - Securty - 1P Source Guard - Canfigurstion
Switch DMS
Mode a
» System €
» Port Management <
Port Mode Configuration
» PoE Management <
» VLAN Management € Port Mode Max Dynamic Clients
» Quality of Service £ 1 Dissbled[™] Unlimited ]
» Spanning Tree «
2 Dizsbled[w| unlimited[¥]
» MAC Address Table £ ~ ~
» Multicast < 3 Dizsbled[V] Unlimited %]
<
> DHCP 4 Disabled[V] Unlimited V]
» Security e
b - 5 Dissbled[™] Unlimited[~]
¢ 6 Dizsbled V] Unlimited %]
Dizsblzd[V] Unlimited %]
8 Disabled[V] Unlimited V]
< 9 Dizsbled[™] Unlimited[~]
¢
10 Dizsbled[™] ited[V]
<
£ 1 Dizsbled[V] Unlimited %]

IP Source Guard Configuration parameters:

Mode: Select the global mode (on or off). The default is off.

Port: A row for configuring each port.

Mode: Select the mode for each port (Enabled or Disabled). The default is Disabled.

Max Dynamic Clients: At the dropdown select 0, 1, 2 or Unlimited. The default is Unlimited.
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12-3.2 Static Table

Navigate to Security > IP Source Guard > Static Table to create new Static IP Source Guard entries.

e TRANSITIGN ™ - I
Tavsman = = ot LI o

SM16TAT2SA Static IP Source Guard Table @Hame - Securty - P Seurce Guard - Static Table

Switch DMS
Delete Port IP Address MAC Address

-

System <

-

Port Management €

PoE Management &

L d

VLAN Management <

-

Quality of Service €

Spanning Tree &

L d

MAC Address Table <

» Multicast €
» DHCP <
» Security h
» Management <
» |EEE 802.1X <

*» |P Source Guard
> Configuration
> Static Table

> Dynamic Table

Static IP Source Guard Table parameters:

Add New Entry: Click the button to add a row for configuring.

Port: At the dropdown select the port to be configured.

IP Address: Enter the IP address for this new entry.

MAC Address: Enter the MAC address for this new entry (must be a valid unicast MAC address).

Apply: Click the Apply button when done.
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The Security > IP Source Guard > Dynamic Table displays data on existing entries. Entries in the Dynamic
IP Source Guard Table are shown on this page. The Dynamic IP Source Guard Table is sorted first by port,

then by IP address, and then by MAC address.

H e G

..ﬁ . =
TRANSITION ® | e
N NETWORKS - L
SM16TAT2SA Dynamic IP Source Guard Table
Switch DMS ( \
Auto-refresh Refresh |
» System < -
» Port Management < Show| o [v] entries
» PoE Management . Port “ 1p Address

b WLGE N g No data available in table
¥ Quality of Service <
» Spanning Tree <

» MAC Address Table <

» Multicast <
» DHCP <
¥ Security ¥
» Management <
» IEEE 802.1X <

5 IP Source Guard
> Configuration
> Static Table

» Dynamic Table

w ADD Incractinn

Dynamic IP Source Guard Table parameters:
Port: Displays the configured port.

IP Address: Displays the IP address for the entry.

MAC Address: Displays the MAC address for the entry.

Previous: Click the button to display the previous set of entries.

Next: Click the button to display the next set of entries.

33717 Rev.D https://www.transition.com

#iHome - Security - P Source Guard - Dynamic Table

Search:

MAC Address

Page 177 of 284


https://www.transition.com/

Transition Networks SMXTAT2SA Web User Guide
12-4 ARP Inspection

This webpage lets you configure ARP Inspection settings including Mode (on and off) and Port
(Enabled and Disabled).

12-4.1 Port Configuration
The Security > ARP Inspection > Port Configuration page displays the Port Mode Configuration table.

SM16TAT2SA ARP Inspection Configuration @Home - Security - ARB Inspection - Port Configuration
Switch DMS
Mode
» System <
» Port Management « . .
Port Mode Configuration
» PoE Management &
» VLAN Management < Port Mode Check VLAN Log Type
» Quality of Service < 1 [} O Mone v
» Spanning Tree & _ _
2 |_| \_\ None v
» MAC Address Table <
» Multicast < 3 0 O None ¥
N < — .
» MVR 4 [l ] None ¥
» DHCP < _ _
i 5 [ O Mone v
¥ Security >
» Management < 5 |:| ‘:‘ None ¥
» SNMP <
» IEEE 802.1X ¢ 7 0 O None
‘1 a ] O None v
9 |:| \:\ Mone v
> VLAN Configuration
Parameters:

Mode: The global mode setting (on or off). The default is off.
Port: A row for each port to be configured.

Mode: Check the box if configured.

Check VLAN: Check the box if configured.

Log Type: Select None, Deny, Permit, or All. The default is None.
Apply: Click the button when done configuring.
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12-4.2 VLAN Configuration
The Security > ARP Inspection > VLAN Configuration page displays the VLAN Mode Configuration table.
Here you can specify ARP Inspection is enabled on which VLANS.

First, you must enable the port setting on Port mode configuration web page. Only when both Global
Mode and Port Mode on a given port are enabled, ARP Inspection is enabled on this given port.

Second, you can specify which VLAN will be inspected on VLAN mode configuration web page. The log
type also can be configured on per VLAN setting.

RANS f?
JRANSITION ™ =[[ = : °
SM16TAT2SA VLAN Mode Configuration @Home - Security - ARP Inspestion - VLAN Configurstion
Switch DMS
Delete VLAN ID Log Type
b System
» Port Management < ‘ Delete | : Hore [¥]
» PoE Management <
Add New Ent |
» VLAN Management &
» Quality of Service < Appl ” =
» Spanning Tree <
» MAC Address Table &
» Multicast <
» DHCP <
» Security h

Parameters:

Delete: Check to delete the entry. It will be deleted during the next save.
VLAN ID: The VID for this instance.
Log Type: Select None, Deny, Permit, or All. The default is None.

None: Log nothing.

Deny: Log denied entries.
Permit: Log permitted entries.
ALL: Log all entries.

Buttons
Add New Entry: Click the button to add a row for configuring.
Apply: Click the Apply button when done configuring.

Reset: Click to undo any changes made locally and revert to previously saved values.
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12-4.3 Static Table

The section describes to configure the Static ARP Inspection Table parameters of the switch. You could use
the Static ARP Inspection Table configure to manage the ARP entries.

Navigate to the Security > ARP Inspection > Static Table menu path to display the Static ARP Inspection
Table:

e

TRANSITION = werer »
JRANSITION = 2 e G

SM16TAT2SA Static ARP Inspection Table @oHame - Sexurity - ARP Inspestion - Stetic Table

Switch DMS
Delete Port VLAN ID MAC Address IP Address
¥ System @ -
» Port Management K | Delets | 1M
¥ <

» PoE Management | Delete | L v
» VLAN Management &
» Quality of Service < Add Nex EI]i”,-'|
» Spanning Tree K

» MAC Address Table @
» Multicast K
» DHCP <

» Security e

Parameters:

Add New Entry: Click the button to add a row for configuring a new VLAN to add to the ARP Inspection
VLAN table.

Port: Select the port being configured.
VLAN ID: The VID for this instance.

MAC Address: Enter the MAC address for the entry. Must be a valid unicast MAC address. Allowed Source
MAC address in ARP request packets.

IP Address: Enter the IP address for the entry; allowed Source IP address in ARP request packets.

Buttons
Apply: Click the Apply button when done configuring to save changes.

Reset: : Click to undo any changes made locally and revert to previously saved values.
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12-4.4 Dynamic Table

Navigate to the Security > ARP Inspection > Dynamic Table menu path to display the Dynamic ARP
Inspection Table. Entries in the Dynamic ARP Inspection Table are shown on this page. The Dynamic ARP
Inspection Table contains up to 1024 entries, and is sorted first by port, then by VLAN ID, then by MAC
address, and then by IP address.

e ——
TRANSITION ® | we® .
JRANSITION = " @G
SM16TAT25A Dynamic ARP Inspection Table #Home - Security - ARP Ingpection - Dynamic Table
Switch DMS —
Auto-refresh | Refresh |
» System < —
» Port Management < Show| w0 [v] entries Search:
» PoE Management < Port “ VLANID MAC Address 1P Address

1A <
b A B No data available in table
» Quality of Service ©
» Spanning Tree €

» MAC Address Table ©

» Multicast €
» DHCP €
¥ Security h

Parameters:

Search: Use the Search box to search for the information that you want to see.

Show entries: You can choose how many items you want to show.

Port: Switch Port Number for which the entries are displayed.

VLAN ID: The VID for this instance. The VLAN ID in which the ARP traffic is permitted.
MAC Address: User MAC address of the entry.

IP Address: User IP address of the entry.

Buttons:

Previous: Click the button to display the previous set of entries.

Next: Click the button to display the next set of entries.
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12-5 SNMP v

> Configuration

# SNMPv3

The Security > SNMP menu path lets you configure SNMP Communities, Groups, Views, and
Access and Trap Event Security.

12-5.1 Configuration -
Security > SNMP > Configuration

This webpage lets you configure SNMP System on the switch. This function is used to configure

SNMP settings, community name, trap host and public traps as well as the throttle of SNMP. A SNMP
manager must pass the authentication by identifying both community names, then it can access the MIB
information of the target device. So, both parties must have the same community name. Once completing
the setting, click button, the setting takes effect.

TRANSITION * = wsmad H 0 G
N NETWORKS
SM16TAT2S5A SNMP Configuration dHome - SNMP - Configurstion
Switch DMS
Read Community public
b System
» Port Management < Write Community private Erabled ¥
» PoE Management <
¢ (eply ) Reset

» VLAN Management

SNMP Configuration Parameters:

Read Community: Indicates the community read access string to permit access to SNMP agent. The
allowed string length is 1 to 31, and the allowed content is the ASCII characters from 33 to 126. The field
is applicable only when SNMP version is SNMPv1 or SNMPv2c. If SNMP version is SNMPv3, the
community string will be associated with SNMPv3 communities table. It provides more flexibility to
configure security name than a SNMPv1 or SNMPv2c community string. In addition to community string,
a particular range of source addresses can be used to restrict source subnet

Write Community: Indicates the community write access string to permit access to SNMP agent.

The allowed string length is 1 to 31, and the allowed content is the ASCII characters from 33 to 126.

The field is applicable only when SNMP version is SNMPv1 or SNMPv2c. If SNMP version is SNMPv3, the
community string will be associated with SNMPv3 communities table. It provides more flexibility to
configure security name than a SNMPv1 or SNMPv2c community string. In addition to community string,
a particular range of source addresses can be used to restrict source subnet. At the dropdown you can
select Enabled (default) or Disabled.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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12-5.2 SNMPv3
Security > SNMP > SNMPv3 > Communities

The function is used to configure SNMPv3 communities. The Community is unique. To create a new
community account, please check <Add New Entry> button, and enter the account information then
check the Apply button. You can create up to six Groups.

SNMPv3 Community Configuration gHome - Security - SNMP - SNMPv3 - Communities

Delete Community Source IP Source Mask

‘ Delete ‘ 0.0.0.0 0

Parameters:

Community: Enter the IP address for this new entry. Indicates the community access string to permit
access to SNMPv3 agent. The allowed string length is 1 to 32, and the allowed content is ASCII characters
from 33 to 126. The community string will be treated as security name and map a SNMPv1 or SNMPv2c
community string.

Source IP: Enter the IP address for this new entry. Indicates the SNMP access source address. A particular
range of source addresses can be used to restrict source subnet when combined with source mask.

Source Mask: Enter the Source Mask for this new entry. Indicates the SNMP access source address mask.
Add New Entry: Click to add a row to the table and configure the new instance.
Apply: Click to save changes when done configuring.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Security > SNMP > SNMPv3 >Users

The function is used to configure SNMPv3 user. The Entry index key is User Name. To create a new User
Name account, please check <Add new user> button, and enter the user information then click the Apply
button. You can create up to six Groups.

SNMPv3 UserConfiguration gbHome - Security - SNMP - SNMPW3 - Use

Delete UserName SecurityLevel AuthenticationProtocol AuthenticationPassword PrivacyProtocol PrivacyPassword

| ['%lei%‘ Auth, Priv v MDS ¥ DES ¥

Parameters:

UserName: Enter a name for this new user entry. A string identifying the user name that this entry should
belong to. The allowed string length is 1 to 31, and the allowed content is ASCII characters from 33 to 126.

SecurityLevel: Select Auth, Priv or Auth, no Priv or no Auth, Priv for the desired combination of Privacy
and Authentication. Security Level indicates the security model that this entry should belong to. Possible
security models are:

NoAuth, NoPriv: No authentication and no privacy.
Auth, NoPriv: Authentication and no privacy.
Auth, Priv: Authentication and privacy.

The value of security level cannot be modified if entry already exists. That means it must first be ensured
that the value is set correctly.

AuthenticationProtocol: If Authentication is configured, select a protocol; either MD5 (uses the Merkle—
Damgard construction) or SHA (Secure Hash Algorithm). Note: The value of security level cannot be
modified if an entry already exists. That means you must first ensure that the value is set correctly.

AuthenticationPassword: If Authentication is configured, enter a password for authenticating. A string
identifying the authentication password phrase. For MD5 authentication protocol, the allowed string
length is 8 to 39. For SHA authentication protocol, the allowed string length is 8 to 39. The allowed
content is ASCII characters from 33 to 126.

PrivacyProtocol: If Privacy is configured, select a protocol; either DES (Data Encryption Standard) or AES
(Advanced Encryption Standard). Indicates the privacy protocol that this entry should belong to. Possible
privacy protocols are:

DES: An optional flag to indicate that this user uses DES authentication protocol.

AES: An optional flag to indicate that this user uses AES authentication protocol.

PrivacyPassword: If Privacy is configured, enter a password for privacy. A string identifying the privacy
password phrase. The allowed string length is 8 to 31, and the allowed content is ASCII characters from 33
to 126.

Add New Entry: Click to add new entry. Specify the name and configure the new entry. Click the Apply
button.
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Security > SNMP > SNMPv3 > Groups

The function is used to configure SNMPv3 group. The Entry index key are Security Model and Security
Name. To create a new group account, check the Add New Group button, and enter the group
information then click the Apply button. You can create up to 12 SNMP Groups.

SNMPv3 Group Configuration @Home - Security - SNMP - SMMPv3 - Groups

Delete Security Model User Name Group Name

| Delete ‘ vioov v

Parameters:

Security Model: Select v1, v2c, or usm (User-based Security Model). Indicates the security model that this
entry should belong to. Possible security models are:

v1: Reserved for SNMPv1.
v2c: Reserved for SNMPv2c.
usm: User-based Security Model (USM).

User Name: At the dropdown select an existing User Name to become a member of this new group.
A string identifying the security name that this entry should belong to. The allowed string length is 1 to
31, and the allowed content is ASCII characters from 33 to 126.

Group Name: Enter the name for the new Group. A string identifying the group name that this entry
should belong to. The allowed string length is 1 to 32, and the allowed content is ASCII characters from 33
to 126.
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Security > SNMP > SNMPv3 > Views

The function is used to configure SNMPv3 view. The Entry index keys are OID Subtree and View Name. To
create a new view account, please check <Add new view> button, and enter the view information then
click the Apply button. Max Group Number: 12. Configure SNMPv3 view table on this page. The entry
index keys are View Name and OID Subtree.

SNMPv3 View Configuration @rHome - security - sl s - R
Delete View Name View Type OID Subtree
|:| myView included ¥ 1.2.3
‘ Add New Entry |
‘\ Apply H Reset |
Parameters:

View Name: Enter the name for this new View. A string identifying the view name that this entry should
belong to. The allowed string length is 1 to 31, and the allowed content is ASCII characters from 33 to 126.

View Type: Select included or excluded for this new View. Indicates the view type that this entry should
belong to. Possible view types are:

Included: An optional flag to indicate that this view subtree should be included.

Excluded: An optional flag to indicate that this view subtree should be excluded.

In general, if a view entry's view type is 'excluded’, there should be another view entry existing with view
type as 'included' and it's OID subtree should overstep the 'excluded' view entry.

OID Subtree: Enter an Object Identifier for this new View. The format is .OID1.0ID2.0ID3 ...
The allowed string content is digital number or asterisk (*). This is the OID defining the root of the subtree
to add to the named view. The allowed OID length is 1 to 128.
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Security > SNMP > SNMPv3 > Access

The function is used to configure SNMPv3 accesses. The Entry index key are Group Name, Security Model
and Security level. To create a new access account, click the Add New Entry button, enter the access
information, and then check the Apply button. You can create up to 12 Groups.

SNMPV3 ACCESS Conﬁguration #Home - Security -~ SNMP - SNMPv3 - Access
Delete Group Name  Security Model  Security Level Read View Name  Write View Name
| Delete | v any v MoAuth, NoPriv ¥ None ¥ None ¥
Add New Entry |
Apply H Reset ‘
Parameters:

Group Name: Select the name of the existing Group. A string identifying the group name that this entry
should belong to. The allowed string length is 1 to 31, and the allowed content is ASCII characters from 33
to 126.

Security Model: Select any, v1, v2¢, or usm for this instance. Indicates the security model that this entry
should belong to. Possible security models are:

Any: Any security model accepted(vl|v2clusm).
v1: Reserved for SNMPv1.

v2c: Reserved for SNMPv2c.

usm: User-based Security Model (USM).

Security Level: Select the level of security to be applied (NoAuth, NoPriv, or Auth, NoPriv, or
Auth, Priv. Indicates the security model that this entry should belong to. Possible security models are:

NoAuth, NoPriv: No authentication and no privacy.
Auth, NoPriv: Authentication and no privacy.

Auth, Priv: Authentication and privacy.

Read View Name: Select None or an existing Read View Name at the dropdown. This is the name of the
MIB view defining the MIB objects for which this request may request the current values. The allowed
string length is 1 to 31, and the allowed content is ASCII characters from 33 to 126.

Write View Name: Select None or an existing Write View Name at the dropdown. This is the name of the
MIB view defining the MIB objects for which this request may potentially set new values. The allowed
string length is 1 to 31, and the allowed content is ASCII characters from 33 to 126.

Buttons

Add New Entry: Click to add a new instance. An empty row is added to the table, and the new instance
can be configured as needed.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Security > SNMP > Trap Event Severity

This page displays the Trap Event Severity Configuration table:

IRANDITION

SM16TAT2SA
Switch DMS

» System

» Port Management

PoE Management

VLAN Management

Quality of Service

Spanning Tree

MAC Address Table

Multicast

» MVR

» DHCP

¥ Security

» Management
» SNMP

» Configuration
» SNMPv3

> Trap Event Severity

Parameters:

ION

SMXTAT2SA Web User Guide

— TRANSITIGN *
B

Trap Event Severity Configuration

Group Name

ACCESS-MGMT

ACL

ARP-INSPECTION

AUTH-FAILED

BCS-PROTECTION

COLD-START

DHCP

DHCP-SNOOPING

IP-SOURCE-GUARD

LACP

LINK-UPDOWN

Severity Level

Info

Info

Info

Info

Info

Info

fHome

R QG
Security = SNMP ~ Trap Event Severity

Trap

Group Name: Select the name of the existing Group. This is the name identifying the severity group.

Severity Level: At the dropdown select Emerg, Alert, Crit, Error, Warning, Notice, Info, or Debug.

Every group has an severity level. These 7 levels are supported:

Emergency: System is unusable.

Alert: Action must be taken immediately.

Critical: Critical conditions.

Error: Error conditions.

Warning: Warning conditions.

Notice: Normal but significant conditions.

Information: Information messages.

Debug: Debug-level messages.

Syslog: Check the box to enable System logging of the trap event.

Trap: Check the box to enable the trap event setting.
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12-4 RADIUS

12-4.1 Configuration

Web Interface

To configure a RADIUS in the web interface:
1. Click Security, RADIUS, Configuration.

2. Set Timeout, Retransmit, Deadtime, Key, NAS-IP-Address, NAS IPv6-Address,NAS-Identifier.
3. Click "Add New Entry".

4. Set Hostname, Auth Port, Acct Port, Timeout, Retransmit, Key.

5. Click the Apply button to save the setting.

6. To cancel the setting, click the Reset button to revert to previously saved values.

RADIUS Server Configuration @Home - Security - RADIUS - Configuration
Global Configuration

Timeout ; seconds

Retransmit s Jtimes

Deadtime 0 minutes

ey

NAS-IP-Address

NAS-IPv6-Address

NAS-Identifier

Server Configuration

Delete Hostname Auth Port Acct Port Timeout Retransmit Key

onfiguration

Delete Hostname Auth Port Acct Port Timeout Retransmit Key

Figure 12-4.1: RADIUS Server Configuration
Parameter descriptions:
Global Configuration
These setting are common for all of the RADIUS servers.

Timeout: Timeout is the number of seconds, in the range 1 to 1000, to wait for a reply from a RADIUS
server before retransmitting the request.

Retransmit: Retransmit is the number of times, in the range 1 to 1000, a RADIUS request is retransmitted
to a server that is not responding. If the server has not responded after the last retransmit it is considered
to be dead.

Deadtime: Deadtime, which can be set to a number between 0 to 1440 minutes, is the period during
which the switch will not send new requests to a server that has failed to respond to a previous request.
This will stop the switch from continually trying to contact a server that it has already determined as dead.
Setting the Deadtime to a value greater than O (zero) will enable this feature, but only if more than one
server has been configured.
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Key: The secret key - up to 63 characters long - shared between the RADIUS server and the switch.

NAS-IP-Address: The IPv4 address to be used as attribute 4 in RADIUS Access-Request packets. If this
field is left blank, the IP address of the outgoing interface is used.

NAS-IPv6-Address: The IPv6 address to be used as attribute 95 in RADIUS Access-Request packets.
If this field is left blank, the IP address of the outgoing interface is used.

NAS-Identifier: The identifier - up to 255 characters long - to be used as attribute 32 in RADIUS Access-
Request packets. If this field is left blank, the NAS-Identifier is not included in the packet.

Server Configuration: The table has one row for each RADIUS server and a number of columns, which
are:

Delete: To delete a RADIUS server entry, check this box. The entry will be deleted during the next Save.
Hostname: The IP address or hostname of the RADIUS server.

Auth Port: The UDP port to use on the RADIUS server for authentication.

Acct Port: The UDP port to use on the RADIUS server for accounting.

Timeout: This optional setting overrides the global timeout value. Leaving it blank will use the global
timeout value.

Retransmit: This optional setting overrides the global retransmit value. Leaving it blank will use the global
retransmit value.

Key: This optional setting overrides the global key. Leaving it blank will use the global key.

Buttons

Add New Entry: Click to add a new RADIUS server. An empty row is added to the table, and the RADIUS
server can be configured as needed. Up to 5 servers are supported. The Reset button can be used to
undo the addition of the new server.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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This section shows you an overview/detail of the RADIUS Authentication and Accounting servers' status to

ensure the function is workable.

Web Interface

To display a RADIUS Status in the web interface:
1. Click Security, RADIUS, and Status.

2. Select a Server line to display the detail statistics for a particular RADIUS server.

RADIUS Server Status

RADIUS Authentication Server Status

# IP Address

1

@ Home - Security - RADIUS - Status

Status

Disabled

2 Disabled
Disabled
i Noaseos Disabled
Disabled
RADIUS Accounting Server Status
# IP Address Status
T 00000 Disabled
0:0 Disabled
Disabled
Disabled

0.0.0.0:0 Disabled

Figure 12-4.2: RADIUS Server Status
Parameter descriptions:
RADIUS Authentication Server Status
#: The RADIUS server number. Click to navigate to detailed statistics for this server.
IP Address: The IP address and UDP port number (in <IP Address>:<UDP Port> notation) of this server.
State: The current state of the server. This field takes one of the following values:
Disabled: The server is disabled.
Not Ready: The server is enabled, but IP communication is not yet up and running.

Ready: The server is enabled, IP communication is up and running, and the RADIUS module is ready
to accept access attempts.

Dead (X seconds left) : Access attempts were made to this server, but it did not reply within the
configured timeout. The server has temporarily been disabled, but will get re-enabled when the dead-
time expires. The number of seconds left before this occurs is displayed in parentheses. This state is
only reachable when more than one server is enabled.

RADIUS Accounting Server Status

#: The RADIUS server number. Click to navigate to detailed statistics for this server.

IP Address: The IP address and UDP port number (in <IP Address>:<UDP Port> notation) of this server.

33717 Rev.D https://www.transition.com Page 191 of 284



https://www.transition.com/

Transition Networks SMxTAT2SA Web User Guide
State : The current state of the server. This field takes one of the following values:

Disabled: The server is disabled.

Not Ready: The server is enabled, but IP communication is not yet up and running.

Ready: The server is enabled, IP communication is up and running, and the RADIUS module is
ready to accept accounting attempts.

Dead (X seconds left): Accounting attempts were made to this server, but it did not reply within
the configured timeout. The server has temporarily been disabled, but will get re-enabled when
the dead-time expires. The number of seconds left before this occurs is displayed in parentheses.
This state is only reachable when more than one server is enabled.

Example: If you select Server#1 to display RADIUS Statistics

RADIUS Statistics @ Home - Security -~ RADIUS - Status

Auto-refresh R server#l -

ADIUS Authentication Statistics for Server #1

Receive Packets Transmit Packets

Access Accepts 0 Access Requests

Access Rejects 0 Access Retransmissions

Access Challenges 0 Pending Requests

Malformed Access Responses 0 Timeouts

Bad Authenticators 0

Unknown Types 0

Packets Dropped

Other Info

IP Address 0.0.0.0:0

State Disabled

Round-Trip Time oms

RADIUS Accounting Statistics for Server #1

Receive Packets Transmit Packets

Responses o Requests 0
Malformed Responses 0 Retransmissions 0
Bad Authenticators 0 Pending Requests 0
Unknown Types 0 Timeouts 0
Packets Dropped 0

Other Info

IP Address 0.0.0.0:0

State Disabled

Round-Trip Time oms

Figure 12-4.2: RADIUS Statistics
Parameter descriptions:
server #: You can select which server that you want display RADIUS.

RADIUS Authentication Statistics for Server #1: The statistics map closely to those specified in IETF
RFC4668 - RADIUS Authentication Client MIB. Use the server select box to switch between the backend
servers to show details for.

Access Accepts: The number of RADIUS Access-Accept packets (valid or invalid) received from the server.

Access Rejects: The number of RADIUS Access-Reject packets (valid or invalid) received from the server.
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Access Challenges: The number of RADIUS Access-Challenge packets (valid or invalid) received from the
server.

Malformed Access Responses: The number of malformed RADIUS Access-Response packets received
from the server. Malformed packets include packets with an invalid length. Bad authenticators or Message
Authenticator attributes or unknown types are not included as malformed access responses.

Bad Authenticators: The number of RADIUS Access-Response packets containing invalid authenticators
or Message Authenticator attributes received from the server.

Unknown Types: The number of RADIUS packets that were received with unknown types from the server
on the authentication port and dropped.

Packets Dropped: The number of RADIUS packets that were received from the server on the
authentication port and dropped for some other reason.

Access Requests: The number of RADIUS Access-Request packets sent to the server. This does not include
retransmissions.

Access Retransmissions: The number of RADIUS Access-Request packets retransmitted to the RADIUS
authentication server.

Pending Requests: The number of RADIUS Access-Request packets destined for the server that have not
yet timed out or received a response. This variable is incremented when an Access-Request is sent and
decremented due to receipt of an Access-Accept, Access-Reject, Access-Challenge, timeout, or
retransmission.

Timeouts: The number of authentication timeouts to the server. After a timeout, the client may retry to
the same server, send to a different server, or give up. A retry to the same server is counted as a
retransmit as well as a timeout. A send to a different server is counted as a Request as well as a timeout.

IP Address: IP address and UDP port for the authentication server in question.
State: Shows the state of the server. It takes one of the following values:

Disabled: The selected server is disabled.

Not Ready: The server is enabled, but IP communication is not yet up and running.

Ready: The server is enabled, IP communication is up and running, and the RADIUS module is
ready to accept access attempts.

Dead (X seconds left): Access attempts were made to this server, but it did not reply within the
configured timeout. The server has temporarily been disabled, but will get re-enabled when the
dead-time expires. The number of seconds left before this occurs is displayed in parentheses.
This state is only reachable when more than one server is enabled.

Round-Trip Time: The time interval (measured in milliseconds) between the most recent Access-
Reply/Access-Challenge and the Access-Request that matched it from the RADIUS authentication server.
The granularity of this measurement is 100 ms. A value of 0 ms indicates that there hasn't been round-trip
communication with the server yet.

RADIUS Accounting Statistics for Server #1: The statistics map closely to those specified in RFC4670 -
RADIUS Accounting Client MIB. Use the server select box to switch between the backend servers to show
details for.

Responses: The number of RADIUS packets (valid or invalid) received from the server.

Malformed Responses: The number of malformed RADIUS packets received from the server. Malformed
packets include packets with an invalid length. Bad authenticators or unknown types are not included as
malformed access responses.
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Bad Authenticators: The number of RADIUS packets containing invalid authenticators received from the
server.

Unknown Types: The number of RADIUS packets of unknown types that were received from the server on
the accounting port.

Packets Dropped: The number of RADIUS packets that were received from the server on the accounting
port and dropped for some other reason.

Requests: The number of RADIUS packets sent to the server. This does not include retransmissions
Retransmissions: The number of RADIUS packets retransmitted to the RADIUS accounting server.

Pending Requests: The number of RADIUS packets destined for the server that have not yet timed out or
received a response. This variable is incremented when a Request is sent and decremented due to receipt
of a Response, timeout, or retransmission.

Timeouts: The number of accounting timeouts to the server. After a timeout, the client may retry to the
same server, send to a different server, or give up. A retry to the same server is counted as a retransmit as
well as a timeout. A send to a different server is counted as a Request as well as a timeout.

IP Address: IP address and UDP port for the accounting server in question.
State: Shows the state of the server. It takes one of the following values:
Disabled: The selected server is disabled.
Not Ready: The server is enabled, but IP communication is not yet up and running.

Ready: The server is enabled, IP communication is up and running, and the RADIUS module is
ready to accept accounting attempts.

Dead (X seconds left): Accounting attempts were made to this server, but it did not reply within
the configured timeout. The server has temporarily been disabled, but will get re-enabled when
the dead-time expires. The number of seconds left before this occurs is displayed in parentheses.
This state is only reachable when more than one server is enabled.

Round-Trip Time: The time interval (measured in milliseconds) between the most recent Response and
the Request that matched it from the RADIUS accounting server. The granularity of this measurement is
100 ms. A value of 0 ms indicates that there hasn't been round-trip communication with the server yet.
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12.5 RMON Configuration

Navigate to the Switch >Security > RMON menu path to configure remote monitoring.
Here you can configure and view RMON functions.

RMON Statistics Configuration

Navigate to Switch > SNMP > RMON Configuration > Statistics to display the RMON
Statistics Configuration table:

RMON StatIStICS COﬂfIgLJI'atIOn $’Home - Security -~ RMON ~ Statistics -~ Configuration
Delete D Data Source
| Delete | 1.3.6.1.2.1.22.1.1.

|
T——— |
‘ Add New Entry | |
[ Apply |[ Reset | :

Parameters:

ID: Enter an ID for the instance.
Data Source: The port ID which you want to be monitored with RMON.

Add New Entry: Click the button to add a new row for configuring.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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RMON Statistics Status
Navigate to Switch > Security > RMON > Statistics > Status to display the RMON Statistics Status page:

RMON Statistics Status fBHoms - Sscurity - RMON - Statistics -~ Status
Auto-refresh | Refresh |
Show| 10 - entries Search:
65 128 256 512 1024
* Data Source CRC Under- Over- 64 - - -
ID  (iflndex) Drop Octets Pkts Broadcast Multicast Errors size size Frag. Jabb. Coll. Bytes 127 255 511 1023 1588

Mo data available in table

Showing 0 to 0 of 0 entries

Parameters:

ID: Indicates the index of Statistics entry.

Data Source (ifIndex): The data source which you want to be monitored.

Drop: The total number of events in which packets were dropped by the probe due to lack of resources.
Octets: The total number of octets of data (including those in bad packets) received on the network.

Pkts: The total number of packets (including bad packets, broadcast packets, and multicast packets)
received.

Broad-cast: The total number of good packets received that were directed to the broadcast address.
Multi-cast: The total number of good packets received that were directed to a multicast address.

CRC Errors: The total number of packets received that had a length (excluding framing bits, but including
FCS octets) of between 64 and 1518 octets.

Under-size: The total number of packets received that were less than 64 octets.

Over-size: The total number of packets received that were longer than 1518 octets.

Frag.: The number of frames with a size is less than 64 octets received with invalid CRC.

Jabb.: The number of frames which size is larger than 64 octets received with invalid CRC.

Coll.: The best estimate of the total number of collisions on this Ethernet segment.

64 Bytes: The total number of packets (including bad packets) received that were 64 octets in length.

65~127: The total number of packets (including bad packets) received that were 65 to 127 octets in
length.

128~255: The total number of packets (including bad packets) received that were 128 to 255 octets long.
256~511: The total number of packets (including bad packets) received that were 256 to 511 octets long.

512~1023: The total number of packets (including bad packets) received that were 512 to 1023 octets
long.

1024~1588: The total number of packets (including bad packets) received that were 1024 to 1588 octets
long.
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RMON History Configuration

Navigate to Switch > Security > RMON > History > Configuration to display the RMON History
Configuration page:

RMON History Configuration $eHoms - Security -~ RMON - History - Canfigurstion

Delete D Data Source Interval Buckets Buckets Granted

1.36.1.2.1.2.2.1.1 1800 50

Parameters:
ID: Indicates the index of the entry. The valid range is 1 to 65535.
Data Source: Indicates the port ID which you want to be monitored with RMON.

Interval: Indicates the interval in seconds for sampling the history statistics data. The valid range is 1 to
3600. The default value is 1800 seconds.

Buckets: Indicates the maximum data entries associated this History control entry stored in RMON. The
valid range is 1 to 3600. The default value is 50. This is the RMON "buckets requested’ value - the
requested number of discrete time intervals over which data is to be saved in the part of the media-
specific table associated with this historyControlEntry. When this object is created or modified, the probe
should set historyControlBucketsGranted as closely to this object as is possible for the particular probe
implementation and available resources. The default is 50.

Buckets Granted: The number of data saved in the RMON. The number of discrete sampling intervals
over which data will be saved in the part of the media-specific table associated with this
historyControlEntry.

See the RMON RFC (IETF RFC 2819) for details on the particular probe implementation and available
resources.
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RMON History Status

Navigate to Switch > Security > RMON > History > Status to display the RMON History Configuration
page:

RMON HiStOI’y Status @Home - Security -~ RMON -~ History ~ Status
Auto-refresh | Refresh ‘
Index v
Show 10 - entries Search:
Sample |, Sample CRC Under- Over-
Index Start Drop Octets Pkts Broadcast Multicast Errors size size Frag. Jabb. Coll. Utilization

No data available in table

Showing 0 to 0 of 0 entries

Parameters:
Sample Index: Indicates the index of the data entry associated with the control entry

Sample Start: The total number of events in which packets were dropped by the probe due to lack of
resources.

Drops: The total number of events in which packets were dropped by the probe due to lack of resources.
Octets: The total number of octets of data (including those in bad packets) received on the network.

Pkts: The total number of packets (including bad packets, broadcast packets, and multicast packets)
received.

Broadcast: The total number of good packets received that were directed to the broadcast address.
Multicast: The total number of good packets received that were directed to a multicast address.

CRC Errors: The total number of packets received that had a length (excluding framing bits, but including
FCS octets) of between 64 and 1518 octets.

Undersize: The total number of packets received that were less than 64 octets.

Oversize: The total number of packets received that were longer than 1518 octets.

Frag.: The number of frames which size is less than 64 octets received with invalid CRC.
Jabb.: The number of frames which size is larger than 64 octets received with invalid CRC.
Coll.: The best estimate of the total number of collisions on this Ethernet segment.

Utilization: The best estimate of the mean physical layer network utilization on this interface during this
sampling interval, in hundredths of a percent (.01% sampling interval).
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RMON Alert Configuration

Navigate to Switch > Security > RMON > Alarm > Configuration to display the RMON Alert Configuration
page:

RMON Alert Configuration @toms - Security - AMON - Alsm  Configuration
Delete D Interval Variable Sample Type Value Startup Alarm Rising Rising Falling Falling
Threshold Index Threshold Index
.1.3.6.1.2.1.2.2.1,
| Delete | 30 o Delta 0 RisingOrfalling

Parameters:

ID: Indicates the index of Alarm control entry.

Interval: Indicates the interval in seconds for sampling and comparing the rising and falling threshold.
Variable: Indicates the particular variable to be sampled.

Sample Type: The method of sampling the selected variable and calculating the value to be compared
against the thresholds, possible sample types are:

Delta: Delta sampling subtracts the current sample value from the last sample taken and then compares
the difference to the threshold. Delta sampling is like a counter that records a value that is constantly
increasing. The difference between samples of the selected variable is used when comparing against the
thresholds.

Absolute: Absolute sampling compares the sample value directly to the threshold. Absolute sampling is
like a gauge that records values that go up or down. An actual value of the selected variable is used
when comparing against the thresholds.

Value: The value of the statistic during the last sampling period. (e.g., 72).

Startup Alarm: The alarm that may be sent when this entry is first set to valid (e.g., RisingOrFalling).
Rising Threshold: Rising threshold value.

Rising Index: Rising event index.

Falling Threshold: Falling threshold value.

Falling Index: Falling event index.
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RMON Alarm Status
Navigate to Switch > Security > RMON > Alarm > Status to display the RMON Alarm Status page:

RMON A{arrﬂ Status @ Home - Security ~ RMON - Alarm - Status
Auto-refresh | Refresh ‘
Show 10 - entries Search:

ID* Interval Variable Sample Type  Value Startup Alarm Rising Threshold Rising Index  Falling Threshold Falling Index

No data available in table

Showing 0 to 0 of 0 entries

Parameters:

ID: Indicates the index of Alarm control entry.

Interval: Indicates the interval in seconds for sampling and comparing the rising and falling threshold.
Variable: Indicates the particular variable to be sampled.

Sample Type: The method of sampling the selected variable and calculating the value to be compared
against the thresholds, possible sample types are:

Delta: Delta sampling subtracts the current sample value from the last sample taken and then compares
the difference to the threshold. Delta sampling is like a counter that records a value that is constantly
increasing. The difference between samples of the selected variable is used when comparing against the
thresholds.

Absolute: Absolute sampling compares the sample value directly to the threshold. Absolute sampling is
like a gauge that records values that go up or down. An actual value of the selected variable is used
when comparing against the thresholds.

Value: The value of the statistic during the last sampling period. (e.g., 72).

Startup Alarm: The alarm that may be sent when this entry is first set to valid (e.g., RisingOrFalling).
Rising Threshold: Rising threshold value.

Rising Index: Rising event index.

Falling Threshold: Falling threshold value.

Falling Index: Falling event index.
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RMON Event Configuration

Navigate to Switch > Security > RMON > Event > Configuration to display the RMON Event Configuration
page:

RMON Event Configuration @ome - Security - RMON - Euent - Configuration

Delete ID Desc Type Community Event Last Time

| Delete ‘ none

Parameters:
ID: Enter the index of the RMON event. The valid range is 1 to 65535. Each ID entry must be unique.
Desc: Indicates this event, the string length is 0 to 127. The default is a null string.
Type: Indicates the notification of the event, the valid types are:
none: No logging action is performed.
log: A syslog entry is added.
snmptrap: An SNMP trap event is sent.
logandtrap: A syslog entry is logged and an SNMP trap event is sent.

Community: Specify the community when a trap is sent; the string length is 0 to 127 characters. The
default is "public".

Event Last Time: Indicates the value of sysUpTime at the time this event entry last generated an event
(e.g., 33554560 or 33 days, 55 hours, 45 minutes, and 50 seconds).

RMON Event Status
Navigate to Switch > Security > RMON > Event > Status to display the RMON Event Status page:

RMON Event Status @Home - Security ~ RMON - Event - Status
Auto-refresh | Refresh |

Show| 10 v entries Search:

Event Index “ Loglndex LogTime LogDescription

No data available in table

Showing 0 to 0 of 0 entries

Parameters:

Event Index: Indicates the index of the event entry.
LogIndex: Indicates the index of the log entry.
LogTIme: Indicates the time that the Event was logged.

LogDescription: Indicates the Event description.
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12.6 TACACS+ Configuration

Navigate to Switch >Security >TACACS+ > Configuration to display the TACACS+ Server Configuration
page:

TRANSITION ' =| Imwsnon ) (> I
= SITIO 5
N NETWORKS
SM16TAT2SA TACACS+ Server Configuration @8 ome - Security - TACACS - Configuration
Switch DMS
Global Configuration
P System &
» Port Management < Timeout 5 seconds
EM = <
» PoE Management Deadtime . minutes
» VLAN Management <
Ke
» Quality of Service < Y
» Spanning Tree <

Server Configuration

MAC Address Table <

Multicast < Delete Hostname Port Timeout Key

» DHCP <

Global Configuration Parameters:

Timeout: Timeout is the number of seconds, in the range 1 to 1000, to wait for a reply from a TACACS+
server before it is considered to be dead.

Deadtime: Deadtime, which can be set to a number between 0 to 1440 minutes, is the period during
which the switch will not send new requests to a server that has failed to respond to a previous request.
This will stop the switch from continually trying to contact a server that it has already determined as dead.
Setting the Deadtime to a value greater than O (zero) will enable this feature, but only if more than one
server has been configured.

Key: The secret key - up to 63 characters long - shared between the TACACS+ server and the switch.

Server Configuration Parameters:
Hostname: The IP address or hostname of the TACACS + server.
Port: The TCP port to use on the TACACS+ server for authentication.

Timeout: This optional setting overrides the global timeout value. Leaving it blank will use the global
timeout value.

Key: This optional setting overrides the global key. Leaving it blank will use the global key.
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Buttons

Add New Entry: Click the button to add a new row for configuring.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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12.7 Access Control List

The section describes how to configure Access Control List rules. An Access Control List (ACL) is a
sequential list of permit or deny conditions that apply to IP addresses, MAC addresses, or other more
specific criteria. This switch tests ingress packets against the conditions in an ACL one by one. A packet will
be accepted as soon as it matches a permit rule, or dropped as soon as it matches a deny rule. If no rules
match, the frame is accepted. Other actions can also be invoked when a matching packet is found,
including rate limiting, copying matching packets to another port or to the system log, or shutting down a
port. This page shows the Access Control List (ACL), which is made up of the ACEs defined on this switch.
Each row describes the ACE that is defined. The maximum number of ACEs is 256 on each switch. Click on
the lowest plus sign to add a new ACE to the list. The reserved ACEs used for internal protocol, cannot be
edited or deleted, the order sequence cannot be changed the priority is highest.

Navigate to Switch >Access Control List > Access Control List to display the Access Control List
Configuration page:

N RANSITION - .
TR NSITIPN E JRANSITION ] H o c.
SM16TAT2SA Access Control List Configuration @eroms - Access Contral - Aceas Contrsl it
Switch DMS L
Auto-refresh ‘ Refresh H Clear || Remove All
» System <
ACE Ingress Port Frame Type Action Metering Mirror Counter
» Port Management £
L+
» PoE Management £

[Add ACE to end of list |

-

VLAN Management <

-

Quality of Service ¢

-

Spanning Tree

-

MAC Address Table <

b Multicast <
» MVR ¢
» DHCP <
b Security <
» Access Control ¥

Click the & icon to add an ACE from the ACE Configuration page:
ACE Configuration / Frame Type: Any

ACE Conflguratlﬂn g Home ~ Access Control ~ Access Control List
Ingress Port All Action Permit v
Port1
Port2 .
Forts o Mirror Disabled v
Frame Type Any v Metering Disabled ¥
Counter Disabled v
| Apply ” Reset ” ancel |
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ACE Configuration / Frame Type: Ethernet Type

ACE Co nfigu ration @etome - Access Control - Access Control List
Ingress Port All Action Deny v
Port1
Port 2 )
Ports| . Mirror Enabled v
Frame Type Fthernet Type v Metering Enabled v
Metering Bandwidth 1000000 Kbps
MAC Parameters
Counter Disabled
SMAC Filter Any v
DMAC Filter Any v VLAN Parameters
C-VLAN Tagged Any v
Ethernet Type Parameters
C-VLAN ID Filter Ay .
Ethernet Type Filter
C-VLAN Tag Priority Any v
S-VLAN Tagged Bny -
S-VLAN ID Filter Any v
S-VLAN Tag Priority Ay v
‘ Apply || Reset H Cancel |
ACE Configuration / Frame Type: IPv4
ACE Configu ration @ Homs  Accass Control  Access Control List
Ingress Port All Action Permit v
Port1
Fort2 )
Ports o Mirror Disabled »
Frame Type IPva v Metering Disabled v
Counter Disabled v
IP Parameters
IP Protocol Filter TP v TCP Parameters
IP Fragment Any v Source Port Filter Any v
ToS Filter Any v Destination Port Filter Any v
SIP Filter Any B TCP FIN Any v
DIP Filter Any v TCP SYN Any v
TCP RST Any v
TCP PSH Any v
TCP ACK Any v
TCP URG Any v

|_ Apply || Reset || Cancel |
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ACE Configuration Parameters:
ACE: Indicates the ACE ID.
Ingress Port: Select the ingress port of the ACE. Possible values are:

All: The ACE will match all ingress port.
Port. The ACE will match a specific ingress port.

Frame Type: Indicates the frame type of the ACE. Possible values are:
Any: The ACE will match any frame type.
Ethernet Type: The ACE will match Ethernet Type frames. Note that an Ethernet Type based ACE will
not get matched by IP and ARP frames.
ARP: The ACE will match ARP/RARP frames.
IPv4: The ACE will match all IPv4 frames.
IPv4/ICMP: The ACE will match IPv4 frames with ICMP protocol.
IPv4/UDP: The ACE will match IPv4 frames with UDP protocol.
IPv4/TCP: The ACE will match IPv4 frames with TCP protocol.
IPv4/0ther: The ACE will match IPv4 frames, which are not ICMP/UDP/TCP.
IPv6: The ACE will match all IPv6 standard frames.

Action: Indicates the forwarding action of the ACE. Possible values are:

Permit. Frames matching the ACE may be forwarded and learned.
Deny: Frames matching the ACE are dropped.
Filter. Frames matching the ACE are filtered.

Metering: Enable or disable metering mode. The default value is "Disabled".
Metering Bandwidth: Enter an integer value between 16 and 1000000 Kbps.

Mirror: Specify the mirror operation of this port. Frames matching the ACE are mirrored to the destination
mirror port. The allowed values are: Enabled: Frames received on the port are mirrored. Disabled: Frames
received on the port are not mirrored. The default value is "Disabled".

Counter: The counter indicates the number of times the ACE was hit by a frame.

MAC Parameters

SMAC Filter: Specify the source MAC filter for this ACE. (Only displayed when the frame type is Ethernet
Type or ARP) Any: No SMAC filter is specified. (SMAC filter status is "don't-care".) Specific: If you want to
filter a specific source MAC address with this ACE, choose this value. A field for entering an SMAC value

displays.

SMAC Value: When "Specific" is selected for the SMAC filter, you can enter a specific source MAC address.
The legal format is "XX-XX-XX-XX-XX-XX" OF "XX.XX.XX.XX.XX.XX" OF "XxXxxxxxxxxx" (x is a hexadecimal digit). A
frame that hits this ACE matches this SMAC value.

DMAC Filter: Specify the destination MAC filter for this ACE. Any: No DMAC filter is specified. (DMAC filter
status is "don't-care".) MC: Frame must be multicast. BC: Frame must be broadcast. UC: Frame must be
unicast. Specific: If you want to filter a specific destination MAC address with this ACE, choose this value. A
field for entering a DMAC value displays.

DMAC Value: When "Specific" is selected for the DMAC filter, you can enter a specific destination MAC
address. The legal format is "XX-XX-XX-XX-XX-XX" OF "XX.XXXX.XXXX.XX" OF "XXXXXXXXXXXX" (X is a hexadecimal
digit). A frame that hits this ACE matches this DMAC value.
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VLAN Parameters

802.1Q Tagged: Specify whether frames can hit the action according to the 802.1Q tagged. The allowed
values are: Any: Any value is allowed ("don't-care"). Enabled: Tagged frame only. Disabled: Untagged frame
only. The default value is "Any".

VLAN ID Filter: Specify the VLAN ID filter for this ACE. Any: No VLAN ID filter is specified. (VLAN ID filter
status is "don't-care".) Specific: If you want to filter a specific VLAN ID with this ACE, choose this value. A
field for entering a VLAN ID number displays.

VLAN ID: When "Specific" is selected for the VLAN ID filter, you can enter a specific VLAN ID number. The
valid range is 1 to 4094. A frame that hits this ACE matches this VLAN ID value.

Tag Priority: Specify the tag priority for this ACE. A frame that hits this ACE matches this tag priority. The
valid number range is 0 to 7. The value Any means that no tag priority is specified (tag priority is "don't-
care")

ARP Parameters
The ARP parameters can be configured when Frame Type "ARP" is selected.

ARP/RARP: Specify the available ARP/RARP opcode (OP) flag for this ACE.
Any: No ARP/RARP OP flag is specified. (OP is "don't-care".)

ARP: Frame must have ARP opcode set to ARP.

RARP: Frame must have RARP opcode set to RARP.

Other: Frame has unknown ARP/RARP Opcode flag.

Request/Reply: Specify the available Request/Reply opcode (OP) flag for this ACE. Any: No Request/Reply
OP flag is specified. (OP is "don't-care".) Request: Frame must have ARP Request or RARP Request OP flag
set. Reply: Frame must have ARP Reply or RARP Reply OP flag.

Sender IP Filter: Specify the sender IP filter for this ACE. Any: No sender IP filter is specified. (Sender IP
filter is "don't-care".) Host: Sender IP filter is set to Host. Specify the sender IP address in the SIP Address
field that appears. Network: Sender IP filter is set to Network. Specify the sender IP address and sender IP
mask in the SIP Address and SIP Mask fields that appear.

Sender IP Address: When "Host" or "Network" is selected for the sender IP filter, you can enter a specific
sender IP address in dotted decimal notation. Notice the invalid IP address configuration is acceptable
too, for example, 0.0.0.0. Normally, an ACE with invalid IP address will explicitly adding deny action.

Sender IP Mask: When "Network" is selected for the sender IP filter, you can enter a specific sender IP
mask in dotted decimal notation.

Target IP Filter: Specify the target IP filter for this specific ACE. Any: No target IP filter is specified. (Target
IP filter is "don't-care".) Host: Target IP filter is set to Host. Specify the target IP address in the Target IP
Address field that appears. Network: Target IP filter is set to Network. Specify the target IP address and
target IP mask in the Target IP Address and Target IP Mask fields that appear.

Target IP Address: When "Host" or "Network" is selected for the target IP filter, you can enter a specific
target IP address in dotted decimal notation. Notice the invalid IP address configuration is acceptable too,
for example, 0.0.0.0. Normally, an ACE with invalid IP address will explicitly adding deny action.

Target IP Mask: When "Network" is selected for the target IP filter, you can enter a specific target IP mask
in dotted decimal notation.

ARP Sender MAC Match: Specify whether frames can hit the action according to their sender hardware
address field (SHA) settings. 0: ARP frames where SHA is not equal to the SMAC address. 1: ARP frames
where SHA is equal to the SMAC address. Any: Any value is allowed ("don't-care”).
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RARP Target MAC Match: Specify whether frames can hit the action according to their target hardware
address (THA) field settings. 0: RARP frames where THA is not equal to the target MAC address. 1: RARP
frames where THA is equal to the target MAC address. Any: Any value is allowed ("don't-care").

IP/Ethernet Length: Specify whether frames can hit the action according to their ARP/RARP hardware
address length (HLN) and protocol address length (PLN) settings. 0: ARP/RARP frames where the HLN is
not equal to Ethernet (0x06) or the (PLN) is not equal to IPv4 (0x04). 1: ARP/RARP frames where the HLN is
equal to Ethernet (0x06) and the (PLN) is equal to IPv4 (0x04). Any: Any value is allowed ("don't-care").

IP: Specify whether frames can hit the action according to their ARP/RARP hardware address space (HRD)
settings. 0: ARP/RARP frames where the HLD is not equal to Ethernet (1). 1: ARP/RARP frames where the
HLD is equal to Ethernet (1). Any: Any value is allowed ("don't-care").

Ethernet: Specify whether frames can hit the action according to their ARP/RARP protocol address space
(PRO) settings. 0: ARP/RARP frames where the PRO is not equal to IP (0x800). 1: ARP/RARP frames where
the PRO is equal to IP (0x800). Any: Any value is allowed ("don't-care").

IPv4 Parameters
The IP parameters can be configured when Frame Type "IPv4" is selected.

IP Protocol Filter: Specify the IP protocol filter for this ACE. Any: No IP protocol filter is specified ("don't-
care"). ICMP: Select ICMP to filter IPv4 ICMP protocol frames. Extra fields for defining ICMP parameters will
appear. These fields are explained later in this section. UDP: Select UDP to filter IPv4 UDP protocol frames.
Extra fields for defining UDP parameters will appear. These fields are explained later in this section. TCP:
Select TCP to filter IPv4 TCP protocol frames. Extra fields for defining TCP parameters will appear. These
fields are explained later in this section. Other: If you want to filter another specific IP protocol filter with
this ACE, choose this value. A field for entering an IP protocol filter displays.

IP Protocol Value: When "Specific" is selected for the IP protocol value, you can enter a specific value. The
valid range is 0 to 255. A frame that hits this ACE matches this IP protocol value.

IP TTL: Specify the Time-to-Live settings for this ACE. Zero: IPv4 frames with a Time-to-Live field greater
than zero must not be able to match this entry. Non-zero: IPv4 frames with a Time-to-Live field greater
than zero must be able to match this entry. Any: Any value is allowed ("don't-care”).

IP Fragment: Specify the fragment offset settings for this ACE. This involves the settings for the More
Fragments (MF) bit and the Fragment Offset (FRAG OFFSET) field for an IPv4 frame. No: IPv4 frames where
the MF bit is set or the FRAG OFFSET field is greater than zero must not be able to match this entry. Yes:
IPv4 frames where the MF bit is set or the FRAG OFFSET field is greater than zero must be able to match
this entry. Any: Any value is allowed ("don't-care").

IP Option: Specify the options flag setting for this ACE. No: IPv4 frames where the options flag is set must
not be able to match this entry. Yes: IPv4 frames where the options flag is set must be able to match this
entry. Any: Any value is allowed ("don't-care").

SIP Filter: Specify the source IP filter for this ACE. Any: No source IP filter is specified. (Source IP filter is
"don't-care".) Host: Source IP filter is set to Host. Specify the source IP address in the SIP Address field that
appears. Network: Source IP filter is set to Network. Specify the source IP address and source IP mask in
the SIP Address and SIP Mask fields that appear.

SIP Address: When "Host" or "Network" is selected for the source IP filter, you can enter a specific SIP
address in dotted decimal notation.

SIP Mask: When "Network" is selected for the source IP filter, you can enter a specific SIP mask in dotted
decimal notation.
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DIP Filter: Specify the destination IP filter for this ACE. Any: No destination IP filter is specified.
(Destination IP filter is "don't-care".) Host: Destination IP filter is set to Host. Specify the destination IP
address in the DIP Address field that appears. Network: Destination IP filter is set to Network. Specify the
destination IP address and destination IP mask in the DIP Address and DIP Mask fields that appear.

DIP Address: When "Host" or "Network" is selected for the DIP Filter, you can enter a specific DIP address
in dotted decimal notation.

DIP Mask: When "Network" is selected for the DIP Filter, you can enter a specific DIP mask in dotted
decimal notation.

IPv6 Parameters
The IPv6 parameters can be configured when Frame Type "IPv6" is selected.

Next Header Filter: Specify the IPv6 next header filter for this ACE. Any: No IPv6 next header filter is
specified ("don't-care"). ICMP: Select ICMP to filter IPv6 ICMP protocol frames. Extra fields for defining
ICMP parameters will appear. These fields are explained later in this section. UDP: Select UDP to filter IPv6
UDP protocol frames. Extra fields for defining UDP parameters will appear. These fields are explained later
in this section. TCP: Select TCP to filter IPv6 TCP protocol frames. Extra fields for defining TCP parameters
will appear. These fields are explained later in this section. other: If you want to filter a specific IPv6 next
header filter with this ACE, choose this value. A field for entering an IPv6 next header filter appears.

Next Header Value: When "other" is selected for the IPv6 next header value, you can enter a specific
value. The allowed range is 0 to 255. A frame that hits this ACE matches this IPv6 protocol value.

SIP Filter: Specify the source IPvé6 filter for this ACE. Any: No source IPvé6 filter is specified. (Source IPv6
filter is "don't-care".) Specific: Source IPv6 filter is set to Network. Specify the source IPv6 address and
source IPv6 mask in the SIP Address fields that appear.

SIP Address (32 bits): When "Specific" is selected for the source IPv6 filter, you can enter a specific SIPv6
address. The field only supported last 32 bits for IPv6 address.

SIP BitMask (32 bits): When "Specific" is selected for the source IPv6 filter, you can enter a specific SIPv6
mask. The field only supported last 32 bits for IPv6 address. Notice the usage of bitmask, if the binary bit
value is "0", it means this bit is "don't-care". The real matched pattern is [sipv6_address & sipv6_bitmask]
(last 32 bits). For example, if the SIPv6 address is 2001::3 and the SIPv6 bitmask is OxFFFFFFFE(bit O is
"don't-care" bit), then SIPv6 address 2001::2 and 2001::3 are applied to this rule.

Hop Limit: Specify the hop limit settings for this ACE. 0: IPv6 frames with a hop limit field greater than
zero must not be able to match this entry. 1: IPv6 frames with a hop limit field greater than zero must be
able to match this entry. Any: Any value is allowed ("don't-care").
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ICMP Parameters

ICMP Type Filter: Specify the ICMP filter for this ACE. Any: No ICMP filter is specified (ICMP filter status is
"don't-care"). Specific: If you want to filter a specific ICMP filter with this ACE, you can enter a specific
ICMP value. A field for entering an ICMP value appears.

ICMP Type Value: When "Specific" is selected for the ICMP filter, you can enter a specific ICMP value. The
allowed range is 0 to 255. A frame that hits this ACE matches this ICMP value.

ICMP Code Filter: Specify the ICMP code filter for this ACE. Any: No ICMP code filter is specified (ICMP
code filter status is "don't-care"). Specific: If you want to filter a specific ICMP code filter with this ACE, you
can enter a specific ICMP code value. A field for entering an ICMP code value appears.

ICMP Code Value: When "Specific" is selected for the ICMP code filter, you can enter a specific ICMP code
value. The allowed range is 0 to 255. A frame that hits this ACE matches this ICMP code value.

TCP Parameters

Source Port Filter: Specify the TCP/UDP source filter for this ACE. Any: No TCP/UDP source filter is
specified (TCP/UDP source filter status is "don't-care"). Specific: If you want to filter a specific TCP/UDP
source filter with this ACE, you can enter a specific TCP/UDP source value. A field for entering a TCP/UDP
source value appears. Range: If you want to filter a specific TCP/UDP source range filter with this ACE, you
can enter a specific TCP/UDP source range value. A field for entering a TCP/UDP source value appears.

Source Port No.: When "Specific” is selected for the TCP/UDP source filter, you can enter a specific
TCP/UDP source value. The allowed range is 0 to 65535. A frame that hits this ACE matches this TCP/UDP
source value.

Source Port Range: When "Range" is selected for the TCP/UDP source filter, you can enter a specific
TCP/UDP source range value. The allowed range is 0 to 65535. A frame that hits this ACE matches this
TCP/UDP source value.

Destination Port Filter: Specify the TCP/UDP destination filter for this ACE. Any: No TCP/UDP destination
filter is specified (TCP/UDP destination filter status is "don't-care"). Specific: If you want to filter a specific
TCP/UDP destination filter with this ACE, you can enter a specific TCP/UDP destination value. A field for
entering a TCP/UDP destination value appears. Range: If you want to filter a specific range TCP/UDP
destination filter with this ACE, you can enter a specific TCP/UDP destination range value. A field for
entering a TCP/UDP destination value displays.

Dest. Port No.: When "Specific" is selected for the TCP/UDP destination filter, you can enter a specific
TCP/UDP destination value. The allowed range is 0 to 65535. A frame that hits this ACE matches this
TCP/UDP destination value.

Destination Port Range: When "Range" is selected for the TCP/UDP destination filter, you can enter a
specific TCP/UDP destination range value. The allowed range is 0 to 65535. A frame that hits this ACE
matches this TCP/UDP destination value.

TCP FIN: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
Specify the TCP "No more data from sender” (FIN) value for this ACE. 0: TCP frames where the FIN field is
set must not be able to match this entry. 1: TCP frames where the FIN field is set must be able to match
this entry. Any: Any value is allowed ("don't-care").

TCP SYN: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
Specify the TCP "Synchronize sequence numbers” (SYN) value for this ACE. 0: TCP frames where the SYN
field is set must not be able to match this entry. 1: TCP frames where the SYN field is set must be able to
match this entry. Any: Any value is allowed ("don't-care").
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TCP RST: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
Specify the TCP "Reset the connection” (RST) value for this ACE. 0: TCP frames where the RST field is set
must not be able to match this entry. 1: TCP frames where the RST field is set must be able to match this
entry. Any: Any value is allowed ("don't-care”).

TCP PSH: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
Specify the TCP "Push” function (PSH) value for this ACE. 0: TCP frames where the PSH field is set must not
be able to match this entry. 1: TCP frames where the PSH field is set must be able to match this entry. Any:
Any value is allowed ("don't-care").

TCP ACK: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
Specify the TCP "Acknowledgment field significant" (ACK) value for this ACE. 0: TCP frames where the ACK
field is set must not be able to match this entry. 1: TCP frames where the ACK field is set must be able to
match this entry. Any: Any value is allowed ("don't-care").

TCP URG: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
Specify the TCP "Urgent Pointer field significant” (URG) value for this ACE. 0: TCP frames where the URG
field is set must not be able to match this entry. 1: TCP frames where the URG field is set must be able to
match this entry. Any: Any value is allowed ("don't-care").

UDP Parameters

Source Port Filter: Specify the TCP/UDP source filter for this ACE. Any: No TCP/UDP source filter is
specified (TCP/UDP source filter status is "don't-care"). Specific: If you want to filter a specific TCP/UDP
source filter with this ACE, you can enter a specific TCP/UDP source value. A field for entering a TCP/UDP
source value appears. Range: If you want to filter a specific TCP/UDP source range filter with this ACE, you
can enter a specific TCP/UDP source range value. A field for entering a TCP/UDP source value appears.

Source Port No.: When "Specific” is selected for the TCP/UDP source filter, you can enter a specific
TCP/UDP source value. The allowed range is 0 to 65535. A frame that hits this ACE matches this TCP/UDP
source value.

Source Port Range: When "Range" is selected for the TCP/UDP source filter, you can enter a specific
TCP/UDP source range value. The allowed range is 0 to 65535. A frame that hits this ACE matches this
TCP/UDP source value.

Dest. Port Filter: When "Specific" is selected for the TCP/UDP destination filter, you can enter a specific
TCP/UDP destination value. The allowed range is 0 to 65535. A frame that hits this ACE matches this
TCP/UDP destination value.

Destination Port Range: When "Range" is selected for the TCP/UDP destination filter, you can enter a
specific TCP/UDP destination range value. The allowed range is 0 to 65535. A frame that hits this ACE
matches this TCP/UDP destination value.

Ethernet Type Parameters
The Ethernet Type parameters can be configured when Frame Type "Ethernet Type" is selected.

EtherType Filter: Specify the Ethernet type filter for this ACE. Any: No EtherType filter is specified
(EtherType filter status is "don't-care"). Specific: If you want to filter a specific EtherType filter with this ACE,
you can enter a specific EtherType value. A field for entering a EtherType value appears.

Ethernet Type Value: When "Specific" is selected for the EtherType filter, you can enter a specific
EtherType value. The allowed range is 0x600 to OxFFFF but excluding 0x800(IPv4), 0x806(ARP) and
0x86DD(IPv6). A frame that hits this ACE matches this EtherType value.
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Access Control List Configuration Example

e —
TRANSITION - || TRANSITION : w .9 (I
— M 44T H
= : . - .
N NETWORKS.. G 508 - ~
SM16TAT2SA Access Control List Configuration ame - Assess Canral - Azsass ComwralLiss
Switch DMS
Auto-refresh | Refresh || Clear || Remove All
» System < . - ~ :
» Port Management ¢ ACE Ingress Port Frame Type Action Metering Mirror Counter
» PoE Management < 1 2 Any Permit Disabled Disabled Disabled o
b VLAN Management < 2 3 Ethernet Type- Oxffff Deny 1000000 Kbps Disabled 0 o
» Quality of Service ¢ 3 3 IPv4/ICMP DIP:0.0.0.0/24 Permit 1000000 Kbps Disabled 0 oz
» Spanning Tree §
P g o

» MAC Address Table <
» Multicast <
» DHCP <
¥ Security s
» Access Control hd

> Access Control List

% Arrace Crntenl Shatboe M

Control Icons

a Add ACE to end of list.
[:" Edit ACE on this line.

a Delete ACE on this line.
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12.7 Access Control Status

This page displays the Access Control status.

TRANSITIGN ™ Y
= — TTT
JRANSITION™ =] e S - - M e e
SM16TAT2SA Access Control Status EHome - Access Cortrel - Access Control Sistua
Switch DMS -
Auto-refresh Refresh |
» System < :
» Port Management < RS e
» PoE Management < Port State Re-open
» VLAN Management E -
1 None | ‘
» Quality of Service E —
» Spanning Tree @ 2 Nona | ‘
» MAC Addi Tabl < ]
ress |able 3 None | ‘
» Multicast < —
» DHCP < |4 None | \
i <
b Security 5 None | ‘
» Access Control > .
» Access Control List 6 None | ‘
» Access Control Status -
7 None | ‘
» SNMP e
» Event Notification < 8 None | ‘
» i < —_—
Diagnostics B None | ‘
» Maintenance <
1n Mena [ |

Port: The port number of the access control status.

State: Shows the current state of the port. It can take one of two values:

None: The port is normally used.
Shutdown: The port is shut down by ACL rule.

Re-open button: Click to recover the shutdown port that triggered by ACL rule.

Buttons
Auto-refresh: Check this box to refresh the page automatically. Automatic refresh occurs every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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This menu path displays the SNMP Trap, Syslog, and Event Notification menu options.

12.8.1 Switch > Event Notification > SNMP Trap

Navigate to the Switch > Event Notification > SNMP Trap menu path to display the SNMP Trap Hosts
Configuration table. Here you can add and configure up to six SNMP Trap hosts.

TR
TRaNSITION

SM16TAT2SA
Switch DMS

-

System

-

Port Management

-

PoE Management

-

VLAN Management

-

Quality of Service

-

Spanning Tree

-

MAC Address Table

-

Multicast

-

DHCP

-

Security

-

Access Control

-

SNMP
» Event Notification

> SNMP Trap

— || JTRANSITIGN®
AR

:
:

!
i
E

SNMP Trap Hosts Configuration

Delete No Name

Ooooooo

@

Apply ” Reset

Version Destination Address

Click a line to display its configurable parameters:

TRANSITION ® =| awerm

v NETWORKS

SM16TAT25A
Switch DMS

-

System

-

Port Management

-

PoE Management

-

VLAN Management

-

Quality of Service

-

Spanning Tree

-

MAC Address Table

-

Multicast

-

DHCP

-

Security

-

Access Control

-

SNMP

» Event Notification

> SNMP Trap

Parameters:

:

A
L]

Add SNMP Trap Host

Trap Host Settings

Mo

Trap Mode

Trap Version

Trap Community
Trap Destination Address
Trap Destination Port

Severity Level

Apply || Reset | Cancel

1

Dizabled ¥

vac

Emerg ¥

No: Displays the instance number for this line in the table.

Destination Port

Name: Indicates the community access string when sending SNMP trap packet.
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Trap Mode: Indicates the SNMP mode operation. Possible modes are:
Disabled: Disable SNMP mode operation (default).
UDP: Enable UDP SNMP mode operation. 5
TCP: Enable TCP SNMP mode operation. TeE

Disabled

Version: The SNMP version (v2c). Set SNMP trap supported version 2c.

Trap Community Name: Enter the SNMP community name. This is the community access string when
sending SNMP trap packet. The allowed string length is 0 to 255, and the allowed content is ASCII
characters from 33 to 126.

Destination Address: Indicates the SNMP trap destination address.

Destination Port: Indicates the SNMP trap destination port. SNMP Agent will send SNMP message via
this port, the port range is 1~65535.

Severity Level: At the dropdown select Emerg, Alert, Crit, Error, Warning, Notice, Info, Debug.
For SNMP traps, configure severity level as Debug. Indicates what kind of message will send to trap server.
Possible modes are:

Emerg:  Emergency; System is unusable. m

Alert: Action must be taken immediately.

e e EI.HE
Crit. Critical conditions. Alert
Error Error conditions. Crit

Warning: Warning conditions. I:f"cr.
Waming
Notice:  Normal but significant conditions.

. E
WOTIHCE

Info: Information messages. nfo
Debug: Debug-level messages. | Debug
Buttons

Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Cancel: Click to cancel the page edits.
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Example

The screen below shows six SNMP Trap Hosts configured:

»

-

-

-

-

-

-

-

-

-

-

-

2

Access Control
SNMP

Event Notification

> SNMP Trap
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TRANSITION ' =| wesmat L EEEE
N NETWORKS: TSR T T
SM16TAT2SA SNMP Trap Hosts Configuration
Switch DMS
Delete No Name Mode Version Destination Address
System
1 Bob TCP vac 192.168.1.10
Port Management
PoE Management O 2 admin TCP v2c 192.168.1.20
VLAN Management I:I 3 jeffs TCP v2c 192.168.1.30
lity of Servi
iy e O 4 adminz  TCP vac 192,168.1.30
Spanning Tree
D 5 admin2 TCP v2c 192.168.1.40
MAC Address Table
Multicast D 6 nnn uopP vac 192.168.1.66
DHCP —
| Apply || Reset
Security
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@ Homs

Destination Port

162

162

162

152

162

163

e c

Event Notiffication - SNMP Trap

Severity Level
Emerg

Alert

Crit

Error

Warning

Debug
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12.8.2 Switch > Event Notification > Syslog

The Switch > Event Notification > Syslog menu path provides the Syslog Configuration and View Log
menu options.

Syslog is a standard for logging program messages. It allows separation of the software that generates
messages from the system that stores them and the software that reports and analyzes them. It can be
used as well a generalized informational, analysis and debugging messages. It is supported by a wide
variety of devices and receivers across multiple platforms.

12.8.2.1 Syslog Configuration

Here you can enable System Logging and provide an IP Address for up to six Syslog servers.

Web Interface

To configure Syslog Configuration in the web interface:

1. Click Event Notification, Syslog, and Syslog Configuration.

2. At Mode, select “on” to enable Syslog globally.

3. Specify the syslog parameters including the IP Address of Syslog server and Port number.
4. Click Apply.

— ——
TRANSITION =|| T »'
N NETWORKS = | | @ C

SM16TAT2SA System Log Configuration @Hame - EventNotification - Syslog - Syslog Canfiguration
Switch DMS
Mode

b System €

» Port Management & Server 1

» PoE Management &

Server2

» VLAN Management &

» Quality of Service < Server3

» Spanning Tree < Server 4

» MAC Address Table &

Server 5

» Multicast &

» DHCP < Server 6

» Security < S

Apply || Reset

» Access Control & ‘—”—‘

» SNMP <

» Event Notification h

\
F nfiauratin

Figure 12-8.1: System Log Configuration page
Parameter descriptions:

Mode: Select the server mode of operation. When the mode is "on” (enabled) syslog messages will be
sent out to the configured syslog server. The syslog protocol is based on UDP communication and
received on UDP port 514 and the syslog server will not send acknowledgments back to the sender since
UDP is a connectionless protocol and it does not provide acknowledgments. The syslog packet is always
sent out even if the syslog server does not exist. Possible modes are:

On: Enable server mode operation.

Off: Disable server mode operation.

Server 1 to 6: Indicates the IPv4 hosts address of syslog server. If the switch provides DNS, it also can be a
host name (FQDN).
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Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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12.8.2.2 View Log
This page displays the switch system log (Syslog) information.

Web Interface
To display the log configuration in the web interface:
1. Click Event Notification, Syslog, and View Log.

2. Observe the log information.

.—ﬁ _—— ,
TRANSITION * =| Zewsmox - H o0&
Na——" NETWORKS
SM16TAT25A System Log Information @Home - Event Notificstion -~ Syslog - ViewLog
Switch DMS
‘ Refresh || Clear Logs
» System <
» Port Management < Show 1w v entries Search:
» PoE Management ¢ D “ Level Time Message
/LAN Manage <
VLA BT ETE ) WARM-START: Switch just made a warm
1 Warning 2017-01-01 00:00:04
¥ Quality of Service < boot.
» Spanning Tree ¢ 2 Info 2017-01-01 00:00:06 LACP: LACP was enabled on port 1 with key 1
» MAC Address Table ¢ 3 Info 2017-01-01 00:00:06 LACP: LACP was enabled on part 2 with key 1
» Multicast < -
e . ~ MGMT-IP-CHANGE: Management IPv4
4 Info 2017-01-01 00:00:09 .
» DHCP < address of interface VLAN 1 was changad
P Security £ 5 Info 2017-01-01 00:00:12 SFP: SFP module inserted on port 17
b Access Control ¢ 5 Info 2017-01-01 00:00:12 SEP: SEP module inserted on port 12
b SNMP < -
T Info 2017-01-01 00:00:13 POE-FD-ON: Port 5 POE FD on
8 Info 2017-01-01 00:00:13 POE-PD-ON: Port 6 PoE PD on

LINK-UPDOWN: Interface GigabitEthernet

9 Warning 2017-01-01 00:00:13 R
1/2, changed state to up.
) R n N LINK-UPDOWN: Interface GigabitEthernet
10 Warning 2017-01-01 00:00:13 R
1/5, changed state to up.
» Diagnostics < Showing 1to 10 of 20 entries n 2 3 Next

} Maintenance <
Figure 12-8.2: The System Log Information page
Parameter descriptions:
ID: ID (>= 1) of the system log entry.
Level: the level of the system log entry. The following level types are supported:
Debug: debug level message.
Info: informational message.
Notice: normal, but significant, condition.
Warning: warning condition.
Error: error condition.
Crit: critical conditions.
Alert: action must be taken immediately.
Emerg: system is unusable.

Time: Displays the log record by device time; the time of the system log entry.

Message: Displays the log detail message; the message of the system log entry (e.g., LINK-UPDOWN).
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Search: Lets you search for the information that you want to view.

Show entries: Lets you choose how many items you want to view per page (i.e., 10, 25, 60, ALL).

Buttons

Refresh: Updates the system log entries, starting from the current entry ID.

Clear Logs: Clears all the system log entries and display “No data available in table".
Next: Updates the system log entries, turn to the next page.

Previous: Updates the system log entries, turn to the previous page.

System Log Message Examples

Warning LINK-UPDOWN: Interface GigabitEthernet 1/1, changed state to up.

Warning WARM-START: Switch just made a warm boot.

Info LOGIN: Login passed for user 'admin’

Info LOGOUT: User " logout

Warning SFP: Interface GigabitEthernet 1/17 rx power 0.00 exceeds Alarm-Low Limitation
Warning POE-PD-OFF: Port 3 PoE PD off

Warning LINK-UPDOWN: Interface GigabitEthernet 1/7, changed state to up.

Info SFP: Interface GigabitEthernet 1/17 rx power 0.00 exceeds Alarm-Low Limitation
Info LACP: LACP was enabled on port 2 with key 1

Alert MGMT-IP-CHANGE: Management IPv4 address of interface VLAN 1 was changed
Info POE-PD-ON: Port 3 PoE PD on
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12.8.3 Event Configuration

The Event Notification > Event Configuration page displays the Event Configuration table. Here you can
view and configure severity levels, Syslog status, and Trap status for each Group Name.

TRANSITION © = | wwener ' Hec
— o -
N NETWORKS
SM16TAT2SA Event Configuration #Fame - Svemsioificetion - Evert Canfizurasion
Switch DMS
Group Name Severity Level Syslog Trap
¥ System
2. s |
» Port Management < BOZ.IX ° N U
» PoE Management ~ ACCESS-MGMT e v O
» VLAN Management <
ACL S ]
» Quality of Service <
» Spanning Tree < AUTH-FAILED Waming ¥ 8
» MAC Addres ble <
MAC Address Table COLD-START Werming ¥ O
» Multicast <
» DHCP 5 LACE " ! -
» Security ¢ LINK-UPDOWN Werming ¥ O
» Access Control <
LOGIN o ¥ O
<
v LOGOUT fo ¥ O
LOOP-PROTECTION nfo v D
<
MAC-TABLE v O
» Diagnostics <
MAINTENANCE nfo v D
» Maintenance <
MGMT-IP-CHANGE nfo v D
OVER-MAX-POE-POWER-
v v
LIMITATION ° O
Parameters:

Group Name: The name identifying the severity group.

Severity Level: Every group has a severity level. The following level types are supported:

Emergency: System is unusable.

Alert: Action must be taken immediately.
Critical: Critical conditions.

Error: Error conditions.

Warning: Warning conditions.

Notice: Normal but significant conditions.

Information:  Information messages.

Debug: Debug-level messages.
Syslog: Check the checkbox to enable Syslog for this Group Name.
Trap: Check the checkbox to enable Syslog for this Group Name.
Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Chapter 13 - Diagnostics

b Diagnostics

This module provides basic system diagnostics that help you determine system health. > Ping
The diagnostics include Ping, Traceroute, Cable Diagnostics, and Mirroring. » Traceroute

. » Cable Diagnosti
13-1 Ping Hisenesties

> Mirroring

This page lets you issue ICMP PING packets to troubleshoot IPv4 or IPv6 connectivity issues.

Web Interface

To configure a PING in the web interface:
1. Click Diagnostics and Ping.
2. Specify IP Address, IP Version, Ping Length, and Ping Count.

3. Click Start.
—
TRANSITION © = e *
" NETWORKS. = " .
SM16TAT2SA Ping T
Switch DMS
o dess 192.162.1.77
» System <
» Port Management < |P Version — =
» PoE Management < Ping Length )
» VLAN Management <
Ping Count .
» Quality of Service <
» Spanning Tree <

| Start |

» MAC Address Table < N

» Multicast E

PING 192.168.1.77 (192.168.1. 77): 56 data bytes

64 bytes from 192.168.1. 772 5eq=0 /=64 time<Ims
» Security < 64 bytes from 192.168.1. 77: seq=1 tti=64 time<Ims
&4 bytes from 192.168.1. 77. seq=2 tti=64 time<Ims

» DHCP <

» A Control <

frcess bontre 64 bytes from 192.168.1. 77: seq=3 til=64 time<Ims
» SNMP < 64 bytes from 192.168.1. 77 seq=4 tt/=64 time<1ms
» Event Notification e

— 192.168.1. 77 ping statistics —
5 packets transmiitted, 5 packets received, 09 packet loss
> Ping round-trip minyavg/max = 0.0/0.0/0.0 ms

* Diagnostics

> Traceroute

> Cable

> Mirroring

» Maintenanra <

Figure 13-1: Ping Diagnostic page

Parameter descriptions:

IP Address: Enter the IP Address of the device that you want to ping.

B

VG

IP Version: Select the required IP Version (IPv4, IPv6, or Domain Name). omain Mame

[w]

Interface VLAN: Specify an interface vlan for sending ICMPv6 Echo packets.

Ping Length: The payload size of the ICMP packet. Values range from 1 - 1452 bytes.
Ping Count: The count of the ICMP packet. Values range from 1 time to 60 times.
Start: Click the “Start” button to start to ping the target IP address.
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After you press Start, five ICMP packets are transmitted, and the sequence number and roundtrip time are
displayed upon reception of a reply. The page refreshes automatically until responses to all packets are
received, or until a timeout occurs.

Successful Ping:

PING 192
64 bytes
64 bytes
64 bytes
64 bytes
64 bytes

--- 192.

.168.1.77

from
from
from
from
from

168.1.

Failed Ping:

PING 192.168.1.32 (192.168.1.32):
out.
out.
out.
out.
out.

Request
Request
Request
Request
Request

--- 192

timed
timed
timed
timed
timed

.168.1.

Messages:

192.
192.

192

192

(192.168.1.77)

: 56 data bytes

168.1.77: seq=0 ttl=64 time=0

168.1.77: seqg=

.168.1.77: seq=
192.

168.1.77: seq=

77 ping statistics
5 packets transmitted, 5 packets
round-trip min/avg/max = ©.000/0

32 ping statistics
5 packets transmitted, © packets

Please enter a valid IP v4 address.

Please enter a valid IP v6 address.

1 ttl=64 time=0
2 ttl=64 time=0
3 ttl=64 time=0

.168.1.77: seq=4 ttl=64 time=0.

received, 0% packet loss

.000/0.000 ms

56 data bytes

received, 100% packet loss

Please enter a valid domain name address.
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13-2 Traceroute
This page allows you to issue ICMP or UDP packets to diagnose network connectivity issues.
Web Interface

To configure a Traceroute in the web interface:

1. Click Diagnostics and Traceroute.

2. Specify IP Address, IP Version, IP Protocol, Wait Time, Maximum TTL, and Probe Count.
3. Click Start.

TRANSITION © = | e . H oo
N \E WORKS -
SM16TAT2SA Traceroute @ Home - Diagnostics - Traceroute
Switch DMS
IP Address 102.168.70.114

» System s
» Port Management < IP Version Py v

Y ¢
» PoE Management IP Protocol e
» VLAN Management ¢

. . Wait Time 5
» Quality of Service &
» Spanning Tree & Maximum TTL 20
» MAC Address Table s

Probe Count
» Multicast 3
¢

b DA | start |
» Security <
» Access Control &
b SNMP ¢ traceroute to 192.168.70.114 (192.168.70.114), 30 hops max, 38 byte packets
» Event Notification < 1192.168.70.114 0.000 ms 0.000 ms 0.000 ms
» Diagnostics M
> Ping
> Traceroute

Figure 13-2: The Traceroute page
Parameter descriptions:
IP Address: The destination IP Address.
IP Version: Select the IP Version (IPv4, IPv6, or Domain Name).
IP Protocol: The protocol ICMP or UDP) packets to send.
Egress Interface: Specify an egress interface for sending traceroute packets. Only used in IPv6.

Wait Time: Set the time (in seconds) to wait for a response to a probe (default 5.0 sec). Values range from
1 to 60. The payload size of the ICMP packet. Values range from 2 bytes to 1452 bytes.

Maximum TTL: Specify the maximum number of hops (max time-to-live value) traceroute will probe.
Values range from 1 to 255. The default is 30.

Probe Count: Sets the number of probe packets per hop. Values range from 1 to 10. The default is 3.

Button

Start: Start traceroute to the IP address that you selected.

Message: traceroute: can't connect to remote host: Network is unreachable
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13-3 Cable Diagnostics

This section is used for running the Cable Diagnostics for copper ports. Press Start to run the diagnostics.
This will take approximately 5 seconds. If all ports are selected, this can take approximately 15 seconds.
When completed, the page refreshes automatically, and you can view the cable diagnostics results in the
cable status table. Note that this is only accurate for cables of length 7 -140 meters. The 10 and 100 Mbps
ports will be linked down while running; running on a 10 or 100 Mbps management port will cause the
switch to stop responding until it is complete.

The cable length reported could have a plus or minus 3 meter inaccuracy if the diagnostic port to be
checked is link down, and it could have a plus or minus 15 meter inaccuracy if the diagnostic port to be
checked is link up. Note that the port link up on 10M speed is not supported.

Web Interface

To configure a Cable Diagnostics Configuration in the web interface:
1. Click Diagnostics and Cable Diagnostics.
2. Se the Port that you want to check.

3. Click Start.
TRANSITION \ = weo® a oG
N NETWORKS.: =
SM16TAT2SA Cable Diagnostics #iHoms - Disgrostics - Cabls Disgnostics
Switch DMS
Fort1n ¥ | Start |
b System <
» PortManagement ¢ Cable Diagnostics Status
X eme
¥ PoE Management i Port Link Status Test Result Length
JLAN M o < . .
2 AR TR 1 Link Down Abnormal 0.00 (m})
¥ Quality of Service < o
2 Link Down Abnormal 4.55 (m}
» Spanning Tree <
3 16 oK 16.00 (m)
» MAC Address Table <
R, < 4 Link Down Abnormal 0.00 {m}
Y
» DHCP A |5 10/100M oK 10.00 (m)
» Security < 6
> Access Control & 7 10/100M oK 2.00 (m)
» SNMP < 8
» Event Notification < X o
9 10/100M oK 2.00 (m)
» Diagnostics d
10 10/100M oK 0.00 {m)

> Ping

Figure 13-3: Cable Diagnostics page
Parameter descriptions:

Port : At the dropdown, select he port number on which you want to run Cable Diagnostics.

Cable Diagnostics Status

Port: The Port number you are requesting Cable Diagnostics.

Link Status: Provides the current link speed of the port (e.g., 1G or Link Down).
Test Result: The status of the cable pair being diagnosed (e.g., OK or Abnormal)
Length: The length (in meters) of the cable pair.
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Button

Start : Start cable diagnostics on the port that you selected.

Message: The cable length reported could have a plus or minus 3 meter inaccuracy if the diagnostic port
to be checked is link down, and it could have a plus or minus 15 meter inaccuracy if the diagnostic port to
be checked is link up.

Meaning: informational message only, detailing the accuracy of the diagnostic in certain conditions.
Recovery: None; click the OK button and continue operation.
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13-4 Mirroring

You can mirror traffic from any source port to a target port for real-time analysis. You can then attach a
logic analyzer or RMON probe to the target port and study the traffic crossing the source portin a
completely unobtrusive manner.

Mirror Configuration is used to monitor the traffic of the network. For example, assume that Port A and
Port B are Monitoring Port and Monitored Port respectively; the traffic received by Port B will be copied to
Port A for monitoring.

Web Interface

To configure the Mirror in the web interface:

Click Diagnostics and Mirroring.

2. Scroll to select Monitor Destination Port on which port.
3. Scroll to disabled, enable, TX Only and RX only to set the Port mirror mode.
4. Click the Apply button to save the setting.
5. To cancel the setting click the Reset button to revert to previously saved values.
o — .
TRANSITION © = | e 5
\.f’r\t_u.';ol-ms - L J H 9 C
SMlGTATZSA Mirror Conﬁgu ration @ Home - Diagnostics - Mirroring
Switch DMS
Mode u‘
> System g ’
» Port Management < Monitor Destination Port Port2 ﬂ
» PoE Management <
» VLAN Management < Monitor Source Port Configuration
3 i <
» Quality of Service Port Mode
» Spanning Tree ¢
1 D\sab.edﬂ
» MAC Address Table g
» Multicast < 2 Disabled V]
¢
> DHCP 3 Tx only ﬂ
» Security 4
» Access Control < ‘ cnabled [
» SNMP € 5 Disabled ||
. p
» Event Notification 5 ——
» Diagnostics h
> Ping 7 D\sab.edﬂ
> Traceroute e D\sab.edﬂ
> Cable Diagnostics
> Mirroring 9 D\sab.edﬂ
» Maintenance & an I

Figure 13-4: Mirror Configuration page
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Mirror Configuration:
Mode: Indicates the Mirror mode operation. Possible modes are:

on: Enable Mirror mode operation.

off: Disable Mirror mode operation.

Monitor Destination Port : Port to output the mirrored traffic. Also known as the mirror port. Frames
from ports that have either source (rx) or destination (tx) mirroring enabled are mirrored on this port.

Mirror Source Port Configuration:
Port: The logical port for the settings contained in the same row.
Mode: Select mirror mode:

Rx only: Frames received on this port are mirrored on the mirror port. Frames transmitted are not
mirrored.

Tx only: Frames transmitted on this port are mirrored on the mirror port. Frames received are not
mirrored.

Disabled: neither frames transmitted nor frames received are mirrored.

Enabled: Frames received and frames transmitted are mirrored on the mirror port.

@ NOTE: For a given port, a frame is only transmitted once. So it is not possible to mirror
Tx frames on the mirror port. Because of this, the mode for the selected mirror port is
limited to Disabled or Rx only.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Chapter 14 - Maintenance > Maintenance

» Configuration
This chapter describes the switch Maintenance configuration tasks to enhance the > Savestartup-config
performance of local network including Save, Backup, Restore, Activate, Delete, Restart > Backup
Device, Factory Defaults, and Firmware upgrade and Firmware Selection. > Restore

> Activate

14-1 Configuration > Delete
The switch stores its configuration in a number of text files in CLI format. ? RS

The files are either virtual (RAM-based) or stored in flash on the switch.

There are three system files: N —

e running-config: A virtual file that represents the currently active configuration on
the switch. This file is volatile. The config settings must be different than the default settings.

e startup-config: The startup configuration for the switch, read at boot time.

o default-config: A read-only file with vendor-specific configuration. This file is read when the system
is restored to default settings.

It is also possible to store up to two other files and apply them to running-config, thereby switching

configuration.

14-1.1 Save startup-config

This will copy the running-config to startup-config, thereby ensuring that the currently active
configuration will be used at the next reboot.

Web Interface
To save running configuration in the web interface:
1. Click Maintenance, Configuration, Save startup-config.

2. Click Save Configuration.

TRANSITION © =| @wsoar ., H oG
e NETWORKS
SM16TAT2SA Save Running Configuration to startup-config @Home - Maintanancs - Configuration - Sava startup-config
Switch DMS
» System < Please note:
» Port Management < The generation of the configuration file may be time consuming, depending on the amount of non-default configuration.
» PoE Management <
b VLAN Management < onfiguration ‘
» Quality of Service <
Figure 14-1.1: Save Running Config to Startup Config
Button

Save Configuration: Click to save configuration; the running configuration will be written to flash
memory for system boot up to load this startup configuration file. When done, the message “startup-
config saved successfully.” displays. Note: The generation of the configuration file may be time consuming,
depending on the amount of non-default configuration.
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14-1.2 Backup Configuration

This webpage lets you export the Switch Configuration for maintenance needs. Any current configuration
files will be exported as text format.

If the file system is full (i.e., contains the three system files mentioned above plus two other files), it is not
possible to create new files, but an existing file must be overwritten or another deleted first.
Web Interface
To download configuration in the web interface:
1. Click Maintenance, Configuration, and Backup.
2. Select running-config, default-config, or startup-config for backup.

3. Click the Backup button. At the prompt select “Save”. Select Open or Save or View Download.

‘ﬁ I
TRANSITION * =| Ismo = (> I
N NETWORKS
SM16TAT2SA Backup Configuration File @Home - Maimenznce - Configurstion - Backup
Switch DMS
Select configuration file for backup.
b System < Please note: running-config may take a while to prepare for download.
» Port Management .
- File Name
» PoE Management <
» VLAN Management < (S LT L
» Quality of Service < () default-config
» Spanning Tree < () startup-config
» MAC Address Table <
b Multicast < | |

— -

Figure 14-1.2: Backup Configuration

Parameter descriptions:

running-config: A virtual file that represents the currently active configuration on the switch. This file is
volatile. The config settings must be different than the default settings.

default-config: A read-only file with vendor-specific configuration. This file is read when the system is
restored to default settings.

startup-config: The startup configuration for the switch, read at boot time.

Buttons

Backup : Click the “Backup” button then the switch will start to download the configuration from flash
memory to the PC or Server. Note: running-config may take a while to prepare for download.

Note: At firmware v1.01.1201, the Backup config file name will automatically include the device's IP
address and date.
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Sample running-config file in WordPad:

r
E,‘, | & = | running-config - WordPad @M
Home View @

D cut Courier New 11 | AAT ?.I-f__ ]}] €% Find

Copy E’,':,0 Replace

Paste B 7 U ahe X 3|52~ A~ Picture Paint Dateand Insert
- = — | - drawing time object Select all
Clipboard Font Paragraph Insert Editing
530 s 00 0 s -g- IR S R B R B S B R S N B S R S I D S AN BN

»

Llsername admin privilege 15 password encrypted YWRtaW4=
|

vlan 1

spanning-tree

trap 1 v2c 192.168.33.25 6 public

event group ACCESS-MGMT trap enable
event group ACL trap enable

event group ARP-INSPECTICN trap enable
event group AUTH-FAILED trap enable
event group COLD-START trap enable
event group DHCF trap enable

event group DHCP-SNCCPING trap enable
event group DOT1X trap enable

event group IP-SCOURCE-GUARD trap enable
event group LACP trap enable

event group LINEK-UPDOWN trap enable
event group LOGIN trap enable

event group LOGOUT trap enable

event group LOCP-PRCTECTICN trap enable
event group MAC-TAELE trap enable

event group MAINTENANCE trap enable
event group MGMT-IP-CHENGE trap enable
event group PORT trap enable

event group PORT-SECURITY trap enable
event group RMON trap enable

event group SFP trap enable

event group SPANNING-TREE trap enable
event group SYSTEM trap enable

event group USER trap enable L
event group WARM-START trap enable
1

interface GigabitEthernet 1/1

no spanning-tree edge

1

interface GigabitEthernet 1/2

no spanning-tree edge
1

m

interfarae GimahitFrhernat 1

100%
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14-1.3 Restore Configuration

It is possible to import a file from the web browser to all the files on the switch, except default-config,
which is read-only. Select the source file to restore, and select the destination file on the target..

Web Interface

To restore a configuration via the web interface:
1. Click Maintenance, Configuration, and Restore.
2. Browse to and select a Source File.
3. Click the Restore button.

‘ﬂ I .
TRANSITION ° =| Zsmo - H 0 ¢
N NETWORKS
SM16TAT2SA Restore Configuration @Home - Maintenance - Configuration - Restore
Switch DMS
Source File Choose File | Mo file chosen
b System <
P Tl 3pa €
D [P Y T Destination File
» PoE Management <
File Mame Parameters
» VLAN Management <
» Quality of Service < (O running-config ® Replace () Merge
» Spanning Tree < () startup-config
MAC A < _
b MAC Address Table (O Create new file
» Multicast <
» DHCP <l |

Figure 14-1.3: Restore Configuration

There are three destination file name selections:

running-config: A virtual file that represents the currently active configuration on the switch. This file is
volatile. You can select "Replace” the existing file, or “Merge” the existing running-config file with the new
file. If the destination is running-config, the file will be applied to the switch configuration.

This can be done in two ways:

Replace: The current configuration is fully replaced with the configuration specified in the source file.
Merge: The source file configuration is merged into running-config.

startup-config: The startup configuration for the switch, read at boot time.

Create new file: A read-only file with vendor-specific configuration. This file is read when the system is
restored to default settings.

Buttons
Browse: Click the browse button to search for the configuration text file and filename.

Restore: Click the "Restore” button then the running web management PC will start to upload the
configuration from the location PC configuration into the managed switch.

Message: The config file is uploaded successfully.
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14-1.4 Activate config
It is possible to activate any of the configuration files present on the switch, except for running-config
which represents the currently active configuration.
Select the file to activate and click. This will initiate the process of completely replacing the existing
configuration with that of the selected file.
Web Interface
To activate configuration in the web interface:

1. Click Maintenance, Configuration, and Activate Configuration.

2. Select the File Name to be activated.

3. Click the Activate Configuration File button.

4-“ I .
TRANSITION © =| @ o= Hoc
Na—"" NETWORKS
SM1GTAT2ZSA )E\Cti\fate Conﬂguratlﬂn @&Home - Maintznance ~ Configuration - Activate
Switch DMS
b System < Activate File Name
» Port Management < O startup-config
» PoE Management s
» VLAN Management s A -
Activate Configuration File |

» Quality of Service <

Figure 14-1.4: Activate Configuration

Parameter descriptions:

Activate: Click to activate the selected file.
Buttons

Activate Configuration File: Click the button then the selected file will be activated and will become this
switch's running configuration.
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14-1.5 Delete config
It is possible to delete any of the writable files stored in flash, including startup-config. If this is done and
the switch is rebooted without a prior save operation, this effectively resets the switch to its default
configuration.
Web Interface
To delete configuration in the web interface:

1. Click Maintenance, Configuration, Delete config.

2. Click Delete Select.

TRANSITION ® =| @ smxasas . | M OO
== o e
VNETWOHKS- NuiEw wawy = T
SM16TAT25A Delete COnﬁgUratTOn @Home - Maintenance - Configuration = Delete
Switch DMS
b System ¢ Delete File Name
» Port Management <
Delete Configuration File
» PoE Management &

Figure 14-1.5: Delete Configuration

Parameter descriptions:

Delete: Select the file that you want to be deleted.

Buttons

Delete Configuration File: Click the button then the selected file will be deleted.
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14-2 Restart Device

This webpage lets you restart switch for any maintenance needs. Any configuration files or scripts that you
saved in the switch should still be available afterwards.

Web Interface
To configure a Device Restart in the web interface:

1. Click Maintenance and Restart Device.

2. Click Yes.
TRANSITION ' = mwsmd - M O &
=| = —
e NETWORKS
SM16TAT25A Restart Device @Home - Maintenance - Restart Device
Switch DMS
» System & Are you sure you want to perform a Restart?
» Port Management <
» PoE Management < | - | |_|
» VLAN Management &

Figure 14-2: Restart Device

Parameter descriptions:

Restart Device: You can restart the switch on this page. After restart, the switch will boot normally.

Buttons
Yes: Click "Yes" to restart the device.

No: Click to undo any restart action and return to the System Configuration page without restarting the
configuration.
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14-3 Factory Defaults

This webpage lets you reset the Switch configuration to Factory Defaults. Any configuration files or
scripts will recover to factory default values.

Web Interface

To reset the switch configuration to its Factory default settings in the web interface:
1. Click Maintenance and Factory Defaults.
2. Check the box if you want to keep the current IP configuration.

3. Click Yes.
TRANSITION ' =| owsndd sz M QG
N NETWORKS.
SM16TAT25A Restore Configuration to Factory Default @Home - Maintenance  Factory Defaults
Switch DMS
b System & Are you sure to restore configuration to
?
» Port Management < factory default ?
» PoE Management <
b VLAN Management < L KeepIPConfiguretion
» Quality of Service < | Yes | | No |
Figure 14-3: Restore Config to Factory Defaults
Buttons

Keep IP Configuration: Check if you want to keep the current IP address configuration after the restore is
completed.

Yes: Click the button to reset the configuration to Factory Defaults.

No: Click to undo any restore action and return to the System Configuration page without restoring the
configuration.
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14-4 Firmware

This webpage lets you upgrade and select Firmware. The Switch can be enhanced with value-added
functions by installing firmware upgrades. Note: Password encoding is changed in FW v1.02.1409. You
cannot login if downgrading the switch to older firmware versions or loading an old config file in new
firmware.

14-4.1 Firmware Upgrade

This page facilitates an update of the firmware controlling the switch.

Web Interface

To configure a Firmware Upgrade Configuration in the web interface:
1. Click Maintenance, Firmware, and Firmware Upgrade.
2. Browse to and select the file to upgrade the switch to (e.g., SM16TAT2SA _Transition_201702024.tgz).

3. Click the Upload button. Continue operation when the message “Firmware upgrade in progress
Completed!" displays.

— — : .
TRANSITION © = woens = H oG
N NETWORKS ;

SMI16TAT2SA Firmware Upgrade @ Home - Maintenance - Firmware - Firmware Upgrade
Switch DMS
Firmware File Choose File | Mo file chosen
b System <
» Port Management < | Upload

o~ €

Figure 14-4.1 Software Upload page
Buttons:

Choose File: Click the button to search for the Firmware filename.

@ NoTE: This page facilitates an update of the firmware controlling the switch. A Software
Upload will update the managed switch to the software image at the specified location.
After the software image is uploaded, a page announces that the firmware update is
initiated. After about a minute, the firmware is updated and the switch restarts.

A WARNING: While the firmware is being updated, Web access appears to be defunct. The
front LED flashes Green/Off with a frequency of 10 Hz while the firmware update is in
progress. Do not restart or power off the device at this time or the switch may fail to
function afterwards.

Messages:

Message: Error : The firmware is already update.
Meaning: You are trying to upgrade to the current (existing) firmware version.
Recovery: Verify that you are upgrading to the latest version.

Message: The firmware update was successful.
Meaning: The software was successfully updated.
Recovery: None required.
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Message: Firmware upgrade in progress  Waiting, please stand by...

Waiting, please stand by...

Meaning: While the firmware is being updated, do not restart or power off the switch or it may fail to
function afterwards.
Recovery: None. Wait for the upgrade to complete.

Message: Error : The firmware image is invalid. Please use a correct firmware image.

Meaning: You tried to upload an invalid firmware file.

Recovery: Check the file format and location. Make sure the firmware filename prefix matches your
specific switch model (e.g., sm16tat2sa).

Message: Firmware upgrade in progress

The uploaded firmware image is being transferred to flash.
The system will restart after the update.

Until then, do not reset or power off the device!

Waiting, please stand by...
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14-4.1 Firmware Selection

This page lets you activate an alternate firmware image. This page provides information about the active
and alternate (backup) firmware images in the device and allows you to activate the alternate image.
The web page displays two tables with information about the active and alternate firmware images.

Note: Password encoding is changed in FW v1.02.1409. You cannot login if downgrading the switch to
older firmware versions or loading an old config file in new firmware.

Navigate to the > Maintenance > Firmware > Firmware Selection menu path to display the Firmware
Selection page.

‘ﬂ R
TRANSITION © =| owsnss ——1 = ©c
NETWORKS
SMI16TAT2SA Firmware Selection @ Home - Mzintenance - Firmware - Firmware Salaction
Switch DMS
Active Image
» System <
» Port Management < Partition primary
b PoE Management % Version v1.02.1415
¥ VLAN Management < Date 2019-08-01 19:50:58 UTC
b Quality of Service <
b Spanning Tree < Alternate Image
MAC A < -
b MAC Address Table Partition secondary
» Multicast < .
Version v1.02.1409
b DHCP <
Date 2019-07-1912:37:34 UTC
» Security <
b Access Control < Activate Alternate Image || Cancel
Parameters:

Active Image

Partition: Indicates whether “primary” or “secondary” partition in the flash is used for storing the firmware
image.

Version: The active firmware version (e.g., v1.02.1409).
Date: The active firmware build date (2019-06-21 16:11:42 UTC).

Alternate Image

Partition: e.g., “secondary” firmware image.

Version: The alternate firmware version (e.g., v1.02.1398).

Date: The alternate firmware build date (e.g., 2018-09-10 11:53:39 UTC).

Buttons:
Activate Alternate Image: Click the button to activate the Alternate Firmware image.

Cancel: Click to cancel the page edits.
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Chapter 15 - DMS (Device Management System)

. . . : . SM16TAT2SA
The Transition Networks DMS (Device Management System) is an intelligent
management tool embedded in the switch to intuitively help IT/TS in reducing Switch DMS
support time, cost, and effort. > DMS Mode
In the SMXTAT2SA main menu pane on the left, navigate to the DMS tab to display » Graphical Monitering ™

the main DMS features: DMS Mode, Graphical Monitoring, Management, and > Topology View
Maintenance. > Floor Vie

DMS features include: > Map View

e DMS automatically discovers and displays all devices connected to the switch > Management

using standard networking protocols such as LLDP, UPnP, ONVIF, etc.

» Device List
> Map APl Key
e DMS supports up to 256 devices within four subnets.
» Maintenance

e DMS operates via an intuitive web GUI to allow you to: g ——

o Power down the IP cameras, NVRs, or any PoE devices.

o Remotely identify the exact cable break location.

o Detect abnormal traffic issues on IP cameras/NVR.

o Monitor devices' status (e.g., link up, PoE power, traffic, etc.).

o Configure VLAN/QoS intuitively for better solution quality/reliability.
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15-1 DMS Mode - DMS Controller Switch

You can configure DMS mode and monitor device numbers/ DMS Controller Switch IP.
e DMS is controlled by the DMS Controller switch, as specified by DMS Mode selection.

e The DMS Controller Switch is in charge of syncing DMS information in order to manage Topology
View, Floor View, and trap event / data polling / DHCP server assignment.

DMS Controller : Managed Devices .» i ,_lp to 256 devices within 4 subnets
Switch 1 .
1 the device 13 a Switch
3 secure 1 ’
a secur
1 (=" g :
: . 7; ] the device is a PC
I .
: ™ s p»>  the device is an IP Camera
I f .
: }: ,E the device is an [P Phone.
[am=s ]
]
' ¥ - : A
1 &= the device is an AP
1 .
1 wa 7 ‘h
1 =3 the device is a Router
1
| Q- 2 P device detectad by DMS, but device type not recognized
: (“unknown” device type)

DMS Controller Switch and Managed Devices
Note:

1. If there are more than two Switches set as High-priority or no High-priority mode switch, the Switch
with the longer system uptime will be the DMS Controller switch. If two switches have same up time,
the switch with the smaller MAC address will be assigned as the DMS Controller Switch.

2. You can set two switches to High Priority for Controller Switch redundancy.

3. The DMS Controller Switch should be put in a secure location such as a server room, with
access/authority limited to IT staff.

4. The DMS Controller Switch is the center of IP / Event management to operate the DMS:

a. When enabled DHCP Server mode in DMS network, the DMS Controller switch is responsible for
assigning IP address for all devices.

b. The DMS Controller Switch will Collect, Poll, and Sync DMS information, and act as the Event
Notification control center to manage all device information.
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15-2 DMS Mode

1. Click the DMS tab to display the startup DMS page:

2. At the DMS Mode dropdown select High Priority or Enabled.

3. Click the Apply button. The DMS menu updates.

TRANSITION © =| msa s G
— e o
N NETWORKS
SM16TAT2SA Information @ Home - DMSHode
Switch DMS |
DMS Mode Enabled ¥
> DMS Mode
» Graphical Monitoring ™ DMS Priority
» Topology View High
Total Devices Mid
Low
> Map View On-line Devices | Nen
» Management v Off-line Devices 0
Controller IP 192.168.1.77

» Maintenance - | Apply |

» Floor image

DMS Mode Information parameters

DMS Mode: At the dropdown select Enabled or Disabled. The default is Enabled.

DMS Priority: At the dropdown select High, Mid, Low, or Non. .
High: Choose "High" to make this switch the DMS Controller switch (Master switch). -
Mid: Makes this switch a middle priority.
Low: Makes this switch a low priority. |r_-:-
pislnl

Non: The switch will never become the controller.
Total Devices: Displays the Total / On-line/ Off-line Devices count in the DMS network (read only).
On-line Devices: Displays the total number of discovered devices that are currently on line (e.g., 7).
Off-line Devices: Displays the total number of discovered devices that are currently off line (e.g., 1).

Controller IP: Displays the active DMS Controller Switch’s IP Address (read only).

DMS Mode Buttons
Apply: Click to save changes.
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156-3 Graphical Monitoring

Navigate to the DMS > Graphical Monitoring menu path to view the options of DMS Graphical
Monitoring Topology View, Floor View, and Map View.

15-3.1 Topology View

SMXTAT2SA Web User Guide

Navigate to the DMS > Graphical Monitoring > Topology View menu path. Note that FW v1.02.1327 adds

automatic logout when the screen is idle for over 10 minutes on the DMS Topology View page.

Click the @ button to display the right pane menu tabs (Device, Group, and Config).

e

——
JRANSITION =

» Management <

» Maintenance <

L ST 7 .
seew =™ “ H oo
SM8TAT2SA Topology View @Home - GraphicalMonitoring - Tosology View
Switch DMS —_—
s n’l, Device | Group Config
M + O¢
> DMS Mode 'J;?N (an M © BEYE [~]
» Graphical Monitoring ™ -
2 —

]

SMATAT25A

192188901

QE Port 1 (0.015VE)

M3025

—~ >
The Topology View icons and controls are shown below.
Zoom in or zoom out :
e . Show/ hide
display area __— Specified DMS Controller Switch Device/Group/Config
Show / hide tabs Save Configuration
the menu Click to display a port’s detailed statistics Help
\ . Log Out

* Maintenance <

Click:anywhere and drag to move the
display area up/down/left/right

33717 Rev.D
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an e TR
S = 88353888 m m
SM1ETAT25A Togology View Click to sort, filter, or
Switch DMS o configure basic settings
==
> CrEE {e.g., VLAN, QoS).
» Graphical Monitoring ¥ Fad ;
L Show:all / show graphic only
2
= Click to select the set of
.=7? information to be displayed
» Management ¢ (MAC, P, PoE power, etc.).
G

Click to zoom in'on an
individual device

A Black device icon indicates-device is operating normally. Click a device
icon to show its device consale

A Red device icon indicates the device is operating abnormally.

A Red circled device number shows the number of alarm notifications for
the device,

A Red circled question mark indicates an unknown type detected; you can
select its type from a pre-defined list,
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Topology View Icons / Controls

Click anywhere and drag to move the display area up /down/ left /right.

+

Click “+” or “-” to zoom in or zoom out the display area.

@) :csmc-
|;|' Genaral PC
g o

21E3.70.14
Part: 1 (0.00Mx)

A Black device icon indicates device is operating normally. Click a device
icon to show its device console.

0 BIZOMI00-354-LATC

[EEgE | 192.165.1.77

Park 1-Part 7

A Red device icon indicates the device is operating abnormally.

A Red circled device number shows the number of alarm notifications for
the device.

Click this icon to select the set of information to be displayed (MAC, IP,
PoE power, etc.).

Click this icon to sort, filter, or configure basic settings (e.g., VLAN, QoS).

DMS Topology View parameters swiTcH

Device tab parameters

Devices dropdown: Select the device type (All, SWITCH, PC, IP Camera, IP Phone, AP,

Others, or Off Line).

Off Line
Snapshot icon: Use the a icon to capture the displayed topology view. SVG -]
File format: Select the graphics file type (SVG, PNG, or PDF). s:z j
PDF

All
All

PC

IP Camera
IP Phone
AP

Others

Search box: Use the |Q
Model/Device name.

Group tab parameters

‘ to search for a device by typing IP/MAC address or

Device Group Config

Vlan ID: Enter a VLAN ID (VID) for the new group (1-4095). |;AII - \Q—[
Name: Enter a name for the new group. [New Group B
OUI 1: Enter an Organizationally Unique Identifier. :lam}
OUI 2: Enter a second Organizationally Unique Identifier. GZT;
OUI 3: Enter a third Organizationally Unique Identifier. 17

oul3

Apply: Click when done entering the new group data.

Delete: Click to close the new group configuration dialog.
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Config tab parameters

Total Device: Displays the total number of devices discovered.
Controller IP: The control device IP address in the format 0.0.0.0.

DHCP Server IP: The IP address of the configured DHCP Server;
otherwise --- if no DHCP Server is configured.

DHCP Server: At the dropdown select Enabled or Disabled.
The default is Disabled.

IP Range: The range type (Single Subnet or Multiple Subnet).
If you select Multiple Subnet, selection fields display for Range 1 -
Range 4.

Apply: Click the button to make the changes.
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Device | Group | Config
Total Device 2
Controller IP 192.168.1.77

DHCP Server IP

DHCP Server Disabled ]
1P Range [single subnet [-]
Apply
Device Group Config
Total Device 2
Controller IP 192.168.1.77
DHCP Server IP
DHCP Server [Enabled  [-]
Range 1 0.0.0.0 -0.0.0.0
Range 2 0.0.0.0 10.0.0.0
Range 3 0.0.0.0 -0.0.0.0
Range 4 0.0.0.0 10.0.0.0

Page 245 of 284


https://www.transition.com/

Transition Networks
Device data

Click a device in the Topology View to display its captured data:

TRANSITION © =| oend ’
N NETWORKS. n
SM16TAT2SA Topology View
Switch DMS
> DMS Mode + SMAETAT2SA *
» al Monitoring ™~ - De: SWITCH
D SM1BTAT2SA )
> FloorView 2Mb)
AR SMIETAT2SA
> Map View 00-c0-2-48-22f5
» Management & P 192.168.1.77
» Maintenance < o 80
PoE Supply 204 W
SMMBTAT2SA
PoE 204 W | gz D1Mb)
=0 L oo
Login Upgrade  Find Switch  PoE Cont
Dashboard Notfication

PoE1.8W

|"& Port: 2 (0.001Mb)

Device data parameters
Device Type: e.g., SWITCH, PC, IP Camera, IP Phone, AP (Access Point).

Device Type is displayed automatically. If an unknown type is
detected, you can still select its type from a pre-defined list. An IP
device recognized as a DMS Control switch supports "Upgrade" and
"Find Switch" functions.

An IP device recognized as a PoE device supports "Upgrade" and

"Reboot" functions.
An IP device recognized as an IP Camera via the ONVIF protocol will
support the "Streaming" function.

Device Name: e.g., SM16TAT2SA. Create your own Device Name or alias
for easy management such  as "1F_Lobby Cam1i".

Model Name: e.g., SM16TAT2SA.

Mac Address: e.g., 00-40-c7-1c-cb-6€; displayed automatically by DMS.
IP Address: e.g., 192.168.1.77; displayed automatically by DMS.

Http port: e.g., 80

PoE Used: e.g., 2 Watts; displayed automatically by DMS.

Login icon: Click to display the login window.

SMXTAT2SA Web User Guide

192.168.90.100

50

Diagnostics PoE Reboot

Notification

Monitor

(2 B
#Homs - Graphicel Manite Topelagy
Device Group Config
it
WS | fan [-] [sve [-]
~la |
L] R
— I u= =
"' 192.162.1.100
00-16-5c-d4-dd-c2
? 192162159
00-1b-11-b2-Ed-db
s
? 192.162.0.80
oo De-ad-i2-1
TV-IP320-PI ®
Device Type [General 1P camera -
evice Name TV-IP320-PI
Model Name
Mac Addre d8-eb-97-ce-08-26

Upgrade icon: Click to display a window in which you can enter a Tftp Server IP address and the name of

a firmware file to upgrade to.

Find Switch icon: Click to flash the device LEDs for 15 seconds to help find the device. Click OK to clear

the message.

Parent Node / Undo Parent: click to toggle between switching the selected device with its parent node

device and back.
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PoE Config icon: Click to display a window in which you can enable or disable PoE Auto Checking

globally, and enable or disable PoE Mode on a port-by-port basis.
PoE Reboot: Click to re-boot PoE.

PoE Supply and PoE Used: displayed automatically by DMS.
Dashboard icon: Click to display the dashboard.

Notification icon: Click to display an editable message area.

Unknown Device parameters

192.168.1.99
? ) Port3(0.001Mb)

You can click on an unknown device ( - ) to display its
discovered data (see descriptions above). If an unknown type is detected,
you can still select its type from a pre-defined list.
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Device Type

Device Name

192.168.1.99

b

|Unknown Device

00-1p-11-b2-6d-4b
192.168.1.99
30

MNon-PoE

Notification

Monitor
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15-3.3 DMS Firmware Upgrade Procedure
1. Navigate to the DMS > Graphical Monitoring > Topology View menu path.

2. Click the {é} button to display the right pane menu tabs (Entry and Config).
3. Connect all switches and make sure DMS is working.
- Set all switches with different IP addresses and in the same IP segment.

- Make sure gateway IP address is configured.

TR TSI ;
- : ol ol ol ¢
\/TR N§IT|9 = : veyy = = g
SM8TAT2SA Topology View @Home ~ Graphical Monitoring ~ Topology View
Switch DMS

@ J

+
> DMS Mode
i

RA
V4N
> Floor View
> Map View
» Management <
» Maintenance <
SMBTAT2SA SMBTAT2SA = LORENCE-
192.1686.136 192.168.6.135 \ General PC
=B ( gﬁ enera
Port: 4 -Port: 7 192.1686.1)
Port: 1(0.00

4. Enable the TFTP server and set the correct image path.

¥ Tfpd6e4 by Ph. Jounin — O >
| Current Directory emp ~ Browse
Server interfaces  [152168.6.130 Realtek PCle GBE Fan_~ Shows Dir
Thp Server | Thp Client | DHCP server  Log viewer |
< >
Clear Copy
About | Settings Help
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5. Click switch's icon, then click the "Upgrade” button in the Dashboard.

& > O | 1921686.136/t0p0logy htm *| = Z o
TRANSITION ® =| =% : assaas e &
N NETWORKS = : vwiwy = =
SM8TAT2SA Topology View @Home  Graphical Monitoring ~ Topology View
Switch DMS 1
> DMS Mode |+ SM8TAT2SA x {:C}}
» Graphical Monitoring - Device Type SWITCH KA
> Topology View Device Name [smsTAT25A N
> Floor View Model Name SMETAT2SA
> Map View Mac Address 00-40-¢7-11-22-22
IP Address 192.168.6.136
» Management s
Http port 80
» Maintenance <
POE Supply ow
S| il Q g SMBTAT2SA
192|  Login Upgrade | FindSwitch  PoE Config | | he b
Port: 4 - Port: 7
Dashboard Notification

http://192.168.6.136/

6. Input TFTP server address and FW image name, and select the switch on which you want to upgrade
the FW.

SM8TAT2SA x
1
Thp Server IP - [192.168.6.130 xllIFxle [SMSTAT2SA_Transition_201702025.tgz | |
Name 1P Version Status
7 SMSTAT2SA 192.168.6.136 v1.00.798 —
7 SMSTAT2SA 192.168.6.135 v1.00.798 =
Apply

7. Click "Apply” to start the FW upgrade.
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8. Observe the upgrade status until completion.

& 5 O | 192168613670 htr *| = a
TRANSITION = T H 0 &
N\ NETWORKS
SM8TAT2SA Topology View @Home ~ Graphical Monitoring ~ Topology View
Switch DMS [
> DMS Mode SM8TAT2SA X {@}
» Graphical Monitoring | 14 s.er o [192.168.6.130 | File - [MBTAT2SA Transition_201702025 19z KA
> Topology View N
> Floor View Name P Version Status
> Map View SMSTAT2SA 192.168.6.136 v1.00.798 2017-01-0101:53
Starting, please wait...
b Management v SMBTAT2SA 192.16856.135 v1.00.798 0 iy i fouri — o %
» Maintenance Curent Directary Biogie

Serverinterfaces (1321686130 Realtek PCle GBE Fan v | Show Dit
Titp Server | Titp Client | DHCP server Log viewer

Connection received from 192.168.6.135 on port 26524 [02/03 1342559 784]

Read request for fle <SMTAT25A, Transilion_201702025.tg2>. Mode octet [02/03 13:42:53.7
Connection received from 192.168.6.136 on port 17186 [02/03 13.42.53.793]

Read request for file <SMBTAT25A_Transiion_201702025.tg2>. Mode octet [02/03 1342596
Using local port 51268 [02/03 13:4259.823]

Using local port 51269 [02/03 13:42:59.833]

File size : 10521483
8460288 Bytes sent 120861 Bytes/sec

File size : 10521489
351984 Bytes sent 119456 Bytes/sec

<

Clear Copy

About | Setiings Help

Messages

Starting, please wait...
Error : Firmware download fail
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15-3.4 Floor View

Navigate to the DMS > Graphical Monitoring > Floor View menu path. After you have added a Floor
Image at DMS > Maintenance > Floor Image, the Floor View lets you:

e Anchor devices onto Floor Maps

e Find device location instantly

e Store up to 10 Maps per Switch

e IP Surveillance/VoIP/WiFi applications
e Other features same as Topology View

2

Click the {C}? button to display the right pane menu tabs (Entry and Config).

TRANSITION ™
=| & »
IRANSITON™  =| - oc
SM16TAT25A Floor View @Home  Graphical Monitoring - FloorView
Switch DMS - n, Device Config
+ -1 EOS
> DMS Mode O [an -] & [sve -]
» Graphical Monitoring > L K2 [Floorplan2 (192.168.1.77) [~
> Topology View S

[a |
> F - e
B 1 e

> Map View \ B s o

N\ -6d-4b
» Management < N .

—
» Maintenance < A ? 182162188 o
00-16-11-b2-58-45
Il I

192.168.1.77/floor_view.htm|# -

DMS Floor View parameters Al

All

Device tab parameters SWITCH
pC

Devices dropdown: Select the device type (All, SWITCH, PC, IP Camera, IP Phone, AP, Others, or  camen

IP Phone

Off Line). AP

Others

Snapshot icon: Use the ﬁ icon to capture the displayed topology view. | Off Line

File format: Select the graphics file type (SVG, PNG, or PDF).

SVG
SVG

Search box: Use the |Q | to search for a device by typing IP/MAC PG
address or Model/Device name. PoF
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Config tab parameters Device
Total Devics 2
Total Device: Displays the total number of devices discovered. r——— PP P
Controller IP: The control device IP address in the format 0.0.0.0. Zi::“w | — |
TVer Disable: -
IP Range: The range type (Single Subnet or Multiple Subnet). IP Range [Single Subnet -]

DHCP Server IP: Select Enabled or Disabled.
DHCP Server: Select Single Subnet or Multiple Subnet.
Apply: Click the button to save the selections.
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15-3.5 Map View
Navigate to the DMS > Graphical Monitoring > Floor View menu path. The Map View lets you:

e Anchor devices onto Google Maps

e Find devices instantly from Map

e Search on-Line by Company/Address
e Run outdoor IP Cam/WiFi applications
e Other features same as Topology View

Click the @ button to display the right pane menu tabs (Device and Config).

\ TRANSITION W a
&%?ﬁggg =7 Snne Pwws = » H O c
SMI16TAT2SA Map View @Home - Graphics| Monitaring -~ MapView
Switch DMS > o
evice onng
» Graphical Meonitering ™ This page can't load Google Maps comectly. ‘
7 Ty Do you own this website? SMITATZ5A
’ SMeTATZSA
> Floor View 192168177
" \ 00-c0-f2-49-32-f8
> Map View
»  Management <
» Maintenance <
f x
" . " - 1 192.168.1.77 wants to:
If the message "192.168.1.77 wants to know your location” displays, 0
. Know your location
click the Allow button. |
| Allow Block

DMS Map View parameters
Device tab:

Devices dropdown: Select the device type (All, SWITCH, PC, IP Camera, IP Phone, AP, Others, or Off Line).

Search box: Use the Q | to search for a device by typing IP/MAC address or
Model/Device name.

Config tab parameters:

. . . Entry Config
Total Device: Displays the total number of devices discovered. Total Device ,
Controller IP: The control device IP address in the format 0.0.0.0. comrlEr i
Tz [single subnet [~

IP Range: The range type (Single Subnet or Multiple Subnet).

/ Apply J

Apply: Click the button to save the selections.
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Satellite View: From DMS > Graphical Monitoring > Map View you can click Satellite to replace the Map
View with a satellite view:

T

T
Uil

H e ¢

SM8TAT2SA Map View @Home - Graphical Monitoring - Map View

Switch DMS
Device Config
> DMS Mode 5]
» Graphical Monitoring ‘
> Topology View SMBTAT2SA &
SMETAT2S

> Floor View e o
5 Map View 00-c0-2-47-a6-f2
» Management < issiisi

o 00-08-3-ff-fc-28
» Maintenance <

Axis211
192.168.90.82
00-20-8¢-7d-81-02

192.168.90.52
00-c0-f2-00-25-dc
SM16TAT20PA
SMI6TAT20PA
169.254.225.32
00-c0-f2-46-87-38

e

= D s S S e —
2 = pRe
g = - General PC
/ [ s T LAPB3BAD

. 192.168.90.200
OF

s } 14-91-82-f-3b-20
SO & ! ;
0
: M3025
192.168.30.101 [x) b
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156-4 Management
Navigate to the DMS > Management menu path to view the options of Device List and Map API Key.

15-4.1 Device List

Navigate to DMS > Management > Device List to show all devices and information detected by DMS.

TRANSITION © =/ wsos? : H e
= 2w ¥
N NETWORKS
SM16TAT2SA Device List @Homs - Management - Devics Lst
Switch DMS ——— ——
Auto-refresh | Refresh || Edit |
> DMS Mode
» Graphical Monitoring < Show 1w v entries Search:
7 DETEERITErE - [J Remove  status Device Type * Model Name Device Name MAC IP Address
Device List
50 AP K COnline  IP Camera 00-16-6C-D4-DD-C2 192.168.1.100
Map APl Key
S BRI ¢ Online  Others 00-1B-11-B2-6D-48  192.168.1.99
Online  Others AC-CC-BE-AD-FE-2A 192.168.0.90
Online  SWITCH SMI1GTAT25A SMI16TAT2SA 00-CO-F2-49-3E-F& 192.168.1.77

Showing 1 to 4 of 4 entries

DMS > Management > Device List parameters

Remove: Check the box to delete the table entry at the next Apply.

Status: e.g., Online or Offline.

Device Type: e.g., SWITCH or Others.

Model Name: e.g., SM8TAT2SA or SM16TAT2SA or SM24TAT2SA.

Device Name: e.g.,, SM8TAT2SA or SM16TAT2SA or SM24TAT2SA.

MAC: e.g,, 00-40-C7-1C-CB-6E.

IP Address: e.g., 192.168.1.77.

Http Port: Click the Edit icon to edit the Http Port number (added at FW v1.02.1327).
User Name: Click the Edit icon to edit the User Name (added at FW v1.02.1327).
Password: Click the Edit icon to edit the Password (added at FW v1.02.1327).

Buttons

Auto-refresh: Select on to automatically refresh the page every 3 seconds. The default is off.
Refresh: Click the button to refresh the page immediately.

Edit: Click the button to display the table in editable form. Click the Edit icon to edit the Device Name,
Http Port, User Name, and Password. This function can also be configured in the Dashboard of Topology
view. There is no HTTP connection function for Unknown Device and PC type devices, so the UI doesn't
provide "Edit HTTP port" function for configuring it. See below.

Show xx entries: At the dropdown select how many entries to show per page (10, 25, 60, or All).
Search: Enter key word(s) to search for on the page.
Remove: Only Offline devices provide "Remove" function to remove from DMS device list.
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Previous: Click to display the previous set of entries (if any exist).

Next: Click to display the next set of entries (if any exist).

Apply: Click to save changes.

You can click the Edit button to show more fields for editing:

SMXTAT2SA Web User Guide

TRANSITION ™ =| wen 1. H oo
N NETWORKS Py il
SM16TAT2SA Device List @Home - Mansgement - Device List
Switch DMS ——r—
Auto-refresh Refresh H Edit ‘
> DMS Mode . = .
» Graphical Monitoring < Show Dantries Search:
L EmEEEmE v O Device, Model Http
> Device List Remove Status Type Name Device Name MAC IP Address Port User Name Password
> Map APl Key . -
= 00-09-18-4E-20-E9  102.168.1.100 a0 admin | eeess
» Maintenance & Online Camera
L] P .
- 00-16-6C-D4-DD-C2  102.168.1.100 a0 admin | eeess
Online  Camera
L]
N Others 00-18-85-11-F4-F9  169.254.212.216
Online
[ ]
N Others 00-1B-11-B2-6D-4B  102.168.1.89
Online
[ ]
N Others AC-CC-8E-AD-F8-2A  102.168.0.80
Online
online SWITCH SMI16TAT2SA SM1G6TAT2SA 00-CO-F2-49-3E-F6  102.168.1.77
Showing 1 to 6 of 6 entries Previous ' lext
\ Apply \
o . .
Parameter descriptions:
Device Name: Enter the desired name for this device.
Http Port: Edit the HTTP port number for this device.
User Name: Edit the Username for this device.
Password: Edit the Password for this device.
Example:
l g : I
TRANS""ON = || JRANSITION Tl 9 C"
JRANSITION ™ = B 00 - o
SM16TAT2SA Device List #erome - Mamsgemers - Dmvce Lz
Switch DMS ——
Auto-refresh | Refresh H Edit |
> DMS Mode
» Graphical Monitoring ¢ Show 1w v entries Search|
P Ma ement - .
anagemen O Device Http
» Device List Remove Status Type Model Name  Device Name MAC IP Address Port User Name Password
7 Maptites o P 00-16-6C-D4-DD
PTZ camer e 192161100 | &0 admin
» Maintenance < Cnline  Camera 2
° | Others Darme camersl 0018118260 05 15 100
Onling 4B
Onling 24
;l' SWITCH SMI16TAT2SA SMI16TAT2SA 00-CO-F2-49-3E-F6  192.168.1.77
nline

Showing 1 to 4 of 4 entries

| Apply |
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15-4.2 MAP API Key

Navigate to DMS > Management > Map APl Key menu path to display the Google Map API Key
Configuration page. You need a valid API key and a Google Cloud Platform billing account to access
Google core products. If not, DMS Map View will not be able to load Google Map correctly.

Please visit the Google website below and following the directions to get API key:
https://developers.google.com/maps/documentation/directions/get-api-key

To configure the DMS Management API Key via the web Ul:
1. Click DMS, Management, Map API Key.
2. Specify the Google Map API Key.
3. Click Apply to save the setting.

—
TRANSITION

=
- »
JRANSITION = : -
SM16TAT25A Google Map APl Key Configuration @rome - Management - Mep APIKay
Switch DMS
Key
> DMS Mode

» Graphical Monitoring < | = |
» Management . i
> Device List

» Maintenance =

Google Map API Key Configuration parameters

Key: Specify the Google API Key. To use the Google Maps Embed API, you must register your
app project on the Google API Console and get a Google API key which you can add to your
app or website.

Buttons

Apply: Click to save changes.

For More Information

From the Information home page you can find Google Maps APl Use rate, Price details, and
more support for APIs at https://console.developers.google.com/apis/api/maps-
backend.googleapis.com/quotas?project=balmy-cab-186007&duration=P30D.
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15-5 Maintenance > Floor Image

Navigate to DMS > Maintenance > Floor Image to display the Floor Image Maintenance page:

a -
TRANSITION ©  =| e >
N NETWORKS = L @ C
SM16TAT2SA Floor Image Maintenance @tome - Maitenance - Floor Image
Switch DMS
Maximum: 10 files Used: 0 file(s) Free: 10 file(s)
> DMS Mode
. o <
Gphicallboniionns Add Floor Image: Browse...
»  Management <
Name
» Maintenance A
> Floor Image (
| Add
Select No. File Name Image

No information found

| Delete |

Parameter descriptions

Maximum: The maximum number of files available for use.

Used: The number of file(s) used.

Free: The number of file(s) free for use.

Add Floor Image: Click Choose File and browse to and select a File Name to add.
Add: Click to add the selected file.

Select: Displays the selected image name.

No.: Displays the instance number.

File Name: Displays the selected file name.

Image: Displays the selected image. Image added (Floor Plan for FloorPlanl):

oy ——
TRANSITION ®  =| @& s e »
N NETWORKS -
SM16TAT2SA Floor Image Maintenance toms  Wsimenance - Foorimage
Switch DMS
Maximum: 10 files Used: 1 file(s) Free: 9 file(s)
> DMS Mode
» Graphical Monitoring ¢ Add Floor Image: | Choose File | No file chosen
» Management & Name
» Maintenance h
> Floor image ‘ Add |
Select No.  File Name Image
O 1 FloorPlan1 (192.168.1.77) ]» ] ‘
| Delete ‘
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Message: 192.168.1.77 says: Insufficient Space. Only x files available.

Meaning: The file is too large or no file exists.

Recovery: Click the OK button to clear the message and choose a new File Name to add.

Message: Special Characters are not allowed in Name.

Meaning: The Floor Image filename has special characters (dash, space, numbers, etc.) which are not

allowed.

Recovery: Click the OK button to clear the message and choose a File Name with no special characters.

H 0 ¢

@Home - Masintenance - FloorImage

Example:
TRANSITION \ =/ o
N NETWORKS: -
SM16TAT25A Floor Image Maintenance
Switch DMS
Maximum: 10 files Used: 1 file(s) Free: 9 file(s)
» DMS Mode
¥ Graphical Monitering ¢ Add Floor Image: | Choose File | No file chosen
» Management &
Name
» Maintenance -
> Floor Imags
(add |
Select MNo. File Name Image
—m [ [+ o
|:| 1 FloorPlanFirstFloor (192.168.1.77) ? l
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15-6 DMS Maintenance > Traffic Monitoring

DMS supports traffic monitoring of each port and keeps a one-week record that can be used to compare
and analyze through visual charts. The page displays two different graphs for a selected device.

Procedure
1. Click DMS > Maintenance > Traffic Monitor.
2. Select the parameters to display.

3. Select the device to monitor.

s

| TRANSITION® =

TS P— - H H oo
N\ NETWORKS |
SMI16TAT2SA Traffic Monitor
Switch DMS "
A Device List
> DMS Mode
SM16TAT25A oToul Rk £ 2019/08/26 ® Day  Wesk
» Graphical Menitoring < SM1STAT23A
5200 [z SM18TATZSA
» Management @ 5500 M- 182188077
1
5000 M
aimterre . ?
» Maintenance 500 M H erssmioe
> Floor Image 4000 M~ A
> Traffic Monitor o ? |
3000 M- 160254212 218 |
500 M & I
2000 M i
15001 1821681100 |
1000 M 10 -
20 W ad =

182.188.1.100
oM | ! | ! ! 1 | | | | | |

192.168.1.99 ® Tosl  Rx T 192 168 0.90

100M Time

bbb 4 b b e b s b o bl o b b b oz & ! (Houn

Parameter descriptions:

0 Total Rx Tx

Total / Rx / Tx: Select the set of data to be displayed.

< 2011/01/04 VESIE

< yy/mm/dd >: Select the date of data displayed.

Day / Week: Select a day’s worth of data or a week’s worth of data to be displayed.
Device List: Displays the set of discovered devices.

Throughput: Vertical axis shows throughput (e.g., 0 M — 18000 M or 0 M-1200 M). The unit of measure
is Mbps.

Port: Horizontal axis shows the switch port numbers.
Time (Hour): Horizontal axis shows the time elapsed in hours (0-23).

The graph’s vertical axis shows throughput and the unit of measure is Mbps.
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1. Navigate to DMS > Maintenance > Traffic Monitor.

TRANSITION

ar
H Twson
NETWORKS«

SEEN EBNS - 4 Moo

SM16TAT25A

Traffic Monitor

Switch DMS

> DMS Mode
SM16TAT25A

» Graphical Menitoring <

» Management @

» Maintenance v
> Floor Image

> Traffic Monitor

192.168.1.99

DRI S 4 2019/08/26 > ® 0z Wesk

o Total  Rx Tx

| [ [ i
2 13 14 15 . 17

2. Hover the cursor over a column in the graph to view its details.
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Time

B 2 A m ' (Hour)

. : E
TRANSITION * | e EEEE. Heeo
SMI16TATZSA Traffic Monitor
Switch DMS =
» oMStode [powes ]
- -
» Graphical Monitoring ¢ P
- o e
o Co U T
o
- ! ? Ype
o _— -
= g Device Name
= = Model Hame
w ‘ . i |
P i b LR SR A " Hﬂﬂ
. B
o LF"
o ort
o
= Rx
=
= LE:

Total

A Device List F

SMIETAT2EA
= SMITAT28A
- 182168077

192188199

189254212218

182.162.1.100

182.168.1.100

182.168.0.80
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3. Click the graph column to display its axis information in the lower graph table.

TRANSITION ® =

—
JRANSITION [ ] — [ ] — ”
" NETWORKS
SM16TAT2SA Traffic Monitor
Switch DMS —
A Device List
> DMS Mode e
SMI16TAT25A ool R e 2019/08/26 ® Day  Week
» Graphical Monitoring < SMISTATZSA
SM16TAT25A
e = 13”‘1&5 L
» Management < 500 M- G
. 5000 M- : ?
4s0 M 192.188.1.98
4000 M- 2
3500 M~ 2
2000 M- - 189254 212218
2500 M-
2000 M i
1500 M~ 1921821100
1000 M- 10
500 M- StEs ==
' 192188100
sy by b s el 4 b b s Port -
i ?
== : 192.188.0.90
Total Rx i 3080 M =
192.168.0.90  Total * e
6000 M-
5500 M-
5000 M-
4500 M
4000 M-
2500 M-
3000 M-
2500 M-
2000 M
1500 M-
1000 M=
500 M— Time
T O T T T TR T T ST SR S S S R PRSP (LT

Bandwidth vs Throughput vs Network Throughput

Bandwidth: the maximum amount of data that can go through a given medium.
Throughput: the amount of data that actually goes through that medium.

(g

Network throughput: the amount of data that is transmitted through a given network medium over a

given amount of time.

Throughput Units of Measurement

Bit. The smallest size of binary information used by computer devices (the ones and zeros in binary)

Byte: 8 bits

Megabit. 1 million bits
Megabyte: 1 million bytes
Gigabit. 1 billion bits
Gigabyte: 1 billion bytes
Mbps: Megabits per second
MBps. Megabytes per second
Gbps: Gigabits per second

GBps. Gigabytes per second

33717 Rev.D https://www.transition.com Page 262 of 284



https://www.transition.com/

Transition Networks SMXTAT2SA Web User Guide
15-7 DMS Troubleshooting

Problem: The switch lists itself as the only device in Topology View of DMS.
Problem: In DMS, the Local image shows the IP address of another switch.

Description: The switch is listed as only device in DMS Topology View in DMS; all devices are listed in
DMS device list. This is usually because the switch's gateway is not configured appropriately.

Resolution: An IP Route must be configured manually. For example, a switch IP address of 192.168.1.77
should have the following IP route configured: ip route 0.0.0.0 0.0.0.0 192.168.1.x. Without the IP route
configured, you may be unable to view all devices on the network in DMS.

1. Go to DMS > Management > DMS Mode to check if the controller IP is correct.
2. Verify that the gateway of this switch is correctly configured.
3. Verify that all connected devices are displayed in DMS Topology View.

Problem: DMS Connectivity diagnostics fails to ICMP reachable device.

Description: DMS displays a device which is reachable via ICMP ping as failing the connection status in
diagnostics. Cable status displays as OK.

Resolution: Contact TN Technical Support. See Contact Us below.

Problem: DMS will discover the device type, name and model of some cameras and hosts but others are
displayed as Unknown.

Description: When a device is detected by DMS, the device’s information (such as type, model
name...etc.) can be recognized via LLDP (e.g. Switch), UPnP (e.g. AP), ONVIF (e.g. IP cam), NBNS (e.g. PC)
packets if the device supports these protocols. So if the device display as Unknown, that means this
device do not issue above mentioned protocol for DMS to recognize.

Resolution: You can manually assign and configure the device type and name for the unknown devices.
See the Topology View > Dashboard or the Topology View section.

Message: This page can’t load Google Maps correctly.
Recovery: See “15-4.2 MAP API Key” on page 241.

TRANSITION ' =| awsmm am
N NETWORKS | v
SM16TAT2SA Map VieW @Home GraphlcalMonitoﬁnQﬂap@
Switch DMS ‘
> DMS Mode Google :E\
» Graphical Monitoring This page can't load Google Maps correctly. :I

> Topology View Do you own this website? OK

00-40-c7-1c-cb-6e

» Management : ? 192168199
: 22.168.1.

15-7 For More DMS Information

See the online DMS Video.
See the online DMS Overview.
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Appendix A - Troubleshooting

Refer to the SMXTAT2SA Install Guide for Install Troubleshooting, Warranty, Support, and Compliance
information.

General Troubleshooting Procedure

Many problems are caused by the following situations. Check for these items first when you start
troubleshooting:

1. Verify the install procedures were performed correctly. See the SMXTAT2SA Install Guide.

2. Check if the SMXTAT2SA POWER LED is Off:
e Check connections between the switch, the power cord and the wall outlet.
e Contact your dealer for assistance.

3. Check if the SMXTAT2SA Link LED is Off:

e Verify that the switch and attached device are powered on.

e Be sure the cable is plugged into the switch and corresponding device.

e |[f the switch is installed in a rack, check the connections to the punch-down block and patch
panel.

e Verify that the proper cable type is used and its length does not exceed specified limits.

e Check the adapter on the attached device and cable connections for possible defects. Replace
the defective adapter or cable if necessary.

4. Make sure all devices connected to the SMXTAT2SA are configured to auto negotiate or are configured
to connect at half duplex (all hubs are configured this way, for example).

5. Check the cabling:
e Look for faulty or loose cables.
e Look for non-standard and miswired cables.

6. Make sure you have a valid network topology:
e Check for improper Network Topologies.
e Make sure that your network topology contains no data path loops.

7. Check the port configuration.

e Make sure ports have not been put into a “blocking” state by Spanning Tree, GVRP, or LACP. The
normal operation of the Spanning Tree, GVRP, and LACP features may put the port in a blocking
state.

e Verify that the port has not been configured as disabled via software.

8. Make sure connected devices (e.g., SFPs, switches, hubs) are cabled, powered, and operating properly.
9. If possible, try switching modes (i.e., from Web Ul to CLI, or vice versa).

10. Verify the specific function that failed (e.g., port config, PoE or VLAN management, QoS, Spanning
Tree). Refer to the specific function's user manual page and online Help for details. Verify that the
function you are trying to perform is supported by your particular switch model.

11. Run the tests in the Diagnostic tab of the Web Ul. Verify that the interface is assigned to the correct
VLAN. Use the Layer 2 traceroute. Check for spanning-tree problems such as BPDU floods or flapping
mac address. Try a ping to broadcast IP address of subnet from your L3 device (Gateway).

12. Record any related error messages, conditions, and configurations for your Tech Support Specialist to
consider. See below.

13. Contact Transition Networks Tech Support. See Contact Us below.
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Record Device and System Information

After performing the troubleshooting procedures, and before calling or emailing Technical Support,
please record as much information as possible in order to help the Transition Networks Tech Support
Specialist.

1. Select the SMXTAT2SA Switch > System > System Information menu path to gather the information
below or as requested by the TN Support Specialist.

2. Record Model:

Hardware Version: Firmware Version:

PoE Firmware Version: S/N:

3. LED Status:

4. Provide additional information to your Tech Support Specialist. See the “Troubleshooting” section
above.

Your Transition Networks service contract number:

A description of the failure:

A description of any action(s) already taken to resolve the problem (e.g., change mode, reboot, etc.):

The serial and revision numbers of all involved Transition Networks products in the network:

A description of your network environment (layout, cable type, etc.):

Network load and frame size at the time of trouble (if known):

The device history (i.e., have you returned the device before, is this a recurring problem, etc.):

Previous Return Material Authorization (RMA) numbers:
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You can get Model, P/N, and S/N information from the Box label and the Device label:

SM16TAT :
MODEL M 2SA This device complies with Part 15
of the FCC Rules

Managaed Switch, 16-port Glgabit PoE+,

2-port 100/1000 SFP

Model: SM16TAT2SA FC
A L I
e noprssseno | INUNFIEINVAN AN mmmnim C€
: : g (€ O

/N: C021319BR2100002 /N: C0211188R2100002

Made in Taiwan

MADE IN TAIWAN

Serial Label on Box Serial Label on Device

Contact Us

Transition Networks Inc.

10900 Red Circle Drive, Minnetonka, MN 55343

Telephone: +1-952-941-7600 / Toll Free: 800-526-9267 / Fax: 952-941-2322

E-Mail: customerservice@transition.com / techsupport@transition.com
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Appendix B — DHCP Per Port

You can configure DHCP Per Port via the CLI and Web UL The DHCP Per Port factory default mode is
Disabled. See the CL/ Reference for CLI mode operation.

Configure DHCP Per Port via the Web Ul

The switch’s DHCP server assigns IP addresses. Clients get IP addresses in sequence and the switch assigns
IP addresses on a per-port basis starting from the configured IP range. For example, if the IP address
range is configured as 192.168.10.20 - 192.168.10.37 with one DHCP device connected to port 1, the
client will always get IP address 192.168.10.20, then port 3 is always distributed IP address 192.168.10.22,
even if port 2 is an empty port (because port 2 is always distributed IP address 192.168.10.21).

The switch does not allow a DHCP per Port pool to include the switch’s address.
IP address assigned range and VLAN 1 should stay in the same subnet mask.

The configurable IP address range is allowed to configure over 18 IP addresses, but the switch always
assigns one IP address per port connecting device.

The DHCP Per Port function is only supported on VLAN 1.

When the DHCP Per Port function is enabled, the switch software will automatically create the related
DHCP pool named "DHCP_Per _Port".

Once the DHCP Per Port function is enabled on one switch, IPv4 DHCP client at VLAN1 mode (DMS DHCP
mode), DHCP server mode are all limited to be enabled at the same time (an error message displays if
attempted).

If the DHCP server pool has been configured, once you enable the DHCP Per Port function, then that
DHCP server pool configuration will be overwritten.

Only for VLAN 1, clients issued DHCP packets will not be broadcast/forwarded to other ports. DHCP
packets in others VLANs will be broadcast/forwarded to others ports.

The DHCP Per Port function allows the switch to connect only one DHCP client device.

DHCP-Per-Port is configured entirely on the Switch > Configuration > System > IP page, IP Interfaces
window.

The feature is enabled here and an IP range (pool) is entered. The “automatic” results of this action can be
displayed in:

) Switch > Configuration > System > DHCP > Server > Mode (Global Mode - Enabled, VLAN
Mode - VLAN 1 created)

. Switch > Configuration > System > DHCP > Excluded (Excluded range created based on range
entered)

. Switch > Configuration > System > DHCP > Pool (Pool "DHCP_Per_Port” created based on range
entered)

Actual DHCP operation is monitored as normal under System > Monitor > DHCP.

The DHCP Per Port pages and parameters are described below.
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DHCP Per Port Mode Configuration

The DHCP Per Port function lets you assign an IP address based on the switch port the device is
connected to. This will speed up installation of IP cameras, as the cameras can be configured after they are
on the network. The DHCP Per Port assignment lets you know which IP was assigned to which camera.

Note: to prevent IP conflict, each switch can be allocated a different IP range.

To configure DHCP Per Port via the Web U navigate to the System > IP Address > Advanced IP
Settings menu path.

4-\ R .
TRANSITION ® =| wesns szas H oG
N NETWORKS
SM16TAT2SA Advanced IP SettTngS ‘@eHoms - System - IP Address - Advenced |P Settings
Switch DMS
DNS Server No DNS server v
IP Interfaces
DHCP Per Port
Mode Disabled ¥
1P
> System Time
» LLDP ¢
> UPnP DHCPv4 IPv4 IPVE
» Port Management < Current Mask Mask
_ ¢ Delete  VLAN  Enable Fallback Lease Address Length Address Length
» PoE Management
» VLAN Management < O 1 O
» Quality of Service <
(‘Add ntertace |
» Spanning Tree <
b MAC Address Table < Link-Local Address binding interface VLANL T
» Multicast <
» DHCP < IP Routes
b Security S
Delete Network Mask Length Gateway Next Hop VLAN
» Access Control <
O 0.0.0.0 0 192.168.1.254 0
» SNMP S
» Ewvent Notification <
» Diagnostics <
» Maintenance < -

Parameter descriptions: The DHCP Per Port parameters and buttons are described below.

DHCP Per Port Mode: at the dropdown select Enable or Disable the DHCP Per Port function globally.
The default is Disabled.

IP: enter the IPv4 IP address range to be used when the DHCP Per Port function is enabled (e.g.,
192.168.10.20 - 192.168.10.37). The DHCP Per Port IP range must be within the interface subnet. Note
that DHCP Per Port with IPv6 is not supported at this time. The DHCP Per Port IP range must equal the
switch port number excluding uplink ports (16).

Apply: Click to save changes to the entries. If the entries are valid, the webpage message “Update
success!" displays. Click the OK button to clear the message. If any entries are invalid, an error message
displays. Click the OK button to clear the message and enter valid values, then click the Apply button
again.

Reset: Click to undo any changes made locally and revert to previously saved values.
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When DHCP Per Port is enabled at Configuration > System > IP, the checkbox and selection in the DHCP
Server Mode Configuration section becomes grayed out (can not be selected):

To monitor DHCP Per Port status, navigate to the System > IP Address > Status menu path.

TRANSITION

N NETWORKS

SM16TAT2S5A
DMS

Switch

n Information

> Status
» System Time
» LLDP

> UPnP

Port Management

» PoE Management

VLAN Management

Quiality of Service

Spanning Tree

» MAC Address Table

Multicast

» DHCP

Security

» Access Control

SNMP

Event Notification

» Diagnostics

Maintenance

=‘ JRANSITION [T 17 1 ”

IP Status

Auto-refresh | Refresh ‘

IP Interfaces
Interface * Type Address
0s:lo Link 00-00-00-00-00-00
0s:lo IPvd 127.0.0.1/8
0s:lo IPv6 :1/128
VLANL Link 00-40-C7-1C-CB-6E
VLANL IPv4 192.168.1.77/24
VLANL IPv6 feg0::240:cTff:felcchbe/64

IP Routes
Metwork * Gateway
0.0.0.0/0 192.168.1.254
0.0.0.0/0 0.0.0.0
127.0.0.0/24 0.0.0.0
169.254.0.0/16 0.0.0.0
192.168.1.0/24 0.0.0.0
n1/128
feg0::/64

feg0u240:c7ffelc:chBe/128

ffoo::/8

Web UI Messages

Message: Interface xx not using DHCP

Status

o c

@Home - System - IPAddress - Status

UP LOOPBACK RUNNING MTU:16436 Metric:1

UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1

Manual

Link Local Address

Status

UP GATEWAY

upP

UP

upP

uP

upP

upP

upP

UP

Interface

VLAN1

VLAN1

os:lo

VLAN1

VLAN1

05:lo

VLAN1

os:lo

VLAN1

Meaning: The Interface being configured does not have DHCP enabled and configured.

Recovery: 1. Click the OK button to clear the webpage message. 2. Enable and configure DHCP for the
interface being configured. See "DHCP Server Mode Configuration” on page 269.

Message from webpage @
l L Interface 10 not using DHCP
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Message: The value of 'DNS Server’ must be a valid IP address in dotted decimal notation (x.y.z.w’).
Meaning: You entered an invalid IP address for the DNS Server being configured.

Recovery: 1. Click the OK button to clear the webpage message. 2. Enter a valid IP address in the format
x.y.z.w per the on-screen restrictions. See "" DHCP Server Mode Configuration” on page 269.

Message from webpage &

The value of 'DMS Server’ must be a valid IP address in dotted decimal
l % notation (wy.zw').

The following restrictions apply:
1) % y, z and w must be decimal numbers between 0 and 255,
2) x must not be 0 unless also v, z, and w are 0,
3) % must not be 127, and
4) x must not be greater than 223,

Message: ‘DHCP Interface VLAN ID’ must be an integer value between 1 and 4095.
Meaning: You entered an invalid VLAN ID for the DHCP Interface.

Recovery: 1. Click the OK button to clear the webpage message. 2. Enter a valid VLAN ID for the DHCP
Interface (1-4095). See “DHCP Server Mode Configuration” on page 269.

Message from webpage [ﬁ

l i 'DHCP Interface VLANID' must be an integer value between 1 and 4035
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Glossary of Terms

Note that mention of a term below does not imply that the feature described is necessarily supported.

A

ACE

An ACE (Access Control Entry) describes access permission associated with a particular ACE ID.

There are three ACE frame types (Ethernet Type, ARP, and IPv4) and two ACE actions (permit and deny).
The ACE also contains many detailed, different parameter options that are available for individual
application.

ACL

An ACL (Access Control List) is the list table of ACEs, containing access control entries that specify
individual users or groups permitted or denied to specific traffic objects, such as a process or a program.

Each accessible traffic object contains an identifier to its ACL. The privileges determine whether there are
specific traffic object access rights.

ACL implementations can be quite complex, for example, when the ACEs are prioritized for the various
situation. In networking, the ACL refers to a list of service ports or network services that are available on a
host or server, each with a list of hosts or servers permitted or denied to use the service. ACL can
generally be configured to control inbound traffic, and in this context, they are similar to firewalls.

There are 3 web-pages associated with the manual ACL configuration:

ACL > Access Control List: The web page shows the ACEs in a prioritized way, highest (top) to lowest
(bottom). Default the table is empty. An ingress frame will only get a hit on one ACE even though there
are more matching ACEs. The first matching ACE will take action (permit/deny) on that frame and a
counter associated with that ACE is incremented. An ACE can be associated with a Policy, 1 ingress port, or
any ingress port (the whole switch). If an ACE Policy is created then that Policy can be associated with a
group of ports under the "Ports" web-page. There are number of parameters that can be configured with
an ACE. Read the Web page help text to get further information for each of them. The maximum number
of ACEs is 64.

ACL > Ports: The ACL Ports configuration is used to assign a Policy ID to an ingress port. This is useful to
group ports to obey the same traffic rules. Traffic Policy is created under the "Access Control List" - page.
You can you also set up specific traffic properties (Action / Rate Limiter / Port copy, etc.) for each ingress
port. They will though only apply if the frame gets past the ACE matching without getting matched. In
that case a counter associated with that port is incremented. See the Web page help text for each specific
port property.

ACL > Rate Limiters: Under this page you can configure the rate limiters. There can be 15 different rate
limiters, each ranging from 1-1024K packets per seconds. Under "Ports" and "Access Control List" web-
pages you can assign a Rate Limiter ID to the ACE(s) or ingress port(s).

AES

The AES (Advanced Encryption Standard) encryption key protocol is applied in 802.1i standard to improve
WLAN security. It is an encryption standard by the U.S. government, which will replace DES and 3DES. AES
has a fixed block size of 128 bits and a key size of 128, 192, or 256 bits.

Aggregation

Using multiple ports in parallel to increase the link speed beyond the limits of a port and to increase the
redundancy for higher availability. (Also Port Aggregation, Link Aggregation).
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ARP

ARP (Address Resolution Protocol) is a protocol that is used to convert an IP address into a physical
address, such as an Ethernet address. ARP allows a host to communicate with other hosts when only the
Internet address of its neighbors is known. Before using IP, the host sends a broadcast ARP request
containing the Internet address of the desired destination system.

ARP Inspection

ARP Inspection is a secure feature. Several types of attacks can be launched against a host or devices
connected to Layer 2 networks by "poisoning" the ARP caches. This feature is used to block such attacks.
Only valid ARP requests and responses can go through the switch device.

Auto-Negotiation

Auto-negotiation is the process where two different devices establish the mode of operation and the
speed settings that can be shared by those devices for a link.

D

DEI

DEl is an acronym for Drop Eligible Indicator. It is a 1-bit field in the VLAN tag.
DES

DES ( Data Encryption Standard) provides a complete description of a mathematical algorithm for
encrypting (enciphering) and decrypting (deciphering) binary coded information. Encrypting data
converts it to an unintelligible form called cipher. Decrypting cipher converts the data back to its original
form called plaintext. The algorithm described in this standard specifies both enciphering and deciphering
operations which are based on a binary number called a key.

DHCP

The DHCP (Dynamic Host Configuration Protocol) is used for assigning dynamic IP addresses to devices
on a network. DHCP used by networked computers (clients) to obtain IP addresses and other parameters
such as the default gateway, subnet mask, and IP addresses of DNS servers from a DHCP server. The DHCP
server ensures that all IP addresses are unique, for example, no IP address is assigned to a second client
while the first client's assignment is valid (its lease has not expired). Therefore, IP address pool
management is done by the server and not by a human network administrator.

Dynamic addressing simplifies network administration because the software keeps track of IP addresses
rather than requiring an administrator to manage the task. This means that a new computer can be added
to a network without the hassle of manually assigning it a unique IP address.

DHCP Relay

DHCP Relay is used to forward and to transfer DHCP messages between the clients and the server when
they are not on the same subnet domain. The DHCP option 82 enables a DHCP relay agent to insert
specific information into a DHCP request packets when forwarding client DHCP packets to a DHCP server
and remove the specific information from a DHCP reply packets when forwarding server DHCP packets to
a DHCP client. The DHCP server can use this information to implement IP address or other assignment
policies. Specifically the option works by setting two suboptions: Circuit ID (option 1) and Remote ID
(option2). The Circuit ID sub-option is supposed to include information specific to which circuit the
request came in on. The Remote ID sub-option was designed to carry information relating to the remote
host end of the circuit.

The definition of Circuit ID in the switch is 4 bytes in length and the format is "vlan_id" "module_id"
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"port_no". The parameter of "vlan_id" is the first two bytes represent the VLAN ID. The parameter of
"module_id" is the third byte for the module ID (in standalone switch it always equal 0). The parameter of
"port_no" is the fourth byte and it means the port number. The Remote ID is 6 bytes in length, and the
value is equal the DHCP relay agents MAC address.

DHCP Snooping

DHCP Snooping is used to block intruder on the untrusted ports of the switch device when it tries to
intervene by injecting a bogus DHCP reply packet to a legitimate conversation between the DHCP client
and server.

DNS

DNS (Domain Name System) stores and associates many types of information with domain names. Most
importantly, DNS translates human-friendly domain names and computer hostnames into computer-
friendly IP addresses. For example, the domain name www.example.com might translate to 192.168.0.1.

DoS

In a DoS (Denial of Service) attack, an attacker attempts to prevent legitimate users from accessing
information or services. By targeting at network sites or network connection, an attacker may be able to
prevent network users from accessing email, web sites, online accounts (banking, etc.), or other services
that rely on the affected computer.

Dotted Decimal Notation

Dotted Decimal Notation refers to a method of writing IP addresses using decimal numbers and dots as
separators between octets. An IPv4 dotted decimal address has the form x.y.z.w, where x, y, z, and w are
decimal numbers between 0 and 255.

DSCP

DSCP (Differentiated Services Code Point)is a field in the header of IP packets for packet classification
purposes.

E

EEE

EEE is an abbreviation for Energy Efficient Ethernet defined in IEEE 802.3az.
Ethernet Type

Ethernet Type, or EtherType, is a field in the Ethernet MAC header, defined by the Ethernet networking
standard. It is used to indicate which protocol is being transported in an Ethernet frame.

F
FTP

FTP is an acronym for File Transfer Protocol. It is a transfer protocol that uses the Transmission Control
Protocol (TCP) and provides file writing and reading. It also provides directory service and security
features.

Fast Leave

Multicast snooping Fast Leave processing allows the switch to remove an interface from the forwarding-
table entry without first sending out group specific queries to the interface. The VLAN interface is pruned
from the multicast tree for the multicast group specified in the original leave message. Fast-leave
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processing ensures optimal bandwidth management for all hosts on a switched network, even when
multiple multicast groups are in use simultaneously. This processing applies to IGMP and MLD.

H
HTTP

HTTP (Hypertext Transfer Protocol) is a protocol that used to transfer or convey information on the World
Wide Web (WWW). HTTP defines how messages are formatted and transmitted, and what actions Web
servers and browsers should take in response to various commands. The other main standard that
controls how the World Wide Web works is HTML, which covers how Web pages are formatted and
displayed. Any Web server machine contains, in addition to the Web page files it can serve, an HTTP
daemon, a program that is designed to wait for HTTP requests and handle them when they arrive. The
Web browser is an HTTP client, sending requests to server machines. An HTTP client initiates a request by
establishing a Transmission Control Protocol (TCP) connection to a particular port on a remote host (port
80 by default). An HTTP server listening on that port waits for the client to send a request message.

HTTPS

HTTPS (Hypertext Transfer Protocol over Secure Socket Layer) is used to indicate a secure HTTP
connection. HTTPS provide authentication and encrypted communication and is widely used on the World
Wide Web for security-sensitive communication such as payment transactions and corporate logons.
HTTPS is really just the use of Netscape's Secure Socket Layer (SSL) as a sub layer under its regular HTTP
application layering. (HTTPS uses port 443 instead of HTTP port 80 in its interactions with the lower layer,
TCP/IP) SSL uses a 40-bit key size for the RC4 stream encryption algorithm, which is considered an
adequate degree of encryption for commercial exchange.

I
ICMP

ICMP (Internet Control Message Protocol) is a protocol that generated the error response, diagnostic or
routing purposes. ICMP messages generally contain information about routing difficulties or simple
exchanges such as time-stamp or echo transactions.

IEEE 802.1X

IEEE 802.1X is an IEEE standard for port-based Network Access Control. It provides authentication to
devices attached to a LAN port, establishing a point-to-point connection or preventing access from that
port if authentication fails. With 802.1X, access to all switch ports can be centrally controlled from a server,
which means that authorized users can use the same credentials for authentication from any point within
the network.

IGMP

IGMP (Internet Group Management Protocol) is a communications protocol used to manage the
membership of Internet Protocol multicast groups. IGMP is used by IP hosts and adjacent multicast
routers to establish multicast group memberships. It is an integral part of the IP multicast specification,
like ICMP for unicast connections. IGMP can be used for online video and gaming, and allows more
efficient use of resources when supporting these uses.

IGMP Querier

A router sends IGMP Query messages onto a particular link. This router is called the Querier.
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IMAP

IMAP (Internet Message Access Protocol) is a protocol for email clients to retrieve email messages from a
mail server. IMAP is the protocol that IMAP clients use to communicate with the servers, and SMTP is the
protocol used to transport mail to an IMAP server. The current version of the Internet Message Access
Protocol is IMAPA4. It is similar to Post Office Protocol version 3 (POP3), but offers additional and more
complex features. For example, the IMAP4 protocol leaves your email messages on the server rather than
downloading them to your computer. If you wish to remove your messages from the server, you must use
your mail client to generate local folders, copy messages to your local hard drive, and then delete and
expunge the messages from the server.

IP

IP (Internet Protocol) is a protocol used for communicating data across an internet network. IP is a "best
effort" system, which means that no packet of information sent over is assured to reach its destination in
the same condition it was sent. Each device connected to a Local Area Network (LAN) or Wide Area
Network (WAN) is given an Internet Protocol address, and this IP address is used to identify the device
uniquely among all other devices connected to the extended network. The current version of the Internet
protocol is IPv4, which has 32-bits Internet Protocol addresses allowing for in excess of four billion unique
addresses. This number is reduced drastically by the practice of webmasters taking addresses in large
blocks, the bulk of which remain unused. There is a rather substantial movement to adopt a new version
of the Internet Protocol, IPv6, which would have 128-bits Internet Protocol addresses. This number can be
represented roughly by a three with thirty-nine zeroes after it. However, IPv4 is still the protocol of choice
for most of the Internet.

IPMC
IPMC is an acronym for IP Multicast.
IP Source Guard

IP Source Guard is a secure feature used to restrict IP traffic on DHCP snooping untrusted ports by
filtering traffic based on the DHCP Snooping Table or manually configured IP Source Bindings. It helps
prevent IP spoofing attacks when a host tries to spoof and use the IP address of another host.

L
LACP

LACP is an IEEE 802.3ad standard protocol. The Link Aggregation Control Protocol, allows bundling several
physical ports together to form a single logical port.

Lightly Managed Switch (AKA, Smart Switch)

This Ethernet switch category offers certain levels of Management, QoS, Security, etc. with somewhat
"lighter” capabilities and scalability than the Managed switches. This makes Lightly Managed switches a
cost-effective alternative to Managed switches. Lightly Managed switches fit well at the edge of a large
network; Managed Switches are better suited in the core. Lightly Managed switches are also used in
infrastructures with smaller deployments, or for generally less complex networks.

The capabilities available for the Lightly Managed switch category vary, but most have a browser-based
Management interface, often with CLI and/or SNMP. Lightly Managed switches let you segment a network
into workgroups by creating VLANSs, but with fewer VLANs and nodes than with a Managed switch. Lightly
Managed switches offer some levels of security, such as 802.1x endpoint authentication, and/or a limited
set of Access Control Lists (ACLs). Lightly Managed switches support basic QoS (Quality Of Service) that
lets you prioritize users and applications per 802.1q/TOS/DSCP.

Transition Networks' SMXTAT2SA switches are included in this Lightly Managed Switch (Smart Switch)
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category.
LLC

The IEEE 802.2 Logical Link Control (LLC) protocol provides a link mechanism for upper layer protocols. It
is the upper sub-layer of the Data Link Layer and provides multiplexing mechanisms that make it possible
for several network protocols (IP, IPX) to coexist within a multipoint network. LLC header consists of 1 byte
DSAP (Destination Service Access Point), 1 byte SSAP (Source Service Access Point), 1 or 2 bytes Control
field followed by LLC information.

LLDP

LLDP is an IEEE 802.1ab standard protocol. The Link Layer Discovery Protocol (LLDP) specified in this
standard allows stations attached to an IEEE 802 LAN to advertise, to other stations attached to the same
IEEE 802 LAN, the major capabilities provided by the system incorporating that station, the management
address or addresses of the entity or entities that provide management of those capabilities, and the
identification of the stations point of attachment to the IEEE 802 LAN required by those management
entity or entities. The information distributed via this protocol is stored by its recipients in a standard
Management Information Base (MIB), making it possible for the information to be accessed by a Network
Management System (NMS) using a management protocol such as the Simple Network Management
Protocol (SNMP).

LLDP-MED

LLDP-MED is an extension of IEEE 802.1ab and is defined by the telecommunication industry association
(TIA-1057). LLDP-MED provides Auto-discovery of LAN policies enabling plug and play networking, device
location discovery to allow VoIP Enhanced 911 services; extended and automated power management of
PoE end points.

M
MAC Table

Switching of frames is based upon the DMAC address contained in the frame. The switch builds up a table
that maps MAC addresses to switch ports for knowing which ports the frames should go to (based upon
the DMAC address in the frame ). This table contains both static and dynamic entries.

The static entries are configured by the network administrator if the administrator wants to do a fixed
mapping between the DMAC address and switch ports.

The frames also contain a MAC address (SMAC address), which shows the MAC address of the equipment
sending the frame. The SMAC address is used by the switch to automatically update the MAC table with
these dynamic MAC addresses. Dynamic entries are removed from the MAC table if no frame with the
corresponding SMAC address have been seen after a configurable age time.

MD5

MD5 (Message-Digest algorithm 5) is a message digest algorithm, used cryptographic hash function with
a 128-bit hash value. It was designed by Ron Rivest in 1991. MD5 is officially defined in RFC 1321 - The
MD5 Message-Digest Algorithm.

Metering

Metering is a service model that an Internet service provider (ISP) uses to track bandwidth usage and then
charges high traffic customers accordingly. Typically, a customer will select a service package with a flat
rate up to a specified limit and then pays additional fees beyond that limit (e.g., per gigabyte of data
downloaded). AKA, bandwidth metering, Internet metering.
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Mirroring

For debugging network problems or monitoring network traffic, the switch system can be configured to
mirror frames from multiple ports to a mirror port. (In this context, mirroring a frame is the same as
copying the frame.) Both incoming (source) and outgoing (destination) frames can be mirrored to the
mirror port.

MLD

MLD (Multicast Listener Discovery) for IPv6 is used by IPv6 routers to discover multicast listeners on a
directly attached link, much as IGMP is used in IPv4. The protocol is embedded in ICMPv6 instead of using
a separate protocol.

MVR

Multicast VLAN Registration is a protocol for Layer 2 (IP)-networks that lets multicast-traffic from a source
VLAN be shared with subscriber-VLANs. The main reason to use MVR is to save bandwidth by preventing
duplicate multicast streams being sent in the core network; instead stream(s) are received on the
MVRVLAN and forwarded to the VLANs where hosts have requested them (Wikipedia).

N
NAS

NAS (Network Access Server) is meant to act as a gateway to guard access to a protected source.

A client connects to the NAS, and the NAS connects to another resource asking whether the client's
supplied credentials are valid. Based on the answer, the NAS then allows or disallows access to the
protected resource. An example of a NAS implementation is IEEE 802.1X.

NBNS

(NetBIOS Name Service); often called WINS on Windows systems. The NBNS is part of the NetBIOS-over-
TCP protocol suite. NBNS serves a purpose similar to DNS (translate human-readable names to IP
addresses).

NetBIOS

NetBIOS (Network Basic Input/Output System) is a program that allows applications on separate
computers to communicate within a Local Area Network (LAN), and it is not supported on a Wide Area
Network (WAN). The NetBIOS giving each computer in the network both a NetBIOS name and an IP
address corresponding to a different host name, provides the session and transport services described in
the Open Systems Interconnection (OSI) model.

NFS

NFS ( Network File System) allows hosts to mount partitions on a remote system and use them as though
they are local file systems. NFS allows the system administrator to store resources in a central location on
the network, providing authorized users continuous access to them, which means NFS supports sharing of
files, printers, and other resources as persistent storage over a computer network.

NTP

NTP (Network Time Protocol) is a network protocol for synchronizing the clocks of computer systems. NTP
uses UDP (datagram) as transport layer.
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(0
ONVIF

(originally an acronym for Open Network Video Interface Forum) ONVIF is a global and open industry
forum with the goal of facilitating the development and use of a global open standard for the interface of
physical IP-based security products (i.e., to create a standard for how IP products in video surveillance and
other physical security areas can communicate with each other).

Optional TLVs

An LLDP frame contains multiple TLVs For some TLVs it is configurable if the switch shall include the TLV in
the LLDP frame. These TLVs are known as optional TLVs. If an optional TLVs is disabled the corresponding
information is not included in the LLDP frame.

oul

OULl is the organizationally unique identifier. An OUI address is a globally unique identifier assigned to a
vendor by IEEE. You can determine which vendor a device belongs to according to the OUI address which
forms the first 24 bits of a MAC address.

P

PCP

PCP (Priority Code Point) is a 3-bit field storing the priority level for the 802.1Q frame. It is also known as
User Priority.

PD

PD is an acronym for Powered Device. In a PoE> system the power is delivered from a PSE ( power
sourcing equipment ) to a remote device. The remote device is called a PD.

PHY

PHY is an abbreviation for Physical Interface Transceiver and is the device that implement the Ethernet
physical layer (IEEE-802.3).

PING

Ping is a program that sends a series of packets over a network or the Internet to a specific computer in
order to generate a response from that computer. The other computer responds with an acknowledgment
that it received the packets. Ping was created to verify whether a specific computer on a network or the
Internet exists and is connected. ping uses Internet Control Message Protocol (ICMP) packets. The PING
Request is the packet from the origin computer, and the PING Reply is the packet response from the
target.

PoE

PoE (Power over Ethernet) is used to transmit electrical power, to remote devices over standard Ethernet
cable. It could for example be used for powering IP telephones, wireless LAN access points and other
equipment, where it would be difficult or expensive to connect the equipment to main power supply.

Policer

A policer can limit the bandwidth of received frames. It is located in front of the ingress queue.
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POP3

POP3 (Post Office Protocol version 3) is a protocol for email clients to retrieve email messages from a mail
server. POP3 is designed to delete mail on the server as soon as the user has downloaded it. However,
some implementations allow users or an administrator to specify that mail be saved for some period of
time. POP can be thought of as a "store-and-forward" service. An alternative protocol is Internet Message
Access Protocol (IMAP). IMAP provides the user with more capabilities for retaining e-mail on the server
and for organizing it in folders on the server. IMAP can be thought of as a remote file server. POP and
IMAP deal with the receiving of e-mail and are not to be confused with the Simple Mail Transfer Protocol
(SMTP). You send e-mail with SMTP, and a mail handler receives it on your recipient's behalf. Then the mail
is read using POP or IMAP. IMAP4 and POP3 are the two most prevalent Internet standard protocols for e-
mail retrieval. Virtually all modern e-mail clients and servers support both.

Private VLAN

In a private VLAN, communication between ports in that private VLAN is not permitted. A VLAN can be
configured as a private VLAN.

Q
QCE

QCE (QoS Control Entry) describes QoS class associated with a particular QCE ID. There are six QCE frame
types: Ethernet Type, VLAN, UDP/TCP Port, DSCP, TOS, and Tag Priority. Frames can be classified by one of
4 different QoS classes: "Low", "Normal", "Medium", and "High" for individual application.

QCL

QCL (QoS Control List) is the list table of QCEs, containing QoS control entries that classify to a specific
QoS class on specific traffic objects. Each accessible traffic object contains an identifier to its QCL. The
privileges determine specific traffic object to specific QoS class.

QoS

QoS (Quiality of Service) is a method to guarantee a bandwidth relationship between individual
applications or protocols. A communications network transports a multitude of applications and data,
including high-quality video and delay-sensitive data such as real-time voice. Networks must provide
secure, predictable, measurable, and sometimes guaranteed services. Achieving the required QoS
becomes the secret to a successful end-to-end business solution. Therefore, QoS is the set of techniques
to manage network resources.

R
RARP

RARP (Reverse Address Resolution Protocol) is a protocol that is used to obtain an IP address for a given
hardware address, such as an Ethernet address. RARP is the complement of ARP.

RADIUS

RADIUS is an acronym for Remote Authentication Dial In User Service. It is a networking protocol that
provides centralized access, authorization and accounting management for

people or computers to connect and use a network service.
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RSTP

In 1998, the IEEE with document 802.1w introduced an evolution of STP: the Rapid Spanning Tree Protocol,
which provides for faster spanning tree convergence after a topology change. Standard IEEE 802.1D-2004
now incorporates RSTP and obsoletes STP, while at the same time being backwards compatible with STP.

S
SHA

SHA (Secure Hash Algorithm) was designed by the National Security Agency (NSA) and published by the
NIST as a U.S. Federal Information Processing Standard. Hash algorithms compute a fixed-length digital
representation (known as a message digest) of an input data sequence (the message) of any length.

Shaper
A shaper can limit the bandwidth of transmitted frames. It is located after the ingress queues.
Smart Switch (AKA, Lightly Managed Switch)

This category of switches offers certain levels of Management, QoS, Security, etc. with somewhat “lighter”
capabilities and scalability than the Managed switches. This makes them a cost-effective alternative to
Managed switches. Smart switches fit well at the edge of a large network; Managed Switches are better
suited in the core. Smart switches are also used in infrastructures with smaller deployments, or for
generally less complex networks.

The capabilities available for the Smart switch category vary, but most have a browser-based Management
interface, often with CLI and/or SNMP. Smart switches let you segment a network into workgroups by
creating VLANSs, but with fewer VLANs and nodes than with a Managed switch. Smart switches offer some
levels of security, such as 802.1x endpoint authentication, and/or a limited set of Access Control Lists
(ACLs). Smart switches support basic QoS (Quality Of Service) that lets you prioritize users and
applications per 802.1q/TOS/DSCP.

Transition Networks' SMXTAT2SA switches are included in this Smart Switch (Lightly Managed Switch)
category.

SMTP

SMTP (Simple Mail Transfer Protocol) is a text-based protocol that uses the Transmission Control Protocol
(TCP) and provides a mail service modeled on the FTP file transfer service. SMTP transfers mail messages
between systems and notifications regarding incoming mail.

SNAP

The Sub Network Access Protocol (SNAP) is a mechanism for multiplexing, on networks using IEEE 802.2
LLC, more protocols than can be distinguished by the 8-bit 802.2 Service Access Point (SAP) fields. SNAP
supports identifying protocols by Ethernet type field values; it also supports vendor private protocol
identifier.

SNMP

SNMP (Simple Network Management Protocol) is part of the Transmission Control Protocol/Internet
Protocol (TCP/IP) protocol for network management. SNMP allow diverse network objects to participate in
a network management architecture. It enables network management systems to learn network problems
by receiving traps or change notices from network devices implementing SNMP.

SNTP

SNTP (Simple Network Time Protocol) is a network protocol for synchronizing the clocks of computer
systems. SNTP uses UDP (datagrams) as transport layer.
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SSID

Service Set Identifier is a name used to identify the particular 802.11 wireless LANs to which a user wants
to attach. A client device will receive broadcast messages from all access points within range advertising
their SSIDs, and can choose one to connect to based on pre-configuration, or by displaying a list of SSIDs
in range and asking the user to select one (Wikipedia).

SSH

SSH (Secure Shell) is a network protocol that allows data to be exchanged using a secure channel between
two networked devices. The encryption used by SSH provides confidentiality and integrity of data over an
insecure network. The goal of SSH was to replace the earlier rlogin, TELNET and rsh protocols, which did
not provide strong authentication or guarantee confidentiality (Wikipedia).

STP

Spanning Tree Protocol is an OSI layer-2 protocol which ensures a loop free topology for any bridged LAN.
The original STP protocol is now obsolete by RSTP.

T
TACACS +

TACACS+ (Terminal Access Controller Access Control System Plus) is a networking protocol which provides
access control for routers, network access servers and other networked computing devices via one or
more centralized servers. TACACS+ provides separate authentication, authorization and accounting
services.

Tag Priority
Tag Priority is a 3-bit field storing the priority level for the 802.1Q frame.
TCP

TCP (Transmission Control Protocol) is a communications protocol that uses the Internet Protocol (IP) to
exchange the messages between computers. The TCP protocol guarantees reliable and in-order delivery
of data from sender to receiver and distinguishes data for multiple connections by concurrent applications
(for example, Web server and e-mail server) running on the same host. The applications on networked
hosts can use TCP to create connections to one another. It is known as a connection-oriented protocol,
which means that a connection is established and maintained until such time as the message or messages
to be exchanged by the application programs at each end have been exchanged. TCP is responsible for
ensuring that a message is divided into the packets that IP manages and for reassembling the packets
back into the complete message at the other end. Common network applications that use TCP include the
World Wide Web (WWW), e-mail, and File Transfer Protocol (FTP).

TELNET (or Telnet or telnet)

TELNET (TELetype NETwork) is a terminal emulation protocol that uses the Transmission Control Protocol
(TCP) and provides a virtual connection between TELNET server and TELNET client.

TFTP

TFTP (Trivial File Transfer Protocol) is a transfer protocol that uses the User Datagram Protocol (UDP) and
provides file writing and reading, but it does not provide directory service and security features.
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U
uDP

UDP (User Datagram Protocol) is a communications protocol that uses the Internet Protocol (IP) to
exchange the messages between computers. UDP is an alternative to the Transmission Control Protocol
(TCP) that uses the Internet Protocol (IP). Unlike TCP, UDP does not provide the service of dividing a
message into packet datagrams, and UDP doesn't provide reassembling and sequencing of the packets.
This means that the application program that uses UDP must be able to make sure that the entire
message has arrived and is in the right order. Network applications that want to save processing time
because they have very small data units to exchange may prefer UDP to TCP. UDP provides two services
not provided by the IP layer. It provides port numbers to help distinguish different user requests and,
optionally, a checksum capability to verify that the data arrived intact. Common network applications that
use UDP include the Domain Name System (DNS), streaming media applications such as IPTV, Voice over
IP (VoIP), and Trivial File Transfer Protocol (TFTP).

User Priority

User Priority is a 3-bit field storing the priority level for the 802.1Q frame. It is also known as PCP.

4
VLAN

A Virtual LAN is method to restrict communication between switch ports. VLANs can be used for the
following applications:

VLAN unaware switching: This is the default configuration. All ports are VLAN unaware with Port VLAN ID
1 and members of VLAN 1. This means that MAC addresses are learned in VLAN 1, and the switch does
not remove or insert VLAN tags.

VLAN aware switching: This is based on the IEEE 802.1Q standard. All ports are VLAN aware. Ports
connected to VLAN aware switches are members of multiple VLANs and transmit tagged frames. Other
ports are members of one VLAN, set up with this Port VLAN ID, and transmit untagged frames.

Provider switching: This is also known as Q-in-Q switching. Ports connected to subscribers are VLAN
unaware, members of one VLAN, and set up with this unique Port VLAN ID. Ports connected to the service
provider are VLAN aware, members of multiple VLANSs, and set up to tag all frames. Untagged frames
received on a subscriber port are forwarded to the provider port with a single VLAN tag. Tagged frames
received on a subscriber port are forwarded to the provider port with a double VLAN tag.

VLAN ID
A VLAN ID is a 12-bit field specifying the VLAN to which the frame belongs.
Voice VLAN

Voice VLAN is VLAN configured specially for voice traffic. By adding the ports with voice devices attached
to voice VLAN, we can perform QoS-related configuration for voice data, ensuring the transmission
priority of voice traffic and voice quality.
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